
  

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 1 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Alfabet Reference Manual 

Getting Started with 
Alfabet  



  

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Documentation Version Alfabet 10.15.1 

Copyright © 2013 - 2023 Software AG, Darmstadt, Germany and/or Software AG USA Inc., Reston, VA, USA, 
and/or its subsidiaries and or/its affiliates and/or their licensors. 

Use, reproduction, transfer, publication or disclosure is prohibited except as specifically provided for in your 
License Agreement with Software AG. 

The name Software AG and all Software AG product names are either trademarks or registered trademarks 
of Software AG and/or Software AG USA Inc. and/or its subsidiaries and/or its affiliates and/or their licen-
sors. Other company and product names mentioned herein may be trademarks of their respective owners. 

This software may include portions of third-party products. For third-party copyright notices, license 
terms, additional rights or restrictions, please refer to "License Texts, Copyright Notices and Disclaimers of 
Third Party Products". For certain specific third-party license restrictions, please refer to section E of the 
Legal Notices available under "License Terms and Conditions for Use of Software AG Products / Copyright 
and Trademark Notices of Software AG Products". These documents are part of the product documenta-
tion, located at http://softwareag.com/licenses and/or in the root installation directory of the licensed 
product(s). 

Software AG products provide functionality with respect to processing of personal data according to the 
EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are documented in the 
respective administration documentation. 

http://softwareag.com/licenses


  

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 3 

Conventions used in the documentation 

 

Convention Meaning  

Bold Used for all elements displayed in the Alfabet interface including, for example, menu 
items, tabs, buttons, dialog boxes, page view names, and commands.  

Example: Click Finish when setup is completed. 

Italics Used for emphasis, titles of chapters and manuals. 

this 

Example: see the Administration reference manual.  

Initial Capitals Used for attribute or property values.  

Example: The object state Active describes...  

All Capitals Keyboard keys 

Example: CTRL+SHIFT  

File > Open Used for menu actions that are to be performed by the user. 

Example: To exit an application, select File > Exit 

< > Variable user input 

Example: Create a new user and enter <User Name>. (Replace < > with variable data.) 

 
This is a note providing additional information. 

 
This is a note providing procedural information. 

 
This is a note providing an example. 

 
This is a note providing warning information. 
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Chapter 1:  Welcome to Alfabet  

This reference manual provides basic information to help you understand the features available in Alfabet 
and carry out your tasks using those features. The first chapters explain basic issues including accessing 
and defining settings for your user interface as well as how to navigate the Alfabet interface. 

The following few chapters address how to work the objects in Alfabet -- that is, the applications, compo-
nents, projects, etc. that are the focus of your tasks. This section explains in detail basic concepts of cap-
turing and editing your IT landscape in Alfabet and the different kinds of views, reports, and business 
graphics you might encounter. 

The other chapters describe the many capabilities provided by Alfabet to support communication with 
other users about your enterprise’s IT landscape. The following scenarios are examples of how Alfabet sup-
ports collaboration about the IT architecture in the enterprise: 

Ask Colleagues to Provide Information about an Object via an Assignment: 

• An assignment allows you to define tasks that must be done in relation to a specific object in the IT 
landscape. You can then assign the task to the relevant user or break the task down into sub-
assignments that cover specific aspects of the relevant object and send each sub-assignment to 
the user responsible for a specific aspect of an object. A notepad functionality allows a detailed 
dialog to occur between multiple users about a particular object or assignment, and reminders and 
automatically-generated emails allow you to keep track of targeted due dates. 

Send a Colleague an Express View with Up-to-Date Data  

• An express view can be sent as a URL via email to a person inside or outside of your Alfabet 
community. When the person clicks the link, he/she will view the most current and up-to-date 
information in the Alfabet database. 

Collaborate with Colleagues via Posts about Specific Objects and Views  

• The My Collaborations functionality supports a free-form exchange of information and ideas 
about objects or views in alfabet by members of the user community. The capability supports the 
exchange of user-generated content as is common in social bookmarking. 

Carry Out Your Specific Data Input or Maintenance Tasks in a Distributed Workflow Process  

• The My Workflows and My Workflow Activities functionalities allow users to initiate and manage 
workflow processes. Typical scenarios for workflows include project approval processes and the 
introduction of new technologies. 

Access Up-to-Date Information about the IT via an Executive Dashboard  

• The Dashboards functionality provides a portal-like environment made up of bookmarks that 
allows the business manager to easily access data via an executive dashboard in order to ascertain 
the health of the enterprise and make informed business decisions. 

Keep Track of Data Input Requirements via Monitors  

• A monitor allows you to keep track of the activity, inactivity, or impending deadlines concerning 
objects in the Alfabet system. A set of users can be informed automatically per email when a 
defined monitor is triggered, thus allowing action to be taken in a timely manner. 
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The following information is available: 

• Welcome to Alfabet  

• Getting Started With Your Alfabet Solution 

• Navigating the Alfabet Interface 

• Creating, Maintaining, and Evaluating Data in Alfabet 

• Searching for Your Objects 

• Managing Your Objects and Object Responsibilities 

• Managing Your Calendar, Tasks, and Timesheets 

• Creating, Managing, and Accessing Your Bookmarks 

• Communicating and Collaborating with Your Colleagues in Alfabet  

• Sending and Receiving Assignments for Alfabet Objects 

• Executing Workflows and Participating in Workflow Steps 

• Keeping Track of Objects via Monitors 

• Creating a Splash Screen As Your Start Page 

• Designing, Sharing, and Viewing Analytics Dashboards 

• Defining and Navigating with Your Corporate Frameworks 

• Working with Storyboards 

• Appendix: Configuration Tools and Functionalities for Alfabet  
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Chapter 2:  Getting Started With Your Alfabet Solution  

You can access Alfabet via your Web browser. Supported browsers are Microsoft® Internet Explorer®, 
Chrome, Firefox, Safari. Please refer to the Technical Requirements to find out which version numbers are 
currently supported and which browser settings are required. 

Please note that you can use many of your browser's functionalities when working with Alfabet such the 
tabbing feature, printing, scroll bars, and the right-click and Shift+Click interactions to open a link in a new 
tab or window. Click your browsers Back button to navigate back to the previous page. A breadcrumbs trail 
is available to help you return to other pages in Alfabet that you have visited. 

 
Please note the following: 

• It is not possible to open Alfabet by means of a URL that has been copied and pasted 
into another browser tab if the user credentials of the user accessing Alfabet by means 
of the copied URL are different than those of the user logged in to Alfabet when the URL 
was copied. When attempting to log in with different user credentials, the session 
expired screen will be displayed and the user will have to re-login in to Alfabet. If the 
user logs in with the same credentials used when the URL was copied, the page view will 
be displayed. The user can navigate back in the browser history to a previous page view 
if that view has been created with the same user credentials as that used by the current 
user. If the user logs in with different user credentials, the user's start page will be 
displayed. The execution of bookmarks and hyperlinks in express view notifications as 
well as other notification emails generated in the context of Alfabet are not impacted. 

• Surrogate symbols (for example, symbols of the range D800 to DFFF in Unicode 
notation) cannot be handled in Alfabet. If such symbols are introduced to the Alfabet 
database, the application may not work correctly. Symbols of this kind should never be 
introduced to the Alfabet database through any interaction with the user interface. 

The following information is available: 

• Configuration of Your Alfabet Solution 

• Logging In and Logging Out 

• Changing the User Profile That You Are Logged In With 

• Changing the Mandate That You Are Logged In With 

• Defining the Language of the User Interface 

• Changing Your Password 

• Defining Your User Information 

• Defining Your User Settings in Alfabet 

• Understanding Access Permissions in Alfabet 

• Visibility of Objects in a Federated Architecture Using Mandates 

• Access Permissions via the User Profile 

• Permissions to Objects for Authorized Users 

• Permissions to Objects for Authorized User Groups 
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• Permissions to Objects for Deputies 

• Permissions to Objects via Permission Rules 

• Permissions to Objects Targeted by Discussions 

• Permissions to Object's Targeted by Assignments 

• Permissions to Objects Targeted by a Workflow Step 

• Permissions to Objects Based on the Release Status 

• Purpose of Responsible Organizations 

• Purpose of Roles 

• Barrier-Free Accessibility in Alfabet 

• General Information About Using Keyboard Shortcuts 

• Using Keyboard Shortcuts in the Start Page and Menu Bar 

• Using Keyboard Shortcuts in the Guide Page 

• Using Keyboard Shortcuts in Explorers 

• Using Keyboard Shortcuts in Object Profiles and Object Cockpits 

• Using Keyboard Shortcuts in Page Views 

• Using Keyboard Shortcuts in Editors, Wizards and Filters 

• Using Keyboard Shortcuts in the Object Selector and Person Selector 

• Using Keyboard Shortcuts in the Bookmark Desktop Functionality 

• Using Keyboard Shortcuts in the Search Functionalities 

• Viewing Your Enterprise's Broadcast Messages 

• Using the Help in Alfabet 

• Using the AlfaBot Capability 

• Using the Automated Help Assistant 

• Using the Context-Sensitive Help 

• Using the Help Available for Editor Fields and Filter Fields 

• Requesting User Assistance for a View in the User Interface 

• Reporting Issues about Your Alfabet Product 

• Using the Showcase Database 

• Example Reports in the Showcase Database 
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Configuration of Your Alfabet Solution  

Alfabet is a highly modular, scalable, and configurable software. As a result of this high degree of configu-
rability, what you see in your Alfabet interface may differ from the documentation of the standard Alfabet 
interface. 

 

Your Alfabet solution environment is largely configured by your solution designer using the con-
figuration tool Alfabet Expand. For more information about configuration of the Alfabet solution, 
see the reference manual Configuring Alfabet with Alfabet Expand. 

The following aspects may influence the user interface that you see: 

• Your Enterprise’s Alfabet Product: The functionalities available in your Alfabet product depends 
on the capability packages that your company has purchased. Please note that the Alfabet 
documentation describes all available functionalities. 

• Configuration of Your User Profile: The user profile you log in with will determine the 
functionalities you have access to as well as your access permissions to the object classes and 
their views in Alfabet. The user profile specifies the Alfabet functionalities available to a user, the 
visibility and editability of object classes and their object class attributes, as well as the availability 
of associated capabilities including, for example, wizards and workflows. 

• Naming of Functionalities: Your enterprise may choose to change the captions of functionalities 
in order to emphasize specific processes or tasks important to the user community. If this is the 
case, the names of functionalities that you see may deviate from the standard described here. 

• Hidden Classes: Object classes and object class properties may be excluded from some user 
profiles. If an object class is hidden, all related views will be removed from Alfabet. For example, if 
the object class Business Function is excluded for a specific profile, the Business Services Page 
View for an application, which is dependent on the class Business Function, will also be removed 
from your interface. 

• Customized Editors: Your enterprise may require that customer-specific data is captured for an 
object class. In this case, additional tabs will be added to the standard class editor. Custom tabs in 
editors are not included in the standard Help provided with Alfabet. 

• Table Columns: A user with Read/Write access permissions to an object may hide information 
about the object displayed in the object's page views. For example, the user may choose to hide 
specific attributes for an object by hiding the table column in the page view. Likewise, the user 
may add other standard or custom attributes to the view. The captions of the table columns may 
also display different captions if the solution designer has configured non-standard captions for 
the attributes. Whether it is possible to define the visibility of table columns will depend on the 
configuration of the server alias by your system administrator. For more information, see the 
section Configuration Attributes for the Alfabet Components in the reference manual System 
Administration. 

Logging In and Logging Out  

To login to Alfabet, you must have a user name, password, and user profile assigned to you. This is typically 
done by your user administrator. 
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In most enterprises, Alfabet is typically accessed via the configuration of Windows Sign On or a single sign-
on mechanism like SAML authentication. In this case, when you open your Alfabet solution in a browser, 
you will immediately see the Alfabet interface and do not need to enter your user name and password in 
the login screen. The default user profile and default language specified by your solution designer will be 
displayed the first time you login as well as when users access the Alfabet solution via an external access 
mechanism such as express views. 

If Windows Sign On is not configured for your company, enter your user name in the User Name field and 
your password in the Password field and click Log In. The user name that you log in with will be displayed 
below the Log In button. The first time you log in, you will see the functionalities associated with your de-
fault user profile. If a default user profile has not yet been defined in your user settings, you must select the 
user profile with which you want to access the Alfabet solution. 

 
The Alfabet Web Application may be configured to provide an I forgot my password link in the 
login screen. If you click the link, the user password will be automatically reset and the Regener-
ate Password function will be invoked. You will receive two emails. One email will provide your 
user name and a link to a first login screen, and a second email will include the first login pass-
word. Upon the first login, you will be prompted to change the password. The functionality is only 
available for users that are logging in via standard login with the user name and password man-
aged directly in the Alfabet database. 

Please note that for security reasons, you will see the message that the functionality has been 
successfully executed even if the user name you entered is not correct. If you do not receive 
emails with the new login data after having invoked the functionality, you might have invoked the 
functionality with a typo in the user name. Re-enter your user name and click I forgot my pass-
word again. If you still receive no emails, contact your user administrator for support. 

The language will be displayed in the default language specified by your solution designer. 

 
Please be aware however that the language settings for your browser will override the language 
settings in your Alfabet solution. 

After your initial login, Alfabet will open using the user profile and interface language that you were last 
logged in with. Your user name will be displayed on the user button in the upper-right corner of the user 
interface. Above the <Alfabet User Name> button and Help button, you will see the server alias that you 
are currently connected with, the user profile and mandate that you are currently logged in with, and the 
current local time. The date format is determined by the configuration of your cultures. 

It is possible to work with Alfabet in multiple browser tabs. If you log into Alfabet and display Alfabet in mul-
tiple browser tabs on the same browser platform, the same session ID will be used for each tab. When you 
log out from one instance of Alfabet in a browser tab and attempt to continue working with Alfabet in an-
other browser tab, the session ID will no longer be available and a message will be displayed stating that the 
session has expired. 

 
For more information regarding supported browsers, see Technical Requirements. Please note 
that the Alfabet Expand user interface freezes when the user executes the Duplicate function 
available when right-clicking the browser tab in Google Chrome®. This can be addressed by re-
freshing the newly created browser tab. 

For more information about changing your user profile and interface language, see the sections 
Changing the User Profile That You Are Logged In With and Defining the Language of the User In-
terface. For more information about configuring your user settings, see the section Defining Your 
User Settings in Alfabet. 
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To end your session, click the <Alfabet User Name> menu in the top right corner and select Log out in the 
drop-down menu. Your session will end and the log in dialog will be displayed. If you opened multiple tabs 
to work with Alfabet within the session, the log out action will end the session for all tabs. When you login in 
to Alfabet again, the last user profile that you were logged in as well as the last language setting will be 
used to render the interface. The user profile and language setting can be changed in the <Alfabet User 
Name> menu as needed. 

Changing the User Profile That You Are Logged In With  

A user profile describes the functional scope that is available to users. Typically, the majority of users will 
have only one user profile assigned. Yet certain users may possess several user profiles that correspond to 
their responsibilities in the enterprise. If more than one user profile is assigned to you, the default user pro-
file defined by your solution designer will be used the first time you login to Alfabet. Therefore, the first 
time you log in, you will see the functionalities associated with your default user profile and the language 
will be displayed in the default language specified by your solution designer. After your initial login, Alfabet 
will open using the user profile and interface language that you were last logged in with. 
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Above the <Alfabet User Name> button and Help button, you will see the name of the user profile and 
mandate that you are currently logged in with, the server alias that you are currently connected with, and 
the current local time. To switch to another user profile assigned to you, click the <Alfabet User Name> > 
Change User Profile in the upper-right corner of the interface. In the drop-down menu, select a user pro-
file from the list of user profiles assigned to you. The functionalities valid for the user profile selected will be 
displayed. 

The Attached User Profiles Page View available in the Personal Info functionality displays all user profiles 
assigned to your user name. 

 

For an overview of the implementation of permission concepts in Alfabet, see the section Under-
standing Access Permissions in Alfabet. Please note that the Default User Profile attribute in 
your user settings determines the default user profile used when accessing Alfabet via external 
access such as an express view. For more information about defining the default user profile in 
your user settings, see the section Defining Your User Settings in Alfabet. 

Changing the Mandate That You Are Logged In With 

Some enterprises have a federated architecture. If this is the case in your enterprise, then the concept of 
mandates may be implemented to control the visibility of objects in Alfabet. 

A mandate is a means to organize and structure the federated architecture of a holding company. The as-
signment of mandates to objects allows the holding company to structure the objects in the enterprise ar-
chitecture in order to regulate visibility to objects across some or all subsidiaries. Only users explicitly as-
signed to a mandate will see objects with that mandate definition. An object that has not been assigned to 
a mandate is considered not to be owned by a mandate and is thus visible throughout the holding company 
to users with relevant access permissions. 

The use of mandates in the Alfabet solution is optional. If mandates are implemented in an enterprise, the 
visibility of an object with a mandate assignment will take precedence over other concepts of access per-
missions in Alfabet. For example, an authorized user of an object must be assigned the relevant mandate to 
access the object that he/she is the owner of. 
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Within the context of mandates, the conventional rules governing access permissions apply. Thus, a user 
assigned to a mandate will only have Read/Write access permission to the objects made visible by the man-
date if he/she has authorized access to the object as an authorized user, deputy, member of an authorized 
user group or discussion group or via rule-based access permissions, workflow contributor or assignee of 
an assignment. 

If you are assigned a mandate, the interface will automatically open with that mandate applied. If multiple 
mandates have been assigned to you, the interface will open per default with the first mandate selected by 
your user administrator in the Mandates tab of the User editor. You may only be logged in with one man-
date at a time. 

Above the <Alfabet User Name> button and Help button, you will see the name of the mandate and user 
profile that you are currently logged in with, the server alias that you are currently connected with, and the 
current local time. To switch to another mandate, click <Alfabet User Name> > Change User Mandate in 
the upper-right corner of the interface and click the relevant mandate. The start page will be displayed and 
the new mandate applied to the interface. 

 

Please note that if only one mandate has been assigned to you, the Change User Mandate op-
tion will not be displayed in the <Alfabet User Name> menu. For more information about the as-
signment of mandates to a user, see the section Assigning a Mandate to a User in the reference 
manual User and Solution Administration. For general information about the implementation of 
the mandate capability, see the section Visibility of Objects in a Federated Architecture Using 
Mandates. 

 

 
Please note that mandates are not supported if you are working with ARIS - Alfabet Interopera-
bility Interface. 

Defining the Language of the User Interface  

When you first open the Alfabet interface, the primary language defined by your enterprise will be automat-
ically displayed. After your initial login, Alfabet will open using the interface language that you were last 
logged in with. Please note the following: 

• Please be aware that the language settings for your browser may override the language settings in 
your Alfabet solution. 

• The languages available in the Language menu are available based on the cultures configured for 
your enterprise and determine the language of the Alfabet interface and online Help as well as the 
formatting for dates and time. The primary culture is configured by your solution designer. For 
more information, see the section Specifying the Cultures Relevant to Your Enterprise in the 
chapter Localization and Multi-Language Support for the Alfabet Interface in the reference 
manual Configuring Alfabet with Alfabet Expand. 

• A bookmark will be displayed using the language that it was created with, even if you are logged in 
with a different language when you open the bookmark. You can change the language of the 
bookmarked view via the <Alfabet User Name> > Language option. For more information about 
creating a new bookmark, see the section Creating, Managing, and Accessing Your Bookmarks. 

• The language displayed for a user's email notifications is specified by a user administrator in the 
Email Notification Language attribute for the relevant user in the User Administration 
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functionality accessible via an administrative user profile. For more information, see the section 
Defining and Managing Users in the reference manual User and Solution Administration. 

The Language sub-menu in the <Alfabet User Name> menu will not be displayed if only one culture has 
been specified in the solution configuration. If multiple cultures have been configured for your enterprise, 
you can change the language at any time during a user session by clicking <Alfabet User Name> > Lan-
guage in the upper-right corner of the interface and selecting one of the languages supported by your en-
terprise. 

The Alfabet interface is available in the following languages: 

Language Locale ID 

Arabic (Saudi Arabia) 1025 

German (Germany) 1031 

English (United States) 1033 

French (France) 1036 

Portuguese (Brazil) 1046 

Polish (Poland) 1045 

If you are displaying the user interface in a secondary language (not the language associated with the pri-
mary culture defined by your enterprise), you will see most interface elements such as page view captions 
and editor field captions displayed in the selected secondary language. You can however translate some 
object data such as the name and description of your Alfabet objects to a secondary language in the re-
spective object's editor. For more information about the object data translation capability, see the section 
Multi-Language Support in Editors and Wizards. 

Changing Your Password  

Passwords are assigned to a user in the User Administration functionality available via an administrative 
user profile. Depending on the configuration of your user definition, you may be required to change your 
password during the first login or if the password reaches its expiration date. You can subsequently change 
your password, as needed. The Change Password function is disabled for users logging in by means of an 
enterprise login (for example, by means of federated authentication or Windows sign-on). 

To change your password, click <Alfabet User Name> > Change Password in the upper-right corner of the 
interface. In the Change Password editor, enter your current password in the Current Password field. In 
the New Password field, enter the new password. Reenter the new password in the Confirm New Pass-
word field and click OK. 
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For more information about the configuration of user passwords, see the section Defining, Clearing, and 
Resetting a User’s Password in the reference manual User and Solution Administration. 

Defining Your User Information  

The Personal Info option allows you to provide an email address, telephone number, Skype ID, and upload a 
picture of yourself. This information may be modified or updated by your user administrator. To access the 
Personal Info option, click the <Alfabet User Name> menu and select Personal Info. The Personal Info 
editor opens. Define the following as needed: 

• Email: Enter your email address. The email address is necessary for notification emails sent in the 
context of various Alfabet functionalities including, for example, assignments and monitors. 

• Phone: Enter a telephone number where you can be reached. 

• Skype ID: Enter your Skype ID. A maximum of 128 characters is allowed. If interoperability with 
Skype is permissible for you, a Skype icon will be displayed next to your name in the Attributes 
section of object profiles/object cockpits and previews, allowing other users to contact you as the 
authorized user of an object should questions arise. Integration with Skype Business Service must 
be configured in order to implement Skype in the context of Alfabet.  

 
The Skype ID and Skype Domain attributes will only be displayed in the User editor and 
in Users Administration functionality if interoperability with Skype for Business 
Server® is activated. For more information about using the Skype capability to com-
municate with your colleagues, see the section Skyping with Your Colleagues. For more 
information about configuring integration with Skype, see the section Configuring In-
teroperability with Skype for Business Server® in the reference manual API Integration 
with Third-Party Components. 

• Skype Domain: Enter your Skype domain to implement interoperability with Skype. 

• MS Teams User Name: Enter your Microsoft Teams® user name to use the integration with 
Microsoft Teams for chatting about an object with colleagues both in Microsoft Teams and Alfabet 
synchronously.  

 
Integration with Microsoft Teams is only available if your company configured the inte-
gration interface for data exchange with Microsoft Teams. In most cases companies will 
then use batch data processing to fill the MS Teams User Name field with the required 
information for all users. 

• Picture: Click the arrow to upload a picture to Alfabet. The picture can be in GIF, PNG, or JPG 
formats and may not be larger than 16 KB. The picture will be displayed in the context of the My 
Collaborations functionality and in the main toolbar of the Alfabet user interface next to the 
< UserName > menu. For more information about the collaboration capability, see the section 
Communicating with Your Colleagues via the Alfabet Internal Collaboration Functionality. 
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Defining Your User Settings in Alfabet  

User settings are the settings that you can define for your user profile. Default settings are typically de-
fined by your enterprise, but you can define and save your user settings for the user profile that you are 
currently working with. Your user settings will be persistent and applied to future user sessions. 

 

For more information about the default configuration of user settings on an enterprise-wide ba-
sis, see the section Configuring Default User Settings for the User Community in the reference 
manual Configuring Alfabet with Alfabet Expand. 

To define your user settings: 

1) In the toolbar, click <Alfabet User Name> > User Settings. 

2) In the Basic Settings tab, define the following, as needed:  

• Default User Profile: Select the user profile that you want as your default user profile when 
you log in. The default user profile will be automatically displayed when you log in. The default 
user profile may also be used when accessing Alfabet by means of an express view. For more 
information, see the chapter Sending and Receiving Express Views. 

• Show Bookmarks As: Specify the default view for your bookmarks displayed in the 
Bookmarks Desktop functionality. Select Details to display the bookmarks in a table 
structure. Select Icons to display the bookmarks as icons on the desktop.  

 

For more information about working with bookmarks, see the section Creating, 
Managing, and Accessing Your Bookmarks. 

• Show Retired Objects: Select the checkbox if you want objects that have reached a retired 
object state to be displayed in search results as well as configured reports based on an alfabet 
query. Clear the checkbox if you do not want objects that have reached a retired object state 
to be displayed in search results and configured reports based on a query.  

 
The setting for Show Retired Objects is ignored for standard views and configured 
reports based on native SQL. For configured reports based on a native SQL query, 
the report designer must specify the inclusion of retired objects in the native SQL 
query. 

• Show Dialog When Printing Datasets: Select the checkbox if the user prompt Please use 
the Print capability in your browser to print this view should be displayed each time the 
user prints an Alfabet view. Clear the checkbox if the user prompt should be suppressed and 
not displayed each time the user prints an Alfabet view. Please note that if the Add Filter 
Summary option is available for a page view or configured report, the dialog will be displayed 
regardless of this setting so that the Add Filter Summary option can be selected for printing. 

• Show Empty Values in Object Profile: Select the checkbox to display attributes that are not 
defined in the Attributes section of the object profile. If a value is not defined, the text 
undefined will be displayed. Clear the checkbox to hide attributes that are not defined in the 
Attributes section of the object profile.  

 
If a property is editable in the user's wizard/editor for the associated object 
class/object class stereotype and the Show Empty Values in Object Profile 
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checkbox is cleared (= False), the setting will be ignored so that the attribute can 
be edited in the context of in-place editing in the object cockpit/object profile. 

• Validate Information Flow Dates: Specify whether information flows may or may not be 
created with invalid start and end dates. If the checkbox for the Validate Information Flow 
Dates attribute is selected (=True), then an error message will occur if you try to create an 
information flow for source and target objects that do not have intersecting dates and you will 
not be able to create the invalid information flow. If the checkbox for the Validate 
Information Flow Dates attribute is not selected (=False), then the information flow can be 
created. In this case, the start date of the information flow will be the earliest date defined for 
the source or target object and the end date will be the latest date defined for the source or 
target object. Invalid information flow dates will be highlighted red in the Information Flows 
page view and should be corrected via the Align Dates functionality. The Validate 
Information Flow Dates checkbox is selected (= Yes) per default and reflects the standard 
behavior of previous releases. 

• Enable Splash Screen: Select the checkbox if the Edit Splash Screen option should be 
available in the Bookmark menu. Clear the checkbox if the Edit Splash Screen option should 
not be available in the Bookmark menu. For more information about the splash screen 
capability, see the chapter Creating a Splash Screen As Your Start Page. 

• Enable Automated Help Assistant: Select the checkbox if the automated assistants available 
to your user profile should be displayed. Clear the checkbox to disable all configured 
automated assistants that are available to you via your user profile. For more information 
about the help provided by automated assistants, see the section Using the Automated Help 
Assistant. 

• Capture Translations in Language of User Interface: Select the checkbox if per default 
object data in editors and wizards shall be shown and edited in the current language of the 
user interface. Clear the checkbox if per default object data in editors and wizards shall be 
shown and edited in the primary language specified for the enterprise or for the object in the 
editor/wizard. This checkbox must be selected to capture data in a secondary language or 
statutory language. For more information about capturing data in a secondary language, see 
the section Capturing Data in a Secondary Language and Capturing Data in a Statutory 
Language. 

• Enable Feedback Bot: Select the checkbox if the Feedback Bot available to your user profile 
should be displayed. The Feedback Bot allows users to provide feedback for a view, configured 
report, object cockpit, guide view, etc. For more information about the configuration of the 
Feedback Bot, see the section Configuring the Feedback Bot. 

• Enable Check Feedback for View: Select the checkbox to activate the Feedback for Current 
View capability. This is relevant for user profiles responsible for reviewing and responding to 
feedback provided via the Feedback Bot.  

 

Feedback that has been provided for a view or report via the Feedback Bot can be 
displayed in the Alfabet user interface in a secondary view for those users respon-
sible for reviewing and responding to the feedback. This allows the responsible us-
ers to navigate the Alfabet user interface and see the feedback for the relevant 
view where they currently are. A secondary view with the caption Feedback for 
Current View will be displayed with a link if feedback has been provided for the 
view, configured report, object cockpit, guide view, etc. Clicking the link will open 
the Feedback Review Functionality in a new browser tab which displays all feed-
back in detail for the view. To implement the Feedback for Current View capabil-
ity, the Enable Feedback for View checkbox must be selected in the User Profile 
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editor for the relevant user profile and the Enable Check Feedback for View 
checkbox must be selected for the relevant user in the User Settings editor. 

• Enable User Interface to Poll Web Server: Web polling allows the user interface to poll the 
server for the completion status of background processes for which completion shall be 
announced via an Event Feedback message. Select the Enable User Interface to Poll Web 
Server checkbox to enable Web polling in your user interface.  

 
Additional configuration is required to implement the Web polling mechanism. For 
more information, see the section Configuring the Web Polling Mechanism in the ref-
erence manual Configuring Alfabet with Alfabet Expand. 

• Enable Animations of Visualizations: Select the checkbox if the graphics in standard views 
and configured reports displaying portfolios, Gantt charts, branching diagrams, sunray 
diagrams, circular roadmaps, etc. shall be built dynamically when the view is opened. 

• Execute Object Validation on Access: Specify whether object validation rules should be 
executed and violations displayed in the object profile.  

• Select Default if the execution of validation rules should be determined by the default 
settings specified by your enterprise. 

• Select No if validation rules should not be executed or violations displayed. 

• Select Yes if all validation rules should be executed and violations displayed in the object 
profile. Depending on your configuration, you may see the following icons: Information 

, Warning  ; or Error .  

 
Please note that implementing the Execute Object Validation on Access ca-
pability may significantly impact performance since each upload to the data-
base will trigger the execution of all validation rules. Object validation rules are 
post-conditions configured for wizard steps. 

Due to the impact on performance, it is highly recommended that validation 
rules are instead configured in the context of a check entry configuration for an 
object cockpit. For more information about the configuration of check entries in 
object cockpits, see the section Adding a Check Entry to the Object Cockpit in 
the chapter Configuring Object Views in the reference manual Configuring 
Alfabet with Alfabet Expand For more information about the configuration of 
post-conditions for wizard steps, see the section Defining Pre-Conditions and 
Post-Conditions for a Wizard Step in the reference manual Configuring Alfabet 
with Alfabet Expand. 

• Include Filter Summary: Specify if the filter settings defined in a view or configured report 
should be included when exporting to PPT, XLS or ZIP formats.  

• Select Default if the inclusion of the filter summary in exports should be determined by 
the default settings specified by your enterprise. 

• Select Yes if the filter settings defined in a view or configured report should be included 
when exporting to PPT, XLS or ZIP formats. 

• Select No if the filter settings defined in a view or configured report should not be 
included when exporting to a PPT, XLS or ZIP formats. This setting serves as the default 
setting for the Include Filter Summary option available in the Export menu in views and 
reports. You can change the option as needed.  
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The option Include Filter Summary is displayed in the Export menu even if fil-
ter settings are not available in the view. 

• Workflow View: Specify the view that opens when the Workflow Activities link defined in a 
guide page is clicked or when the Open Workflow Activities link in an object profile is clicked.  

• Select Default if the view that opens should be determined by the default settings 
specified by your enterprise. For more information about the configuration of the default 
setting for the Workflow View attribute, see the section Configuring Default User 
Settings for the User Community in the reference manual Configuring Alfabet with Alfabet 
Expand. 

• Select My Workflow Activities view if this view should open. 

• Select Workflow Activities Explorer if this view should open. This view requires 
configuration to be implemented. Please contact your workflow designer to find out if the 
Workflow Activities Explorer has been configured for use. Go to the Workflow Explorer 
Settings tab to further configure workflow explorer options. For more information, see 
the chapter Configuring Workflows in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• Collaboration: Specify whether the collaboration functionality should be enabled.  

• Select Default if the availability of the collaboration functionality should be determined by 
the default settings specified by your enterprise. 

• Select Yes if the collaboration functionality should be enabled. The Show Collaboration 

Panel  button will be displayed in object views and page views. 

• Select No if the collaboration functionality should not be enabled. 

• Max. Dataset Cell Text Length: Specify the number of characters to display in columns in 
datasets as well as for the test displayed for event feedback messages. Enter -1 or leave the 
value empty to specify an unlimited number of characters, or enter an integer to limit the 
number of characters to display in columns. Any characters after the specified number will be 
truncated. You can point to the cell to display a tooltip with the complete text or access the 
full information about the object by using the preview functionality. Please note that it is 
recommended that you enter -1 in order to see the entire text available for event feedback 
messages. 

• MS PowerPoint Export Format: Specify the slide size for export to Microsoft® PowerPoint®. 
The selected option corresponds to the slide size in the generated PowerPoint. Select 
Default if the slide size should be determined by the default settings specified by your 
enterprise. It is assumed Full HD resolution is supported. The following size formats are 
available: For more information about exporting to Microsoft® PowerPoint®, see the section 
Exporting Datasets, Diagrams, Matrix Reports, and Gantt Charts as PPT.  

• PPT Widescreen 16:9: 720 x 405 Points 

• PPT Standard 4:3: 720 x 540 Point 

• PPT Widescreen x4: 1440 x 810 Points. This format is equal to the slide size for current 
Microsoft® PowerPoint® export features. 
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• Session Expiration Countdown: Specify the number of seconds prior to the session timeout 
that the warning should be displayed about the timeout. The default value is 60. If the current 
session reaches the expiration of the timeout period, the view in the current session will no 
longer be displayed. Instead, a timeout image and message explaining that the session has 
timed out will be displayed. A message will be displayed on the screen warning the user that 
the session is about to expire and the amount of time remaining. The user can click the 
Resume Session button and Logout button in the screen. After logging in again, the view for 
the last session will be displayed in the browser again. 

• Max. Recently Visited Objects: Specify how many objects shall be displayed in the Object 
Usage Tracking Page View. A general maximum of 99 is applied. 

• Max. Recently Visited Reports: Specify how many configured reports shall be displayed in 
the Configured Reports Usage Tracking Page View. A general maximum of 50 is applied. 

• Number of History Days to Check Recent Reports: Specify how many days shall be used to 
determine the values in the Configured Reports Usage Tracking Page View and Object Usage 
Tracking Page View. A general maximum of 100 days is applied per default. 

3) In the Workflow Activities Explorer Settings tab, define the following as needed:  

• Workflow Activity Sort Order: Specify how the workflow activities shall be structured in the 
Workflow Activities Explorer functionality. 

• Group by Workflow Template. Select the checkbox if the workflows should be grouped based 
on the workflow templates that they are based on. 

• Move to Next Open Workflow Activity: Select the checkbox if the first open workflow activity 
shall be automatically selected in the Open Activities folder of the My Workflow Activities 
explorer after a workflow activity is completed.  

 
For more information about using the Workflow Activities Explorer, see the sec-
tion Performing and Tracking Your Workflow Steps in the Workflow Activities Ex-
plorer Functionality. 

4) Click OK to save your changes or click Cancel to exit without saving. 

Understanding Access Permissions in Alfabet 

Before you begin working with Alfabet, you should familiarize yourself with the concepts of visibility and 
editability of objects in order to understand why objects might not be visible in the interface vs. how per-
missions can enable and disable editability: 

• Mandate Definition Hiding Objects: By means of a federated architecture, it is possible to hide 
individual objects in an object class while other objects of the same object class are displayed in 
the Alfabet interface. For more information, see the section Visibility of Objects in a Federated 
Architecture Using Mandates 

• Permissions Granting Read/Write Access and ReadOnly Access: By means of user profiles, it is 
possible to define basic permissions regarding visibility and editability for objects in Alfabet. If the 
user profile grants ReadOnly access permissions, the user can only view objects when logging in to 
Alfabet. For any object that does not have Read/Write permission and thus cannot be edited, users 

will see the symbol  in its object profile. For an overview of the access permissions via user 
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profiles, see the section Access Permissions via the User Profile. If the user profile grants 
Read/Write permission, the user can edit the objects if the following apply:  

• If the user is the authorized user of the object. For more information, see the section 
Permissions to Objects for Authorized Users. 

• If the user is a member of an authorized user group defined for the object. For more 
information, see the section Permissions to Objects for Authorized User Groups. 

• If the user is a deputy of the object. For more information, see the section Permissions to 
Objects for Deputies. 

• If edit permissions are granted via a configured permission rule based on a query that finds the 
object or a configured default permission rule for the object class. For more information see 
the section Permissions to Objects via Permission Rules. 

• If the user is a member of a discussion group about the object. For more information, see the 
section Permissions to Objects Targeted by Discussions. 

• If the user is to process an assignment for the object. For more information, see the section 
Permissions to Object's Targeted by Assignments. 

• If the user is to perform a workflow step for the object. For more information, see the section 
Permissions to Objects Targeted by a Workflow Step. 

• If the release status of an object allows the object to be edited. For more information, see the 
section Permissions to Objects Based on the Release Status. 

Access permissions may be configured by a solution designer in the configuration tool Alfabet Expand or a 
user administrator in the User Administration functionality available via an administrative user profile. For 
a detailed overview of the sequence that access permission concepts are evaluated, see the section Con-
figuring Access Permissions in the chapter Configuring Access Permissions in the reference manual Con-
figuring Alfabet with Alfabet Expand. 

The following information is available to describe these access permission concepts in more detail: 

• Visibility of Objects in a Federated Architecture Using Mandates 

• Access Permissions via the User Profile 

• Permissions to Objects for Authorized Users 

• Permissions to Objects for Authorized User Groups 

• Permissions to Objects for Deputies 

• Permissions to Objects via Permission Rules 

• Permissions to Objects Targeted by Discussions 

• Permissions to Object's Targeted by Assignments 

• Permissions to Objects Targeted by a Workflow Step 

• Permissions to Objects Based on the Release Status 

• Purpose of Responsible Organizations 

• Purpose of Roles 
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Visibility of Objects in a Federated Architecture Using Mandates  

Some enterprises have a federated architecture. If this is the case in your enterprise, then mandates may 
be implemented to control the visibility of Alfabet objects. 

A mandate is a means to organize and structure the federated architecture of a holding company. The as-
signment of mandates to users and objects allows the holding company to structure the objects in the en-
terprise architecture and regulate visibility and accessibility to common objects across some or all subsidi-
aries. An object that has not been assigned to a mandate is considered not to be owned by a mandate and 
is thus visible throughout the holding company to users with relevant access permissions. 

The use of mandates in the Alfabet solution is optional. If mandates are implemented in an enterprise, ac-
cessibility determined by the assignment of mandates take precedence over other concepts of access per-
missions in Alfabet. For example, an authorized user of an object must be assigned the relevant mandate to 
access the object that he/she is the authorized user of. Within the context of mandates, the conventional 
rules governing access permissions apply. Thus, a user assigned to a mandate can only access those ob-
jects owned by the mandate if he/she has authorized access to the object (because of a permission rule or 
as either an authorized user, authorized user, deputy, or member of an authorized user group or discussion 
group.) 

Keep the following in mind when working with mandates: 

• A user will typically have only one mandate associated with his/her user name. When the user is 
logged in with a mandate, he/she will have access only to those objects that are assigned to that 
mandate as well as to all objects that are not assigned to a mandate. In other words, the user will 
not see objects that have a different mandate assigned. 

• Objects that do not have a mandate assigned are visible to anyone with relevant access 
permissions. 

• If an object has a mandate assignment different than the user’s mandate assignment, the user will 
still be able to view basic preview information as well as the reference information about the 
dependent objects associated with the object. However, any custom object class properties 
defined for the object are not visible in the object’s preview or object profile to the user with the 
mandate different than the object’s mandate. 

• If objects at the root level in an explorer structure are controlled by a mandate, then they will only 
be visible to users logged in with that mandate. Any root object in the explorer structure that has a 
different mandate than the mandate that the user is logged in with will not be visible in the 
explorer. If the user has accessibility to an object at the root level in the explorer structure, then all 
subordinate objects will be displayed in the explorer even if the subordinate objects have a 
different mandate than the mandate assigned to the user. However, the user will only see the 
basic preview information for such objects if he/she attempts to select the object. 

• Dependent objects that are not controlled by a mandate are accessible to anyone that has access 
permission to the ascendant object. For example, a business support is a dependent object 
associated with an application, organization/market product, or business process/domain. 
Therefore, the business support can be viewed and possibly edited by anyone with a mandate 
owning the associated application, organization/market product, or business process/domain. 
Likewise, an information flow can be viewed and possibly edited by anyone with a mandate owning 
the source or target application. 

• When a user with a mandate creates an object, the object is automatically assigned to the user's 
mandate.  
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Please note that the assignment of mandates to information flows deviates from this 
rule. Mandates for information flows are implicitly derived from the source and target 
applications/components that they connect. Information flows are assigned to all man-
dates that the source and target objects are assigned to. 

• When a user switches to another mandate, the access permission of the new mandate is 
immediately applied and the user is redirected to the start page. 

• The mandate owning an object may change over the lifecycle of an object. For example, an 
application may be owned by one mandate during the pilot phase, but another mandate may 
become the owning mandate once the application is in a productive status. 

• If a user receives an assignment associated with an object owned by a mandate different than the 
mandate that the user is logged in with, then, in order to view or edit the object, the user must re-
login with the mandate that matches the mandate owning the object. 

• The object classes for which mandates are available are configured by Software AG. For an 
overview of the object classes that support the mandate capability, see Overview of Configurable 
Features for Object Classes in the reference manual Configuring Alfabet with Alfabet Expand - 
Appendix. 

 

The following steps are necessary in order to work with the mandate capability: 

• Mandates must be created for your enterprise in either the configuration tool Alfabet 
Expand or the tool Alfabet Administrator. 

• The mandate capability must be activated for each individual object class for which it is 
relevant in the configuration tool Alfabet Expand. 

• The mandate capability as a whole must be activated in the configuration tool Alfabet 
Expand. For information about the configuration of mandates carried out in Alfabet 
Expand, see the section Configuring Access Permissions in the reference manual 
Configuring Alfabet with Alfabet Expand. 

• Each user must be assigned a mandate. Mandates can be assigned to users in either the 
User Management functionality available via an administrative user profile or the tool 
Alfabet Administrator. For more information about assigning users to a mandate in the 
User Management functionality, see the section Assigning a Mandate to a User in the 
reference manual User and Solution Administration. 

• All relevant objects must be assigned to a mandate in the Mandates Page View available 
for that object. 

Access Permissions via the User Profile  

User profiles are the basis of user administration in Alfabet and serve as the entry point when accessing 
Alfabet. Every user must log in with a user profile that has been assigned to him/her by a user administra-
tor. Therefore, all users accessing Alfabet must be assigned at least one user profile. However, users may 
possess multiple user profiles in accordance with their responsibilities in the user community and in the 
enterprise as a whole. A user can switch to another permissible user profile at any point during a user ses-
sion. 
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A user profile specifies the Alfabet functionalities available to a user, the visibility and editability of object 
classes and object class attributes, as well as the availability of associated capabilities including, for exam-
ple, wizards and workflows. 

The user administrator will configure a user profile to grant either ReadOnly permission or Read/Write per-
mission. If the user profile is configured to be a ReadOnly profile, the user can view information about all 
objects that are available in the scope of the functionalities assigned to the user profile. The user is not al-
lowed to edit or delete objects. 

If the user profile is configured to have Read/Write permissions, the editability of the object will depend on 
all other access permission concepts described here. Therefore, some objects may be displayed in 
ReadOnly mode while the user may be able to edit or delete other objects. 

Access permissions are not evaluated at all if the user logs in with an administrative user profile. Users 
logged in with an administrative user profile can edit any object in the Alfabet database independent of the 
access permission concepts described here. The visibility of objects determined by the mandate settings 
will also apply if the user logs in with an administrative user profile. 

 
Please note that changes made to user profiles via the User Profiles Administration functional-
ity that can be accessed via the Admin user profile are not automatically updated to the user pro-
file configuration in the configuration tool Alfabet Expand that is concurrently in use. The solu-
tion designer working in Alfabet Expand must either use the Rescan Tree functionality or close 
and reopen the database to view the updated user profiles. 

Permissions to Objects for Authorized Users  

When an object is created, the user creating the object is automatically designated the authorized user. 
Every object can have at most one authorized user. However, it is also possible that no authorized user is 
defined for an object. 

The authorized user has Read/Write permission to the object. After an object is created, the authorized user 
may be changed at any time. This change may be made by the authorized user as well as a user that is a 
member of an authorized user group or a deputy. The authorized user definition is made in the object's edi-
tor. 

 
Access permissions for authorized users, deputies and authorized user groups are only valid if no 
conflicting permission rules have been configured. If permission rules are defined that do not in-
clude the authorized user as a permitted user, the authorized user may only edit the object in the 
context of the user session in which the object is being created. Once the user session ends, the 
authorized user will no longer be able to edit the object. For a detailed overview of the order of 
evaluation of access permission concepts, see the section Configuring Access Permissions in the 
chapter Configuring Access Permissions in the reference manual Configuring Alfabet with 
Alfabet Expand. 

Permissions to Objects for Authorized User Groups  

An authorized user group is a group made up of users who automatically have Read/Write permissions to 
the object. If an authorized user group is assigned access permission to an object, all members of the group 
will have Read/Write permissions to the object. The definition of an authorized user group is optional. The 
authorized user group(s) assigned to an object can be changed at any time in the object's editor. 
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The solution designer can also configure rules for the inheritance and/or propagation of a user group’s ac-
cess permissions to all ascendant and/or descendant user groups. If propagation of permissions is config-
ured, then all user groups in the user group hierarchy that are ascendant to a user group will have the same 
access permissions to that object. If inheritance is configured, then all user groups in the user group hierar-
chy that are descendant to a user group will have the same access permissions to that object. For more in-
formation, see the section Configuring Access Permissions in the chapter Configuring Access Permissions 
in the reference manual Configuring Alfabet with Alfabet Expand. 

 
Access permissions for authorized users, deputies and authorized user groups are only valid if no 
conflicting permission rules have been configured. If permission rules are defined that do not in-
clude the authorized user as a permitted user, the authorized user may only edit the object in the 
context of the user session in which the object is being created. Once the user session ends, the 
authorized user will no longer be able to edit the object. For a detailed overview of the order of 
evaluation of access permission concepts, see the section Configuring Access Permissions in the 
chapter Configuring Access Permissions in the reference manual Configuring Alfabet with 
Alfabet Expand. 

Permissions to Objects for Deputies  

The authorized user of an object can assign one or more deputies to an object in order to maintain the ob-
ject when the authorized user is unable to. Each deputy has Read/Write permission to the object and thus 
can capture, edit, and delete the data for the object. The deputy is defined for an object in the Authorized 
Deputies Page View of the relevant object. 

 
Access permissions for authorized users, deputies and authorized user groups are only valid if no 
conflicting permission rules have been configured. If permission rules are defined that do not in-
clude the authorized user as a permitted user, the authorized user may only edit the object in the 
context of the user session in which the object is being created. Once the user session ends, the 
authorized user will no longer be able to edit the object. For a detailed overview of the order of 
evaluation of access permission concepts, see the section Configuring Access Permissions in the 
chapter Configuring Access Permissions in the reference manual Configuring Alfabet with 
Alfabet Expand. 

Permissions to Objects via Permission Rules  

Read/Write permission to objects can be granted by means of configured permission rules that are based 
on queries that finds the objects that a user may access. 

The permission rules are configured by a solution designer in the configuration tool Alfabet Expand. If per-
mission rules are defined that do not include the authorized user as a permitted user, the authorized user 
may only edit the object in the context of the user session in which the object is created. Once the user 
session ends, the authorized user will no longer be able to edit the object. 

For more information about the implementation of rule-based access permissions in your enterprise, please 
contact your solution designer. For more information about the configuration of permission rules, see the 
chapter Configuring Access Permissions in the reference manual Configuring Alfabet with Alfabet Expand. 
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Permissions to Objects Targeted by Discussions  

Alfabet provides a discussion functionality that supports collaborative discussions about an object by con-
figured discussion groups. If Read/Write permission has been configured for a discussion group, the mem-
bers of that discussion group will also be able to access and edit the object that is under discussion. 

The discussion capability is configured by a solution designer in the Discussion Groups functionality avail-
able via an administrative user profile. For more information, see the section Defining Discussion Groups for 
Collaborative Discussions in the reference manual User and Solution Administration. 

Permissions to Object's Targeted by Assignments  

Alfabet provides an assignment capability that allows users to define tasks for objects and assign the tasks 
to users that are responsible to perform that task. An assignment is created for an object in the Assign-
ments page view available for that object. For more information about working with assignments, see the 
chapter Sending and Receiving Assignments for Alfabet Objects. 

Any user that has been assigned an assignment associated with an object has Read/Write permission to 
that object for the period of the assignment. 

Permissions to Objects Targeted by a Workflow Step  

A workflow is a collaborative process made up of workflow steps that are typically carried out by one or 
more users. A user that is currently responsible for a workflow step associated with an object has 
Read/Write permission to that object as long as the workflow step is not completed or the deadline to com-
plete the workflow step has not been reached. 

It may be that the workflow step has been configured so that the targeted object may only be edited by the 
user(s) responsible for the workflow step. In this case, other users including authorized users will have 
ReadOnly access permissions to the object for the period that the workflow step is active. This ensures that 
other users not involved in the current workflow step can not edit the data of the object that is being cur-
rently processed in the workflow step. 

For more information about the workflow capability in Alfabet, see the section Executing Workflows and 
Participating in Workflow Steps. 

Permissions to Objects Based on the Release Status  

In Alfabet, a release status can be defined for many object classes including for example, applications, de-
mands, and projects. A release status is a status defined for an object that describes its status of approval. 
Typical status values include Draft, Described, Reviewed, Approved, or Rejected. The release status is typi-
cally maintained for an object by the authorized user(s) in the object's editor. 

The release status definitions can be configured for some object classes and their object class stereotypes. 
Some release statuses can be configured to be non-editable. For all objects with release statuses that are 
configured as non-editable, users will not be able to edit the attributes in the object’s editor nor edit the 
object’s relationships in the object’s page views. Release status definitions are configured in Alfabet 
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Expand. For information about configuring release statuses, see the section Configuring Release Status 
Definitions for Object Classes in the reference manual Configuring Alfabet with Alfabet Expand. 

Purpose of Responsible Organizations  

An object may also have a responsible organization defined for it. The responsible organization is the owner 
organization that governs important aspects of an object. Organizational responsibilities are for the pur-
pose of documentation and analysis only and do not have any impact on the permissions associated with 
the object. To assign an organization responsibility for an object, see the Organizational Responsibilities 
Page View of an organization. 

Purpose of Roles  

In Alfabet, you may attach roles to a user or an organization. A role describes a functional relationship that 
the user or organization has to an object (for example, as a controller, stakeholder, or manager). The defini-
tion of a role does not affect permission to the object in any way. Roles are for the purpose of documenta-
tion and analysis only and do not have any impact on the access permissions associated with the object. 

It is possible to grant Read/Write permission to users with a specific role for the object by defining a per-
mission rule. For more information, see the chapter Configuring Access Permissions in the reference man-
ual Configuring Alfabet with Alfabet Expand. 

Barrier-Free Accessibility in Alfabet 

Software AG provides a number of options to support accessibility to Alfabet functionality and content in 
conformance with established accessibility guidelines and requirements. 

• JAWS® for Windows® screen reader software: Alfabet can be used in conjunction with JAWS® 
for Windows® software (v. 18) in order to support visually impaired users. Please note the following 
information about working with JAWS: 

• The screen reader will read out the login information displayed in the Alfabet user interface 
about the current user, user profile, and mandates when the start page is in focus if Alfabet is 
rendered in Google Chrome® and Microsoft Internet Explorer. 

• The screen reader will read out the text of the interface element that currently has the focus. 
This includes, for example, menus and menu options, data-entry fields, static texts, and 
buttons. 

• The screen reader will read out the ARIA label, control type, and help-related content such as 
page view descriptions or editor and filter field descriptions. Additionally, relevant keyboard 
shortcuts will also be read out loud by the screen reader. For example, if the keyboard shortcut 
SHIFT + F7 is used to select a block of text to ease navigation via tabbing, the screen reader 
will read aloud the keyboard shortcut SHIFT + F7. 

• The screen reader will read out if a field is a mandatory field. 
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• The texts for the interface elements will be read out in the language the user has selected in 
the Alfabet user interface if the same language has been selected in the JAWS® for Windows® 
software. 

• Tabbing navigation and keyboard shortcuts: Users can use tabbing navigation to navigate 
through the interface. Keyboard shortcuts and key sequences allow the user to move the focus in 
the Alfabet interface and carry out tasks without using the mouse. Keyboard shortcuts are 
available in all functionalities in Alfabet and can be used to navigate via the menu bar of the Start 
page, explorers, object profiles, page views, editors, wizards, filters, and selectors. 

 
Please note the following regarding the configuration of Alfabet for barrier-free accessibility: 

• The implementation of JAWS® for Windows® software with Alfabet must be explicitly 
enabled for the relevant user profile in the configuration tool. The Use WAI-ARIA 
attribute should be set to True for the relevant user profile in order to implement the 
WAI ARIA (Web Accessibility Initiative – Accessible Rich Internet Applications) 
specification for barrier-free accessibility. If the Use WAI-ARIA attribute is set to True 
for a user profile, the following changes will be automatically implemented to support 
barrier-free accessibility:  

• Conventional tabular datasets will be replaced by flat datasets with no hierarchical 
grouping in the table, no legend, and no cell coloring or icons in the cells. If a dataset 
is empty, the text " No data provided " will be read by the screen reader software. 
The Export > MS File and MS PowerPoint options will be available and the Export > 
HTML options removed. Please note that a special set of keyboard combinations are 
available for this dataset and are described in the section Using Keyboard Shortcuts 
in Page Views in the reference manual Getting Started with Alfabet.  

 
Please note that editable cells with JAWS® for Windows® software will 
only be read by the JAWS® for Windows® software if Alfabet is rendered 
in Google Chrome®. This functionality is not available if Alfabet is ren-
dered in Microsoft Internet Explorer. 

• The auto-complete functionality that is typically available for edit search fields or 
combo-boxes in editors and filter fields will be automatically disabled. 

• The pop-up calendar that is typically available to select dates will be replaced by a 
simple data entry field for date fields. 

• The slide-in toolbar, secondary windows, and AlfaBot will not be available in the 
Alfabet user interface. 

• Placeholder texts displayed in editor fields and filter fields will be automatically 
disabled. 

• It is recommended that high contrast mode is specified for the browsers used by visually 
impaired users. Please note that the default high-contrast mode used in Microsoft 
Windows may display the background as pure black and white without support for 
inverse colors, thus causing any specified background colors to be not visible. Therefore, 
it is highly recommended that users render the Alfabet interface with Google Chrome® 
37.0 or higher or Mozilla® Firefox® 24.0 or higher with their add-on extensions for high-
contrast mode. 

• In the case of Microsoft Internet Explorer, the use of the ALT key can trigger the 
activation of browser options, which may interfere with keyboard shortcuts in Alfabet. 
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Therefore, it is recommended that the command bar and status bar are disabled for 
users using keyboard shortcuts in some browsers such as Microsoft Internet Explorer. 

• In order to support accessibility to the Alfabet interface for users that are required to 
use keyboard shortcuts, it is recommended that the visualization of the focus is 
configured according to the needs of users working with keyboard shortcut via the 
AlfaGuiScheme definition in the configuration tool Alfabet Expand. The options to 
specify the visualization of the focus as well as many other aspects of the interface is 
described in the section Configuring GUI Scheme Definitions for the Alfabet Interface in 
the reference manual Configuring Alfabet with Alfabet Expand. 

• It is recommended that access to the Alfabet functionalities is available via a menus 
rather than via guide pages. Additionally, the implementation of JAWS® for Windows® 
software with Alfabet must be explicitly enable for the relevant user profile. For details 
of the configuration options and requirements for user profiles requiring barrier-free 
accessibility to Alfabet, see the section Configuring Barrier-Free User Profiles in the 
reference manual Configuring Alfabet with Alfabet Expand. 

The following information is available regarding keyboard shortcuts: 

• General Information About Using Keyboard Shortcuts 

• Using Keyboard Shortcuts in the Start Page and Menu Bar 

• Using Keyboard Shortcuts in the Guide Page 

• Using Keyboard Shortcuts in Explorers 

• Using Keyboard Shortcuts in Object Profiles and Object Cockpits 

• Using Keyboard Shortcuts in Page Views 

• Using Keyboard Shortcuts in Editors, Wizards and Filters 

• Using Keyboard Shortcuts in the Object Selector and Person Selector 

• Using Keyboard Shortcuts in the Bookmark Desktop Functionality 

• Using Keyboard Shortcuts in the Search Functionalities 

General Information About Using Keyboard Shortcuts 

The keyboard shortcuts and key sequences listed below allow the user to move the focus in the Alfabet in-
terface and carry out tasks without using the mouse. The following keyboard functionalities are generally 
available: 

• Press the TAB key to move the focus to the next interface element. 

• Press SHIFT + TAB to move the focus to the previous interface element. 

• Press SHIFT + F7 to display the interface in blocks in order to ease navigation and reduce the 
number of TAB clicks required. After you press SHIFT + F7, the interface will be displayed as blocks, 
whereby each block is labelled with a letter (A, B, C, etc.). Press the TAB key to move the focus to 
the next block of interface elements or press the letter key (A, B, C, etc.) to move directly to that 
block. Press ENTER to select the relevant block for focus. If the keyboard shortcut SHIFT + F7 is 



 
 Chapter 2: Getting Started With Your Alfabet Solution 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 34 

used to select a block of text to ease navigation via tabbing, the screen reader will read aloud the 
keyboard shortcut SHIFT + F7. 

• Press ENTER to select the interface element that currently has the focus.  

 
For example, the following key sequence means that first the TAB key is pressed and 
then the ENTER key is pressed. 

1) TAB (to highlight option) 

2) ENTER (to select) 

• The Help available for the fields in an editor or wizard are typically available in toolitps as well as a 
Help page for the editor. To open the Help page, press the F1 key and to close the Help page press 
the ESC key. 

• To go back to the previous view in the history of the views you have visited in the Alfabet interface, 
press ALT + LEFT ARROW. 

• To go forward to the next view in the history of the views you have visited in the Alfabet interface, 
press ALT + RIGHT ARROW. 

• To use your browser's Back button, use the keyboard shortcut relevant for the browser you are 
working with. 

 
Please be aware that keyboard shortcuts are not supported in the following contexts: 

• Keyboard shortcuts are not supported in the context of a business graphic. It is not 
possible, for example, to navigate to the object profile of an object displayed in a 
portfolio report, for example. 

• Keyboard shortcuts are not supported in the context of the Workflow Explorer view. 
Instead, the Workflow Activities views should be implemented for user profiles 
requiring accessibility to Alfabet functionality via keyboard shortcuts. For more 
information about configuring workflows, see the chapter Configuring Workflows in the 
reference manual Configuring Alfabet with Alfabet Expand. 

• Keyboard shortcuts are not supported in the Alfabet Diagram Designer. Therefore, it is 
recommended that the Open Diagram button be hidden in all diagram views available in 
the user profiles requiring accessibility to Alfabet functionality via keyboard shortcuts. 
For more information about hiding buttons, see the section Hiding Functionalities in a 
Page View or Configured Report in the reference manual Configuring Alfabet with 
Alfabet Expand. 

Using Keyboard Shortcuts in the Start Page and Menu Bar  

To Do This Press 

Move focus to the menu bar TAB 
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To Do This Press 

Move focus to a button or menu in the menu 
bar 

RIGHT ARROW/LEFT ARROW 

Select a button and open the functionality ENTER 

Open a menu and select a menu item 1) DOWN Arrow (to open menu) 

2) UP/DOWN ARROW (to highlight option) 

3) ENTER (to select) 

To leave the menu without selecting a menu item, click 
ESC. 

Using Keyboard Shortcuts in the Guide Page  

To Do This Press 

Move focus in the guide page TAB 

Open a hyperlink ENTER 

Using Keyboard Shortcuts in Explorers  

To Do This Press 

Select the Show Explorer , Hide Explorer , or 

Refresh , buttons. 

1) TAB (to move focus to Explorer Search 
toolbar) 

2) RIGHT ARROW/LEFT ARROW (to move 
focus to button) 

3) SPACE or ENTER (to activate button) 

Use the Explorer Search functionality 1) SPACE (to open Explorer Search 
functionality) 
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To Do This Press 

2) Type search criteria in the criteria field, 
ENTER 

3) Repeat ENTER (to move to 
next/previous match) 

Move focus to the next explorer node DOWN ARROW 

Move focus to the previous explorer node UP ARROW 

Expand a selected explorer node RIGHT ARROW 

Collapse a selected explorer node LEFT ARROW 

Select the explorer node and display the object's ob-
ject profile 

SPACE 

Using Keyboard Shortcuts in Object Profiles and Object Cockpits  

Keyboard shortcuts are supported in object profiles and object cockpits. 

To Do This Press 

Move focus to the object profile 
toolbar 

F7 + SHIFT 

Move focus to a button or menu in the 
toolbar 

RIGHT ARROW/LEFT ARROW or TAB 

Select a button and open the func-
tionality 

ENTER 

Open a menu and select a menu item 1) Down Arrow (to open menu) 

2) UP/DOWN ARROW (to highlight option) 

3) ENTER (to select) 
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To Do This Press 

Open a page view 1) TAB (to move the focus to the page view) 

2) ENTER (to open the page view) 

Open the preview of a hyperlinked at-
tribute 

1) TAB (to move the focus to the next hyperlink) 

2) ALT + I key (upper-case letter "I") or ALT + SPACE (to 
open the preview) 

3) TAB (to highlight button) 

4) UP/DOWN ARROW (to highlight option in drop-down 
menu) 

5) ENTER or SPACE (to select option) 

6) ESC to close the preview 

Open the hyperlinked page view in an 
object cockpit 

1) TAB (to move the focus to the page view title with the 
hyperlink) 

2) SPACE to open the targeted page view. 

Scroll view up or down 1) TAB (to move the focus on the view pane) 

2) UP ARROW/DOWN ARROW  

or 

PAGE UP/PAGE DOWN 

Using Keyboard Shortcuts in Page Views  

Please note the following restrictions regarding the use of keyboard shortcuts in page views: 

• Standard matrix views (such as business support maps): All keyboard combinations described 
below are generally available in matrices. Please note however that it is not possible to create new 
business supports nor select an object in the matrix and navigate to its object profile using 
keyboard shortcuts. 

• Diagrams: All keyboard combinations described below are generally available in diagrams. Please 
note however that it is not possible to design diagrams with the Alfabet Diagram Designer nor is it 
possible to select an object in the diagram and navigate to its object profile using keyboard 
shortcuts. 

• Gantt charts: All keyboard combinations described below are generally available in Gantt charts. 
Please note however that it is not possible to select an object in the Gantt chart and navigate to its 
object profile using keyboard shortcuts. 
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• Business graphics (such as pie charts, line charts, and portfolios): Filters can be defined via 
keyboard shortcuts as well as scrolling. Otherwise, keyboard shortcuts are not supported in 
business graphics. 

• Custom reports: All keyboard combinations described below are generally available in configured 
reports with tabular datasets. The use of keyboard shortcuts in the context of the Active Analysis 
capability is not supported. Scroll and zoom functions are available in configured reports displaying 
graphic formats such as treemap reports layered diagrams, etc. Please note however that it is not 
possible to select an object in configured reports displaying graphic formats and navigate to its 
object profile using keyboard shortcuts. 

• Please note that if you are using the JAWS® for Windows® software, a special dataset will 
automatically replace conventional tabular datasets. The dataset is a flat dataset with no 
hierarchical grouping in the table, no legends, and no cell coloring or icons in the cells. The floating 
toolbar denoting the pages of the dataset will also be hidden. If a dataset is empty, the text "No 
data provided" will be read by the screen reader software. Please note the following keyboard 
combinations for the dataset:  

• LEFT/RIGHT ARROW to move on a cell-by-cell basis through the dataset so that all data can be 
read out loud by the screen reader. The cell-by-cell navigation allow users to understand the 
table structure and the current column in focus. 

• UP/DOWN ARROW to move between rows. 

• ALT + N to navigate to the next editable cell. 

• ALT + P to navigate to the previous editable cell.  

 
Please note that editable cells with JAWS® for Windows® software will only be read 
by the JAWS® for Windows® software if Alfabet is rendered in Google Chrome®. 
This functionality is not available if Alfabet is rendered in Microsoft Internet Explorer. 

• N to navigate to the object profile for the object in a row that is selected. 

• D to navigate to the object profile for the object in a row that is in focus. 

 

To Do This Press 

Move focus to a filter TAB  

For more information about how to define different types of filter fields via 
keyboard shortcuts, see the section Using Keyboard Shortcuts in Editors, 
Wizards and Filters. 

Move focus to a button or 
menu in the toolbar 

RIGHT ARROW/LEFT ARROW 

Select a button and open 
the functionality 

ENTER or SPACE 
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To Do This Press 

Open a menu and select a 
menu item 

1) Down Arrow (to open menu) 

2) UP/DOWN ARROW (to highlight option) 

3) ENTER (to select) 

Change the sort order of 
the contents in the table 

1) TAB (to move the focus to the view pane) 

2) TAB (to move the focus to the column header that should be 
resequenced) 

3) carry out one of the following options to change the sequence of 
the data in the column:  

• If JAWS® for Windows® software (v. 18) is enabled: CTRL + S 

• If JAWS® for Windows® software (v. 18) is not enabled:  

• ENTER 

• SHIFT + ENTER 

• ALT + ENTER 

Select an object in the ta-
ble 

1) TAB (to move the focus to the view pane) 

2) UP/DOWN ARROW (to select object) 

3) I key (upper-case letter "I") or SPACE (to highlight object) 

Open the preview for an 
object in the table 

1) UP/DOWN ARROW (to move the focus in dataset) 

2) I key (upper-case letter "I") or SPACE (to highlight object) 

3) ALT + I (to open the preview) 

4) TAB (to move the focus to the next attribute in the preview 
window) 

5) ESC (to exit the preview) 

6) ENTER (to navigate to the object profile from preview) 

Select multiple individual 
objects 

1) I key (upper-case letter "I") (to select first object) 

2) UP/DOWN ARROW (to next object) 

3) CTRL + I key (to select next object) 

4) Repeat steps 2-3 as needed 

Select multiple objects in a 
block 

1) CTRL + I key (upper-case letter "I") (to select first object in block) 

2) UP/DOWN ARROW (to final object in block) 
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To Do This Press 

3) SHIFT + I or SHIFT + SPACE to highlight multiple rows in dataset 
simultaneously 

Scroll view up or down 1) TAB (to move the focus to the view pane) 

2) UP ARROW/DOWN ARROW 

For views with expanda-
ble and collapsible table 
sections:  

Expand the entire dataset 
to a specific level 

1) TAB (to move the focus to the view pane) 

2) ALT + <number of level to expand>  

(for example, ALT + 3 expands the first three levels in the table) 

To collapse the dataset: ALT + (number of level to collapse to) 

Please note that the number must be typed via the typewriter keys and not 
the numeric keyboard. 

Expand a specific table 
section 

1) UP ARROW/DOWN ARROW to relevant row 

2) CTRL + RIGHT ARROW 

To collapse the table: CTRL + LEFT ARROW 

For views with zoom ca-
pabilities:  

Zoom view in or out 1) TAB (to move the focus to the view pane) 

2) CTRL ++ (plus symbol to zoom in)  

or 

CTRL -- (minus symbol to zoom out) 

Move focus to legend 1) TAB (to legend) 

2) TAB to select button in legend 

3) SPACE to activate the legend option 
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Using Keyboard Shortcuts in Editors, Wizards and Filters  

Please note the following: 

• The tab of the active editor or wizard step will be read out when WAI-ARIA is enabled. 

• If objects are found via a filter functionality, the summary of results displayed above the results 
dataset will be read by the screen reader software if rendered with Google Chrome® 37.0 or higher. 

• The Help available for the fields in an editor or wizard are typically available in toolitps as well as a 
Help page for the editor. To open the Help page, press the F1 key and to close the Help page press 
the ESC key. 

The following table describes the keyboard shortcuts that can be used in editors and wizards as well as 
how to define the individual types of filter and editor fields. 

To Do This Press 

Standard and cus-
tom editors:  

Open the editor/wiz-
ard 

1) TAB (to Edit button) 

2) ENTER 

Move focus to a field 
or another tab in the 
editor 

TAB to fields and tabs in the editor 

ENTER to activate the page of a selected tab 

Please note that you can only tab to active fields that can be edited. Fields that 
cannot be edited will be skipped. 

Save the definition 1) TAB to OK button 

2) ENTER 

Close editor without 
saving changes 

1) TAB to Cancel button 

2) ENTER 

Select a value in a 
drop-down list 

1) DOWN ARROW (to open list) 

2) UP/DOWN ARROW (to select option) 

3) ENTER 

Open the Help link in 
the wizard header 

1) TAB to link 

2) ENTER 
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To Do This Press 

Filter and editor 
fields:  

Define a date in a cal-
endar field 

TAB to the date field and type a date directly in the field. 

 
The pop-up calendar that is typically available to select dates will be 
replaced by a simple data entry field for date fields if you are using 
the JAWS® for Windows® software. 

 

Define a reference to 
an object in a field 
with the object selec-

tor  icon 

1) TAB to the selector field and type the first letters of the name of the 
object to reference directly in the field. 

2) UP/DOWN ARROW (to select option) 

3) ENTER to confirm selection 

or 

1) TAB to the selector field 

2) CTRL + S (to open the selector) 

3) ESC (to close the selector) 

4) To use the selector, see the section Using Keyboard Shortcuts in the 
Object Selector and Person Selector. 

 
The autocomplete functionality that is typically available when defin-
ing data entry fields with a search symbol will be automatically disa-
bled if you are using the JAWS® for Windows® software. 

 

Define a drop-down 
field 

1) TAB to field 

2) DOWN ARROW to open drop-down list 

3) UP ARROW/DOWN ARROW to option in drop-down list 

4) ENTER (to confirm selection) 

Define a multi-selec-
tion field (multi-se-
lection combo-box) 

1) TAB to field 

2) DOWN ARROW to open the multi-selection combo-box 

3) UP ARROW/DOWN ARROW to option 

4) SPACE to select/deselect option 

5) Repeat steps 2 and 3 to select all necessary values 

6) ENTER (to confirm selection) 

To activate the Select All button in the multi-selection combo-box: CTRL + A 
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To Do This Press 

To activate the Clear All button in the multi-selection combo-box: CTRL + D 

 
Please note if you are working with the JAWS® for Windows® soft-
ware, editable cells with multi-selection fields (multi-selection 
combo-boxes) will only be read by the screen reader if Alfabet is ren-
dered in Chrome. This functionality is not available if Alfabet is ren-
dered in Microsoft Internet Explorer. 

 

Define a radio button 
field 

1) TAB to radio button (focus will be on the default or currently defined 
value) 

2) UP ARROW/DOWN ARROW to radio button 

3) SPACE to select option 

4) TAB (to confirm selection and move to next interface element) 

Define a checkbox 1) TAB to checkbox 

2) SPACE to select or deselect option 

Define a color selec-
tor 

TAB to color selector field and enter the name of the color directly in the field. 

Editors with embedded datasets:  

(For example, the Mass Update, Evaluation, or Business Case editors) 

Move focus to an ob-
ject in the editor 

1) TAB (to move the focus to the view pane) 

2) UP ARROW/DOWN ARROW (to select object) 

Select the cell in 
which the indicator 
can be edited 

RIGHT ARROW/LEFT ARROW (to select cell) 

Define the indicator 
in a selected cell 

For a cell where a selection can be made by setting or clearing a checkmark 
(Boolean value): SPACE 

For a cell where a selection can be made in a drop-down list: 

1) SPACE 

2) UP ARROW/DOWN ARROW (to highlight option) 

3) ENTER 

Save the definition TAB to OK button, ENTER 
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To Do This Press 

Wizards:  

Navigate to link in 
header 

1) TAB (to link) 

2) ENTER 

Navigate back to pre-
vious wizard step 

Use browser's Back button or the Go To Step field 

Navigate to wizard 
steps via the Go To 
Step field 

1) TAB (to focus on field) 

2) ALT + DOWN ARROW (to open list) 

3) UP ARROW/DOWN ARROW (to select option) 

4) ENTER 

Move focus to Back, 
Next, Reset, Exit, 
etc. buttons 

1) TAB 

2) ENTER 

Using Keyboard Shortcuts in the Object Selector and Person Selector  

To Do This Press 

To open the 
selector 

1) TAB to the selector field 

2) CTRL + S (to open the selector) 

Move focus to 
a filter 

1) TAB 

2) Enter search criteria 

3) ENTER 

For more information about how to define different types of filter fields via keyboard 
shortcuts, see the section Using Keyboard Shortcuts in Editors, Wizards and Filters. 

Select an ob-
ject 

1) TAB (to move the focus to the view pane) 

2) UP ARROW/DOWN ARROW (to move to object) 

3) I key (upper-case letter "I") (to select object) 

4) TAB to move focus to the OK button 
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To Do This Press 

Close selector 1) TAB to OK or Cancel button 

2) ENTER 

Scroll dataset 
up or down 

1) TAB (to move the focus to the view pane) 

2) UP ARROW/DOWN ARROW 

Using Keyboard Shortcuts in the Bookmark Desktop Functionality  

Keyboard shortcuts can be used in the context of the Bookmark Desktop functionality. Please note the 
following: 

• To access bookmarks in the Bookmark Desktop, the bookmarks must be displayed as a list in a 
table. The All Bookmarks tab will be activated. This can be defined in the Bookmark Desktop by 
selecting View > Show as List. Alternatively, the bookmarks can be displayed per default as a list. 
This is specified in the user settings by selecting the Details option in the Show Bookmarks As 
field in the User Settings editor. For more information, see the section Defining Your User 
Settings in Alfabet. 

• If the bookmarks are displayed as a list, all relevant keyboard shortcuts described for page views 
can be used. For more information, see the section Using Keyboard Shortcuts in Page Views. 

Using Keyboard Shortcuts in the Search Functionalities  

Keyboard shortcuts can be used in the context of the Search functionalities. Please note the following: 

• In the Full-Text Search functionality, the checkbox Show as Data Set must be selected. TAB to 
the checkbox Show as Data Set and click the SPACE key to select the checkbox. If the search 
results are displayed as a list, all relevant keyboard shortcuts described for page views can be 
used. For more information, see the section Using Keyboard Shortcuts in Page Views. 

• In the Simple Search functionality, all relevant keyboard shortcuts described for page views can 
be used. For more information, see the section Using Keyboard Shortcuts in Page Views. To select 
an object class in the Search For field:  

1) Tab (to move the focus to the Search For field) 

2) Enter the first letter of the object class to search for  

If the object class displayed is not the correct class: 

3) Tab (to return the focus to the Search For field) 

4) DOWN ARROW (to display next object class) 

5) Repeat steps 3 and 4 until the correct object class is displayed. 
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Viewing Your Enterprise's Broadcast Messages  

Your enterprise may configure one or more broadcast messages to be displayed to the user community 
with information such as when the system will be shut down for maintenance, etc. All broadcast messages 
will be displayed in a pop-up window in the lower-right corner of the Alfabet interface. If multiple broadcast 
messages have been configured, the number of available broadcast messages to view will be displayed in 
the pop-up window. 

  

 FIGURE: Example of a broadcast message 

All broadcast messages will be displayed in a pop-up window in the lower-right corner of the Alfabet inter-
face. If the text is excessively long, a vertical scrollbar will be added to the window. If multiple broadcast 
images have been configured, the number of available broadcast messages to view will be displayed in the 
pop-up window. You can click the X in the upper-right corner of the pop-up window to close the current 
message for the current user session and view the next one. The message can be closed for the current 
and future user sessions by clicking the Do not show this message again button. 

Using the Help in Alfabet 

A number of capabilities are available provide information to help you understand how to perform your 
tasks using the standard functionalities provided by Alfabet as well as your enterprise's solution configura-
tion. 

The following information is available: 

• Using the AlfaBot Capability 

• Using the Automated Help Assistant 

• Using the Context-Sensitive Help 

• Using the Help Available for Editor Fields and Filter Fields 

Using the AlfaBot Capability 

An AlfaBot capability is available that provides assistance via a textual chatbot to help Alfabet users in gen-
eral tasks such as creating, editing and finding objects as well as navigating to standard page views and 
configured reports. Users can open the AlfaBot window, ask for help by typing in texts such as "Create an 
application" or "Edit TradeNet" or "Open report". The AlfaBot will respond either by asking for more 
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information to service the request, providing a list of objects matching the input, or directly executing the 
action derived from the user input. For example, if you enter "Edit application" the AlfaBot might respond 
with "Provide me with the name of the application." Or if you enter "Navigate to report" the AlfaBot might 
respond with "Provide me with the name of the report." The following scenarios are supported by Alfabet: 

• Create a new object (any class or class stereotype): The AlfaBot will open the editor or wizard for 
creating a new object. 

• Edit/update an object (any class or class stereotype): The AlfaBot will open the editor or wizard for 
updating the object. Optionally, the wizard can be opened at a defined wizard step. 

• Navigate to an object (any class or class stereotype): The AlfaBot will open the object view or 
object cockpit of the object. 

• Navigate to a standard page view for an object (any class or stereotype): The AlfaBot will open the 
page view for the selected object. 

• Navigate to a configured report: The AlfaBot will open the configured report. Navigation to the 
configured report may be based on the name of the report, keywords, or the base object. 

 

User interaction in the AlfaBot window is based on natural language processing. A set of stand-
ard word patterns is available for the standard AlfaBot capability. The AlfaBot capability may be 
further configured to provide additional word patterns that are relevant for the enterprise's user 
community. The user can enter a simple phrase and the AlfaBot capability will search for given 
structures and keywords based on training phrases. The training phrases are analyzed initially 
by the third-party NLP processing tool Dialogflow™. Dialogflow is a third-party service that is not 
embedded in Alfabet. A license must be purchased by the customer directly from Google in order 
to be able to use the AlfaBot capability. For details about the configuration of the AlfaBot capa-
bility, see the section Configuring the AlfaBot Capability in the reference manual User and Solu-
tion Administration. For more information about configuring the appearance of the AlfaBot in 
the slide-in toolbar, see the section Configuring GUI Scheme Definitions for the Alfabet Interface 
in the reference manual Configuring Alfabet with Alfabet Expand. 

To access the AlfaBot: 

1) Click the AlfaBot notch in the slide-in toolbar and click the AlfaBot icon to open the AlfaBot 
window. 

2) In the AlfaBot window, type in text. Enter questions such as "Create an application" or "Navigate to 
TradeNet". 

3) Hit the ENTER key to enter the question. The AlfaBot will return a maximum of 13 matches. If more 
than 13 matches are possible, you should refine the question. 

4) Based on how the AlfaBot responds, either select the result that matches your query or refine your 
query as needed. Hit the ENTER key after each selection of text entry. You may copy text in the 
AlfaBot window to formulate a refined query. 

Using the Automated Help Assistant 

Training users how to process a specific use case or to carry out their tasks in Alfabet can be challenging. 
The automated help assistant capability supports the enterprise in training efforts as well as disseminating 
relevant information to occasional users about the Alfabet functionalities that they use. The automated 
help assistant capability allows the enterprise to provide a URL targeting an HTML document, video, anima-
tion, PowerPoint file, etc. with explanations about methodology, use cases, procedural instructions, and 
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complex processes when working with wizards with many wizard steps, for example. The automated help 
assistant can be configured for any user profile and displayed on the Home page whether that is a guide 
view/guide page, splash screen, or storyboard. Automated help assistants can also be configured for a cus-
tom wizard, custom object profile and object cockpit, standard business function/custom explorer, stand-
ard page view, or configured report. If the standard page view or configured report is embedded in a wizard 
step, the automated help assistant will also be available for that wizard step. 

  

 FIGURE: Automated hep assistant for a user profile 

When a relevant guide view, wizard, etc. is opened for which an automated help assistant has been config-
ured, a fly-in element will be displayed for a few seconds in the upper-right corner of the user interface be-
low the main menu. Users can click the fly-in element to open the automated help assistant which will open 
in a separate window. If the automated help assistant is not opened by the user, it will drop into the slide-in 
toolbar on the right of the screen in order to provide an unobstructed view of the current view. The auto-
mated help assistant for the current view can be opened at any time, as needed, by clicking the colored 
notch in the slide-in toolbar. 

Please note the following: 

• The automated help assistant will automatically be minimized if the user clicks in the Alfabet user 
interface. 

• To close the automated help assistant, the user must click the close (X) button in the automated 
help assistant window. 

• To reopen the automated help assistant for the current view, click the colored notch in the slide-in 
toolbar and click the automated help assistant icon to open the assistant. 

 
The Enable Automated Help Assistant checkbox in the User Settings editor must be selected 
to display all automated help assistants that are available for your user profile. If you do not want 
the automated help assistants to be displayed in the user interface, you ca disable the auto-
mated help assistants by removing the checkmark for the Enable Assistant option. For more in-
formation about specifying your user settings, see the section Defining Your User Settings in 
Alfabet. For more information about the configuration required to implement the automated as-
sistant capability, see the chapter Providing Custom Online Help to the User Community in the 
reference manual Configuring Alfabet with Alfabet Expand. 
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Using the Context-Sensitive Help 

A context-sensitive help may be available in Alfabet that provides you with the information that you require 
to understand the view that you are currently working with in the interface. The standard context-sensitive 
help contains documentation for all functionalities in the software, including those that may not be part of 
the configuration of your Alfabet solution. 

To access a full-text search for the context-sensitive help, click the Help button in the upper right corner 
of the interface and select Open online Help for the current view. In the window that opens, click Solu-
tion Help Search. Enter your search term in the pop-up window and click the Search button in the pop-up 
window that opens. The search options are the same as for the full text search of the interface. For more 
information about search options, see the section Searching for Your Objects. You do not have to open the 
online help first to search for a keyword via the full-text search. 

To access the context-sensitive help for functionalities, explorers, object profiles, and views that you are 
currently working with, click the Help button in the upper-right corner of the interface and select Open 
online Help for the current view. A pop-up window opens. Click any of the links in the pop-up window to 
get the relevant help you need. Documentation is available for your current view and all higher levels in the 
hierarchy of the interface. Depending on the configuration of your solution, you may see links listed in the 
order below to any of the following in the Help Selector: 

• Solution Help 

• Solution Help Search 

• Custom Help on User Profile 

• Standard Help on Business Function 

• Custom Help on Business Function 

• Standard Help on Explorer 

• Custom Help on Explorer 

• Standard Help on Object View 

• Custom Help on Object View 

• Custom Help on Object Cockpit 

• Standard Help on Page View 

• Custom Help on Page View/Configured Report 

The context-sensitive help will open in a separate browser tab. 

 
Please note that the context-sensitive help is available only in English and German. The custom 
help will be available in the language that was provided by your enterprise. If your enterprise did 
neither install the standard help nor a custom help, the button menu option Open online Help for 
the current view is not available. 

When you access the context-sensitive help, you will see a page displaying information about the context 
you are working in. To navigate to another topic, you can do any of the following: 

• Click a grey hypertext link in the documentation to navigate to a related topic, 
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• Click a green hypertext link in the documentation to view a glossary definition of the hyperlinked 
term in a new window, 

• Click one of the buttons on the left to see the next or previous page in the help chapter this page 
belongs to, 

• Click the Back to Previous Help Page button in the upper right of the page to navigate back to the 
page you viewed before navigating to the current page, 

• Click the Show Help Contents button to open the navigation bar of the online help and to access 
the table contents, index, and glossary. 

To open the navigation bar of the context-sensitive help, click the Show Help Contents button in the up-
per-left corner of the help screen. The navigation bar displays Contents, Index, and Glossary buttons. Be-
low the navigation bar you will see a Forward and a Back button that allows you to navigate to the pages 
you have viewed during the current session. 

Using the Help Available for Editor Fields and Filter Fields 

To access specific information regarding the data to enter in filter and editor fields: 

• Filter fields: Click the Options  button on the right edge of the filter panel and select Help 
on Filter Fields to access a help window providing information about the fields that can be filled 
out in the filter area. 

• Editor fields: Click the Help button to access a help window providing information about the fields 
that can be filled out in the editor tab. Switch to another tab in the editor and click the Help button 
to access information about the fields in that editor tab.  
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Requesting User Assistance for a View in the User Interface  

Users may be able to request user assistance for a standard or configured view in the user interface. A Re-
quest User Assistance option may be displayed in the Help menu available in the main toolbar in Alfabet. 
If triggered, an email with a link to the view will be sent to the user in the enterprise who has been specified 
as responsible for user assistance. 

Please note that the Request User Assistance option will only be displayed in the Help menu if the func-
tionality has been enabled and a user has been specified as a user responsible for answering user questions 
about the Alfabet solution. 

 

. The Request User Assistance option must be enabled in the XML object SolutionOptions. For 
more information, see the section Enabling the User Assistance Functionality in the reference 
manual Configuring Alfabet with Alfabet Expand. For more information about specifying a user 
as responsible for user assistance, see the section Defining and Managing Users in the reference 
manual User and Solution Administration. 

Reporting Issues about Your Alfabet Product  

Please open a ticket in the Empower eService for any service request as well as all non-standard support 
incidents such as training requests, scripting, or data integration: 

https://empower.softwareag.com 

When you submit a ticket for a service request, you should include the main release number and patch ver-
sion of your Alfabet product. This information can be accessed by clicking Help < About Alfabet. Tickets 
will be recorded and transferred to the relevant team. 

Empower eService also includes: 

• tracking ticket statuses 

• local telephone numbers for support. 

In addition to the local support telephone numbers, you can use the following toll-free number: 

+800 2747 4357 

Using the Showcase Database 

 Software AG provides a showcase database with example data that allows you to examine and navigate 
many of the functionalities in Alfabet. The showcase database is included in the initial installation of 
Alfabet. The data examples are accessible via preconfigured bookmarks available in the Bookmark Desk-
top functionality. 

 
Configured objects such as configure reports, workflows, custom editors, custom wizards, ADIF, 
etc. available in the Showcase database are based on native SQL and are designed for a database 
located on a Microsoft® SQL server. When the Showcase is installed on an Oracle® database 
server, execution of the solution configuration may fail. 

https://empower.softwareag.com/
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To access the showcase data: 

1) Log in to Alfabet by entering CUSTOMER in the User Name field and selecting Full Access PS in 
the User Profile field. A password is not necessary. 

2) In the Alfabet user interface, click the Show Bookmarks  icon in the top left corner of the 
interface. The Bookmark Desktop view opens and displays all preconfigured bookmarks that 
demonstrate the Alfabet functionalities. 

The following user names are available in the showcase database: CUSTOMER, CLIENTE, GOSSARATH, 
ALFABET, KOWALSKI, LEE, MUSTERMANN, NATSCHI, NGOMBE, OMAR, PICARD, ADMINISTRATOR, USER1, USER2, 
USER3. The user name CUSTOMER has full access permissions and allows you to view and navigate to all 
functionalities in Alfabet. 

The showcase database provides the following additional user profiles: 

• Data Entry: This user profile is limited to the functionalities that allow the basic capture of data 
including Capture Applications, Capture ICT Objects, Capture Demands, etc. This user profile 
can also be accessed with the user name CUSTOMER. 

• Viewer: This user profile is a ReadOnly user profile for anonymous users. This user profile can only 
be accessed with the user names USER1, USER2, and USER3. 

Example Reports in the Showcase Database 

Customer configured reports can be created by a solution designer with the configuration tool Alfabet Ex-
pand in order to provide customer-specific information that is not available via standard reports. The con-
figured report can be either a tabular dataset or a graphic representation of data. The showcase database 
contains examples for all available types of configured reports. For a complete overview of the available 
types of reports that can be configured, see the chapter Configuring Reports in the reference manual Con-
figuring Alfabet with Alfabet Expand. 

A list of all configured reports available in the Showcase Database is available as a PDF file included in the 
Alfabet documentation. 



 
 Chapter 3: Navigating the Alfabet Interface 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 53 

Chapter 3:  Navigating the Alfabet Interface  

This section provides general information that will help you understand the standard user interface. The 
most common interface elements as well as the basics to navigating through the user interface are de-
scribed. 

 
Alfabet is a highly modular, scalable, and configurable software. As a result of this high degree of 
configurability, your user interface may differ from the descriptions in the documentation. For an 
overview about how your interface may differ from the standard Alfabet interface, see the sec-
tion Configuration of Your Alfabet Solution or contact your solution designer. 

Multiple instances of the Alfabet user interface can be simultaneously open for a user in multiple browser 
tabs. In this way, the user can switch back and forth between views. The user can open a new browser win-
dow when navigating to a page view or object profile/object cockpit by selecting the link and using the 
Shift+Click interaction. The user can also navigate to a page view by right-clicking the hyperlink in an ob-
ject profile or object cockpit and selecting the browser functionality to open the link in new tab or window. 
A new browser tab will be explicitly opened in the following situations: 

• to open the Alfabet Diagram Designer  

• to open a view from within a diagram 

• to open a view from within a wizard 

• to open a view to perform a workflow step 

Please note that excessively long captions will be truncated on the Alfabet interface, but the entire text will 
be displayed in the tooltip. To view tooltips, point to editor and filter field captions, toolbar buttons, menu 
options, etc. 

The following information is available: 

• Accessing Functionalities via Your Start Page 

• Accessing User Assistance via the Slide-In Toolbar 

• Using the AlfaBot User Assistance 

• Using the Faceted Semantic Search of the AlfaBot 

• Using the Feedback Bot 

• Using the Automated Help Assistant 

• Using the Event Feedback Messages 

• Using Data Quality Widgets 

• Working with Explorers 

• Working with Object Profiles and Object Cockpits 

• Working with Page Views 

• Working with Data Workbenches 

• General Overview of Alfabet Toolbar Buttons 
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Accessing Functionalities via Your Start Page  

User profiles are the basis of user administration in Alfabet and serve as the entry point when accessing 
Alfabet. Every user must log in with a user profile that has been assigned to him/her by a user administra-
tor. Therefore, all users accessing Alfabet must be assigned at least one user profile. However, users may 
possess multiple user profiles in accordance with their responsibilities in the user community and in the 
enterprise as a whole. A user can switch to another permissible user profile at any point during a user ses-
sion. 

A user profile specifies the Alfabet functionalities available to a user, the visibility and editability of object 
classes and object class attributes, as well as the availability of associated capabilities including, for exam-
ple, wizards and workflows. 

The standard Alfabet toolbar and menu bar are displayed above the start page. Please note the following 
about the standard toolbar and menus: 

• The standard toolbar displays the following:  

• The Start Page  button. The options in this menu allow you to return to any of the start 
pages that are available to you. You may see any of the following options:  

• Navigate to Guide Page  

• Navigate to Guide View  

• Navigate to Splash Screen  

• Navigate to Start Dashboard  

• The Bookmark menu. The options in this menu allow you to create and view your bookmarks 
in the Bookmark Desktop as well as to create a splash screen as your start page. For more 
information about working with bookmarks, see the section Creating, Managing, and 
Accessing Your Bookmarks. 

• The < UserName > menu. This menu allows you to manage your content in the Alfabet 
interface. For more information about the options available, see the relevant sections in the 
chapter Getting Started With Your Alfabet Solution. 

• The Help menu. The options in this menu allow you to access context-sensitive help for the 
view you are currently working with. For more information about using the online help, see the 
section Using the Help in Alfabet. 

• A global search field: If a search field has been configured for the start page, it will be available 
on the right side of the standard Alfabet toolbar during the entire user session. The global 
search field allows the user to search for objects in the Alfabet database. You can enter the 
name or partial name or ID of an object in the global search field. Once the first three letters of 
a search string have been entered in the global search field, the auto-complete function will 
invoke a search and start displaying a list of the first thirteen objects found by the query. The 
list of matching objects will be updated with each additional letter typed in to the search field. 
A configured report displaying the results of the search will be displayed in the current 
browser tab. For more information about configuring a global search field, see the section 
Configuring a Global Search Field for a Guide View or Guide Page in the reference manual 
Designing Guide Pages for Alfabet. 
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• Click your browser's Back button to navigate back to the previous page. A breadcrumbs trail is 
available to help you return to other pages in Alfabet that you have visited. Please note that if you 
start with a view that you opened via a bookmark, the Back button will return you to the 
bookmarked view regardless of the the number of times that you have navigated further in Alfabet. 

• If screenspace is insufficient or if you decrease the size of the Alfabet screen, the button captions 
will be removed from the toolbar to ensure that the button and search bar remain accessible to the 
user. If the screenspace is insufficient for the display of all buttons without their captions, the 
buttons and search bar will be dropped from the toolbar starting with those furthest to the right. 

After you have logged in to Alfabet, you will see your start page. Depending on the configuration of your 
solution, you may see any of the following as your start page. 

• A dashboard configured as the start page. The dashboard typically displays visual elements that 
can be clicked to open relevant functionalities or views. For more information about the 
dashboards capability, see the section Working with Storyboards. 

• A personalized splash screen with a set of views that you specify as your start page. For more 
information about the splash screen capability, see the chapter a personalized splash screen with 
a set of views that you specify as your start page. For more information about the splash screen 
capability, see the chapter Creating a Splash Screen As Your Start Page.. 

• The standard start view with drop-down menus in the toolbar that allow you to open 
functionalities relevant for your user profile. For more information, see the section Configuring 
User Profiles for the User Community in the reference manual Configuring Alfabet with Alfabet 
Expand. 

• A customized guide page or guide view that has been designed for your user profile. You can click 
any of the links to navigate to the targeted page or functionality. For information about the guide 
pages configured for your enterprise, please contact your solution designer. For more information 
about how to configure guide pages, see the reference manual Designing Guide Pages for Alfabet.  

  

FIGURE: Example of a guide view that has been configured as the start page 

A guide page or guide view may contain any of the following: 

• Links to the functionalities assigned to the selected user profile 
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• Links to configured reports 

• Informational text or images 

• Links to documents 

• URLs to Web resources 

• Links to the Alfabet online help 

• Configured reports or standard views directly embedded in the page 

• A menu bar with drop-down menus below the standard Alfabet toolbar. The drop-down menus 
many also provide immediate access to a functionality or another guide page 

• A configured search field available in the standard Alfabet toolbar that allows objects to be 
searched for 

• A configured search field available in the standard Alfabet toolbar that allows objects to be 
searched for. An autocomplete function is available and displays potential matches in a drop-
down menu. The query associated with the autocomplete function will be triggered after a 
short delay in typing in the field in order to display a relevant list of potential matches in a 
drop-down menu. The matching option must be explicitly selected in the drop-down menu for 
the data to be entered in the field. 

• A welcome panel designed to align with your corporate branding 

• A personal information topic that consists of the following:  

• An Open Assignments hyperlink that informs the current user about his/her open 
assignments and provides direct navigation to the My Assignments functionality 

• An Open Workflow Activities hyperlink that informs the current user about the workflow 
steps that he/she is responsible for as the responsible user or proxy user. The link 
provides direct navigation to the Workflow Activities functionality 

• An Open Collaborations hyperlink that informs the current user about the collaboration 
topics that he/she has initiated or been invited to and provides direct navigation to the My 
Collaborations functionality 

• An automated help assistant available in the slide-in toolbar that provides custom help for 
your user profile or start page. For more information about working with the Assistant, see the 
section Using the Automated Help Assistant. 

 
Please note the following when navigating to the guide view or guide page: 

• The Start Page  button will lead the user to the start page. If this is a 
guide page, the focus will be on the first node in the left navigation menu. If this 
is a guide view, the focus will be on the first tab. 

• The browser's Back button will return the user to the most recently visited 
menu item in the left navigation for a guide page or the more recently visited 
tab for a guide view. 
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Accessing User Assistance via the Slide-In Toolbar 

A slide-in toolbar is available in the Alfabet use interface in order to provide additional support to the user in 
a non-intrusive way. The slide-in toolbar is located on the right edge of the user interface and, depending 
on the configuration of the view, may display various colored notches that provide access to the following 
capabilities in the slide-in toolbar: 

• AlfaBot User Assistance: An AlfaBot capability provides assistance via a textual chatbot to help 
Alfabet users in general tasks such as creating and finding objects as well as navigating to 
configured reports or diagrams. The Alfabet capability is based on natural language processing 
technology provided by the third-party component Dialogflow. Users can opens the AlfaBot 
window that opens, ask for help by typing in texts such as "Create an application" or "Navigate to 
TradeNet". 

• Feedback Bot: A Feedback Bot capability is available that enables end users to provide feedback 
about the Alfabet implementation. The capability allows your enterprise to collect ratings, 
comments, and questions on the precise view the user is employing. 

• Automated Help Assistants: An automated help assistant provides custom information via HTML 
documents, videos, animations, PPTX files for configured guide views, object cockpits, configured 
reports, wizards, etc. 

• Dynamic Quality Widgets: Quality widgets may be configured for object cockpits and configured 
reports to provide information to the user such as the completeness of the underlying data of an 
object and may even provide a link to a view that allows incomplete data to be updated. 

• Event Feedback Messages: Event feedback messages provide information about the success of 
asynchronously executed processes like scheduled jobs, the asynchronous import/export of data 
capture templates, and offline-executed configured reports, and provide direct access to 
execution results. 

When you first open a view, you may see fly-in elements in the upper right corner of the user interface be-
low the main toolbar. For example, you may see a fly-in element indicating that an automated help assis-
tant is available as well as a quality widget displaying data. If you do not click these elements, they will drop 
into the slide-in toolbar after a few seconds so that the current view is no longer obstructed. 

The slide-in toolbar can be activated by moving the mouse to the right edge of the screen. In this case, the 
slide-in toolbar will expand to reveal all available user assistance configured for the current view. When the 
slide-in toolbar is not activated it will be collapsed to a thin vertical bar to the right of the view's scrollbar 
and will display colored notches to indicate that various types of user assistance are available. Users can 
point to a colored notch to activate and expand the slide-in toolbar and thus open the relevant form of user 
assistance they are seeking. A tooltip may be configured explaining the functionality available for each col-
ored notch. Clicking anywhere in the user interface will collapse the slide-in toolbar so that only the colored 
notches are visible. 

The following information is available for the slide-in toolbar: 

• Using the AlfaBot User Assistance 

• Using the Faceted Semantic Search of the AlfaBot 

• Using the Feedback Bot 

• Using the Automated Help Assistant 

• Using the Event Feedback Messages 
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• Using Data Quality Widgets 

Using the AlfaBot User Assistance  

An AlfaBot capability is available that provides assistance via a textual chatbot to help Alfabet users in gen-
eral tasks such as creating, editing and finding objects as well as navigating to configured reports and dia-
grams. Users can open the AlfaBot window, ask for help by clicking a link to typing in texts such as "Create 
an application" or "Edit TradeNet" or "Open report". The AlfaBot will respond either by asking for more infor-
mation to service the request, providing a list of objects matching the input, or directly executing the ac-
tion derived from the user input. For example, if you enter "Edit application" the AlfaBot might respond with 
"Provide me with the name of the application." Or if you enter "Navigate to report" the AlfaBot might re-
spond with "Provide me with the name of the report." 

The following scenarios are supported by Alfabet: 

• Navigate to an object  

If no page view name is provided, the object profile or object cockpit of the object will open. The 
object profile or object cockpit that opens will depend on your user profile configuration. If a page 
view name is provided, the page view will open for the object. 

• Create a new object  

For objects such as applications and components that do not have a master object, the editor or 
wizard to create the new object will open. The editor or wizard that opens will depend on your user 
profile configuration. After you have created the object, the object profile or object cockpit of the 
new object will open. The object profile or object cockpit that opens will depend on your user pro-
file configuration. 

For objects such as information flows which are defined in the context of a source or target object 
and thus have a master object (the source or target object), the relevant view required to create 
the object will open. 

• Edit/update an object.  

The editor or wizard will open. If your user profile is configured to open a wizard to edit the object, 
you can tell the AlfaBot to open a specified wizard step. 

• Navigate to a configured report.  

Navigation to the configured report is based on the name of the report, keywords, and base object. 

• Navigate to a diagram  

Navigation to a diagram is based on the diagram type, diagram name, and the base object for 
which the diagram was created. 

• Start a workflow for a new or existing object. 

• Analyze the content of configured reports to find relevant information. You can ask for any 
information about objects like for example which are the applications with the highest costs or 
which components are cloud components. 
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User interaction in the AlfaBot window is based on natural language processing. A set of stand-
ard word patterns is available for the standard AlfaBot capability. The AlfaBot capability may be 
further configured to provide additional word patterns that are relevant for the enterprise's user 
community. The user can enter a simple phrase and the AlfaBot capability will search for given 
structures and keywords based on training phrases. The training phrases are analyzed initially 
by the third-party NLP processing tool Dialogflow™. Dialogflow is a third-party service that is not 
embedded in Alfabet. A license must be purchased by the customer directly from Google® in or-
der to be able to use the AlfaBot capability. For details about the configuration of the AlfaBot ca-
pability, see the section Configuring the AlfaBot Capability in the reference manual User and So-
lution Administration. For more information about activating the AlfaBot capability, see the sec-
tion Implementing the AlfaBot for Navigation via a Full-Text Command in the reference manual 
Configuring Alfabet with Alfabet Expand. 

To access the AlfaBot: 

1) Click the AlfaBot notch in the slide-in toolbar and click the AlfaBot icon to open the AlfaBot 
window. 

2) In the AlfaBot window, type in text. Enter questions such as "Create an application" or "Navigate to 
TradeNet".  

 
The first time that the AlfaBot is opened in a session, a link list with relevant use cases 
for using the AlfaBot will be displayed. You can click the link that is relevant to your 
question instead of typing in a question. The AlfaBot will continue to request information 
in order to understand the question at hand. To return to the link list after using the 
AlfaBot in a session, enter any text (such as 'Hello'). 

3) Hit the ENTER key or click on the arrow  to the right of the text field to enter the question. 

4) The AlfaBot will answer with the following:  

• If your questions provides all required information, the AlfaBot will open the requested view, 
editor, or wizard. 

• If information (such as the name of an object or view) required to process your request is 
missing in your question, the AlfaBot will ask you to provide the missing information. If you do 
not know the exact name of an object class or view name, you can provide part of the name or 
a list of keywords to find the object or view. Keywords can be separated with a comma, the 
word and, and the ampersand character (&). The keyword search will also search for terms in 
the descriptions provided for objects and views. 

• If multiple results are available for a view name, object name, or object class name, the AlfaBot 
will return a link list of possible matches. The maximum number of returned results is 
configured by your solution designer. If one of the results in the list matches your intent, click 
the result to select it. Otherwise, enter search criteria in the text field beneath the result list to 
refine the search for the correct result. If you have clicked a result in the link list but the view 
to which you have navigated is not the right one, you can go back to the AlfaBot and click the 
Go back to list of options link. 

5) Based on how the AlfaBot responds, either select the result that matches your query or refine your 
query. You may copy text in the AlfaBot window to formulate a refined query. Hit the ENTER key 
after each selection or text input. 

6) The AlfaBot will show the complete history of requests from the current session. You can scroll to 
any point in the history and click on a link in any of the lists of possible matches. The AlfaBot will 
then continue the previous request with the new selected option. 
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If you select Analyze in the list of relevant use cases in the AlfaBot or enter a question starting with for 
example "What is" or "Who is", the AlfaBot will open the Faceted AlfaBot Search view. If you already de-
fined a question in the AlfaBot, this question will be visible in the search field on top of the view. Search 
view the view is described in the section XXX. 

Using the Faceted Semantic Search of the AlfaBot 

In the search field of the Faceted AlfaBot Search view you can enter a question requesting information 
about objects matching defined conditions, like for example objects of a specific class for which a specific 
indicator is set to a specific value. The search functionality will then provide a list of configured reports that 
are identified to include relevant information. 

In addition, tabular reports will be created automatically during processing of the question if the identified 
data permits the definition of a relevant dataset. Automatically generated datasets will only be added to the 
results if you are searching for an object class or object class stereotype with either a defined value for an 
object class property based on a fixed range of selectable values, a defined value for a specific indicator 
type, or a defined role for a specific person. 

If automatically generated reports have been added to the result dataset, a Report Type filter will be avail-
able on the left of the result dataset to limit display to customer configured or automatically generated re-
ports only. 

In the result dataset, results are marked as automatically generated or customer configured with different 
icons and text: 

  

 
This view is either available via the Analyze intent of the AlfaBot or as a separate functionality 
accessible via a menu or a navigation page. As a separate functionality, the view is called Fac-
eted Semantic Search. Both the AlfaBot and the Faceted Semantic Search functionality are 
only available for search in English language and will be deactivated if the user interface is not 
rendered in English language. 

In the search field, enter a question starting with for example "What" or "Who" or "Which". If you already de-
fined a question in the AlfaBot, this question will be visible in the search field on top of the view. 

The view will list all configured reports identified to show information that might include the requested in-
formation. For example if you have searched for "What are the applications with the highest risk", config-
ured reports that find objects of the object class application and display information about risk indicators 
are listed, even if there is no hit for "highest". 

If the results are not as expected, for example because there are too many results or results are not mean-
ingful, you can use the following methods to fine tune your search: 

• You can filter the results via the filters on the left of the dataset. These filters represent facets of 
the configured report, like the type of presentation, the object classes or object class stereotypes 
the configured reports are providing information about, or the indicator types the configured 
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reports are providing information about. In addition, a filter for hits found for substrings of your 
question is added to allow search to be limited to a subset of the words that were used to generate 
the search results.  

Please note that filtering for a facet will automatically exclude all the reports that are not having 
this facet at all. If you are filtering for an object class via the Base Class facet, you will only see 
automatically generated reports in the result dataset because information about a base class is 
only available in automatically generated reports. 

You will see different filter fields for each question asked because the generation of facet filters 
depends on the result dataset. A filter is only displayed if configured reports in the result dataset 
have different values for a facet. 

• Try to alter your search to be more specific. For example for component names that are very long, 
the search may not find any results if you only look for a small part of the component name 
because the percentage of match with the name of the component is too low to be regarded as 
relevant. 

• You can provide a comma separated list of relevant strings to avoid search for irrelevant words or 
search for parts of a name consisting of multiple strings separated with a whitespace. For example 
if the question in the search field contains "business support", configured reports providing 
information about "business support", "business", or "support" are found. If "business support" is 
listed in a comma separated search input, only configured reports about "business support" are 
found.  

 
A questionmark in a blue bubble is displayed on the right of the search field. You can 
move the cursor over the bubble to see a tooltip with a description on how to enhance 
search results using comma separated search. 

The view will list all configured reports identified to show information that might include the requested in-
formation. For example if you have searched for "What are the applications with the highest risk", config-
ured reports that find objects of the object class application and display information about risk indicators 
are listed. 

On the left of the results, a filter panel with additional filters will be available that allows results to be fil-
tered. This filter panel is generated dynamically, taking the search results into account. For example you 
can filter for the type of report. The drop-down list will only list the report types that are available in the re-
sult dataset. You can also filter by base class if the configured report shall be opened for a base object, or 
for evaluation types if the configured reports inform about indicators. 

You can navigate from the search results directly to the configured report. Each search result shows the 
name and description of the configured report, the hits the search engine found when comparing the 
words in the search string with the relevant information about the configured reports, and a ranking within 
the search results. In addition, a popularity score informs you whether the report is used seldom or often by 
the user community. 

Using the Feedback Bot  

A Feedback Bot capability is available in the slide-in toolbar that allows you to provide feedback about any 
view, configured report, object cockpit, guide view, etc. implemented in your Alfabet solution. Two different 
concepts are available for the Feedback Bot: 
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• The Feedback Bot may provide a 5-star rating system whereby you rate the current view and 
optionally provides feedback. In this case, you will typically not receive a response to your 
feedback. 

• The Feedback Bot may provide a contact form whereby you provide feedback or ask a question. In 
this case, you would typically receive a response from a user responsible for the feedback. 

The Feedback Bot may be configured to implement only one or both concepts. If both feedback concepts 
are implemented, the start page of the Feedback Bot will open when you click the Feedback Bot icon in the 
slide-in toolbar. Please note that the content displayed in the Feedback Bot is highly configurable and thus 
cannot be described here in detail. Typically your solution designer will configure texts in the Feedback Bot 
that will help you to provide your feedback. After you have provided your feedback and clicked the Send 
button, an email will typically be sent to a mailbox configured as the recipient of the feedback. 

Please note that screenshots may be made in association with a feedback entry. The screenshot capability 
may be implemented for the 5-star rating system and/or the first-level support concept. The screenshot 
will be made of the part of the screen where your mouse pointer is focused at the time that the feedback 
was provided. No user information displayed in the masthead will be included in the screenshot. 

 

The following is required to enable the Feedback Bot capability: 

• The XML attribute IsActive must be set to "true" in the XML object 
AlfaFeedbackBotConfig. For more about the configuration required for the Feedback 
Bot capability, see the section Configuring the Feedback Bot in the reference manual 
Configuring Alfabet with Alfabet Expand. 

• The Enable Feedback Bot attribute must be set to True for the relevant user profiles 
to use the Feedback Bot capability. For more information, see the section Creating a 
User Profile in the reference manual User and Solution Administration.. 

• Each permissible user must select the Enable Feedback Bot checkbox in the User 
Settings editor to enable the Feedback Bot capability. For more information, see the 
section Defining Your User Settings in Alfabet. 

All feedback created will be displayed in the Feedback Review functionality (ADMIN_Feed-
backInstances) that may be accessed via an administrative user profile. The feedback can be 
systematically analyzed based on various filters such as feedback types, views type, base ob-
ject, user profile, etc. in order to understand areas of improvement in the configuration of the 
Alfabet solution. For more information, see the section Reviewing the Feedback Provided by the 
User Community in the reference manual User and Solution Administration. 

Using the Automated Help Assistant  

Training users how to process a specific use case or to carry out their tasks in Alfabet can be challenging. 
The automated help assistant capability supports the enterprise in training efforts as well as disseminating 
relevant information to occasional users about the Alfabet functionalities that they use. The automated 
help assistant capability allows the enterprise to provide a URL targeting an HTML document, video, anima-
tion, PowerPoint file, etc. with explanations about methodology, use cases, procedural instructions, and 
complex processes when working with wizards with many wizard steps, for example. The automated help 
assistant can be configured for any user profile and displayed on the Home page whether that is a guide 
view/guide page, splash screen, or storyboard. Automated help assistants can also be configured for a cus-
tom wizard, custom object profile and object cockpit, standard business function/custom explorer, 
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standard page view, or configured report. If the standard page view or configured report is embedded in a 
wizard step, the automated help assistant will also be available for that wizard step. 

  

 FIGURE: Automated hep assistant for a user profile 

When a relevant guide view, wizard, etc. is opened for which an automated help assistant has been config-
ured, a fly-in element will be displayed for a few seconds in the upper-right corner of the user interface be-
low the main menu. Users can click the fly-in element to open the automated help assistant which will open 
in a separate window. If the automated help assistant is not opened by the user, it will drop into the slide-in 
toolbar on the right of the screen in order to provide an unobstructed view of the current view. The auto-
mated help assistant for the current view can be opened at any time, as needed, by clicking the colored 
notch in the slide-in toolbar. 

Please note the following: 

• The automated help assistant will automatically be minimized if the user clicks in the Alfabet user 
interface. 

• To close the automated help assistant, the user must click the close (X) button in the automated 
help assistant window. 

• To reopen the automated help assistant for the current view, click the colored notch in the slide-in 
toolbar and click the automated help assistant icon to open the assistant. 

 
The Enable Automated Help Assistant checkbox in the User Settings editor must be selected 
to display all automated help assistants that are available for your user profile. If you do not want 
the automated help assistants to be displayed in the user interface, you ca disable the auto-
mated help assistants by removing the checkmark for the Enable Assistant option. For more in-
formation about specifying your user settings, see the section Defining Your User Settings in 
Alfabet. For more information about the configuration required to implement the automated as-
sistant capability, see the chapter Providing Custom Online Help to the User Community in the 
reference manual Configuring Alfabet with Alfabet Expand. 

Using the Event Feedback Messages 

An event feedback message provides information about the availability of results for processes that have 
been executed asynchronously in the background. Asynchronous response messages are available for the 
following processes: 
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• Asynchronous import and export of data capture templates. 

• Events based on customer-defined ADIF import and ADIF export event templates that are 
configured to provide the asynchronous response. 

• Jobs triggered via the Job Schedule functionality. 

• Configured reports that are executed offline. 

By default, the messages will be sent to the user triggering the process. In the case of event templates, this 
is the user that triggers the execution of the event template (for example, when entering or closing a wiz-
ard step or workflow step). For scheduled jobs, this is the user that is defined in the job schedule as execut-
ing user, or, if the executing user is not defined, the user triggering the job schedule. For data capture tem-
plates, this is the user triggering the import or export of data. 

After the asynchronous process is triggered, you can continue to work in Alfabet. A slide-in event feedback 
message window will be displayed when execution has finished. The slide-in event feedback message win-
dow will provide information about the success of the process and provide access to log files and process 
results. Clicking anywhere outside the event feedback message closes the window. It can be re-opened via 
the slide-in toolbar as long as you remain working in the current view. After changing to another view, the 
message can no longer be opened separately but will be available via the My Last Event Feedback notch in 
the slide-in toolbar which contains a list of all event feedback messages that were presented to the current 
user during the last 24 hours. 

 
The success of the event is only checked when the view is changed or refreshed. Therefore, you 
will not see the event feedback message if you remain inactive in the current view. If you trigger 
a process and then change to another session (for example, by logging out and logging in again), 
you will still be informed via the event feedback message when the triggered process is finished. 

The Event Feedback window informs about the success of the execution and provides access to resulting 
data: 

• Successfully executed processes are listed with a checkmark in a green field  while failed 

processes are listed with a red cross . 

• To the right of the message, log files and process results are available via download  or link 

 symbols. 

• Move the cursor over the download  or link  symbol to view a tooltip describing which 
content is available. 

• Click the download  or link  symbol to access the data. 

• If you have set a size restriction for text in table cells with the Max. Dataset Cell Text Length 
attribute in user User Settings, the text in the event feedback window will be displayed truncated 
if it is longer than the defined maximum text length. To view the full text in a tooltip window, move 
the cursor over the text. 
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Using Data Quality Widgets 

Quality widgets may be configured for object cockpits and configured reports to provide information to the 
user such as the completeness of the underlying data of an object and may even provide a link to a view 
that allows incomplete data to be updated. The quality widget may either be a configured widget report, 
Gantt chart report or a configured business chart report that provides additional information to the user 
such as the completeness of the underlying data of the object associated with the object cockpit or config-
ured report. 

When the user opens the configured report/object cockpit, the fly-in element will be displayed and the user 
can click the caption to open the quality widget. If the configured report opening as quality widget provides 
navigation, the navigation target will open in a new tab in the browser. The user could thus update data in 
this view and reload the original view to display the updated data. If the user does not open the secondary 
view, it will drop in to the slide-in toolbar after a few seconds. The quality widget will remain open until the 
user clicks outside of the pop-up window or clicks the close button. 

 
Quality widgets can be configured via the secondary views available for object cockpits and con-
figured reports. For more information about the configuration of a quality widget, see the section 
Configuring Reports in the reference manual Configuring Alfabet with Alfabet Expand. For more 
information about configuration of the appearance of the secondary view in the slide-in toolbar, 
see the section Configuring GUI Scheme Definitions for the Alfabet Interface in the reference 
manual Configuring Alfabet with Alfabet Expand. 

Working with Explorers  

When you access a functionality in Alfabet, you may see a number of different types of views depending on 
the functionality you have chosen. For example, you may see a view entailing many tiles that allow you to 
navigate to the specified explorer or you may see a standard explorer on the left and a workspace on the 
right. Each explorer has a root node and displays a hierarchy of objects. Please note the following regarding 
standard explorers: 
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 FIGURE: Selecting a node in an explorer 

• Standard explorers typically display the standard icon assigned to each object class. However, if 
the objects in the explorer are based on object class stereotypes, the icon defined for the object 
class stereotype will be displayed in the explorer.  

 
Custom explorers may be configured by your solution designer. In this case, you will see 
a non-standard explorer that will have a customized hierarchy of object classes dis-
played in the explorer as well as different views displayed in the workspace to the right 
when an object is selected in the explorer. Please note that if a custom icon has been 
defined for an object, the custom icon will be displayed in the custom explorer. If the ob-
ject in the custom explorer is based on an object class stereotype, the custom icon will 
have precedence over the icon defined for the object class stereotype. If no custom icon 
or object class stereotype icon has been defined, the standard icon will be displayed in 
the custom explorer. For more information about the custom explorers you encounter, 
contact your solution designer. For detailed information about the configuration of cus-
tom explorers, see the section Configuring Standard Business Functions and Custom 
Explorers in the reference manual Configuring Alfabet with Alfabet Expand. 

• Click the expand and collapse arrows next to the nodes of the explorer to view or hide the node's 
subordinate objects. 

• Click the root node to display either a view that you can work in or multiple links that will open 
other views. 

• Click a node in the explorer to view its object profile/object cockpit(s) in the workspace. 

• Click the blue scrollbar on the right edge of the explorer to scroll the results. 
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• To search for an object in the explorer, click a node in the explorer where you expect to find the 
object. For the sake of performance, only 1000 nodes below the selected node will be searched. 
Enter the name or part of the name in the search field and click the Return key to execute the 
explorer search. The first result is highlighted. Click the Return key to navigate to the next result in 
explorer. Please keep the following in mind when entering search pattern:  

• If you enter the full name of an object, it must be spelled correctly. The search pattern is case-
insensitive. 

• For the sake of performance, only the first 1000 nodes are searched starting with selected 
node. The search will first target the subordinate nodes of the selected node and continue to 
subsequently search the node hierarchies listed below it. Please note that only the selected 
node and its sub-nodes will be searched. If no objects are found in the search, a message will 
be displayed stating that no objects have been found below the selected explorer node. You 
can select a different node and begin a new search. If the object you are searching cannot be 
found because the explorer is excessively large, it is recommended that you use the Simple 
Search functionality to find the object. 

• Depending on the configuration of your solution, an automatic wildcard may be implemented. 
If this has not been configured by your solution designer, you must explicitly enter the * 
symbol as a wildcard character. Please note that name and version are concatenated in the 
search string. For more information about the configuration of wildcards, see the section 
Configuring the Full-Text Search Capability in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• Objects with names that begin with a special character (such as Å or Ü) are listed in the Others 
sections located at the bottom of the explorers displayed in the Alfabet interface. 

• Click the Hide Explorer  button at the top of the explorer to hide the explorer from the 
interface and increase the workspace. 

• Click the Show Explorer  button at the top of the explorer to return the explorer to the 
interface and reduce the workspace. 

• Click the Refresh Explorer  button at the top of the explorer to update the explorer with new 
objects.  

 
Most changes that you make to an object that you have selected in an explorer will be 
automatically updated. However, if you make a change to the parent object of a cur-

rently selected object, then you must click the Refresh Explorer  button to update 
the explorer. For example, if you select an application and assign it to a new application 
group or if you select an organization and define it as a sub-organization of another or-
ganization, then you must update the explorer to reflect the new position of the applica-
tion or organization in the explorer. 

• If you select an object in the explorer and then navigate to a page view in the object profile/object 
cockpit by clicking a hyperlink, the entire interface available will be overloaded with the view and 
the explorer will no longer be displayed. 
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Working with Object Profiles and Object Cockpits  

When you click an object in the explorer, you will typically see the object profile describing the selected ob-
ject's attributes and displaying hyperlinks to all of the views in which you can further refine the object's 
data. Depending on your solution configuration, you may see one or more tabs in the object profile toolbar 
that allow you to display customized object cockpits. Because Alfabet is highly configurable, it may be that 
the object profile has been hidden and you only see one or more object cockpits. Click the object profile or 
object cockpit tabs to open the relevant view. 

  

The object profile summarizes information that is relevant to a selected object. The header of the object 
profile displays the name of the object class and the object's ID and name. 

The object profile typically displays an overview of the object's attributes. Some attributes are highlighted 
in blue. You can point to the attribute caption to view a tooltip explaining the meaning of the attribute. At-
tribute values that are exceedingly long will be truncated. You can point to any attribute value to view the 
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complete value. If interoperability with Skype for Business Server® is configured for your enterprise and 
Skype is permissible for a user, a Skype status symbol will be displayed next to the user's name. A user can 
click the Skype status icon to open the Skype screen, allowing the user to contact the authorized user of an 
object should questions arise. For more information about using the Skype functionality in Alfabet, see the 
section Skyping with Your Colleagues. 

 
Alfabet provides a content voting capability similar to that found in social media. The capability is 
configurable and can be implemented to allow users to rate, like, and identify expert users for 
specified object classes. If configured, the button to vote or like an object or report will be availa-
ble in the object profile toolbar. The following may be implemented: 

• A voting concept allows an object to be voted on based on a star-rating system. The 
voting can be expressed as an icon with a specified number of stars or via another type 
of icon gallery that supports rating an object. For example, users could specify their 
recommendation of an application based on a 3-star rating system. 

• A like concept allows an object to be endorsed based on a binary rating system. The 
rating can be expressed via a Like button or Heart icon or any other type of icon gallery 
that supports a true/false rating of an object. For example, users could click the Like 
button to specify their approval for a configured report. Please note that the Like button 
would be available in the object profile of that configured report and not in the 
configured report itself. 

• An expert concept allows a user to register him/herself as an expert of an object. For 
example, a user could specify him/herself to be an expert of a technology or technical 
component. The user could deregister him/herself at any time. 

For more information about configuring the content voting capability, see the section Configur-
ing the Content Voting Capability via Object Associations in the reference manual Configuring 
Alfabet with Alfabet Expand. 

The object profile also displays workspaces which are rectangles grouping a set of hyperlinked page views 
and reports relevant to the selected object. You can click on any hyperlinked view to open the relevant view 
in order to view and/or edit the data. 

If you do not have the necessary permissions to edit the selected object or the object has a non-editable 

release status, you will see the  symbol displayed next to the object name and ID in the header of the 
object profile. In this case, the object profile is ReadOnly and the object cannot be edited. 

Because Alfabet is so highly configurable, the object profiles you see in your Alfabet solution may differ 
significantly from the standard object profile displayed above. Furthermore, the design, content, and func-
tionality available for an object profile may vary depending on the user profile you are currently logged in 
with. Typically, object profiles will be customized by your solution designer in order to address the tasks as-
sociated with your user profile. Thus, if you have multiple user profiles that you can use to access Alfabet, 
you may see different information displayed for the object profiles available for an object class. The follow-
ing aspects may be configured in an object profile: 

• The object information in the header of the object profile. For example, the standard object profile 
for the object class Application displays the object class, ID, and name of the object. However, 
other properties such as the start date or authorized user might be displayed in your configuration. 

• The operations available in the toolbar. A standard button or an option in a drop-down menu may 
be hidden by your solution designer and thus not visible in the object profile toolbar. Furthermore, 
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if workflows have been configured for the selected object class, you may see a 

Workflow  button in the toolbar that will allow you to perform the current workflow activity. 

• The standard and custom attributes displayed in the attribute overview section of the object 
profile. Typically, the visibility of standard and custom attributes is configured by your solution 
designer. You can specify in your user settings whether you want to see only the attributes that 
have values defined or whether you want to see all relevant attributes including whose without a 
value defined. Depending on your configuration, such attributes may display tooltips on mouse-
over.  

 

Scalar attributes may be edited via in-line editing directly in the Attributes section of 
an object profile without needing to open the object's editor or wizard. The Edit icon will 
be displayed when you point to the attribute to indicate the object can be edited in-line. 
Depending on the type of attribute, you can click in the field and define a text, select a 
value in a drop-down list, or specify a date. Upon completion, you must click the 

Save  button to save the definition to the Alfabet database or click the Can-

cel  button to remove the definition. Please note that all unique constraints de-
fined for the class and validation rules specified for the editor/wizard associated with 
the user profile will be applied. 

• The visibility of standard page views displayed in the object profile may be configured by your 
solution designer. Furthermore, configured reports that are not part of the standard product may 
be included in an object profile. 

• One or more object cockpits may be configured to provide additional views capturing a specific set 
of attributes, page views, business graphics, and configured reports deemed relevant for a 
particular perspective. 

If object cockpits have been configured for the object profile, you will see the tab to open them to the right 
of the object profile tab. You can switch between the object profile and the object cockpits by clicking the 
relevant tab. 
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An object cockpit provides users with an immediate and transparent overview of data for the selected ob-
ject, typically from a particular perspective such as an architecture perspective or a strategy perspective. 
For example, one object cockpit for the object class Application might display data relevant for understand-
ing the application in the as-is architecture, another cockpit might display data relevant to master planning 
issues, and a third cockpit might display relevant data for cost and budget issues. 

Keep the following in mind when working with the object cockpit: 

• Please consider the following regarding the Attributes section of an object cockpit:  

• Scalar and reference attributes may be edited via inline editing directly in the Attributes 
section of an object cockpit without needing to open the object's editor or wizard. The Edit 
icon will be displayed when you point to the attribute to indicate the object can be edited 
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inline. Depending on the type of attribute, you can click in the field and define a text, select a 
value in a drop-down list, or specify a date. Upon completion, you must click the 

Save  button to save the definition to the Alfabet database or click the 

Cancel  button to remove the definition. Please note that all unique constraints defined 
for the class and validation rules specified for the editor/wizard associated with the user 
profile will be applied. 

• Attributes displayed in the attribute overview in the object cockpit may provide a hyperlink. 
Depending on your configuration, such attributes may display tooltips on mouse-over or may 
be colored in a different way to indicate that you can navigate when you click the attribute 
caption. 

• The maximum height of group boxes containing attributes can be configured in order to 
control the height of group boxes. If the content of the group box exceeds the configuration of 
the maximum height, a scrollbar will be added so that the user can scroll to see the complete 
content in the group box. 

• Please consider the following regarding embedded views and reports in the object cockpit:  

• All views displayed in the object cockpit are ReadOnly. If a view in the object cockpit displays a 
hyperlinked caption, you may navigate to the view for the view displayed in the object cockpit 
or to a completely different view that may be useful for the user context. The data will be 
displayed based on the last values defined when the user last opened the view or report. Once 
you have opened a view, the context-sensitive online help can be accessed as usual. 

• The height of embedded views and configured reports including datasets, matrices, Gantt 
charts, and diagrams will be automatically reduced based on the content in the view, thus 
ensuring that space is used efficiently. Please note that in the case of grouped datasets, the 
height of the embedded view/report will be based on the height specified by the solution 
designer. If the grouped dataset in the embedded view/report is collapsed, height of the 
view/report will decrease to the height required by the content. If the grouped dataset is 
expanded, the height will increase to the maximum specified height. Please note that 
collapsing or expanding the grouped dataset in the embedded view/report may result in the 
dynamic rearrangement of the object cockpit. 

• If no data is shown in a configured report or view embedded in the object cockpit:  

• A filter  symbol will be displayed in the header of presentation controls embedded in 
object cockpits if filters are active in the underlying page view or custom configured 
report. The filter symbol indicates that only some of the applicable data is displayed. It 
might also indicate why the presentation controls displays a " No data provided … " 
message. Users can hover with the mouse pointer over the filter symbol to display a 
tooltip providing the filter summary. 

• If the presentation control does not show data because a mandatory filter has not been 

defined, a filter  symbol will be displayed with a tooltip providing information about 
the undefined mandatory filter field(s). 

• The content of views and configured reports embedded in an object cockpit can be collapsed 
and expanded in order to optimize the use of space and reduce the amount of scrolling 

required. A Collapse  button is displayed in the right corner header of the embedded view. 
When clicked, the view will collapse to show only the header bar with the caption of the view. 
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The contents will be automatically rearranged in the object cockpit when the view is collapsed. 

You can click the Expand  button in the header to expand the view. 

• A Navigation  button is available in the header bar of embedded views and reports. When 
clicked, the view or report will open to fit the full screen. The user can also navigate to the view 
or report by clicking the caption of the view or report in the header bar. 

• A floating toolbar which contains buttons to zoom or show the legend is displayed in datasets 
and business graphics that are embedded in the object cockpit. The buttons are streamlined 

and a new Collapse  button has been added to the floating toolbar to minimize the amount 
of space that it takes up. The collapsed floating toolbar can be maximized again via the new 

Expand  button. The floating toolbar can also be moved by dragging-and-dropping it to a 
new location within the view. The floating toolbar will be collapsed per default when the object 
cockpit is first opened. 

• A configured report that has the report state set to Plan will not be displayed. A message 
stating that the report is under construction will be displayed in its place in the object cockpit. 

• To return from a view that you have navigated to in the object cockpit, click your browser's Back 
button. 

Working with Page Views  

Depending on your enterprise’s configuration, an object profile may have a varying number of workspaces 
that provide access to page views where data is displayed and maintained. A workspace in an object profile 
groups a set of page views in the object profile. The number and selection of workspaces, the workspace 
captions, and the set of page views displayed in each workspace are configurable and may vary depending 
on the user profile you are currently logged in with. 
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A page view is the context where you capture, maintain, or view data for the objects you are responsible 
for. If you do not have the necessary permissions to use the available Read/Write interactions or the se-

lected object has a non-editable release status, you will see the  symbol displayed in the header of the 
page view. The symbol will not be displayed for views that inherently provide no editing capabilities. 

A page view may display a table, diagram, matrix view, portfolio chart or other business graphic displaying 
data. A general description about the purpose of the page view is displayed in the object profile. Click the 
hyperlinked title of the page view in the object profile to open the view. In the page view, you can point to 
the caption of the view to display the description of the view in a tooltip. 

A preview can be opened for an object displayed in a dataset or business graphic. The preview is a pop-up 
window that displays basic information about the object as well as a Show Details button that, when 
clicked, allows the user to navigate to the object profile. 

 
If the page view or configured report displays portfolios, Gantt charts, branching diagrams, sun-
ray diagrams, circular roadmaps, etc., you can specify whether or not the graphics shall be built 
dynamically when the view is opened. This is done via the Enable User Interface to Poll Web 
Server attribute in the User Settings editor. For more information, see the section Defining Your 
User Settings in Alfabet. 

Please note the following: 

• To open the preview, click the object and hold the mouse button until the preview opens. Click 
anywhere outside of the preview to close it. 

• The preview displays all standard and custom attributes that have been configured to be displayed 
in the preview relevant for your user profile. Blue links will be displayed for properties for which 
navigation has been specified. Click the link to open the object profile/object cockpit of the 
referenced object. For more information about the configuration of the preview window, see the 
section Configuring Class Settings for Object Classes and Object Class Stereotypes in the 
reference manual Configuring Alfabet with Alfabet Expand. 

• If the preview contains the email address of the user, the email will also be displayed with a blue 
hyperlink. Click the link to open your email client in order to send an email to the relevant user. If 
interoperability with Skype for Business Server® is configured for your enterprise and Skype is 
permissible for a user, a Skype status symbol will be displayed next to the user's name. A user can 
click the Skype status icon to open the Skype screen, allowing the user to contact the authorized 
user of an object should questions arise. For more information about using the Skype functionality 
in Alfabet, see the section Skyping with Your Colleagues. 

• Scalar attributes displayed in the preview window can be copied and saved to the clipboard and 
later pasted into a relevant field. Please note that copying of links is not supported and will not 
result in an invalid URL. 

• Actions that can be carried out on the object may be available via an Operations button displayed 
in the preview. 

For more information about the types of views available and how to specify the display of the views, see 
the section Analyzing Your Data in Page Views and Reports. The chapter Creating, Maintaining, and Evalu-
ating Data in Alfabet describes the basic tasks that you will encounter in page views. 
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Working with Data Workbenches 

A data workbench is a configured view that provides the means to view and edit a set of data for a specified 
object class or object class stereotype in a data table as well as render the data in various visualizations di-
rectly from the workbench. Out-of-the-box visualizations include data tables, timelines, bar charts, line 
charts, spine charts, radar charts, pie charts, area charts, spine area charts, waterfall charts, doughnut 
charts, and Kanban reports. 

 
Data workbenches are configured by your solution designer. The configuration specifies the data 
displayed in the data workbench as well as which attributes may be displayed and edited. For de-
tailed information about configuration requirements, see Configuring Data Workbenches in the 
reference manual Configuring Alfabet with Alfabet Expand. 

  

You can do the following in a data workbench: 

• Decide which data you want to see. You can add or remove attributes, indicators, roles, and 
generic attributes to the dataset to determine the type of information to show. You can then set 
filters on columns to limit the data to the objects you are most interested in. 

• Decide how you want to see your data. You can choose between a standard data table or a number 
of out-of-the-box visualizations like bar charts, line charts, spine charts, radar charts, pie charts, 
area charts, spine area charts, waterfall charts, doughnut charts, Gantt charts, and Kanban 
reports. All attributes, indicators, roles, and generic attributes that are visible in the data table will 
be automatically available in the context of the visualizations. For example, if the Status, Object 
State, and Data Quality Score attributes are shown in the data table, then you will be able to 
select these attributes for the X- and Y- dimensions in a bar chart. If filters are set to only display 
applications with in an Active object state, then only active applications will be visible in the bar 
chart. 

• Create a new object. Use the New button to create a new object. The configured editor/wizard will 
open to define the object. 

• Edit your data. All properties that have read/write permissions can be edited inline in the context 
of the data workbench. Please note that the data workbench does not support the creation or 
deletion of objects. 

To use the data workbench: 

1) Specify the data you want to see in the data workbench:  

• Ensure that the data table is displayed. Click Visualize Data > Data Table. You can choose 
a different visualization, but you must select Data Table in order to modify the attributes, 
indicators, and roles that are displayed in the dataset. 
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• Specify the columns of data to display. You can add attributes, indicators, roles, and generic 
attributes to the data table. Only the attributes, etc. that are visible in the data table will be 
available in the data visualizations. This enables you to create ad-hoc a data source that is 
relevant for a visualization like a bar chart, Gantt chart, Kanban board, etc. Click Structure 
Data and select the relevant option:  

• Add/ Remove Attributes: Set a checkmark for each attribute that you want to add to the 
data workbench. 

• Add/Remove Indicators: Set a checkmark for each indicator that you want to add to the 
data workbench. If an icon is configured for the indicator type, the indicator icon and 
semantic value will be displayed in the column. 

• Add/Remove Roles: Set a checkmark for each role that want to add to the data 
workbench. The name of the person or organization along with the respective person or 
organization icon will be displayed. 

• Add/Remove Generic Attributes and set a checkmark for each generic attribute that 
you want to add to the data workbench. 

 
Your solution designer can specify the visibility and order of columns in a data work-
bench and save the configuration as the default view via the Save as Default View 
option in the Structure menu. You can make changes to the visibility and order of 
columns in the data workbench. These changes will be saved to the user context 
settings. You can return to the configured default view at any time by clicking the 
Switch to Default View option in the Structure menu. 

• Organize the data columns:  

• Click Structure Data > Reorder Columns and click a column in the editor and use the up 
and down arrows to change the sort order. 

• Click the filter  icon at the top of a column to filter the data in the data workbench. 
Type a string and specify criteria such as Starts With, Contains, and Case-Sensitive. 
Click Show and Select Matches to display the first 10 matches in lexicographic order in 

the filter. Select one or more of the matches and click Submit.  icon to clear the filter. 

2) Edit the data in the data table: Click Edit Options > Edit Mode. All permissible attributes as well 
as indicators and roles will be changed to inline-editing fields. Click Edit to open the editor/wizard 
to edit the object. Permissibility is configured by your solution designer. For more information, see 
the section Specifying Permissions for the Object Class Properties in the Data Workbench of the 
reference manual Configuring Alfabet with Alfabet Expand.  

 
Only one person or organization may be currently displayed for a role in the context of 
the data workbench. If multiple persons and organizations are defined for a role, the 
most recent person/organization defined for the role in the context of the data work-
bench will be displayed. If you change the person or organization for a role in the context 
of the data workbench, a new role will be added to the object but the role that you 
changed will not be deleted from the object. All roles for the object are displayed in the 
Responsibilities Page View 

3) Access additional information about data in the data workbench: The following options are 
available to access more information about an object displayed in the data workbench:  
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• Click and hold on a row to display the preview about the object. 

• Click the ID property to navigate to the object profile/object cockpit of an object. 

• Click any reference property that is hyperlinked (blue) to navigate to the object profile/object 
cockpit of the referenced object. 

4) Choose a different visualization of the data: Out-of-the-box data visualizations include bar 
charts, line charts, spine charts, radar charts, pie charts, area charts, spine area charts, waterfall 
charts, doughnut charts, Gantt charts (timelines) and Kanban reports. A legend is available for 
most visualizations. The current data displayed in the data workbench is the source data for the 
visualizations. Ensure that the relevant filters are set in the data table to produce a meaningful 
visualization.  

1) To display a Gantt chart: A Gantt chart is only meaningful for object classes that have start 
and end dates or other custom data attributes. Click Visualize Data > Gantt Chart. Define the 
following:  

• Define the time schedule settings:  

• Calendar Unit: Specify whether to display the timeline in years, quarters, months, or 
weeks. 

• Start with Current Year: Select if the current year shall be the start year of the 
Gantt chart. To focus on a different timeframe, define a specific start year in the 
Calendar Start Year and end year in the Calendar End Year fields. 

• Define the display of object information:  

• Column Caption: Specify an caption for the column displaying the object information. 

• Object Attributes to Display: Select the attributes, indicator types, roles, and 
generic attributes to display for the objects. You can either have each attribute 
displayed in its own column or select the Object Attributes in One Column checkbox 
to display them in only the first column. 

• Attribute for Start Date and Attribute for End Date: Define the date attribute to 
use to determine the start and end dates of the bars in the Gantt chart. 

• Add milestone information by selecting the Project Milestones and Enterprise 
Milestones checkboxes. 

2) To display a Kanban board: Click Visualize Data > Kanban Report. The following is possible 
in Kanban reports:  

• Define the content of the Kanban report. Click Kanban Settings to design the Kanban 
board.  

• To visualize a Kanban with lanes, define the Column Definition field. A column is 
displayed for each value of the selected attribute. For example, if you select Status, 
then a column is added for each status value. If you select a role, a column will be 
created for each user assigned the role. 

• To visualize a Kanban report with a matrix, define the Column Definition and Row 
Definition fields.  

The same value should not be defined in both fields. 
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To remove the value for the row or column, select the empty row in the drop-
down of the relevant field. 

• To specify the information displayed on the matrix items, select the attributes to 
show in the Item Definition field. It is recommended to only show a few attributes on 
the matrix items. 

• Change the definition of an attribute, indicator, role, etc. in the Kanban report.  

• A column with an empty header will be displayed if one or more objects in the Kanban 
board does not have a value defined for the selected attribute, indicator, role, etc. 
These objects can be assigned the missing value by moving them to the relevant 
column. 

• Move an object via drag-and-drop to another column to easily redefine the object. 
Objects can only be moved if the attributes specified for the corresponding column 
and row definitions are configured to have write access permissions. 

• Press CTRL+C to copy a selected object to multiple columns. This is only possible if 
the attribute specified for the column definition supports multiple references. For 
example, an application can be assigned to multiple application groups or an 
application may be specified to have multiple users responsible for it via a role. 

3) Define the following. 

4) To display a bar chart, line chart, spine chart, radar chart, pie chart, area chart, spine 
area chart, waterfall chart, or doughnut chart: Click Visualize Data > Business Charts. 
The last visualization will be displayed. Click Business Chart Settings and define the 
following fields:  

• Business Chart Type: Select the type of data visualization that you want to display. The 
attributes to define for the visualization will change depending on the business chart type 
you select. 

• X-Value Definition: Select one or more attributes to show as the value on the X-axis in 
bar charts, line charts, area charts, spline charts, or spline area charts.  

• For pie charts or doughnut charts: X-values are shown as sections. 

• For radar charts: X-values correspond to the radiuses of the radar chart. 

• For waterfall charts: X-values are used as labels on the X-axis. 

• Y-Value Definition : Select either <RecordCount> to show the total number of records or 
a different number value to display on the Y-axis. 

• Series Definition: Select one or more attributes to specify a data series to further 
distinguish the results based on a selected attribute. The series is represented by bars of 
the same color in a bar chart or by different lines in a line chart, etc. 

• Graphic Title: Enter a title to display for the visualization. 

• If the Business Chart Type field is set to Bar Chart or Area Chart, the following 
attributes may also be defined:  

• Bar Chart: Define the following attributes in the attribute window:  

1) Bar Series Placement: Select Normal to place simple bars next to one another in 
the chart thereby rendering a bundle of bars for each X-value. Each data series 
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point is represented as a separate bar. Select Stacked to display a single stacked 
bar for each X-value where the data series points are represented as stack 
elements of the bar. Select Overlapped to display a single bar for each X-value 
where the two data series points are represented as an overlapped and an 
overlapping bar positioned in front of one another. The default value is Normal. 

2) Bar Orientation: Set a checkmark to orient the bars vertically. Clear the 
checkmark to orient the bars horizontally. 

• Area Chart: If more than one attribute is specified for the Series Attributes field, set 
a checkmark for the Stacked Area Chart attribute if multiple series shall be stacked 
on each other. Clear the checkbox if the series shall be displayed independently from 
one another. 

• Go to the Additional Attributes tab to specify the visualization in terms of color, line size, 
etc. 

General Overview of Alfabet Toolbar Buttons  

The following table is an overview of the most common buttons available in the Alfabet toolbar as well as 
the toolbars available for object profiles and page views. Point to a button to see the tooltip displaying the 
tool’s name. Depending on the configuration of your solution, some toolbar buttons may be greyed out. 
These toolbar buttons are disabled and cannot be used by you. 

Button Name Action 

  

Back  Click your browsers Back button to navigate back to the 
previous page. A breadcrumbs trail is available to help you 
return to other views in Alfabet that you have visited. 

  

Start Page  Drop-down menu options allow you to access your book-
marks as well as create new bookmarks and express 
views. 

  

Bookmark  Allows you to create a bookmark or express view to the 
current view or define a splash screen as your start page. 

  

<UserName>  Drop-down menu options include logging out, changing 
user profiles, changing mandates, and defining user set-
tings. 

  

Help  Provides access to context-sensitive Help as well as a 
full-text search of the Help. 
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Button Name Action 

  
Hide Explorer  Typically displayed at the top of an explorer. Click to hide 

the explorer and expand the main view that you are work-
ing with. This is particularly useful for views such as dia-
grams or business maps that typically contain a large 
amount of graphic data. 

  
Show Ex-
plorer  

Typically displayed at the top of an explorer. Click to re-
turn the explorer to the interface. 

  
Refresh Ex-
plorer  

Typically displayed at the top of an explorer. Click to up-
date the explorer after changes have been made to the 
object you are working with. 

  
Non-Editable 
Object  

Typically displayed in an object profile or page view. Indi-
cates that the object cannot be edited. The symbol is dis-
played next to the object information (object name and 
description). 

  
Action  Typically displayed in an object profile or page view. Click 

to open a drop-down menu that allows you to process the 
object. The options you see depend on the object class 
you are working with. 

  
New  Typically displayed in a page view. Click to open a drop-

down menu that allows you to create, add, or copy an ob-
ject. The options you see depend on the page view you are 
working with. 

  
Workflow  Typically displayed in an object profile. Click to select a 

workflow that supports you in carrying out a workflow ac-
tivity that has been defined for the selected object. Once 
you select and initiate the workflow via the Workflow but-
ton, you must navigate to the My Workflow Activities 
functionality in order to perform the activity. 

  
Edit  Typically displayed in an object profile or page view. Click 

to open an editor in which you can define and edit the se-
lected object’s attributes in either an editor or custom 
wizard. 

  
Notify Au-
thorized User  

Typically displayed in an object profile. Click to open a dia-
log view that allows you to send a notification assignment 
to the authorized user concerning the selected object. 
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Button Name Action 

  
Mark as Re-
viewed  

Typically displayed in an object profile. Click to mark the 
object as reviewed in the case that the object has an inac-
tivity monitor defined for it. All listeners will see that the 
object has been reviewed and a notification regarding the 
object’s inactivity will not be triggered. 

  
Audit Trail  Typically displayed in an object profile. Click to open the 

Object Audit view displaying the change history of the 
selected object. The view displays the type of change that 
has occurred, the user making the change, the timestamp 
of the change, and which property or relation has been 
changed. 

  
Publish  Typically displayed in an object profile. Click to publish the 

object profile in a DOC or PDF format. 

  
Collaboration 
Panel  

Typically displayed in an object profile or page view. Click 
to open the collaboration panel to create a new collabora-
tion topic or and display existing collaboration topics 
about the object or view. 

  
Export  Typically displayed in page views. Click to export the page 

view. File formats are displayed in the drop-down menu 
and may include ZIP, HTML, SVG, XLS, PPT. 

  
Detach  Typically displayed in page views. Click to detach an ob-

ject from the selected object. 

  
Delete  Typically displayed in page views. Click to delete an object 

from the Alfabet database. 

  

Navigate  Typically displayed in page views. Click the button to navi-
gate to the object profile of the selected object. You can 
also double-click an object in view to trigger the navigate 
button. Please note that the double-click action is re-
served only for navigation. If you double-click an object 
and nothing happens, then navigation is not possible for 
the object. 

  
Calculate In-
dicators  

Typically displayed in page views. Click to calculate the in-
dicators for the selected object and displays the results as 
numbers or icons. 
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Button Name Action 

  
Clipboard  Typically displayed in page views. Click to save the se-

lected object to a clipboard. The relevant objects can be 
selected in the My Objects tab in the object selector. 

  
Configure  Typically displayed in page views. Click to configure the 

visibility of the columns displayed in data sets. 

  
Filter Panel 
Options  

Typically displayed in the filter panel in a page view. Click 
to open a drop-down menu that allows you to hide the fil-
ter panel, clear all filter settings, or open a pop-up ex-
plaining the purpose of the filter fields. 

  Print  Typically displayed in the floating toolbar in a page view. 
Click to print the view via your browser's print functional-
ity. 

  Legend  Typically displayed in the floating toolbar in a page view. 
Click to open a legend for the view. 

  Fit to Window  Typically displayed in the floating toolbar in a page view. 
Click to adjust the view to your screen 

  Original Size  Typically displayed in the floating toolbar in a page view. 
Click to return the zoom factor to 100%. 

  Zoom In  Typically displayed in the floating toolbar in a page view. 
Click to zoom in and increase the zoom factor. 

  Zoom Out  Typically displayed in the floating toolbar in a page view. 
Click to zoom out and decrease the zoom factor. 
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Chapter 4:  Creating, Maintaining, and Evaluating Data in Alfabet  

Typical tasks that are performed in Alfabet include creating, editing, and maintaining data for objects that 
you have access permissions to. Any changes you make to objects are saved to the Alfabet database and 
will be available for any other user having access permissions to the given object. For more information 
about the concept of access permissions in Alfabet, see the chapter Understanding Access Permissions in 
Alfabet. 

The following information is available: 

• General Information About Objects in Alfabet  

• Understanding Object Classes and Attributes 

• Understanding Object Class Stereotypes 

• Understanding Object Profiles and Object Cockpits 

• Understanding Reference and Evaluation Data 

• Understanding Object States 

• Understanding Release Statuses 

• Understanding Lifecycles 

• Entering Data in Editors and Wizards 

• Working with Editors 

• Defining Text Fields 

• Defining Object Selector Fields 

• Defining Checkbox Fields 

• Defining Combo Box Fields 

• Defining Checked List Box Fields 

• Defining Calendar Fields 

• Working with Wizards 

• Multi-Language Support in Editors and Wizards 

• Translating Object Data Manually 

• Translating Object Data via the Automated Translation Capability 

• Capturing Data in a Secondary Language 

• Capturing Data in a Statutory Language 

• Entering Data in Object Profiles and Object Cockpits 

• Creating Objects in Alfabet 

• Detaching and Deleting Objects 

• Analyzing Your Data in Page Views and Reports 
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• Defining Filter Settings 

• Defining Text Fields 

• Defining Object Selector Fields 

• Defining Checkbox Fields 

• Defining Combo-Box Fields 

• Defining Filters with Two Fields 

• Defining Calendar Fields 

• Defining Multiple Selection Combo Box Fields 

• Working with Data in Tabular Datasets 

• Working with Diagrams 

• Designing a Diagram 

• Interpreting a Diagram 

• Working with Portfolio Reports 

• Working with Lifecycle Reports and Time Schedules 

• Working with Configured Business Support Matrix Reports 

• Understanding the Different Types of Customized Business Support Matrices 

• Defining the Standard Filters in the Configured Business Support Matrix 

• Creating New Business Supports By Means of the Configured Business Support Matrix 

• Working with Layered Diagram Reports 

• Working with Tree Reports 

• Working with Cluster Map Reports 

• Working with Affinity and Diagram Matrix Reports 

• Working with Radar, Bar, Line and Pie Charts 

• Working with Treemap Reports 

• Executing Your Configured Reports 

• Adding a Configured Report to the View 

• Opening a Configured Report 

• Opening a Configured Report Executed Offline 

• Printing a View in Alfabet 

• Printing Data in a Table 

• Printing a Business Graphic, Diagram, or Matrix 
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• Printing an Object Profile/Object Cockpit via the Publish Capability 

• Exporting Data 

• Publishing an Object Profile/Object Cockpit as a DOC or PDF File 

• Exporting and Saving Data in a Table as XLS or XLSX 

• Exporting an Object Cockpit or Page View as a DOC or PDF File 

• Exporting and Saving Data as HTML 

• Exporting Views with Graphics as HTML+ PNG, EMF, JPEG, or BMP, or as SVG 

• Exporting Datasets, Diagrams, Matrix Reports, and Gantt Charts as PPT 

• Using the Clipboard Capability 

• Marking the Object as Reviewed 

• Sending an Assignment About an Object to the Authorized User 

• Viewing the Change History of an Object 

• Accessing Existing Publications About Objects 

General Information About Objects in Alfabet  

The following terms and concepts are important to understand in order to capture and maintain data about 
your IT: 

• Understanding Object Classes and Attributes 

• Understanding Object Class Stereotypes 

• Understanding Object Profiles and Object Cockpits 

• Understanding Reference and Evaluation Data 

• Understanding Object States 

• Understanding Release Statuses 

• Understanding Lifecycles 

Understanding Object Classes and Attributes  

When you capture data about your enterprise's IT landscape, you are typically capturing data about the ob-
jects -- that is, the applications, components, devices, platforms, etc. -- in the IT. Every object in Alfabet 
belongs to an object class that has a preconfigured set of standard attributes that serve to semantically 
describe the object class. In order to capture additional data about an object class that might be specific to 
your enterprise, your solution designer may also have configured custom attributes for the object class. 



 
 Chapter 4: Creating, Maintaining, and Evaluating Data in Alfabet 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 86 

 

For example, the object class Application has a number of attributes including Name, Descrip-
tion, Start Date, End Date, Object State, Release Status, ICT Object, Required Application Availa-
bility, and Committed Recovery Time. 

• The attributes Name, Description, Start Date, End Date, Object State, Release Status, 
and ICT Object are standard attributes. 

• The attributes Name, Start Date, and End Date are mandatory and must be defined 
when the object is created. 

• The attribute ICT Object is an attribute for the class Application but it is also an object 
class with its own set of attributes. The ICT object defined for the application is 
considered the ICT object that owns the application. 

• The attributes Required Application Availability and Committed Recovery Time are 
custom attributes that the enterprise has configured to capture its compliance data. 

Understanding Object Class Stereotypes  

Some object classes will have object class stereotype configured by your solution designer. An object class 
stereotype is a sub-classification within an object class. By configuring object class stereotypes, it is possi-
ble to specify an object class to have multiple class types, each of which captures a specified set of object 
class properties, reference data, and class configurations. For example, the object class Application might 
have the object class stereotypes Business Application and Technical Application. The object classes will 
typically have the same standard attributes available but will each have a different set of custom attributes 
that capture characteristics specific to, for example, business applications and technical applications. 

  

When you create a new object for an object class for which stereotypes have been defined, a stereotype 
selector will open in which you must first select the stereotype to use to base the new object on. The stere-
otype selector will list the possible stereotypes that you can choose from including information configured 
by your solution designer about the purpose of the stereotype. The Stereotype Selector lists the possible 
object class stereotypes for the selected object class. The Stereotypes attribute is thus specified for the 
object via the selection in the Stereotype Selector. Once the selector is closed, the relevant editor will 
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open and you can continue to define the new object. The defined object can then be viewed in the relevant 
custom object view configured for the object class stereotype. The Stereotypes attribute must be speci-
fied whenever an object is created that is based on an object class for which object class stereotypes are 
configured. 

The object class stereotype that an object is based on can be changed if a Change Stereotype button is 
available in the toolbar of the relevant object profile. You can select the object class stereotype that you 

want to base the object on in the drop-down menu. You can then click the Edit  button to specify any 
relevant custom attributes configured for the object class stereotype that the object is now based on. 

 
Please note that the Change Stereotype button will not be available for the following object 
classes: Application, Component, Domain, Feature, ICT Object, Organization, Project, Re-
source, Service Product, Service Product Item, Standard Platform, Technical Service, 
Technical Service Operation, Technical Service Operation Method, and Value Node, and 
Vendor Product. 

Understanding Object Profiles and Object Cockpits 

In general, each object class in Alfabet has a standard object profile that contains a standard set of page 
views available that allow an object to be defined and evaluated. The object profile also serves as a kind of 
fact sheet or data record that displays the most important information about the object you are working 
with. 

Your solution designer may also configured object cockpits that display specific set of attributes and views 
that are relevant for a specific issue about the object. For example, for the object class Application, a cock-
pit Recovery and Resolution Planning or Architecture Planning might be configured for your solution de-
signer. If object cockpits have been configured for your user profile, you will see them available as tabs 
above the toolbar in the object profile. 

Object data can either be captured by editing scalar attributes directly in the object profile or object cockpit 
or via the object's editor available via the Edit button in the toolbar of the object profile. Further data can 
also be captured in the views available in the object profile and object cockpit. The solution designer may 
customize a standard object profile so that some views are hidden for your user profile or that non-stand-
ard configured reports are visible for your user profile. 

Understanding Reference and Evaluation Data 

Some of the data that you need to capture, such as indicators, will depend on the configuration of evalua-
tion data. However, the indicators that you assess for applications might differ than the indicators you 
might assess for projects. In Alfabet, a users with access permissions to the Configuration functionalities 
in the Alfabet user interface can configure evaluation types, indicator types as well as roles and cost types 
that are needed in enterprise and assign them to the relevant object classes. Users will see the reference or 
evaluation data in the relevant views for the object classes that they have been assigned to. This includes 
the following: 

• Evaluation types and indicator types that allow you to capture a specific dimension of an object's 
performance. For example, the object class Application might have the evaluation types 
Application Protection Requirements, Business Relevance and Business Value assigned to it and 
the object class Component may have the evaluation types Technology Rating and Performance 
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assigned to it. In this case, users will only see the evaluation types Application Protection 
Requirements, Business Relevance and Business Value in the Evaluation page view for an 
application and only Technology Rating and Performance will be displayed in the Evaluation page 
view for a component. 

• Cost and income types that allow you to classify the costs and earnings of projects as well as 
operational cost types that are relevant to track costs for applications, ICT objects, deployments, 
and service products. Cost types and income types are displayed in the relevant cost planning 
views as well as in the views targeting a project's business case. 

• Role types that allow responsibilities for objects to be defined. A role defines the functional 
relationship or responsibility that a user or organization has to an object. For example, the role type 
Architect might be available for the object class Application and the role type Operator might be 
available for the object class Device. Roles are defined for informational purposes only and provide 
detail about users or organizations that may have information about or a stake in the object. Roles 
are defined in the Responsibilities page view. The definition of a role for an object does not impact 
access permissions. 

Reference and evaluation data is configured in the Configuration functionalities in the Alfabet user inter-
face. For more information, see the reference manual Configuring Evaluation and Reference Data in 
Alfabet. 

Understanding Object States  

An object state describes the operational status of an object in the enterprise. The object state indicates 
whether an object is actively used, planned to be used, or has been used in the past. Because an object’s 
start and end dates specify the planned period of activity for the object, the object state should be 
changed from Plan to Active once the object's start date is reached. Equally, the object state should be 
changed from Active to Retired when the object's end date is reached. If the lifecycle concept is available 
for an object class the object's start and end dates will initially be aligned with the active period of the ob-
ject. 

An object's object state can be changed by a user with Read/Write access permissions. For objects like ap-
plications or components, relevant object dependencies must be taken into consideration when the object 
state is changed. For applications, for example, the user changing the object state should consider whether 
the object state should be propagated to the application's associated information flows or business sup-
ports. 

If the object state can be defined for an object, you will see the Object State field in the object's editor. An 
object state must be defined for an object if this field is available. Typically, a default object state has been 
configured so that when you create a new object, the field is automatically filled in. For some object classes 
such as Application and Component, the object state cannot be changed in the editor but can only be 
changed by means of the Change Object State button in the toolbar of the object's profile. The standard 
object states are Plan, Active, and Retired, although the names of these object states may be modified by 
your solution designer. 

 

The names of the object states are configured by your solution designer in the configuration tool 
Alfabet Expand. For more information, see the section Configuring Object State Definitions for 
Object Classes in the reference manual Configuring Alfabet with Alfabet Expand. 
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Understanding Release Statuses  

A release status describes the state of approval for or agreement about an object in the enterprise. An ob-
ject's release status can be changed by a user with Read/Write access permissions. For all release statuses 
that are configured as non-editable release statuses (for example, a retired status), users will not be able to 
edit the attributes in the object’s editor nor be able to edit the object’s relationships in the object’s page 

views. Users will see the  icon at the top of the object profile of an object that may not be edited due to 
its current release status definition. 

If the release status can be defined for an object, you will see the Status or Release Status field in the ob-
ject's editor. Typically, a value must be defined for an object if this field is available. A Status field is usually 
used to capture the release status attribute for objects such as assignments, demands, and projects 
whereas a Release Status field is usually displayed for architecture-related objects such as applications, 
components, and deployments. Release status definitions may be differently configured for different ob-
ject classes depending on their context in Alfabet. The number of statuses defined for an object class is 
determined by the needs of your enterprise. For example: 

• Assignments might have the status definitions Created, Accepted, In Progress, Work 
Completed, Returned, Re-Assigned, and Closed. 

• Architecture-related objects like applications or components might have the status definitions 
Draft, Under Review, Approved, Archived, Returned, Re-Assigned, and Closed. 

• Planning-related objects like projects might have the status definitions New, Created, Supported, 
Endorsed, Pre-Approved, Approved, and Rejected. 

For more information about objects that implement an approval process, see the section Configuring Re-
lease Status Definitions for Object Classes in the reference manual Configuring Alfabet with Alfabet Ex-
pand. 

Understanding Lifecycles  

Many objects in Alfabet have lifecycles that can be defined and updated by users. 

A lifecycle describes the succession of stages that an architecture element goes through. Many objects 
(for example, applications, components, standard platforms, business supports) in Alfabet have a lifecycle, 
although a lifecycle does not have to be defined for all objects. A lifecycle is comprised of lifecycle phases 
that describe the object's status of activity or production over time. Each lifecycle phase is aligned with its 
proceeding and succeeding lifecycle phase. 

The lifecycle definition also includes the definition of the object’s active period. The active period of an ob-
ject is considered the period that the object is in production. Therefore, the active period of an object cor-
responds to the object’s start and end dates. The active period may be configured to be aligned with one or 
more specified lifecycle phases that represent the period when the object is in production. Typically, the 
object state of the object will be specified as Active in the period between the start and end date. 

The lifecycle definitions of dependent objects should be aligned with the lifecycle of the object that they 
have been defined for. For example, the lifecycles of any local components, information flows, and business 
supports should be aligned with the lifecycle of the application that they are assigned to. In the case of 
components, the lifecycles of any local components, information flows, and technical services should be 
aligned with the component’s lifecycle. 
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Furthermore, the lifecycle definition for an application may include the specification of predecessor and 
successor versions and the lifecycle definition of components may have successor versions. Successor 
versions will be assigned per default to the same ICT object as the original application/component, but this 
can be modified, as needed. 

The start and end dates of an object’s active period are typically defined in the editor of the relevant object. 
The object's active period can then be viewed and the individual lifecycle phases defined in the Lifecycle 
Page View. 

 

For more information about the methodology of lifecycle management of the application archi-
tecture, see the section Lifecycle Management in the reference manual IT Planning Basic. 

For more information about the configuration of lifecycle phases for object classes, see the sec-
tion Configuring Lifecycle Definitions for Object Classes in the reference manual Configuring 
Alfabet with Alfabet Expand. 

Entering Data in Editors and Wizards 

When you create or edit an object, you will do so in either an editor, which allows you to define the basic at-
tributes relevant to the object, or a wizard, which guides you through a series of steps that allow you to de-
fine the object in more detail than is possible in just an editor. Typically, the editor will be embedded as the 
first step in the wizard, followed by additional views to collect, evaluate, or analyze data. For example, an 
application wizard might include a step to create the application (in the editor) followed by steps to define 
the application lifecycle (embedded Lifecycle page view), to specify the business services it supports (em-
bedded Business Services page view), and to define it's information flows (embedded Information Flows 
page view). 

Whether an editor or wizard opens when you create or edit an object will depend on your solution configu-
ration. The configured editor or wizard will open when you select the Create <Object>... option to create a 

new object or the Edit  button to edit an existing object. The modal windows that open when an editor 
or wizard is opened can be resized, as needed. 

 
If uniqueness constraints have been configured for a combination of attributes for an object 
class, the combination of attributes must be unique for all objects in the object class. If a new ob-
ject is created and a unique key violation occurs, a warning message will be displayed providing a 
link to the object that is the source of the violation. You can click the link to open the relevant ob-
ject view in order to understand more about the conflicting object. This object view will be 
opened in another browser tab in order to leave the current work environment undisturbed. 

Depending on the configuration of your Alfabet solution, object data such as names, descriptions, and 
other relevant custom properties may be captured in the enterprise's primary language, any of its second-
ary languages, or in a statutory language that is mandated for relevant object classes. If the enterprise 
supports multiple languages, the data captured for protected and custom properties of the type String 
and Text may be translated to the other languages implemented in your Alfabet solution. When the user 
interface is rendered in a one of the languages for which translations are available, the translated names of 
objects will be displayed in explorers, object profiles, page views, previews, etc. Objects with names defined 
in a secondary language will be ordered accordingly in explorer trees and page views. 
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If data translation is supported for the class Business Process, a user could capture the Name 
and Description of their business processes in the primary language. The same user or other 
users with access to the business processes could then either manually provide a translation for 
the names and descriptions of the business processes in the editor/wiazárd or, if the automated 
translation capability is configured, the data can be translated via a translation service to the 
languages supported by the enterprise. 

 

 

Custom editors and custom wizards are configured by your enterprise’s solution designer in the 
configuration tool Alfabet Expand. For information about configuring a custom editor, see the 
chapter Configuring Custom Editors in the reference manual Configuring Alfabet with Alfabet 
Expand. For more information about configuring uniqueness constraints, see the section Config-
uring Class Keys for Object Classes in the reference manual Configuring Alfabet with Alfabet Ex-
pand. 

The following information is available: 

• Working with Editors 

• Defining Text Fields 

• Defining Object Selector Fields 

• Using the Simple Search 

• Using the Browse Search 

• Using the My Objects Search 

• Defining Checkbox Fields 

• Defining Combo Box Fields 

• Defining Checked List Box Fields 

• Defining Calendar Fields 

• Working with Wizards 

• Multi-Language Support in Editors and Wizards 

• Translating Object Data Manually 

• Translating Object Data via the Automated Translation Capability 

• Capturing Data in a Secondary Language 

• Capturing Data in a Statutory Language 

Working with Editors  

Each object class has a standard editor that allows you to consistently capture data across objects in a 
class. The editor may include additional tabs that have been configured by your solution designer to cap-
ture enterprise-specific data. 



 
 Chapter 4: Creating, Maintaining, and Evaluating Data in Alfabet 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 92 

  

 FIGURE: Example of an editor with a traditional layout 

The editors may be displayed in a traditional layout, as shown in the image above, or in a more streamlined 
stack layout shown below which structures the fields in a flat list in the editor at runtime. If you see the 
stack layout in an editor, please note that each tabbed page of the editor will be displayed as an expanda-
ble/collapsible section that, when expanded, displays the interface controls available in the tabbed page. 
Depending on the configuration of your solution, the tooltips for each field may be displayed directly in the 
editor. For more information about configuring the layout of standard and custom editors, see the section 
Specifying the Rendering Definition of the Custom Editor in the reference manual Configuring Alfabet with 
Alfabet Expand. 
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 FIGURE: Example of an editor with a stack layout 

The example above shows many of the interface elements that you will encounter when you define an ob-
ject’s data in an editor. Please keep the following in mind when defining data as well as filters and selectors: 

• Each editor field provides cursory information in the field about how to define the data. 

• You can either search for an object in the object selector by clicking the Search  symbol or 
you can begin to enter the name of an object. A list of potential matches will be displayed in a list 
and updated with each additional letter typed in the field. The object must be explicitly selected in 
the drop-down list for the data to be entered in the field. 

• Fields with a red star next to the caption are mandatory and must be filled in. If you do not enter 
data in a mandatory field, you will see a prompt message asking you to do so. 

• Grey fields display data that is automatically generated. These fields cannot be edited. 

• White fields without a star next to the caption are optional. You may enter data, as needed. 
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• The possible release status, object states, and enumeration values that may be defined in an editor 
file will be displayed in a tooltip when you point to the respective editor field. 

• For some classes, class keys (uniqueness constraints) may be configured that specify that a 
combination of attributes must be unique for each new object. If a class key violation occurs when 
a user attempts to create a new object, a warning message will open listing the attributes that 
caused the violation to the defined uniqueness constraints as well as a link to the existing object 
that is the source of the violation. The user can click the link to open the configured object view 
specified for the associated class setting in order to understand more about the conflicting object. 

• In some browsers such as in Microsoft® Internet Explorer® 11, copying text from a PPT file to paste 
into a text field (such as a Description field) in an editor in Alfabet may result in an error due to 
invalid characters. If this is the case, you should contact your system administrator to ensure that 
the server alias is configured to clean invalid characters. For more information, see the section 
Basic Configuration of the Alfabet Components in the reference manual System Administration. 

• The formatting of dates (for example MM/DD/YYYY vs. DD.MM.YYYY) is determined by the cultures 
defined for the interface that you are currently using. The date format required to correctly define 
editor and date fields in editors and filters will be included in the tooltips of those fields. For more 
information about specifying the language to display in the interface, see the section Defining the 
Language of the User Interface. 

• The editor will open in the current user interface language. The language selector in the lower left 
corner of the editor may be changed in order to translate specified fields to a secondary language. 

• Icons may be displayed next to some fields to indicate that the data may be translated to a 
language supported by your enterprise. The following may be displayed:  

• Manual Translation : This field may be manually translated. Select a language in the 
language selector at the bottom of this editor/wizard and enter the translation in this field. 

• Automated Translation : This field will be translated to all secondary languages via the 
automated translation capability. The automated translation is triggered when the editor is 
closed or the wizard advances to the next step. 

• Disable Automated Translation : This field will not be translated for this object via the 
automated translation capability. It may be manually translated. Select a language in the 
language selector at the bottom of the editor/wizard and enter the translation in this field.  

 
For more information about translating object data, see the section Multi-Language 
Support in Editors and Wizards. 

• Various types of help may be available in the editor, depending on the configuration of the 
solution:  

• Help buttons may be available for individual fields in the editor. Click the button to display the 
help for the editor field. 

• A Help  button will be displayed in the upper right corner. Click the Help  button to 
access a Help for Editor window providing information about the fields displayed in the 
currently selected tab. Click anywhere outside of the Help for Editor r window to close it. 

Switch to another tab in the editor and click the Help  button to access information about 
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the fields in that editor tab. If hints have been configured for custom attributes displayed in 
the editor's tabs, help texts will also be displayed for these attributes 

• Editors and wizards can be maximized to fit the user's screen so that complex editors with many 
tabs or datasets embedded in a wizard can be more easily viewed and handled. A maximize 

 or minimize  icon is displayed in the upper right corner of editors and wizards. Editors 
can also be resized to fit the full screen via a double-click action in the header of the editor. A 
double-click in the header of the maximized editor will return it to the default size and position. 

In many of the fields in editors, you will simply enter text such as a name, short name, or version number. 
However, you may also encounter the following data entry fields in an editor: 

• Defining Text Fields 

• Defining Object Selector Fields 

• Using the Simple Search 

• Using the Browse Search 

• Using the My Objects Search 

• Defining Checkbox Fields 

• Defining Combo Box Fields 

• Defining Checked List Box Fields 

• Defining Calendar Fields 

Defining Text Fields 

Many of the fields available in editors are text fields in which you simply type in the text. This is typical for 
editor fields with the caption Name, Short Name, or Description. 

  

Depending on your solution configuration, some text fields may be captured in an embedded HTML editor. 
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The HTML editor provides a toolbar as well as a drop-down menu with formatting options. HTML text can be 
copied, for example, from a website and pasted to the HTML editor in the editor. Only permissible HTML ele-
ments, attributes, and URIs may be saved in the HTML editor. An error message will be displayed if the 
HTML content is invalid. 

 
Please note the following regarding the use of the embedded HTML editor: 

• The HTML editor must be made available by your solution designer. Depending on the 
solution configuration, the HTML text defined in the editor may also be displayed in 
object profiles and object cockpits. Please note however that previews and reports will 
display the ASCII representation of text property values. For more information, see the 
section Adding a Text Box to Capture ASCII and HTML in the Custom Editor in the 
reference manual Configuring Alfabet with Alfabet Expand. 

• The display of images from other Web servers must be enabled in the Web application. 
For more information, see the section Enabling the Display of Images and Videos from 
External Web Servers in the reference manual System Administration. 

• If automated translation is executed for formatted text in an HTML editor, it is advised 
that you review the formatting because in some cases the formatting may not be 
correctly applied after translation is executed. 

Icons may be displayed next to some fields to indicate that the data may be translated to a secondary lan-
guage supported by your enterprise. For more information about translating object data, see the section 
Multi-Language Support in Editors and Wizards. 



 
 Chapter 4: Creating, Maintaining, and Evaluating Data in Alfabet 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 97 

 
Object data should be captured by users in the language of the culture that is defined as the pri-
mary culture. In other words, users should specify such information as names and descriptions of 
new objects in editors in the primary language, regardless of the current language displayed in 
the Alfabet user interface. If object data is not first captured in the primary language, language 
inconsistencies may occur in the user interface. 

Defining Object Selector Fields  

Many of the tasks in Alfabet require you to select an existing object in an object selector in order to define a 
reference between objects. For example, if you are defining an application, you may need to assign the ap-
plication to an ICT object in the context of the Application editor. If a reference to an object shall be defined 

in an editor, the Search  symbol will be displayed next to the fields that provides an object selector to 
find the object. You can also enter the name of the object directly in the field. You may encounter an object 
selector when you define filters or editor fields, or when you create a relationship between objects in a 
page view. 

 
When you want to assign a user to an object (for example, as a deputy or proxy), you will use a 
person selector. Depending on the configuration of your solution, the person selector may dis-
play the named users in the Alfabet database or may access an external database such as LDAP 
to retrieve the users. The object selector and the person selector are similar in their operation 
and handling. 
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There are a number of different methods available in an object selector to find the objects that you are 
looking for: The standard tabs are: 

• Simple: Allows you to define filters and display the results in a table. 

• Browse: Allows you to browse through a tree hierarchy to find the object you are looking for. 

• My Objects: Allows you to select objects that have been saved to the clipboard. For general 
guidelines about the clipboard search, see Using the Clipboard Capability. 

The tabs available in the object selector may vary depending on the object class you are searching in or 
whether custom selectors have been configured for the object class. Your enterprise may have configured 
custom search selectors for some of object classes. Custom selectors assigned to a class setting will glob-
ally replace the standard selector except when a standard selector is required. 

It is highly recommended that you read the sections below in order to understand the general functionali-
ties that may be available in your customized search capability. If questions or errors should arise in your 
use of a custom search capability, please contact your enterprise’s solution designer. 

 

Please note that if the object that is needed as the target of a reference is not available in the 
Alfabet database, it may be possible to create the missing object on an ad-hoc basis. If the solu-
tion designer has configured this capability for the object class you are searching in, you will see 
the Add Missing <Class.Caption> button in the selector. When you click the Add Missing 
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<Class.Caption> button, the configured functionality, explorer, configured report, or standard 
view will open in which you can create the new object will open in a separate browser tab. Once 
the missing object has been created, the user can return to the original browser tab with the ob-
ject selector and search in the selector for the new object. For more information about the con-
figuration requirements for the Add Missing <Class.Caption> button, see the section Configur-
ing Class Settings for Object Classes and Object Class Stereotypes in the reference manual Con-
figuring Alfabet with Alfabet Expand. 

The following information is available: 

• Using the Simple Search 

• Using the Browse Search 

• Using the My Objects Search 

Using the Simple Search 

The Simple tab allows you to define filters and display the results in a table. This functionality allows you to 
conduct a search based on criteria that you enter. For example, if you know the first few letters of the ob-
ject's name, you can enter this information. You can also select other standard object class properties 
and/or custom properties to include in the search criteria. 

The search criteria you define is stored per object class so that the next time you search for the same ob-
ject class in the object selector, the search terms will be displayed. The search terms are persistent for later 
user sessions or if you change to a different user profile. 

 
For performance reasons, the return set for any search is limited to 300 objects. If more than 300 
objects are found, the search criteria should be refined. Otherwise, the object(s) you are looking 
for may not be included in the return set. 

To conduct a simple search: 

1) In the in field, select the attributes that should be searched. The search capability searches all 
searchable properties listed in the in filter by default. However, you can narrow the search criteria 
by specifying one or more attributes. For example, you could select Name in the drop-down list to 
base a search on a name or part of a name defined for your objects. Click the arrow symbol to open 
the drop-down list. Set a checkmark next to one or more attributes or click the Select 

All  button to select all attributes. You can remove a checkmark by clicking it click the Clear 

All  button to remove the checkmark from all attributes. Click the Accept Selection button 

 to confirm your selection or click the Revert Selection  button to close without making 
the selection. 

2) In the Search Pattern field, enter additional search criteria to be searched in the properties 
selected in the in field. Please note the following guidelines:  

• If you enter the full name of an object, it must be spelled correctly 

• If you do not know the full name of an object, you may use the * symbol as a wildcard 
character. For example, to find all applications beginning with the letters ABC, enter ABC*, 
enter *ABC to find applications ending with ABC, or A*BC to find applications containing the 
letters ABC.  
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Depending on the configuration of the standard search functionalities, the wildcard 
* symbol my be automatically implemented. In this case, you do not need to enter 
the wildcard in the Search Pattern field. A message will be displayed in the header 
panel of the Simple tab if the wildcard is automatically implemented and thus not 
required. The configuration of the automatic implementation of the wildcard is con-
figured in the configuration tool Alfabet Expand. For more information, see the sec-
tion Configuring the Wildcard for Standard and Custom Search Functionalities in the 
reference manual Configuring Alfabet with Alfabet Expand. 

• Use the operator AND to search for an object containing both of two terms. For example, 
entering ABC AND OptiRetail returns all objects with both terms ABC and OptiRetail. 

• Use the operator BETWEEN <date> <date> or BETWEEN <number> <number> to search for 
custom attributes with values in a specific range. Be sure to use the date conventions for the 
culture implemented for your solution.  

 
You can only search for dates, integers, and real numbers that have been defined 
for custom attributes. It is not possible to search the standard attributes Start Date 
and End Date. 

• Use the operators <, <=, >, >=, = to specify values for integers and real numbers for custom 
attributes.  

 
The format for search criteria using operators is: 

"<operator>_<value>" 

where _ is a whitespace. The whitespace is mandatory. 

• The characters % and _ should be escaped because some databases regard these characters 
as wildcards. The % and _ can be escaped by used square brackets [ ]. 

• A validation of the search pattern you specify will be performed. The search pattern will not be 
applied to any of the selected search attributes if the search pattern does not match the type 
of the search attribute. (For example, if you select a custom property for which an integer 
must be entered as a value but you enter text in the Search Pattern field, the custom 
property will automatically be dropped from the list of search attributes). 

3) Click the Search button to execute the search based on your settings. Please keep the following in 
mind:  

• Click and hold on any object in the results list to open a preview about the object. Click 
anywhere outside of the preview window to close it. 

• The number of results found by the search will be displayed in the header of the results table. 
Up to 300 objects may be found in the search. Each page in the results will display 100 results. 

• To navigate forward to the next page of results, click the Next Page  button. 

• To navigate forward to the last page of results, click the Last Page  button. 

• To navigate back to the previous page of results, click the Previous Page  button. 

• To navigate open to the first page of results, click the First Page  button. 
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• Depending on the context in which you have opened the object selector, it may be possible to 
select multiple objects in the object selector. If this is the case, use CTRL + click to 
simultaneously select multiple objects in a page. Multiple objects can only be selected on one 

page at a time in the object selector. If you click the Next Page , Last Page , etc. 
buttons, your selection will be lost. 

4) Select the relevant object and click the OK button. 

Using the Browse Search 

The Browse functionality allows you to browse through an object hierarchy to find the object you are look-
ing for. For example, you could search for a specific domain by searching through the hierarchical structure 
of domains defined for your enterprise. Not all object classes listed in the Search For field can be meaning-
fully searched in the Browse functionality. The browse functionality requires that you search for an object 
by means of an explorer structure. Therefore, the object must be structured in an object hierarchy in order 
to be found via the browse. All available hierarchies will be displayed in the explorer. 

1) Select the object class that you want to search for in the Search For field and click the Browse 
tab. If only one object class can be selected, the class will already be displayed in the Search For 
field and the filter cannot be defined. If object class stereotypes have been configured for your 
enterprise, the stereotypes will be displayed in the Search For field. However, if you select an 
object class stereotype for which no object has been defined on the root level of the object class 
stereotype hierarchy, then no results will be displayed in the Browse tab. For example, the object 
class Domain has the object class stereotypes 1) Area, 2) Sub-Area, and 3) Domain. If you select 
Sub-Area in the Search For field and no objects for the stereotype Area have been defined, a 
browse hierarchy cannot be displayed and thus no results will be displayed. 

2) Browse through the hierarchy to locate the object you want. Click  to expand the explorer and 

click  to collapse it. 

3) Click and hold on any object in the explorer to open a preview about the object. Click anywhere 
outside of the preview window to close it. 

4) Select an object and click the OK button. 

Using the My Objects Search 

The My Objects tab allows you to view and select objects in relevant object classes that have been saved 
to the clipboard. The clipboard functionality is available in views where it is useful to copy data. It allows 
you to save objects to a clipboard and then easily access them later in the My Objects tab. If you have not 
copied any objects to the clipboard, the My Objects tab will be empty. 

Any data saved to the clipboard will remain in the clipboard for the current user session. The clipboard con-
tents are cleared when the Alfabet session is ended. For more information about how to use the clipboard 
functionality, see the section Using the Clipboard Capability. 

To select objects in the My Objects tab: 

1) In the selector, click the My Objects tab. 

2) Click and hold on any object in the explorer to open a preview about the object. Click anywhere 
outside of the preview window to close it. 
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3) Select an object and click the OK button. 

Defining Checkbox Fields  

  

Checkboxes serve as a means to capture a True/False value. Setting a checkmark in the checkbox indi-
cates the value True. If a checkbox is selected, you can clear the setting and set the value False by click-
ing the checkbox and removing the checkmark. 

Defining Combo Box Fields  

Many fields in Alfabet are defined by means of a drop-down list. The drop-down list may be blank the first 
time you encounter it. Click the arrow to open the drop-down list. You can select any of the options availa-
ble. If the first line in the list is blank, you can select the blank line if no value should be defined. 

  

Defining Checked List Box Fields 

A checked list box field allows a user to select multiple values by setting a checkmark next to each relevant 
value. The field will automatically display a vertical scroll bar if the list of available values (determined by 
the enumeration defined) is too long for the standard box. 

If the editor is rendered in a stacked layout, an auto-complete function will be available in Authorized User 
Group editor fields and may be available if the checked list box field has a significant number of entries. 
You can either select the object in the drop-down list or enter text in the field. A list of potential matches 
will be displayed in a list and updated with each additional letter typed in the field. The object must be ex-
plicitly selected in the drop-down list for the data to be entered in the field. The editor field will increase in 
size to display all selected objects in the field. 
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Defining Calendar Fields  

Date filters usually display a Calendar  symbol. You can either enter a date in the field or click the Cal-
endar symbol to open a drop-down calendar. The date format required to correctly define editor and date 
fields in editors and filters will be included in the tooltips of those fields. 

 
Please note that the dates in editor fields are always displayed as a numeric value, regardless of 
the configured date format. For example, the date format 22 August 2006 displayed in the object 
profile will be displayed as 22/08/2006 in the editor field. 

 

 
The formatting of dates (for example MM/DD/YYYY vs. DD.MM.YYYY) and numbers is determined 
by the culture used to render the interface. Please note that the culture configuration super-
sedes the regional settings of the client machine. For more information about specifying cul-
tures, see the section Specifying the Cultures Relevant to Your Enterprise in the chapter Locali-
zation and Multi-Language Support for the Alfabet Interface in the reference manual Configuring 
Alfabet with Alfabet Expand. 

  

When you open the calendar, you will see the current date highlighted in red. You can do the following: 

• Click a date to select it. The date will be automatically displayed in the date field. 

• Click  to move forward one month. 

• Click  to move back a month. 

• Click the arrow next to the name of the month to open a drop-down list with all of the months. 
Select a month from the list. 



 
 Chapter 4: Creating, Maintaining, and Evaluating Data in Alfabet 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 104 

• Click the arrow next to the year to open a drop-down list with years. Select a year from the list. 

Working with Wizards  

  

 FIGURE: Example of the steps in a wizard designed to capture data about devices 

A wizard is an assistant that consists of a configured set of wizard steps that may include standard editors, 
custom editors, standard views, and configured reports. The wizard will typically guide a user through a lin-
ear multi-step process to capture data for an object that the user has access permissions to. 

Standard data capture wizards are available for commodity classes in which a large number of objects are 
typically documented. An unlimited number of custom wizards may be configured for an object class in or-
der to allow different users working in different contexts to capture the object data that they are responsi-
ble for. However, only one wizard may be available for an object class per user profile. 

Keep the following in mind when working with a wizard. 

• If a wizard has been configured for the selected object class and is accessible to the user profile 
that the user is logged in with, the custom wizard will open when the user clicks the Edit button in 
the object profile. Depending on the configuration of your Alfabet solution, you might work with a 
wizard when editing objects in one object class, but might see an editor when working with objects 
in a different object class. 
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• The wizard process cannot be executed for a selected object if the object has a non-editable 
release status. For more information about the role of release statuses regarding access 
permissions, see the chapter Understanding Access Permissions in Alfabet.  

  

• In the white pane at the top of the wizard, you will see the caption for the current wizard step and 
text with basic instructions describing what you must do in the current wizard step, and, if 
relevant, information about the existing object you are defining. 

• An editor is typically embedded in the wizard. The guidelines provided in the section Working with 
Editors also applies to editors embedded in wizards. 

• Mandatory fields in an editor must be completed in order to save the data and proceed to the next 
wizard step. If a wizard cannot advance to the next wizard step because mandatory properties 
have not been defined, an error message will list the mandatory properties that must be defined in 
order for the wizard to proceed to the next step. 

• Texts displayed in read-only text boxes and memo fields in editors and wizards can be copied and 
pasted to other text boxes and memo fields in the Alfabet user interface. 

• Icons may be displayed next to some fields to indicate that the data may be translated to a 
secondary language supported by your enterprise. For more information about translating object 
data, see the section Multi-Language Support in Editors and Wizards. 

• Click the F1 key to open the online help for the editor displayed in the wizard. Click the blue help 
link to open the context-sensitive help for the standard page views embedded in a wizard. A Help 
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link may also be available for configured reports if your solution designer has defined custom Help 
for the report. 

• If the size of the wizard is decreased, the captions of the toolbar buttons will be dropped if the size 
of the wizard window is too small to display them. If the screen is sized even smaller, the toolbar 
button icons will be dropped starting with the button furthest to the right. 

• Wizards can resized to fit the full screen via a double-click action in the header of the wizard, 
making it easier to work with large wizards with multiple tabs. A double-click in the header of the 
maximized wizard will return it to the default size and position. Please note that quality widgets will 
not be viewable if a wizard is maximized to fit the full screen. 

• Quality widgets may be configured for wizards or individual wizard steps to provide information to 
the user such as the completeness of the underlying data of an object and may even provide a link 
to a view that allows incomplete data to be updated. The quality widget may either be a configured 
widget report, Gantt chart report or a configured business chart report that provides additional 
information to the user such as the completeness of the underlying data of the object associated 
with the object cockpit or configured report. When the user opens the wizard/wizard step, the 
quality widget will be attached to the right-hand edge of the wizard and will stay attached to the 
wizard if it is resized or repositioned. If the configured report opening as quality widget provides 
navigation, the navigation target will open in a new tab in the browser. The user could thus update 
data in this view and reload the original view to display the updated data. The quality widget will 
remain open until the user clicks outside of the pop-up window or clicks the close button. 

  

 
Captions on the wizard buttons in your Alfabet solution are configurable and may differ from the 
standard captions described in this documentation. 

Each wizard step typically constitutes one screen with preconfigured buttons that control the wizard pro-
cess. The following information explains the general behavior that is triggered by the buttons as well as ad-
ditional information that will help you understand possible consequences if post-conditions are configured 
for a wizard step. The Next button and Exit button are preconfigured by Software AG and will be displayed 
per default. The Back button and Go to Step button are optional and must be configured to be displayed in 
the wizard. 

A wizard step may have pre-conditions or post-conditions defined in order to validate whether data has 
been entered for a wizard step. Thus, depending on the configuration, it may be mandatory or desired that 
specific data is completed for a wizard step. Please note that any post-conditions that have been config-
ured for that wizard step will be executed AFTER the data has been saved in the wizard step. This is of par-
ticular relevance for post-conditions defined for editors. The first database transaction will attempt to save 
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the data that has been defined in the wizard step. However, this may fail if mandatory or uniqueness condi-
tions are violated. Such errors must first be resolved before the system can check the post-conditions. A 
customized error message will be displayed providing the user with information about the data that is re-
quired. 

Please note the following issues regarding the behavior of the wizard: 

• Mandatory Fields: Mandatory fields in an editor must be completed in order to save the data and 
proceed to the next wizard step. If a wizard cannot advance to the next wizard step because 
mandatory properties have not been defined, an error message will list the mandatory properties 
that must be defined in order for the wizard to proceed to the next step. 

• NextButton: The Next button allows the user to save the data entered during the wizard step and 
proceed to the next wizard step. If the automated translation is supported for the object class, the 
automated data translation capability will be triggered when the Next button is clicked. Please 
note the following:  

• If a pre-condition is defined for the last wizard step and the pre-condition is not fulfilled, then 
the wizard will close when the user clicks the Next button in the wizard step before the last 
wizard step. 

• If the post-condition specifies that the data is required (mandatory), a customized error 
message will be displayed when the user clicks the Next button. The user will not be able to 
advance to the next wizard step until the required data is provided. If the post-condition 
specifies that the data is desired (optional), a customized information message will be 
displayed if the data is missing. However, the user will not be prevented from advancing to the 
next wizard step. 

• If multiple post-conditions have been configured for a wizard step, only one error message at 
a time will be displayed when the user attempts to save the data by clicking the Next button. 
Once the user corrects the first violation and attempts to advance to the next wizard step, a 
customized error message for the next violation will be displayed. This process will continue 
until all violations have been corrected. The user will only be able to advance to the next 
wizard step when no violations have been found via the data entry prompts. 

• ExitButton: The Exit button allows the user to save the data entered during the wizard step and 
close the wizard. The next time the user opens the wizard for the selected object, the wizard will 
automatically open to the wizard step that the user most recently exited. Likewise, if the user 
session is terminated while the wizard is open, the wizard will open to the wizard step that was last 
open when the session was terminated. Please note the following:  

• If a user clicks the Exit button during the creation of a new object on a first wizard step, the 
new object will be deleted! 

• The caption displayed on the Exit button is configurable and therefore, a different caption 
(such as Save) may be displayed on the button. 

• BackButton: A Back button may be displayed that allows the user to return to the preceding 
wizard step. By clicking the Back button, the user saves the data entered during the wizard step 
and returns to the preceding wizard step. The Back button will be greyed out and inactive on the 
first step of a wizard. 

• Go to StepButton: A Go to Step drop-down box may be displayed that will allow users to select 
another wizard step in the workflow. This enables the user to leave the linear sequence of steps 
and return to a subsequent or preceding wizard step in the wizard process. The Go to Step field is 
only available when an existing object is being edited. It is not available when a new object is being 
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created. If the wizard is configured to include the Go to Step field, users will be able to traverse to 
any subsequent or proceeding wizard step. If post-conditions are configured for the wizard step 
that the user is leaving, the post-conditions will be executed and, if necessary, required data must 
be entered in order to leave the current wizard step. Please be aware, however, that post-
conditions for any intermediary steps between the wizard step the user is leaving and the wizard 
step the user is going to will not be checked. For example, if a user goes from Wizard Step 2 to 
Wizard Step 4, the post-conditions for Wizard Step 2 will be checked and must be fulfilled, but 
post-conditions for Wizard Step 3 will not be triggered and must not be fulfilled in order to go to 
Wizard Step 4. 

• Close Button: The wizard can be closed by clicking the X button in the upper right corner of the 
wizard. All data that has been saved via the Next button will be saved to the Alfabet database. 

Multi-Language Support in Editors and Wizards  

Depending on the configuration of your Alfabet solution, object data such as names, descriptions, and 
other relevant custom properties may be captured in the enterprise's primary language, any of its second-
ary languages, or in a statutory language that is mandated for relevant object classes. If the enterprise 
supports multiple languages, the data captured for protected and custom properties of the type String 
and Text may be translated to the other languages implemented in your Alfabet solution. When the user 
interface is rendered in a one of the languages for which translations are available, the translated names of 
objects will be displayed in explorers, object profiles, page views, previews, etc. Objects with names defined 
in a secondary language will be ordered accordingly in explorer trees and page views. 

 

If data translation is supported for the class Business Process, a user could capture the Name 
and Description of their business processes in the primary language. The same user or other 
users with access to the business processes could then either manually provide a translation for 
the names and descriptions of the business processes in the editor/wiazárd or, if the automated 
translation capability is configured, the data can be translated via a translation service to the 
languages supported by the enterprise. 

Your solution designer will configure on a per-class basis whether the translation of object data is possible 
and which properties may be manually translated or translated via the automated translation capability. To 
understand which languages are supported by your enterprise, click the < Alfabet User Name > Language 
menu in the main toolbar. The following scenarios to capture and translate object data are supported: 

• Data can be captured in the primary language only. If only one culture is defined for the enterprise, 

then the Manual Translation  and Automated Translation  icons will be disabled in the 
editor/wizard. 

• Data can be captured in the primary language and may be translated either manually and/or 
automatically to one or more secondary languages. It is possible to configure on a per-class basis 
the object classes where only manual translation is possible, where only automated translation is 
possible, or where an automated translation is provided if no manual translation has been entered. 

• The manual translation can be captured by changing the language selector in the 
editor/wizard and entering the translation in the relevant field. 

• The automated translation will be triggered when the OK button in the editor or Next button in 
the wizard is clicked. 
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In some cases, a new object will inherit the translated name, description, etc. of its par-
ent object. This is the case, for example, for information flows, local components, or 
business services. If translations are available for the name of the parent object, the new 
information flow, local component, or business service will inherit the translated name of 
its parent object. For example, a business service will inherit the translated name of the 
business function it is based on and an information flow will inherit the name of its 
source and target applications. 

• Data can be captured in a secondary language. The Alfabet user interface must be rendered in the 
secondary language to capture data in that language. In this case, it is recommended that the 
automated translation capability is configured in order to provide a translation of the name for the 
object in the primary language. For more information about capturing data in a secondary 
language, see the section Capturing Data in a Secondary Language. 

• Data can be captured in a statutory language, which can be the primary language or a secondary 
language. The Alfabet user interface should be rendered in the statutory language to capture data 
in that language. If the statutory language is a secondary language, it is recommended that the 
automated translation capability is configured in order to provide a translation of the name for the 
object in the primary language. For more information about capturing data in a statutory language, 
see the section Capturing Data in a Statutory Language. 

• Data can be captured via XLSX files based on data capture templates configured in the Extended 
Data Capture Templates functionality. In this case, data can also be captured in a primary, 
secondary, or statutory language. For more information about configuring and using data capture 
templates to import object data, see the chapter Capturing Data with Data Capture Templates in 
the reference manual User and Solution Administration. 

An icon will be displayed next to each field in the editor/wizard that may be translated. You may see any of 
the following icons next to the fields that support data translation: 

• Manual Translation : This field may be manually translated. 

• Automated Translation : This field may be manually translated or translated via the 
automated translation capability. 

• Disable Automated Translation : This indicates that the automated translation capability has 
been disabled because an automated translation is not desired for this particular field for the 
selected object. For example, in the case of the object class Location, whereas it may be 
meaningful for a city name to be translated (for example, Berlin would be translated to Berlino in 
Italian, Berlim in Portuguese, and Berlina in Polish), it may make no sense for the names of small 
towns to be translated because no actual translation of the town's name exists. 

 

Your solution designer will configure whether the translation of data is supported for a class, 
which of the properties of the class may be translated, and whether only manual translation or 
both manual and automated translation is allowed. For more information about configuring per-
missibility for object data translation as well as the general requirements to implement the man-
ual and automated translation capability, see the section Configuring the Translation of Object 
Data in the chapter Localization and Multi-Language Support for the Alfabet Interface of the 
reference manual Configuring Alfabet with Alfabet Expand. 

The following prerequisites must be fulfilled for strings to be successfully fetched for automated 
translations: 

• The enterprise must have a valid licence to one of the following translation services:  
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• Google Translate® 

• AWS Translate® 

• DeepL® Translator 

• Microsoft® Azure® Translate Text 

• The XML object AlfaTranslationServicesConfig must be configured and the 
connection to the translation service must be activated. For more information about the 
configuration of the XML object AlfaTranslationServicesConfig, see the section 
Configuring Interoperability with a Translation Service in the reference manual API 
Integration with Third-Party Components. 

• The pre-conditions for activating the Rest API must be fulfilled. For more information, 
see the reference manual Alfabet RESTful API. 

• One user in the enterprise must be specified to execute self-reflective events and must 
start the Alfabet Server. For more information, see the chapter Setting a User as a Self-
Reflective User to Execute Events in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• The Alfabet Server must be running and able to connect to the Internet. 

The following information is available: 

• Translating Object Data Manually 

• Translating Object Data via the Automated Translation Capability 

• Capturing Data in a Secondary Language 

• Capturing Data in a Statutory Language 

Translating Object Data Manually 

Depending on the configuration of your Alfabet solution, data can be captured in the primary language or a 
secondary language and may be manually translated to the other languages supported by the enterprise. 
To display any existing translations of text fields in the editor/wizard or to provide a manual translation for 
a field in the editor/wizard, you must explicitly change the language selector in the lower left corner of the 
editor to the relevant language. 

 

Your solution designer will configure whether the translation of object data is supported for a 
class, which of the properties of the class may be translated, and whether only manual transla-
tion, only automated translation, or both manual and automated translation is allowed. For more 
information about configuring permissibility for object data translation as well as the general re-
quirements to implement the manual and automated translation capability, see the section Con-
figuring the Translation of Object Data in the chapter Localization and Multi-Language Support 
for the Alfabet Interface of the reference manual Configuring Alfabet with Alfabet Expand. 

For more information about capturing object data in a secondary language, see the section Cap-
turing Data in a Secondary Language. 

A manual translation may be defined for object data in editor/wizard fields displaying any of the following 
icons: 
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• Manual Translation : This indicates that a manual translation may be specified for a language 
selected in the language selector at the bottom of the editor/wizard. If no translation is manually 
provided for a language, the following will occur: 

• Automated Translation : This indicates that the field may be translated via the automated 
translation capability but it is possible to provide a manual translation instead. If a manual 

translation is entered in a field with the Automated Translation  icon, the manual translation 
will have precedence and the field will not be translated via the automated translation capability. If 
no manual translation is provided, the value in the field will be translated via the automated 
translation capability when the OK button in the editor/the Next button in the wizard is clicked. 
The configured translation service will fetch the translation strings for all relevant languages. 

• Disable Automated Translation : This indicates that the automated translation capability has 
been disabled for the field because an automated translation is not desired for this particular field 
for the selected object. Nevertheless, a manual translation could be entered if this was necessary 
for some reason. 

 
For more information about configuring permissibility for object data translation as well as the 
general requirements to implement the manual translation capability, see the section Configuring 
the Translation of Object Data in the chapter Localization and Multi-Language Support for the 
Alfabet Interface of the reference manual Configuring Alfabet with Alfabet Expand. 

To manually define a translation string: 

1) Ensure that the Alfabet user interface is rendered in the language that you want to capture the 
original data for. Typically this is the enterprise's primary language. If you are capturing the original 
data in a secondary language, please also refer to the section Capturing Data in a Secondary 
Language. 

2) In the relevant view, click the option available to create the new object. 

3) In the editor/wizard, enter a value in a relevant editor field the language selected for the user 
interface. 

4) Change the language selector at the bottom of the editor to the language of the translation. 

5) Enter the translated value in the relevant editor field supporting data translation. Please note the 
following:  

• If the original string is changed in the editor/wizard, the existing strings that have been 
manually translated will not be changed or deleted. 

• If no manual translation is provided for a selected language, the field in the editor/wizard will 
remain empty. 

• If the value in the field is defined for the primary language, then the primary language string 
will be displayed for the value when the user interface is rendered in a language with no 
translated string. 

• If the value in the field is defined for a secondary language and no value is defined for the 
primary language, then the secondary language string will be displayed for the value when the 
user interface is rendered in the primary language or another language with no translated 
string. Please note that this is not recommended as it will cause inconsistencies in the 
language displayed in the user interface. All objects should have an appropriate value in the 
primary language. 
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6) Click the OK button in the editor or the Next button in the wizard to save the translation. 

Translating Object Data via the Automated Translation Capability 

Depending on the configuration of your Alfabet solution, data can be captured in the primary language or a 
secondary language and may be translated via the automated translation capability to the other languages 
supported by the enterprise. If automated translation is executed for formatted text in an HTML editor, it is 
advised that you review the formatting because in some cases the formatting may not be correctly applied 
after translation is executed. 

 

Your solution designer will configure whether the translation of data is supported for a class, 
which of the properties of the class may be translated, and whether only manual translation, 
only automated translation, or both manual and automated translation is allowed. For more in-
formation about configuring permissibility for object data translation as well as the general re-
quirements to implement the manual and automated translation capability, see the section Con-
figuring the Translation of Object Data in the chapter Localization and Multi-Language Support 
for the Alfabet Interface of the reference manual Configuring Alfabet with Alfabet Expand. 

Please note the following prerequisites must be fulfilled for strings to be successfully fetched 
for automated translations: 

• The enterprise must have a valid licence to one of the following translation services:  

• Google Translate® 

• AWS Translate® 

• DeepL® Translator 

• Microsoft® Azure® Translate Text 

• The XML object AlfaTranslationServicesConfig must be configured and the 
connection to the translation service must be activated. For more information about the 
configuration of the XML object AlfaTranslationServicesConfig, see the section 
Configuring Interoperability with a Translation Service in the reference manual API 
Integration with Third-Party Components. 

• The pre-conditions for activating the Rest API must be fulfilled. For more information, 
see the reference manual Alfabet RESTful API. 

• One user in the enterprise must be specified to execute self-reflective events and must 
start the Alfabet Server. For more information, see the chapter Setting a User as a Self-
Reflective User to Execute Events in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• The Alfabet Server must be running and able to connect to the Internet. 

For more information about capturing object data in a secondary language, see the section Cap-
turing Data in a Secondary Language. 

 

 
You can disable the automated translation capability if an automated translation should not be 
triggered for a particular field in the editor/wizard. For example, in the case of the object class 
Location, whereas it may be meaningful for a city name to be translated (for example, Berlin 
would be translated to Berlino in Italian, Berlim in Portuguese, and Berlina in Polish), it may make 
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no sense for the names of small towns to be translated because no actual translation of the 
town's name exists. 

To disable the automated translation capability, click the Automated Translation  button. 

The icon will change to the Disable Automated Translation  icon. You can click the Disable 

Automated Translation  button to return the Automated Translation  button. If a field 
with an existing automated translation string is disabled for automated translation, the trans-
lated string will be deleted from the Alfabet database. 

 

 
Please note that if a user logs in and creates an object in the language of the Alfabet user inter-
face and shortly thereafter another user logs in to the user interface with a different language 
and edits the same object by changing the automatically translated string, a pop-up will open 
asking the user whether the changed string shall be translated to all supported languages. This 
allows the user to differentiate between a major change to the content of the string which would 
warrant the need for the string to be retranslated vs. a minor change whereby the user is making 
a slight correction to the translation of the string. 

To execute the automated translation capability to fetch translation strings: 

1) Ensure that the Alfabet user interface is rendered in the language that you want to capture the 
original data for. Typically this is the enterprise's primary language. If you are capturing the original 
data in a secondary language, please also refer to the section Capturing Data in a Secondary 
Language. 

2) In the relevant view, click the option available to create the new object.  

 
If an object is created as a copy of an object, then the automated translation will be cop-
ied to the new object. For example, if an application variant is created based on an appli-
cation or if a local component is created for an application, the translation of the appli-
cation's description would be copied to the respective application variant or local com-
ponent. The translation string can be changed as needed. 

3) In the editor/wizard, enter a value in the language selected for the user interface in a field with the 

Automated Translation  icon. If a manual translation is entered in a field with the Automated 

Translation  icon, the manual translation will have precedence and the field will not be 
translated via the automated translation capability. 

4) Click the OK button in the editor/the Next button in the wizard. The configured translation service 
will fetch the translation strings for all relevant languages. Please note the following:  

• The translated string will not be immediately displayed. A few minutes may be needed to fetch 
the translations. 

• If an object is created as a copy of an object, then the automated translation will be copied to 
the new object. For example, if an application variant is created based on an application or if a 
local component is created for an application, the translation of the application's description 
will be copied to the respective application variant or local component. The translation string 
can be changed as needed. 

• If the original string is used for multiple object data, the same translation string will be used for 
all occurrences of the original string in the Alfabet database. 
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• If the original string is changed in the editor/wizard after translation strings have been 
fetched, the automated translation will be triggered again when the OK button in the 
editor/the Next button in the wizard is clicked and new translation strings will be fetched from 
the translation service. 

• If an existing translation string has already been translated manually or via the automated 
translation capability, it will not be retranslated if the automated translation capability is 
triggered for other fields in the editor/wizard. 

• If an existing translation string has been translated via the automatic translation capability, it 
may be manually revised in the editor/wizard or in the Automated Data Translation 
Functionality. If the original string is used for multiple object data, then only the explicit 
translation string that is being revised will be changed in the Alfabet database. Other 
instances of the translation string will remain unchanged and will not be impacted by the 
revised translation string. In this way, you can revise the translation string for a specific 
context. 

• A user with an administrative profile may review the translation strings fetched via the 
automated translation capability and modify them as needed in the Automated Data 
Translation Functionality. For more information, see the chapter Managing Automated 
Translation Strings in the reference manual User and Solution Administration. 

 
• If no translated string is returned, please consider the following: The following 

prerequisites must be fulfilled for strings to be successfully fetched for automated 
translations:  

• The enterprise must have a valid license to one of the supported translation 
services. 

• The connection to the translation service must be active in the XML object 
AlfaTranslationServicesConfig. For more information about configuring the XML 
object AlfaTranslationServicesConfig, see the chapter Configuring 
Interoperability with a Translation Service in the reference manual API Integration 
with Third-Party Components. 

• The Alfabet Server must be running and able to connect to the Internet. 

• The pre-conditions for activating the Rest API must be fulfilled. For more 
information, see the reference manual Alfabet RESTful API. 

• A user with an administrative profile may review whether the event has been 
successfully triggered in the Events Administration Functionality. If the event is not 
displayed or has an Error status, then the prerequisites should be reviewed. For more 
information about events administration, see the chapter Managing Events in the 
reference manual User and Solution Administration. 

• A user with an administrative profile may view the status of the ADIF import scheme 
(Get Automated Instance Translations from Service Provider or Get 
Automated Translations for an Instance from Service Provider) that are 
executed for the automated translations in the ADIF Jobs Administration Functionality. 
For more information about events administration, see the chapter Executing and 
Controlling ADIF Jobs in the reference manual User and Solution Administration.  

If automated translations have not been fetched due to Internet connection outages, a 
solution designer can trigger the ADIF import scheme Get_Instance_Auto-
mated_Translations_For_Empty_Texts or similar ADIF jobs to retrieve the 
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automated data translations that have been missed as a result of the Internet connec-
tion outages. For more information about the predefined ADIF schemes for the auto-
mated translation capability, see the section Predefined ADIF Schemes in the reference 
manual Alfabet Data Integration Framework. 

 

Capturing Data in a Secondary Language  

The possibility to capture data in a secondary language provides end users with the means to capture and 
maintain IT portfolio information in their preferred language and ensures high data quality in multi-lan-
guage organizations. The method to capture data in a secondary language is similar to that described in the 
section Translating Object Data via the Automated Translation Capability... 

 

In order to capture language in a secondary language, you must ensure that the checkbox for 
the Capture Translations in Language of User Interface field in their User Settings editor is 
selected. For more information, see the section Defining Your User Settings in Alfabet. For more 
information about the other configuration requirements to capture data in a secondary lan-
guage, see the section Allowing Data To Be Captured in a Non-Primary Language in the refer-
ence manual Configuring Alfabet with Alfabet Expand. 

Please note that it is highly recommended that the automated translation capability is config-
ured in order to provide an adequate translation of the name for the object in the primary lan-
guage. For more information about configuring permissibility for object data translation as well 
as the general requirements to implement the manual and automated translation capability, see 
the section Configuring the Translation of Object Data in the chapter Localization and Multi-
Language Support for the Alfabet Interface of the reference manual Configuring Alfabet with 
Alfabet Expand. 

A user with an administrative profile may review the translation strings fetched via the auto-
mated translation capability and modify them as needed in the Automated Data Translation 
Functionality. For more information, see the chapter Managing Automated Translation Strings in 
the reference manual User and Solution Administration. 

To capture data in a secondary language: 

1) Ensure that the Alfabet user interface is rendered in the secondary language that you want to 
capture the original data for. 

2) In the relevant view, click the option available to create the new object.  

 
The secondary language should be the same as the language of the Alfabet user inter-
face. 

3) In the editor/wizard, enter a value in a relevant editor field in the language selected for the user 
interface.  

 
Every new object that is created requires a value in the Name attribute for the primary 
language. If the data is originally captured in a secondary language, then the Name at-
tribute must be specified in the primary language either via a manual translation or via 
the translation capability. 
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 FIGURE: Translation to primary language 

Please note the following: 

• If the translation to the primary language is provided via the automated 
translation capability: 

• If the automated translation capability is implemented, the name will be 
automatically translated to the primary language when the editor/wizard is 
closed. 

• If the automated translation capability is not implemented, please consider 
the following: 

• If the language of the user interface is the same as the language 
selected in the editor/wizard, the value entered in the Name field will 
be saved for both the selected secondary language as well as the 
primary language. The language can be manually translated to the 
primary language in the editor after the new object has been saved. 

• If the language of the user interface is not the same as the language 
selected in the editor/wizard, the object cannot be saved because the 
Name attribute is NULL for the primary language. In this case, you must 
change the language of the user interface to the language that you 
want to capture the data in. 

• If a translated string is changed, the automated translation will be 
triggered again for all languages. The original string captured in the 
secondary or statutory language will not be changed via the automated 
translation. 
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• If the translation to the primary language shall be defined via a manual 
translation: 

• Enter the value in the editor field, change the language selector at the 
bottom of the editor to the primary language, and enter the translated value 
in the relevant editor. Click the OK button in the editor/the Next button in 
the wizard to save the definitions. 

• If no manual translation is defined for the primary language, the original 
string defined in the secondary language will be displayed for the Name 
when the user interface is rendered in the primary language. This may be 
revised at any time in the editor/wizard. 

• If no manual translation is defined for any of the other secondary 
languages, the value displayed for the Name when the user interface is 
rendered in the primary language will also be displayed when the user 
interface is rendered in the secondary language. 

4) Click the OK button in the editor or the Next button in the wizard to save the data. The automated 
translation capability will be triggered. 

Capturing Data in a Statutory Language  

A statutory language capability is available in order to address regulatory requirements that mandate that 
objects are captured in a specific language. For example, if an enterprise has English as its primary lan-
guage, but an organization in the enterprise is located in Germany and is required to capture data in Ger-
man, than users can capture the data in the statutory language of German. 

When a user creates an object based on a relevant object class/object class stereotype, a statutory lan-
guage selector will open in which the statutory language can be selected. All languages supported by the 
enterprise will be available for selection. In the object editor that opens, the user can capture all attributes 
that support data translation in the statutory language. The automated translation capability will then 
translate the data to the primary language as well as other relevant secondary languages. 

 

In order to capture language in a statutory language, you must ensure that the checkbox for the 
Capture Translations in Language of User Interface field in their User Settings editor is se-
lected. For more information, see the section Defining Your User Settings in Alfabet. For more 
information about the other configuration requirements to capture data in a statutory language, 
see the section Specifying a Statutory Language for the Enterprise in the reference manual 
Configuring Alfabet with Alfabet Expand. 

Please note that it is highly recommended that the automated translation capability is config-
ured in order to provide an adequate translation of the name for the object in the primary lan-
guage. For more information about configuring permissibility for object data translation as well 
as the general requirements to implement the manual and automated translation capability, see 
the section Configuring the Translation of Object Data in the chapter Localization and Multi-
Language Support for the Alfabet Interface of the reference manual Configuring Alfabet with 
Alfabet Expand. 

A user with an administrative profile may review the translation strings fetched via the auto-
mated translation capability and modify them as needed in the Automated Data Translation 
Functionality. For more information, see the chapter Managing Automated Translation Strings in 
the reference manual User and Solution Administration. 
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A user with an administrative profile may review the values defined for the Name attribute of 
the objects with a statutory language definition and change them as needed in the Statutory 
Language Review for Data Translations functionality. Furthermore, the administrative user can 
change the statutory language or remove the statutory language definition if needed For more 
information, see the chapter Managing the Translations for the Enterprise's Statutory Language 
in the reference manual User and Solution Administration. 

 

 
Please note the following: 

• All languages configured for your Alfabet solution will be available in the statutory 
language selector. 

• There is no enforcement mechanism that requires users to capture data in a statutory 
language. 

• The Alfabet user interface must be rendered in the statutory language that the user 
wants to capture the original data for. 

• The value defined for the selected statutory language will never be replaced by an 
automated translation string.  

Please note that if the user interface is rendered in a language that is different than the 
selected statutory language, a warning will be displayed in the editor. If the user never-
theless proceeds to capture data in the non-statutory user interface, an automated 
translation string will not be fetched for the statutory language and the value for the 
statutory language will be empty. 

To capture data in a statutory language: 

1) Ensure that the Alfabet user interface is rendered in the statutory language that you want to 
capture the original data for. 

2) In the relevant view, click the option available to create the new object. 

3) In the language selector that opens, select the statutory language.  

 
The statutory language should be the same as the language of the Alfabet user inter-
face. 

4) In the editor/wizard, ensure that the statutory language is selected in the language selector at the 
bottom of the editor/wizard. 

5) Enter a value in a relevant editor field the language selected for the user interface.  

 
Every new object that is created requires a value in the Name attribute for the primary 
language. If the data is originally captured in a secondary language, then the Name at-
tribute must be specified in the primary language either via a manual translation or via 
the translation capability. 
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 FIGURE: Translation to primary language 

Please note the following: 

• If the translation to the primary language is provided via the automated 
translation capability: 

• If the automated translation capability is implemented, the name will be 
automatically translated to the primary language when the editor/wizard is 
closed. 

• If the automated translation capability is not implemented, please consider 
the following: 

• If the language of the user interface is the same as the language 
selected in the editor/wizard, the value entered in the Name field will 
be saved for both the selected secondary language as well as the 
primary language. The language can be manually translated to the 
primary language in the editor after the new object has been saved. 

• If the language of the user interface is not the same as the language 
selected in the editor/wizard, the object cannot be saved because the 
Name attribute is NULL for the primary language. In this case, you must 
change the language of the user interface to the language that you 
want to capture the data in. 

• If a translated string is changed, the automated translation will be 
triggered again for all languages. The original string captured in the 
secondary or statutory language will not be changed via the automated 
translation. 
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• If the translation to the primary language shall be defined via a manual 
translation: 

• Enter the value in the editor field, change the language selector at the 
bottom of the editor to the primary language, and enter the translated value 
in the relevant editor. Click the OK button in the editor/the Next button in 
the wizard to save the definitions. 

• If no manual translation is defined for the primary language, the original 
string defined in the secondary language will be displayed for the Name 
when the user interface is rendered in the primary language. This may be 
revised at any time in the editor/wizard. 

• If no manual translation is defined for any of the other secondary 
languages, the value displayed for the Name when the user interface is 
rendered in the primary language will also be displayed when the user 
interface is rendered in the secondary language. 

6) Click the OK button in the editor or the Next button in the wizard to save the data. The automated 
translation capability will be triggered. 

Entering Data in Object Profiles and Object Cockpits  

Depending on your solution configuration, you may able to edit data directly in fields capturing scalar and 
reference attributes in object profiles and object cockpits. If inline editing is supported, you can edit scalar 
attributes for an existing object directly in the Attributes section of an object profile or in an object cockpit 

without needing to open the object's editor or wizard. When you point to the attribute, the Edit  icon 
will be displayed next to the attribute to indicate the object can be edited inline. 

To edit inline, click in the field and depending on the type of field, define text, select a value in a drop-down 
list, or specify a date. The size of a text field will expand accordingly for fields with longer texts. In the case 
of text fields that have long texts in them, the size of the field will expand to comfortably edit inline. Upon 

completion, you can then click the Save  button to save the definition to the Alfabet database or click 

the Cancel  button to remove the definition. 

 
Please note the following regarding the inline editing functionality: 

• Only scalar and reference properties that are editable in the editor/wizard available in 
the object profile or object cockpit can be edited via inline editing. 

• All unique constraints defined for the class as well as any post-conditions configured for 
the wizard associated with the object profile/object cockpit will be applied to the data 
entered.  

 
Please note that data is saved to the Alfabet database prior to the post-condi-
tion being validated. Therefore, data entered via inline editing will be saved 
even if the post-condition is not fulfilled. This is because the data must be 
available in the Alfabet database in order to be evaluated for the post-condi-
tion. If the data entered does not fulfill the post-condition, the configured 
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warning message will be displayed explaining that the input must be corrected 
in order to fulfill the post-condition. 

• Inline editing may be limited or prevented if the syntax of the post-condition is not 
correct. In this case, an error will be displayed if the user tries to open the wizard. 

 

 

Permissibility of inline editing can be specified by your solution designer on the level of an object 
view, class setting, or GUI scheme. For more information, see the section Configuring Inline Edit-
ing of Attributes in the Object View in the reference manual Configuring Alfabet with Alfabet Ex-
pand. 

Creating Objects in Alfabet 

The view to use to create an object will depend on the object class that you are working with. For example: 

• To create an object at the root level of the object hierarchy, click the root icon at the top of the 
explorer tree and either click New > Create New <Object> in the view to the right or, if several 
views are displayed, open the relevant view and click New > Create New <Object>. 

• To create a subordinate object of another object in the explorer tree structure, click the parent 
object in the explorer tree and then open the relevant page view in the object profile. Click New > 
Create New <Object> in the toolbar in that page view. 

• Some views such as Capture Applications, Capture Components, etc. are not accessible via an 
explorer tree. In these cases, a New button may be available to create a new object. 

In the process of creating an object, you typically define its basic properties such as the name, start date, 
description, authorized user, etc. that describe the object. If the object is based on an object class stereo-
types, the Stereotype attribute must be defined for the object. 

The user who creates the object is automatically designated the authorized user. An authorized user has 
Read/Write access permission to the object. After an object is created, the authorized user may be changed 
at any time. Every object can have at most one authorized user and multiple authorized user groups. How-
ever, it is also possible that no authorized user is defined for an object. The authorized user or user group 
can be reassigned in the Authorized Access tab in the respective object’s editor. To access the editor, 

click the Edit  button in the toolbar of the object’s profile. A user can see all objects that he/she has au-
thorized access to in the Authorized User Objects page view in the Personal Info functionality in the 
Home. If permission rules are defined for the enterprise, it is possible that the authorized user may only edit 
the object during the user session in which the object was created. Once the session ends, the authorized 
user will no longer be able to edit the object. For more information about the configuration of access per-
missions, see the section Configuring Access Permissions in the reference manual Configuring Alfabet with 
Alfabet Expand. 

After an object has been created and its basic properties have been defined in the editor or wizard, the data 
can be modified at any time by a user with access permissions to the object. This can be done in the page 
views that are available in the object profile. Please note that if filters are defined in a page view and the 
edited object no longer fulfills the filter criteria, it will no longer be visible in the table. You will need to ad-
just your filter settings to see the object. 
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Most changes that you make to an object that you have selected in an explorer will be automati-
cally updated. However, if you make a change to the parent object of a currently selected object, 

then you must click the Refresh Explorer  button to update the explorer. For example, if you 
select an application and assign it to a new application group or if you select an organization and 
define it as a sub-organization of another organization, then you must update the explorer to re-
flect the new position of the application or organization in the explorer. 

Detaching and Deleting Objects  

When you detach an object from its parent object, you are simple removing it from the object that it has a 
relationship to. The relationship between the two objects is deleted, but both objects remain in the data-
base. For example, if you detach an application from an application group, the application is no longer as-
signed to the application group and the application and application group are still in the Alfabet database. 

When you delete an object, you irrevocably delete the object from the Alfabet database. The message that 
is displayed when an object is deleted will warn the user that related objects will also be deleted when ap-
plicable. For example: 

 
• If you delete an application, it will be irrevocably deleted from the Alfabet database. 

• If the deleted application has application variants, the application variants will become 
application versions. In this case, the value True will be removed from the Is Variant 
attribute. 

• If any of the following dependent objects or data is defined for the deleted application, 
these will also be deleted: Enterprise Release Item, Business Service, Business Data 
Usage, Information Flow, Local Component, Stack, Migration Rule, Operational Business 
Support, Tactical Business Support, Solution Business Support, Solution Information 
Flow, Application Diagram, Platform Diagram, Assignment, Attachment, Deputy, 
Evaluation, Lifecycle, Role. 

Depending on the object that is being deleting, there may be consequences to objects that are subordinate 
to a deleted object. 

 
• If you delete an ICT object category, it will be irrevocably deleted from the Alfabet 

database. 

• If you delete an ICT object category that has ICT objects assigned to it, those ICT objects 
will remain in the database but will no longer be assigned to an ICT object category. To 
view all ICT objects that are not assigned to a category and reassign them to another 
category, see the Unassigned ICT Objects Page View. 

• Only an ICT object category with no subordinate ICT categories can be deleted. 
Therefore, you may need to first delete all sub-categories from the selected ICT object 
category or reassign them to another ICT object category. To reassign an ICT object 
category to another ICT object category, see the Sub-Categories Page View of the 
category that is to be the new ascendant (parent) ICT object category. 

• If any of the following dependent objects or data is defined for the deleted object, these 
will also be deleted: Assignment, Attachment, Deputy, Role. 
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Please note the following information about the Delete action: 

• You cannot delete an object that has the release status Draft. If you erroneously create an object 
and want to delete it, you must first change the release status. 

• The deletion of objects in Alfabet is not recommended. Rather, it is recommended that you set the 
release status of an object to retired. An error may occur if a user attempts to create a relationship 
to an object that is concurrently being deleted.  

 
There is no Undo function in Alfabet ! There is no Undo action if an object is falsely de-
leted nor will archive information be automatically generated for a deleted object. You 
should only delete an object if you are certain that it should be deleted from the Alfabet 
database. If archive information is desired, the object must be explicitly archived by your 
solution administrator who is responsible for the archiving capability. For more infor-
mation about the archiving capability, see the chapter Deleting and Archiving Alfabet 
Objects in the reference manual User and Solution Administration  

To delete an object: 

1) In the relevant view, click the object you want to delete. 

2) In the toolbar, click the Delete  button. 

3) Confirm the warning by clicking Yes, or click No to exit without deleting the selected object(s). 

To detach an object: 

1) In the relevant view, click the object you want to detach. 

2) In the toolbar, click the Detach  button. 

3) Confirm the warning by clicking Yes, or click No to exit without saving your changes. 

Analyzing Your Data in Page Views and Reports  

Alfabet provides a wide variety of views to present and analyze data. Many reports display data in standard 
dataset tables with columns. However, a number of other types of visualizations of data are also available. 
These include: 

• landscape diagrams 

• matrix reports 

• portfolio charts 

• pie charts 

• Gantt charts 

• bar charts 

• treemap report 

• layered diagrams 

• cluster maps 
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In most views and reports, you can double-click an object in order to navigate to its object profile. Please 
note that the double-click action is reserved only for navigation. If you double-click an object and nothing 
happens, then navigation is not possible for the object. 

Business graphics will be rendered to maximize the screen space available. When relevant, Alfabet business 
graphics provide a legend that will help you to understand the information displayed in the graphic. The 
functionalities available in the legend will depend on the type of business graphic that you are currently 
working with. Finally, graphics can be exported, linked to Microsoft® Office documents, and printed at full 
printer resolution with reliable color. 

 
If the page view or configured report displays portfolios, Gantt charts, branching diagrams, sun-
ray diagrams, circular roadmaps, etc., you can specify whether or not the graphics shall be built 
dynamically when the view is opened. This is done via the Enable User Interface to Poll Web 
Server attribute in the User Settings editor. For more information, see the section Defining Your 
User Settings in Alfabet. 

 

 
Depending on the configuration of your Alfabet solution, many of the reports that you see may 
be configured reports that have been created by your solution designer in order to provide a cus-
tomized data analysis that is not available in the standard Alfabet product. Reports may be con-
figured to display data in tables, matrices, portfolios, or Gantt charts. Other graphic visualizations 
may also be displayed in configured reports including, for example, treemap reports, layered dia-
grams or grid reports. Configured reports may be available in the object profiles or object cock-
pits that you have access permissions to as well as in the Executing Your Configured Reports. If 
your solution designer has provided a context-sensitive help page for the configured report, you 
will be able to open this via the Help button in the Alfabet interface. 

The following information is available: 

• Defining Filter Settings 

• Defining Text Fields 

• Defining Object Selector Fields 

• Defining Checkbox Fields 

• Defining Combo-Box Fields 

• Defining Filters with Two Fields 

• Defining Calendar Fields 

• Defining Multiple Selection Combo Box Fields 

• Working with Data in Tabular Datasets 

• Working with Diagrams 

• Designing a Diagram 

• Interpreting a Diagram 

• Working with Portfolio Reports 

• Working with Lifecycle Reports and Time Schedules 

• Working with Configured Business Support Matrix Reports 
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• Understanding the Different Types of Customized Business Support Matrices 

• Defining the Standard Filters in the Configured Business Support Matrix 

• Creating New Business Supports By Means of the Configured Business Support Matrix 

• Working with Layered Diagram Reports 

• Working with Tree Reports 

• Working with Cluster Map Reports 

• Working with Affinity and Diagram Matrix Reports 

• Working with Radar, Bar, Line and Pie Charts 

• Working with Treemap Reports 

• Executing Your Configured Reports 

• Adding a Configured Report to the View 

• Opening a Configured Report 

• Opening a Configured Report Executed Offline 

Defining Filter Settings  

Standard page views as well as configured reports may allow you to capture, maintain, and analyze the 
data for the objects you are responsible for. Page views and configured reports may display a table with 
data or a graphic visualization such as a diagram, portfolio, bar chart, matrix view, etc. Many page views in 
Alfabet have a filter panel above the toolbar that typically allow you to limit the data displayed in the view 
so that you can focus on a specific set of objects in the IT. In configured reports, filters may also be dis-
played on the left or right of the content area. 

  

 FIGURE: Defining filters in a page view 

You can define any combination of filter settings. Each filter field provides cursory information about how 
to define the data. To access a help window providing more detailed information about the fields to be de-

fined, click the Options  button on the right edge of the filter panel and select Help on Filter Fields. 
After you define the relevant fields, click the Update button. 

If the data is hierarchically structured (for example, a hierarchy of projects and sub-projects), all objects 
below the object matching the filter criteria will also be hidden in the view. If no filters are defied, then all 
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data relevant to the selected object will be displayed. Once you have defined your filter settings, Alfabet will 
remember your settings in the view you are working in. When you return to the view during the session that 
you are logged on, you will not need to redefine the settings. The following options are available for the fil-
ter panel: 

  

• To hide the filter area in order to increase the space to display data, click the 

Options  button and select Hide Filter Panel. 

• To clear all filter settings, click the Options  button and select Clear Search Patterns. 

• To access a help window providing information about the fields that can be filled out in the filter 

area, click the Options  button and select Help on Filter Fields. 

In some configured reports you may see filters structured into basic filter options and advanced filter op-
tions. If you open a view with basic and advanced filters, only the basic filter fields will be displayed. You 
can click the Advanced link to expand and collapse the advanced filters: 

  

You may see any of the following types of filters fields in Alfabet: 

• Defining Text Fields 

• Defining Object Selector Fields 

• Defining Checkbox Fields 

• Defining Combo-Box Fields 

• Defining Filters with Two Fields 

• Defining Calendar Fields 

• Defining Multiple Selection Combo Box Fields 

Defining Text Fields 

Edit fields are fields in which you can enter a string. Typically, these are filter fields in which you can enter 
the name of an object. If you don't know the complete name of an object, you may be able to enter the first 
letters and append a wildcard (*) to it to find objects whose names match the letters. For example, you can 
enter CR* to find objects such as CRM Analysis, Credit Card Check, etc. 
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Additionally an auto-complete capability is available for filters based on edit fields in standard page views 
and enabled configured reports. You can enter text in the field and the auto-complete functionality will 
search for a matching string that has been previously used to search in the current view. A list of potential 
matches will be displayed in a list and updated with each additional letter typed in the field. The object 
must be explicitly selected in the drop-down list for the data to be entered in the field. Depending on your 
solution configuration, the search may return only strings you have entered or strings that all users have 
used to search in the field. 

 

The implementation of the auto-complete capability must be configured by your solution de-
signer. For more information, see the sections Configuring the Wildcard for Standard and Cus-
tom Search Functionalities and Configuring Edit Fields in the reference manual Configuring 
Alfabet with Alfabet Expand. 

Defining Object Selector Fields 

Many of the tasks in Alfabet require you to select an existing object from an object selector. The 

Search  symbol is displayed next to the fields that provide an object selector to find the object. An 

auto-complete function is available for filter fields displaying a Search  symbol. You can either search 

for an object in the object selector by clicking the Search  symbol or you can begin to enter the name 
of an object. The auto-complete function displays potential matches in a drop-down menu. Once the first 
three letters of a search string have been entered in the search field, the auto-complete function will in-
voke a search and start displaying a list of the matching objects. The list of matching objects will be up-
dated with each additional letter typed in to the search field. The matching option must be explicitly se-
lected in the drop-down menu for the data to be entered in the field. 

Defining Checkbox Fields  

Checkboxes serve as a means to capture a True/False value. Setting a checkmark in the checkbox indi-
cates the value True. If a checkbox is selected, you can clear the setting and set the value False by click-
ing the checkbox and removing the checkmark. 

Defining Combo-Box Fields  

Many fields in Alfabet are defined by means of a combo box with a drop-down list. The drop-down list may 
be blank the first time you encounter it. Click the arrow to open the drop-down list. You can select any of 
the options available. If the first line in the list is blank, you can select the blank line if no value should be 
defined. 

You can either select the object in the drop-down list or enter text in the field. A list of potential matches 
will be displayed in a list and updated with each additional letter typed in the field. The object must be ex-
plicitly selected in the drop-down list for the data to be entered in the field. 



 
 Chapter 4: Creating, Maintaining, and Evaluating Data in Alfabet 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 128 

Defining Filters with Two Fields 

Some filters are made up of two fields. In the first you select an option and in the adjacent field you define 
the value you are searching for. The example above shows a date selector, but you may encounter other 
selector fields, such as an object selector or other search mechanism. 

Defining Calendar Fields  

Date filters usually display a Calendar  symbol. You can either enter a date in the field or click the Cal-
endar symbol to open a drop-down calendar. 

 
Please note that the dates in editor fields are always displayed as a numeric value, regardless of 
the configured date format. For example, the date format 22 August 2006 displayed in the object 
profile will be displayed as 22/08/2006 in the editor field. 

 

 
The formatting of dates (for example MM/DD/YYYY vs. DD.MM.YYYY) and numbers is determined 
by the culture used to render the interface. Please note that the culture configuration super-
sedes the regional settings of the client machine. For more information about specifying cul-
tures, see the section Specifying the Cultures Relevant to Your Enterprise in the chapter Locali-
zation and Multi-Language Support for the Alfabet Interface in the reference manual Configuring 
Alfabet with Alfabet Expand. 

  

When you open the calendar, you will see the current date circled in red. You can do the following: 

• Click a date to select it. The date will be automatically displayed in the date field. 

• Click > to move forward one month. 

• Click < to move back a month. 

• Click the arrow next to the name of the month to open a drop-down list with all of the months. 
Select a month from the list. 
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• Click the arrow next to the year to open a drop-down list with years. Select a year from the list 

Defining Multiple Selection Combo Box Fields  

  

A multiple selection combo box is often available in diagrams as well as other views and is often labelled 
Object Filter. This field displays standard or custom attributes that are configured to be searchable and 
that are either 1) of the type String and have an enumeration assigned or 2) of the type Boolean. Search-
ability of properties is configured by your solution designer in the configuration tool Alfabet Expand. For 
more information on configuring custom properties, see the section Configuring Custom Properties for 
Protected or Public Object Classes in the reference manual Configuring Alfabet with Alfabet Expand. 

Custom properties are written using the convention: <ClassName>.<CustomPropertyName> = <Custom-
PropertyValue> 

• Click the arrow symbol to open the drop-down list. If the attribute text is cut off, you can point 
your mouse at it to display a tooltip showing the entire text. 

• Set a checkmark next to one or more attributes or click the Select All  button to select all 

attributes. You can remove a checkmark by clicking the Clear All  button to remove the 
checkmark from all attributes. 

• Click the Confirm Selection button  to confirm your selection or click the Cancel 

Selection  button to close without making the selection. 
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Working with Data in Tabular Datasets  

The majority of views in Alfabet use tables to display data. Users are typically able to create objects in these 
views but tables also allow data to be understood and analyzed. Each column in a table represents an at-
tribute associated with the object class you are currently working with. The size of columns will be deter-
mined by the content of the cell and the overall width of the Alfabet interface. If you resize the Alfabet in-
terface, you must refresh the browser to automatically resize the columns. 

 
Please note that you may be able to add or hide columns to the view, reorder the columns, and 
freeze selected columns in the view if the Configure button is displayed in the toolbar. The Con-

figure  button is displayed in the toolbar of views that support user-specific configuration. 

The Configure  button is only available for relevant views if the Allow User-Specific Config-
uration attribute to be set to True in the server alias setting. For more information about config-
uring the server alias, see the section Configuration Attributes for the Alfabet Components in the 
reference manual IT Governance, Risk and Compliance. 

You can do the following when you work with a table: 

• Sort the data in the table based on the contents of a column. To do so, click the column caption. 
For example, click the Name column to sort the data alphabetically or click a Start Date column to 
sort the data chronologically according to its start date. An arrow is displayed next to the column 
caption indicating whether the sort is in an ascending or descending order. 

• Click the filter  icon at the top of a column to filter the data in the data workbench. Type a 
string and specify criteria such as Starts With, Contains, and Case-Sensitive. Click Show and 
Select Matches to display the first 10 matches in lexicographic order in the filter. Select one or 
more of the matches and click Submit.An empty row will be displayed at the top of the list of 
objects if empty cells exist in the column. Select one or more results to display in the dataset. 
Please note that the filtering capability is not available in grouped datasets that can be expanded 
and collapsed. 

• Adjust the column size by pulling on the column outline. This provides a cleaner and easy-to-read 
view of cells with long texts. Any number of column and row headers can be frozen to better 
understand content in any location of a table.  

 
Please note that you can specify the default number of characters to display in columns 
in datasets in order to improve the handling of data in columns in the Max. Dataset Cell 
Text Length attribute of your user settings. Any characters after the specified number 
will be truncated but you can point to the cell to display a tooltip with the complete text 
or access the full information about the object by using the preview functionality. For 
more information, see the section Defining Your User Settings in Alfabet. 

• Re-order the columns using drag-and-drop in order to adapt the table view to fit your information 
needs. To manually change the sequence of the columns directly in the dataset, click a column 
caption and drag-and-drop it onto the column it should precede. This is available for configurable 

standard reports as well as reports in which the Configure  button is displayed in the toolbar. 

• Any number of column and row headers can be frozen to better understand content in any 
location of a table. Columns in a standard view or configured report displaying a tabular dataset 
can be specified to be fixed and retain their default size. For views with a high number of columns, 
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a scrollbar will be displayed only below the columns that are not fixed. To specify the columns that 

shall be frozen, click the Configure  button and carry out the following:  

• In the Presentation Object Configuration editor, specify the sequence of the columns in the 
view by selecting an object class property and clicking the Up and Down buttons. Repeat this 
step until all object class properties specified as visible are in the correct sequence. 

• To freeze columns so that they cannot be resized or resequenced in the view, select the 
number of columns that shall be frozen in the dataset in the Number of Fixed Columns field. 
The columns will be frozen starting with the first column on the left. The fixed columns cannot 
be manually resized or resequenced.  

 
If the Number of Fixed Columns s attribute is defined in the Presentation Object 
Configuration editor and a view is exported to PDF, the specification of the Num-
ber of Fixed Columns attribute might be ignored and the dataset will be exported 
as a normal table without fixed columns. Please note that the fixed column defini-
tion will only be dropped if the number of fixed columns makes paging of the table 
across multiple PDF pages impossible with a row header repetition logic. If this is 
undesired, the user is advised to select a different paper format and rerun the ex-
port. 

• 25011If the Number of Fixed Columns attribute is defined in the Configure View editor and a view is 
exported to PDF, the specification of the Number of Fixed Columns attribute might be ignored and 
the dataset will be exported as a normal table without fixed columns. Please note that the fixed 
column definition will only be dropped if the number of fixed columns makes paging of the table 
across multiple PDF pages impossible with a row header repetition logic. If this is undesired, the 
user is advised to select a different paper format and rerun the export. 

• Hide columns with data that is not relevant to your information needs. To add or hide columns in 

the dataset, click the Configure  button. In the Presentation Object Configuration editor, 
set a checkmark in the Visible column to add a column. Clear the checkmark to hide the column. 
The following columns are displayed in the Presentation Object Configuration editor.  

• Class: The name of the object class. In some views, data may be displayed for more than one 
object class. The name is not identical to the caption usually displayed for the object class on 
the user interface. 

• Visible: The column will be displayed in the view for each property that has a checkmark. 

• Property: The name of the property that can be displayed in the table. 

• Caption: The caption of the property that is displayed in the user interface. The caption will be 
used as the header of the column. 

• To manually resize the columns directly in the dataset, drag the column border left or right as 
needed. The column size is stored in the user context settings and will be displayed when the user 
accesses the view in the next user session. 

• Freeze any number of column and row headers to better understand content in any location of a 
table. Columns in a standard view or configured report displaying a tabular dataset can be 
specified to be fixed and retain their default size. For views with a high number of columns, a 
scrollbar will be displayed only below the columns that are not fixed. Please consider the following:  

• In standard views: To specify columns so that they are cannot be manually resized or 

resequenced in the view, click the Configure  button and select the number of columns 
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that shall be frozen in the dataset in the Number of Fixed Columns field. The columns will be 
fixed starting with the first column on the left. 

• In configured reports: The number of freeze header columns is defined by the solution 
designer during configuration of the report and cannot be changed by the user. 

• Expand or collapse the content if the data is hierarchical. If the second column on the left displays 
numbers in boxes, then you are working in a page view with grouped datasets. The data in the 
table is hierarchical and has as many levels as boxed numbers displayed in the header of the first 
table column. There are two ways to expand the subordinate levels of the table:  

• To expand a level for all objects, click that number in the column header. For example, if the 
column has three levels, click the 3 to display the first, second, and third levels for all objects 
with subordinate levels. 

• To expand a level for a single object, click the  symbol next to the object to display its 
subordinate level. You may need to repeat this procedure to expand all subordinate levels 

below the object. Click the  symbol to collapse that level of the table. 

• In page views displaying large datasets, the first 100 of those results will be displayed directly in 
the page. You can navigate to a next page showing the next 100 results by means of the floating 
toolbar in the lower right corner of the page view and navigate to the next page, previous page, 
first page, or last page of results. The paging is also available in views with large grouped datasets. 

• To open an object's preview, click the object in the table and hold. In the pop-up, click Show 
Details to open the object profile or, if relevant, click Operations and select an option. The 
preview will display all attributes that have been defined and are configured to be displayed for the 
class setting. If no values are defined for the object's attributes, then per default only the name 
and description, and if applicable, object class stereotype will be displayed in the preview. 

• To navigate to the object profile, double-click the object in the table. Please note that the double-
click action is reserved only for navigation. If you double-click an object and nothing happens, then 
navigation is not possible for the object. 

• The floating toolbar is displayed per default in the lower right-hand corner of the view. The floating 

toolbar contains buttons to zoom or show the legend. The Collapse  button allows the floating 
toolbar to be minimized to reduce the amount of space that it takes up. The collapsed floating 

toolbar can be maximized again via the Expand  button. The floating toolbar can also be moved 

by dragging-and-dropping it to a new location within the view. Click the Print  button. For more 
information about printing in Alfabet, see the section Printing a View in Alfabet. 

Working with Diagrams  

Diagrams can provide a variety of information about the IT landscapes they visualize. For example, dia-
grams can depict the applications supporting a business process, devices in a device group, platforms in 
the platform architecture, or the business services requested by a business process. The display of qualita-
tive information combined with the navigation through object hierarchies allows the user to effectively and 
efficiently analyze problem zones that might exist in your company's architecture as well as pinpoint prob-
lems at the lowest level of granularity. Diagrams can be exported as HTML, SVG or PPT files. Exported dia-
grams will include any graphic images in the diagram as well as the diagram legend. 
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In Alfabet, some diagrams such as information flow diagrams are automatically generated. Other diagrams 
must be designed by a user with access permissions to the Alfabet Diagram Designer. For more information 
about working with the Alfabet Diagram Designer, see the reference manual Alfabet Diagram Designer. 

Depending on the diagram type you are working with, Alfabet diagrams may feature any of the following: 

• Filters that allow you to hide information that you don’t want to see 

• Computation and display of indicators defined for objects displayed in the diagram 

• Navigation through the object hierarchy of the objects displayed in the diagram. 

• Coloring that provides an additional layer of information to the diagrams. 

• Custom icons on objects in the diagram. 

• Access to the Alfabet Diagram Designer via the Open Diagram button. Diagrams can be designed 
and edited in the Alfabet Diagram Designer. 

Keep the following in mind when working with diagrams: 

• To open an object's preview, click the object in the diagram and hold. Click Show Details to open 
the object profile or, if relevant, click Operations and select an option. 

• To navigate to an object's object profile, double-click the object in the diagram. Please note that 
the double-click action is reserved only for navigation. If you double-click an object and nothing 
happens, then navigation is not possible for the object. 

• To navigate to the object profile of the information flow, click the source or target end of the 
information flow. This is especially helpful if multiple information flow are on top of one another.  

 
If an excessively high number of objects is displayed in an automatically-generated dia-
gram, the information flows may be stacked on top of each other in the diagram, thus 
hiding some information flow attributes. This is a result of the limitations of processing 
complex diagrams by the third-party layout engine. 

• To view the diagram of an object displayed in the current diagram, click the dark blue click the dark 

blue Navigate  icon on the lower-right corner of the diagram object. The name of the target 

diagram and its base object will be displayed in the tooltip for the Navigate  icon. Please note 
that navigation to diagrams is not supported for connections. Alternatively, you can click the 

diagram object and click the Drill Down to Object Diagram  button in the toolbar. If a diagram 
is defined for the object, you will see that diagram. If no diagram is defined for the object, the 
object profile will be displayed. You can repeat this procedure to navigate further through the 
object hierarchy. To return to the initial diagram that you started with, click your browser's Back 
button. 

• To open an object's preview, click the object in the diagram and hold. In the pop-up, click Show 
Details to open the object profile. 

• In many diagrams, you will see the Calculate Indicators  button. This functionality allows you 
to automatically generate the values for indicators for which computation rules have been 

configured. To update computed indicators, click the Calculate Indicators  button. The 
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indicators are persistent and will be visible the next time a user views this page view. Please note 
the following when working with computed indicators:  

• Indicator values are not typically automatically updated. You may need to recalculate them 
periodically to display updated values. 

• The definition of indicator types and evaluation types are cached in Alfabet to provide better 
performance. Consequently, any changes to these definitions may result in a few minutes 
delay before the computed indicators are available to the user community. 

• To export the diagram, click the Export  button in the toolbar and select an export format. For 
more information about exporting diagrams, see the section Exporting Data. 

• The floating toolbar is displayed per default in the lower right-hand corner of the view. The floating 

toolbar contains buttons to zoom or show the legend. The Collapse  button allows the floating 
toolbar to be minimized to reduce the amount of space that it takes up. The collapsed floating 

toolbar can be maximized again via the Expand  button. The floating toolbar can also be moved 
by dragging-and-dropping it to a new location within the view. The following may be possible in 
the floating toolbar:  

• To print the diagram, click anywhere in the diagram pane to activate the floating toolbar. Click 

the Print  button. For more information about printing in Alfabet, see the section Printing a 
View in Alfabet. 

• To view the legend, click anywhere in the diagram pane to activate the floating toolbar. Click 

the Legend  button. 

• To return the zoom factor to 100%, activate the floating toolbar. Click the Original 

Size  button. 

• To zoom in, activate the floating toolbar. Click the Zoom In  button and to zoom out click 

the Zoom Out  button. Zooming in is especially useful in order to read the detailed 
information displayed on user items when a diagram view is selected. 

The following information is available: 

• Designing a Diagram 

• Interpreting a Diagram 

Designing a Diagram  

The Alfabet Diagram Designer component is automatically installed with Alfabet and can be accessed in the 
Web browser. To design a diagram, users must be able to open the Alfabet Diagram Designer by means of 
the Open Diagram button available in the relevant page views in Alfabet. Access permission to the Alfabet 
Diagram Designer is controlled via the Has Access to Diagram Designer attribute available in the User ed-
itor. If a checkmark is set for the Has Access to Diagram Designer attribute in the User editor, the Open 
Diagram button will be displayed in all relevant diagram page views that the user has access to and the 
user can thus open the Alfabet Diagram Designer to design or edit the diagram. If a checkmark is not set for 
the Has Access to Diagram Designer attribute in the User editor, the Open Diagram button will be hidden 
in all diagram page views that the user has access to. In this case, the user can only view the diagram but 
not alter the design. The default value of the Has Access to Diagram Designer attribute is False. 
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To open the Alfabet Diagram Designer, click the Open Diagram button in the relevant diagram page view. 
Once a diagram has been designed and saved in the Alfabet Diagram Designer, all users with relevant ac-
cess permissions may view the diagram in Alfabet. Click Update to update the diagram with the most re-
cent changes. 

Designing diagrams is a very involved process and is explained in detail in the reference manual Designing 
IT Landscape Diagrams in Alfabet. 

Interpreting a Diagram  

Diagrams in Alfabet provide a wealth of information about the objects displayed in the IT landscape. The 
following provides general information to help you understand and interpret diagrams in Alfabet. Please 
refer to the context-sensitive online Help for detailed information about a specific diagram. 

  

 FIGURE: Diagram with application landscape 

The diagram shows the application landscape for a selected application group. The following objects are 
displayed: 

1) the application group UTS-affected applications 

2) the application Trade*Net 

3) the local component Oracle Database 

4) incoming and outgoing information flows 

When you first open a page view displaying a diagram, you will typically see a default view. If the view is 
empty, then a diagram has not yet been designed for the selected object. 

You can define the filters available for the diagram in order to add or remove information in the diagram. 
You must click Update to refresh the diagram with the new filter settings. The next time you open the dia-
gram, the diagram will be displayed with your most recent settings. 
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The filters available will vary depending on the type of diagram that is being displayed. 

  

 FIGURE: Diagram with filters defined 

In the diagram above, only the filters Information Flow Attribute, Object State, and Active Date have 
been defined. All objects that do not match the filter criteria are greyed out. The following filters are typical 
for many page views displaying diagrams: 

• Diagram View: Specify a configured diagram view that superimposes qualitative information - 
such as indicators - on the objects in the diagram. In this example, color rules have been 
configured for the diagram view and as a result, objects fulfilling the color rule are colored. For 
more information about the configuration of diagram views, see the section Configuring Diagram 
Views for Diagrams in the reference manual Configuring Evaluation and Reference Data in Alfabet. 

• Information Flow Attribute: Specify an information flow attribute to display on the information 
flows. The attributes that are available in this field are configured by your solution designer. For 
more information about configuring the attributes available in this field, see the section 
Configuring the Visualization of Connection Items and Subordinate Object in Diagrams in the 
reference manual Configuring Alfabet with Alfabet Expand. 

• Object State: Specify the object state for the objects visualized in the diagram. Any objects that 
do not meet the setting will be greyed out. 
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• Object Filter: Select one or more attributes to determine the objects displayed in the diagram. An 
object will be displayed if it satisfies at least one of the checked attributes. The attributes that are 
available in this field are configured by your solution designer. The Object Filter field displays 
standard or custom attributes that are configured to be searchable and that are either 1) of the 
type String and have an enumeration assigned or 2) of the type Boolean. The selected attributes 
are combined with an OR property. Any objects that do not meet the setting will be greyed out. For 
more information about configuring custom properties, see the section Configuring Custom 
Properties for Protected or Public Object Classes in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• Active Date: Specify a date to display all objects for which the selected date is within the object's 
active period (as defined by its start and end date). Any objects that do not meet the setting will be 
greyed out. 

• Hide Mismatches: Set a checkmark to simplify the visualization by removing the greyed out 
objects from the diagram. 

The Diagram View filter has been defined in the diagram displayed below. 

  

 FIGURE: Diagram view 

A diagram view is a configuration that is associated with a diagram. It allows users to superimpose qualita-
tive information - such as aggregated indicators or attribute values - associated with these architectural 
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elements. The applications in the diagram above have two indicators displayed on the right and the start 
and end dates of the application displayed on the bottom of the object. A diagram view may include up to 
four indicators and four attributes per object class. If you do not see indicators in the diagram, then either 
no indicators have been configured for the object classes visualized in the diagram, no indicators have 
been defined for the objects displayed in the diagram, or no appropriate diagram view was selected in the 
Diagram View field. 

In addition to the indicators and attributes that have been added via the diagram view definition, the ob-
jects have also been highlighted with different colors. In this case, color rules are also associated with the 
diagram view. Color rules constitute queries that color a objects that fulfill the query criteria. In the exam-
ple, color rules have been configured to highlight different types of applications based on the definition of 
the Application Type attribute. In this case, color rules are defined to highlight 1) applications of the type 
Client Server, 2) applications of the type eBusiness, and 3) applications of the type Mainframe. The diagram 
items representing applications display a considerable amount of information about the applications. 

In order to understand the information displayed on an object in the diagram, you can click the Legend 
button in the floating toolbar in the bottom right corner of the diagram. 

  

 FIGURE: Object in diagram and legend with explanation 

The image above demonstrates how to interpret the information on a diagram item by means of the legend. 
The application Sugared Treasury has a start date of 9/14/2007 and an end date of 2/12/2019. It has an ag-
gregated indicator named Criticality which has a value of Highly Critical and an indicator Standardization 
Status which has the value non-Standard. The application is colored green by means of a color rule, which 
indicates that the application is of the type Client Server. 
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The following prerequisites must be fulfilled in order to work with diagram views and indicators 
in diagrams: 

• In order to display indicators on the objects in a diagram, evaluation types and their 
indicator types must first be configured in the Evaluations and Portfolios functionality 
and then assigned to the respective object class in the Class Configuration 
functionality. For more information, see the chapter Configuring Evaluations, 
Prioritization Schemes, and Portfolios in the reference manual Configuring Evaluation 
and Reference Data in Alfabet. 

• In order to select a diagram view and superimpose preconfigured information on the 
objects in the diagram, diagram views must first be configured in the Diagram Views 
functionality. For more information, see the chapter Configuring Diagram Views for 
Diagrams in the reference manual Configuring Evaluation and Reference Data in 
Alfabet. 

• In order to display meaningful indicators on the objects in a diagram, indicators must be 
defined and updated for the evaluation types relevant to each object in the diagram. For 
more information about defining and updating an object’s indicators, see the Evaluation 
Page View for the relevant object. 

Please note the following prerequisites to display color rules in a Alfabet diagram: 

• Color rules must first be specified in the Color Rules Manager functionality and 
assigned to the relevant diagram view in the Diagram View functionality. For more 
information, see the chapter Configuring Color Rules for Map Views and Diagram Views 
in the reference manual Configuring Evaluation and Reference Data in Alfabet. 

• Once a color rule is defined, it must be activated in order for the Alfabet query to be 
executed. The query should be re-activated periodically in order to update the query 
results and include changes made to the database. The color rule may be manually 
activated in the Color Rules view or activated via a batch process. For more information 
about activation via a batch process, see the section Batch Evaluation of Color Rules 
with RescanColorRules.exe in the reference manual System Administration. 

Working with Portfolio Reports  

A portfolio is a bubble chart that represents the relative performance of a set of objects that belong to the 
same object class in two or three independent dimensions of measurement. Typical portfolios include a 
group of applications that are owned by a specific organization or used by a particular process. 

The portfolio consists of an X-, Y-, and if necessary, power-axis. The power-axis is the Z-dimension and is 
reflected via bubble size. Either an indicator type, evaluation type, or prioritization scheme can be assigned 
to a portfolio axis. In Alfabet, a portfolio may also be displayed as a BCG quadrant. Access to portfolios can 
be controlled via user profiles. A user can view any portfolio that has either no user profile defined or the 
same user profile as that which he/she is currently logged in with. 

A number of different portfolio reports are available in Alfabet that allow you to visualize and analyze your 
IT landscape. The following displays an example of a typical portfolio. - a Business Service Portfolio in 
which all business services provided by a selected application are displayed: 
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 FIGURE: Typical portfolio in Alfabet  

The figure displays seven business services provided by the application 360T 1.1 Variant 1.1. Service Portfo-
lio is the configured portfolio selected in the Show Portfolio field. The prioritization schemes Technical 
Alignment and Performance are defined for the selected portfolio and represent the X- and Y-axis in the 
report. The prioritization scheme for the Z-dimension, which is displayed via the bubble size, is Business 
Value (and is identified with its numeric value in the bubble’s tooltip). 

The report shows that the two business services Account Management and Marketing Analytics score in 
the very high range for both Technical Alignment and Performance, and the large bubble size indicates that 
it also scores very high for Business Value. The bubbles of the two business services Evaluation Trends and 
Manage and Analyze Customer’s Data have the same value for all three dimensions, indicated by the fact 
that they both are the same color and are placed on top of each other. 

Keep the following in mind when viewing a portfolio report: 

• The portfolio chart may display up to three dimensions:  

• The X- and Y-dimensions are displayed on the X- and Y-axis, respectively. The ticks displayed 
on the X- and Y axes show preconfigured caption names. The default captions Low, Medium, 
High, and Very High are displayed if no caption names have been configured. 

• The Z-dimension is displayed by means of the bubble size. The larger the Z-dimension, the 
larger the bubble. Bubbles with the same X- and Y-dimensions are placed on top of each 
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other. The bubble with the smallest Z-dimension value will have the smallest bubble size and 
will be placed on top of a larger bubble which will have a larger Z-dimension value. 

• When you open the portfolio report, you will see a default view based on the most recent filter 
settings. To change the information displayed in the portfolio, define the filter settings above the 
toolbar and click Update. If you change the filter settings, the objects may be repositioned in the 
portfolio and they may be assigned different colors. Available filters may vary depending on the 
class of the objects displayed in the portfolio. 

• To display an object’s name, point to the respective bubble to display the tooltip. If a Z-dimension 
is defined for the portfolio, the name of the prioritization scheme and numeric value will also be 
displayed. 

• To open an object's preview, click-and-hold the object in the portfolio. In the pop-up, click Show 
Details to open the object profile. 

• To navigate to an object's profile, double-click the object in the diagram. Please note that the 
double-click action is reserved only for navigation. If you double-click an object and nothing 
happens, then navigation is not possible for the object. 

• The floating toolbar is displayed per default in the lower right-hand corner of the view. The floating 

toolbar contains buttons to zoom or show the legend. The Collapse  button allows the floating 
toolbar to be minimized to reduce the amount of space that it takes up. The collapsed floating 

toolbar can be maximized again via the Expand  button. The floating toolbar can also be moved 
by dragging-and-dropping it to a new location within the view. The following may be possible in 
the floating toolbar:  

• To print the diagram, click anywhere in the diagram pane to activate the floating toolbar. Click 

the Print  button. For more information about printing in Alfabet, see the section Printing a 
View in Alfabet. 

• To view the legend, click anywhere in the diagram pane to activate the floating toolbar. Click 

the Legend  button. 

• To return the zoom factor to 100%, activate the floating toolbar. Click the Original 

Size  button. 

• To zoom in, activate the floating toolbar. Click the Zoom In  button and to zoom out click 

the Zoom Out  button. Zooming in is especially useful in order to read the detailed 
information displayed on user items when a diagram view is selected. 

• To export the portfolio, click the Export  button in the toolbar and select an export format. For 
more information about exporting portfolios, see the section Exporting Data. 

• To edit the color assignment of objects in the portfolio, click the Colors  button in the toolbar. 
You can assign colors to the portfolio objects in the Object Colors editor. The color you assign to 
an object will be displayed for the object in all other business graphics for all other users in the 

Alfabet community. The visibility of the Colors  button will depend on the configuration of 
your Alfabet solution. For more information about the configuration of the visibility of the 

Colors  button, see the section Allowing Users to Change the Color Assigned to Objects in 
Business Graphics in reference manual System Administration. 
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The following prerequisites must be fulfilled in order to work with portfolios in Alfabet: 

• Portfolios must first be configured in the Evaluations and Portfolios functionality. In 
order for an object to display meaningful values in a portfolio, the evaluation types 
defined for the prioritization schemes displayed in the portfolio must be assigned to the 
respective object class in the Class Configuration functionality. If an object class does 
not have an evaluation type assigned to it, the objects displayed in the portfolio will 
show the lowest possible value. For more information about the configuration of 
portfolios, see the chapter Configuring Evaluations, Prioritization Schemes, and 
Portfolios in the reference manual Configuring Evaluation and Reference Data in 
Alfabet. 

• For each object displayed in the portfolio, indicators must be defined and updated for 
the evaluation types relevant to the portfolio. For more information about defining and 
updating an object’s indicators, see the Evaluation Page View for the relevant object. 

Working with Lifecycle Reports and Time Schedules  

In Alfabet, Gantt charts are often used to display object lifecycles and time schedules. For reasons of per-
formance, the maximum period of time displayed for lifecycles in Gantt charts is limited to 40 years. The 
time displayed will be based on 20 years before the current date and 20 years after the current date. 

 
Please note the following: 

• The general placement of the current date in the Gantt chart may be configured in 
Alfabet Expand. For more information, see the section Configuring Gantt Charts in the 
reference manual Configuring Alfabet with Alfabet Expand. 

• Please note that objects displayed in a lifecycle report can not be sorted based on their 
version numbers. If this is required for a lifecycle report, then a configured report must 
be created by your solution designer. For more information, see the chapter Configuring 
Reports in the reference manual Configuring Alfabet with Alfabet Expand. 
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 FIGURE: Time schedule for a project 

The time schedule shown above displays the scheduling for various projects and sub-project as well as for 
the skills required for the projects. Please keep the following in mind when reviewing a time schedule: 

• When you open the time schedule, you will see a default view based on the most recent filter 
settings. To change the information displayed in the view, define the filter settings above the 
toolbar and click Update. If you change the filter settings, the objects may be repositioned. 

• The time scale used to display the data is managed through the Zoom In  and Zoom 

Out  buttons in the floating toolbar. The zoom functions allow you to switch between the time 
scales of weekly, monthly, quarterly and annually relevant for the view and thus control the 
granularity of information displayed. 

• The time schedule typically displays various types of objects in a hierarchical table layout. 

• The various time spans are displayed as colored bars. 

• The blue vertical line denotes the current date. 

• To open an object's preview, click-and-hold the object in the time schedule. In the pop-up, click 
Show Details to open the object profile or, if relevant, click Operations and select an option. 

• To navigate to an object's profile, double-click the object in the time schedule. Please note that the 
double-click action is reserved only for navigation. If you double-click an object and nothing 
happens, then navigation is not possible for the object. 
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• The floating toolbar is displayed per default in the lower right-hand corner of the view. The floating 

toolbar contains buttons to zoom or show the legend. The Collapse  button allows the floating 
toolbar to be minimized to reduce the amount of space that it takes up. The collapsed floating 

toolbar can be maximized again via the Expand  button. The floating toolbar can also be moved 
by dragging-and-dropping it to a new location within the view. The following may be possible in 
the floating toolbar:  

• To print the diagram, click anywhere in the diagram pane to activate the floating toolbar. Click 

the Print  button. For more information about printing in Alfabet, see the section Printing a 
View in Alfabet. 

• To view the legend, click anywhere in the diagram pane to activate the floating toolbar. Click 

the Legend  button. 

• To return the zoom factor to 100%, activate the floating toolbar. Click the Original 

Size  button. 

• To zoom in, activate the floating toolbar. Click the Zoom In  button and to zoom out click 

the Zoom Out  button. Zooming in is especially useful in order to read the detailed 
information displayed on user items when a diagram view is selected. 

• To export the time schedule, click the Export  button in the toolbar and select an export 
format. For more information about exporting time schedules, see the section Exporting Data. 

• It may be that enterprise milestones have been defined to document and plan for activities that 
are critical to the enterprise. Each enterprise milestone will specify a target date and an symbol 
that represents the milestone. To display enterprise milestones in a time schedule, click View > 
Show Enterprise Milestones in the toolbar. Enterprise milestones are created in the Enterprise 
Milestones Functionality 

Working with Configured Business Support Matrix Reports  

Customized business support matrices are configured reports that allow business supports for one or more 
organizations/market products and business processes/domains to be captured. Every configured busi-
ness support matrix can be customized for the specific data entry requirements of the user. 

Customized business support matrices are advantageous because they simplify the user’s task of captur-
ing business supports in a manageable small matrix displaying only the relevant processes and organiza-
tions, for example. Furthermore, the customized business support matrix allows a large number of business 
supports to be easily captured at once for multiple organizations/market products or business pro-
cesses/domains. 

The visualization of the matrix is based on a configured query that finds the relevant objects for the matrix 
axis. The matrix is created at run-time. 

You can export the matrix to an HTML file or an Microsoft Excel file. Please note however that matrices with 
more than 64000 rows and more than 300 columns cannot be exported to Excel 

 
Because multiple users could simultaneously access a configured business support matrix, it is 
possible that multiple business support definitions could be made at the same time. If this 
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occurs, the first user who saves the business support to the database will be the authorized user 
of the business support. 

The following information is available: 

• Understanding the Different Types of Customized Business Support Matrices 

• Defining the Standard Filters in the Configured Business Support Matrix 

• Creating New Business Supports By Means of the Configured Business Support Matrix 

Understanding the Different Types of Customized Business Support Matrices 

There are generally two types of configured business support matrices that may be available in Alfabet. 

• Object-centric matrices. In this case, the business support matrix allows you to define the 
business supports for the object that you have selected in the Select <ObjectClass> filter located 
at the top of the view. You could thus capture business supports from the perspective of an 
application, ICT object, business process, domain, market product, or organization.  

 
In the Select <ObjectClass> filter, you should select an object that you have access 
permissions for. You can only view and edit the business support matrix for an object for 
which you have the relevant access permissions. 

• General matrices. In this case, the application or ICT object providing the business support is 
embedded in the X- or Y-axis of the matrix. 
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 FIGURE: Object-centric matrix to capture business supports provided by a selected application 

 

For example, an application architect may be required to define the business support for the ap-
plications that he is responsible for. Typically, his/her area of responsibility will encompass a lim-
ited number of business processes relevant to a small selection of organizations. In this case, 
the application architect would typically work with an object-centric matrix similar to the exam-
ple below. 

The figure above provides an example of a configured business support matrix that is configured for the 
object class Application. The business processes on the X-axis and the organizations on the Y-axis have 
been found by the configured query for the selected application. 

If the user selects a different application in the Select Application field, the query associated with the ma-
trix will typically find a different set of organizations and business processes. 

9+q

  

 FIGURE: General matrix to capture business supports provided by ICT objects owned by a set of organiza-
tions 

 

For example, a strategy planner may be required to define the business support for a set of or-
ganizational units. In this case, the strategy planner would typically work with general matrix 
that displays the relevant organizations and their ICT objects. In this case, the strategy planner 
might work with a matrix similar to the example below. 

The figure above provides an example of a business support matrix that is configured to find the ICT ob-
jects owned by a specified set of organizations. The business processes on the X-axis and the organiza-
tions and ICT objects on the Y-axis have been found by the configured query. 
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Defining the Standard Filters in the Configured Business Support Matrix 

The filters allow you to specify the business supports that you see in the matrix as well as the type of busi-
ness supports that you can capture. 

• Business Support Type: Select the type of business support that you want to view or define. The 
business support types available will depend on the configuration of the business support matrix.  

 
You must select a value in the Business Support Type field in order to create and save 
business supports. 

• Master Plan: Select a master plan in order to display or define tactical business supports for that 
master plan. Any business supports you define for the selected master plan will be displayed in the 
standard business support maps associated with that master plan. For more information, see the 
for the relevant master plan map. 

• IT Strategy: Select an IT strategy in order to display or define strategic business supports for that 
IT strategy. The business supports you define for the selected IT strategy will be displayed in the 
standard business support maps associated with that IT strategy. For more information, see the 
for the relevant IT strategy map. 

• Aspect Group: Select an aspect group for the business support matrix. An aspect group is a 
collection of up to two aspects with predefined aspect values that are relevant for the analysis of 
business supports in a business support map. Aspect groups allow you to define more precisely 
how this business support provides services for the processes/products in your enterprise. When 
you select an aspect group, any business supports you define will be assigned the group’s 
predefined aspect values. Values for the aspects associated with the selected aspect group are 
visualized on the relevant business supports in standard business support maps.  

 
The filter fields described above are standard fields that will be automatically displayed 
in the customized business support matrices that are configured by your enterprise. Ad-
ditional filters may be configured by your solution designer that are not described here. 

Creating New Business Supports By Means of the Configured Business Support Matrix 

When you create a business support in a configured business support matrix, the business support’s start 
and end dates will be copied from the application or ICT object providing the support. 

 

Please note that when business supports are created via a configured business support matrix, 
values such as the object state, start and end dates, and relevance group will be automatically 
defined per default for the new business supports. If the default definition of a business support 
must be modified, then you must navigate to the object profile of the business support to edit its 
properties. 

The business supports you can create are determined by the filter settings that you define. To create busi-
ness supports: 

1) In the Business Support Type field, specify the type of business support that you want to create. 
Please note the following when defining new business supports:  

• If you select Operational Business Support, no other filter settings are required. 
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• If you select Tactical Business Support, you must select the relevant master plan in the 
Master Plan field for which you want to create tactical business supports for. 

• If you select Strategic Business Support, you must select the relevant IT strategy in the IT 
Strategy field that you want to create strategic business supports for. 

2) In the toolbar, click the Edit  button. An editor opens displaying the business support matrix 
that you are currently working with. 

3) Click a relevant cell in the matrix to define the business support. For each business support you 
create, the matrix cell will turn red. 

4) If the business supports you create for one matrix object are relevant for another matrix object, 
you can copy the business supports and paste them to the relevant matrix object. For example, if 
you have defined business supports for a business process on the X-axis, you can copy those 
business supports to another business process on the X-axis. This applies equally to objects of the 
same object class on the Y-axis.  

• To copy the business supports defined for an object in the X-axis, right-click in the cell for the 
relevant matrix object in the axis area (grey cells) and select Copy Row Values. Right-click the 
matrix object in the X-axis that you want to copy the business supports to and select Paste 
Row Values. 

• To copy the business supports defined for an object in the Y-axis, right-click in the cell for the 
relevant matrix object in the axis area (grey cells) and select Copy Column Values. Right-click 
the matrix object in the Y-axis that you want to copy the business supports to and select 
Paste Column Values. 

5) Once you are ready to save the business supports you have created, click the OK button. The 
editor will close and the data will be saved to the database. To exit without saving your changes, 
click the Cancel button. 

 
Because multiple users could simultaneously access a configured business support matrix, it is 
possible that multiple business support definitions could be made at the same time. If this oc-
curs, the first user who saves the business support to the database will be the authorized user of 
the business support. 

Working with Layered Diagram Reports  

A layered diagram report is a report configured by your solution designer. The report shows Alfabet objects 
from various object classes that are related to each other. Each object class is displayed in a separate layer 
and is related to the objects displayed in the layer directly above and below the current layer. Each object in 
the report is displayed as a colored box with an indicator icon. Each object in the report is represented by a 
colored box. The color and indicator symbols represent various dimensions of evaluation. Multiple colors 
and indicator symbols can be defined per object class in the report. 

For example, the colors of an object in an object class may depend on the number of open assignments 
while the colors displayed for objects of another object class may represent the object’s criticality for the 
business. 



 
 Chapter 4: Creating, Maintaining, and Evaluating Data in Alfabet 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 149 

  

 FIGURE: Example of a layered diagram report 

In the diagram above: 

• The first layer displays the selected device. 

• The second layer displays the applications deployed on the device. 

• The third layer displays the business processes supporting the application. 

• The legend is open and explains the use of colors and indicators. The colors depend on different 
object attributes in each layer. 

To highlight the objects related to a selected object, click an object in the report and click the Show Con-
nected Items button in the toolbar. The objects related to the selected objects are displayed in the colors 
determined by the color definition. Unrelated objects are displayed in grey. 
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 FIGURE: Layered diagram report displaying devices and related objects 

Depending on the configuration of your report, you may be able to navigate to an object profile by double-
clicking an object. Please note that the double-click action is reserved only for navigation. If you double-
click an object and nothing happens, then navigation is not possible for the object. A legend may also be 
available. 

Working with Tree Reports  

A tree report is a report configured by your solution designer. The report shows a bi-directional tree dis-
playing the relations between a selected object and related Alfabet objects. 

A base object or a set of base objects is displayed in the center of the tree. Related objects are displayed in 
as branches pointing in one or two directions. The tree may be configured to branch horizontally or verti-
cally. 
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 FIGURE: Tree report with two branches 

Each object in the report is displayed as a colored box with an indicator icon. Each object in the report is 
represented by a colored box. The color and indicator symbols represent various dimensions of evaluation. 
Multiple colors and indicator symbols can be defined per object class in the report. 

For example, the colors of an object in an object class may depend on the number of open assignments 
while the colors displayed for objects of another object class may represent the object’s criticality for the 
business. 

A grid report can display multiple trees reflecting relations: 

• The report can display more than one object as the starting point for the tree. The trees are then 
displayed next to each other. 

• Multiple tree reports can be displayed in one report view. Each cell in the view may be filled with an 
individual tree report. The content of a cell is completely independent of the content of other cells 
in the report. Other objects can be displayed as the tree roots and the trees can reflect other 
relationships. Colors and indicators may also be specified separately for each cell. This makes it 
possible to specify multiple aspects of the same object or to compare different relationships with 
one another. 
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 FIGURE: Grid report with two cells 

In the image above, the first cell displays a relationship tree, the second cell displays relationships of three 
different base objects. 

Depending on the configuration of your report, you may be able to navigate to an object profile by double-
clicking an object. Please note that the double-click action is reserved only for navigation. If you double-
click an object and nothing happens, then navigation is not possible for the object. A legend may also be 
available. 

Working with Cluster Map Reports  

A cluster map report is a report configured by your solution designer. The report shows related Alfabet ob-
jects in multiple levels of nested boxes. The outermost boxes could be arranged vertically or horizontally. 
The boxes represent objects that are found by means of queries that define the object relationships. Each 
object in the report is represented by a colored box. The color and indicator symbols represent various di-
mensions of evaluation 
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 FIGURE: Cluster map 

For example, the cluster map displayed above shows sub-organizations, business processes executed by 
the organizations, and applications providing support for the business processes. The colors of objects in 
an object class may depend on the number of open assignments while the colors displayed for objects of 
another object class may represent the object's criticality for the business. Multiple cluster maps can be 
displayed in one cluster map report. Each cell in the cluster map report may be filled with another cluster 
map. 

Depending on the configuration of your report, you may be able to navigate to an object profile by double-
clicking an object. Please note that the double-click action is reserved only for navigation. If you double-
click an object and nothing happens, then navigation is not possible for the object. A legend may also be 
available. 

Working with Affinity and Diagram Matrix Reports  

Matrix reports shows object dependencies in a matrix. Columns and rows of the report represent Alfabet 
objects. The cells display objects that are related to both the object in the row header row and the object of 
the column header. Each object in the report is represented by a colored box, border color and an optional 
indicator icon. The color and indicator symbols represent various dimensions of evaluation 

The Affinity Matrix features the following: 

• Column and row headers that are fixed during scrolling. The column header is excluded from 
vertical scrolling and the row header is excluded from horizontal scrolling. 

• All cells in the matrix are displayed with sharp edges and the color is plain fill. 

• Indicators cannot be displayed for objects in the matrix. 

The picture can't be displayed.
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 FIGURE: Upper-left corner of an affinity matrix before scrolling 

  

 FIGURE: Upper-left corner of the affinity matrix above after vertical scrolling 

The Diagram Matrix features the following: 

• Column and row headers are included in scrolling and move out of sight when scrolling. 

• All cells in the matrix are displayed either with rounded or sharp edges and with a color gradient. 

• Indicators can be displayed for objects in the matrix. 
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 FIGURE: Diagram matrix with indicators displayed for some objects 

Working with Radar, Bar, Line and Pie Charts  

Chart reports display the results of a query in either a radar chart, bar chart, pie chart or line chart. Only nu-
merical values (for example, indicator values or the number of results in a report) can be displayed in chart 
reports. Configured radar, bar, pie, or line chart reports offer the following features: 

• The color used for objects in the chart can be changed by the user if the Colors  button of the 
report is enabled or if a color selector is defined in a custom editor for the respective object class. 
Alternatively, the report can be configured to assign a fixed color to each graphic element in the 
result via a definition in the data set the report is based on. 

• You can click the graphic representation of an object in the report to display a link below the image 
in order to navigate to the object profile or to a configured report. 
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 FIGURE: Radar chart displaying evaluations for sub-domains of a selected domain 

In the radar chart, a link to the object is displayed when the bubble for an object on one of the axes is 
clicked. 
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 FIGURE: Line chart displaying the number of applications over time in different lifecycle states 
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 FIGURE: Bar chart in horizontal orientation displaying the number of ICT objects per organization 
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 FIGURE: Pie chart displaying the number of business supports that an application provides 

Working with Treemap Reports  

A treemap report is a report configured by your solution designer. The report shows Alfabet objects from 
the perspective of a specified object class. The report is structured in columns that represent an object 
class that is associated with the specified object class. For example, a report can show application groups 
in the column headers and the applications assigned to the respective application group as objects in the 
columns. Each object in the report is represented by a colored box. The color, size, and indicator symbols 
represent various dimensions of evaluation 
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 FIGURE: Example for treemap report displaying sub-domains sorted by parent domain. 

In the example above, a domain with high criticality is displayed in red whereas a domain with low criticality 
is displayed in green. The size of the domain represents its operating costs. The lower the operating costs, 
the smaller the box representing the object in the report. The indicator displayed on the box highlights a 
third aspect that is critical to the evaluation of the domain. In this case, a risk assessment for the domain is 
visualized. 

Depending on the configuration of your report, you may be able to navigate to an object profile by double-
clicking an object. Please note that the double-click action is reserved only for navigation. If you double-
click an object and nothing happens, then navigation is not possible for the object. A legend may also be 
available. 

Executing Your Configured Reports 

The Configured Reports view allows you to view and execute the configured reports that you have access 
to. Depending on the configuration of the configured reports, the reports may be automatically available in 
the view or you may need to explicitly add the configured report to the view. 

There are many different types of configured reports in Alfabet. For an overview of how to work with the 
different kinds of visualizations available in configured reports, see the section Analyzing Your Data in Page 
Views and Reports in the reference manual Getting Started with Alfabet. The following explains the values 
that may be displayed in the Type column of the view. 
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Report 
Type 

Description 

Query Configured report based on an Alfabet query. The output is a tabular report. 

Tabular reports display search results in a table. Depending on the configuration, search 
parameters can either be defined by the user or exclusively defined by the solution de-
signer who configured the report. 

Na-
tiveSql 

Configured report based on a native SQL query. The output is a tabular report. 

Custom Configured report displaying graphic representation of data based on Alfabet queries or 
native SQL queries. The Alfabet queries defining the content of the configured report are 
specified in a report assistant. Graphic reports include cluster maps, trees and tree maps, 
layered diagrams, data-capture matrices and charts. 

Ob-
jectView 

Configured report displaying an object profile or object cockpit configured for objects in a 
selected object class. 

Extern Configured report opening a URL. This type of report displays data in the Alfabet database 
or external data generated by third-party reporting tools. The report could display either a 
static website or dynamic content generated by means of a script or reporting tool that 
searches the Alfabet database via an SQL-based query. 

Optionally, an external report may be configured to provide ReadOnly access to views via 
hyperlinks. Depending on the configuration of the link syntax, access may be via a named 
user or an anonymous user, and the view may open with a different user profile than the 
one that was used for log in. For more information, see the section Links to Alfabet Views 
from External Applications in the reference manual System Administration  

When you open the view, you will see a table listing all configured reports that have been configured by 
your report designer in the configuration tool Alfabet Expand. The configured reports are structured in sec-
tions in the table that correspond to the report folders created in Alfabet Expand. The name, structure, and 
number of sections will depend on your individual solution configuration. You can click a column header to 
sort the configured reports in alphanumeric order based on the value of the columns. When configured re-
ports are structured in report folders, the configured reports are sorted within the folders and the folder 
structure is maintained. 

If necessary, you can limit the objects in the table. To do so, enter search criteria in the Search Pattern 
field and click Update. The search pattern is used to match the name, caption or description of the config-
ured reports or report folders. If a configured report or report folder matches the search criteria, the com-
plete folder hierarchy of the configured report or report folder will be displayed. Objects not matching the 
search criteria but that are located in the same hierarchy are also displayed. If a report folder matches the 
search criteria, the configured reports and report folders subordinate to the report folder will also be dis-
played. To return to the view that displays all reports structured in report folders, you must clear the 
Search Pattern field and click Update. 
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The view displays all configured reports that you have access permissions. A configured report displayed in 

an orange row cannot be executed and the Open Report  button will not be available when the con-
figured report is selected. Each column in the table is explained below: 

• Caption: The caption of the configured report/report folder. The caption is displayed to the user in 
the Configured Reports view. 

• Description: The description of the configured report/report folder provided by the creator of the 
configured report/report folder. The description is displayed to the user in the Configured 
Reports view. 

• Type : Whether the configured report is based on a native SQL query (SQL), an Alfabet query 
(Query), graphic template (Custom), object profile/object cockpit (ObjectView), or URL (Extern). 

The following information is available: 

• Adding a Configured Report to the View 

• Opening a Configured Report 

• Opening a Configured Report Executed Offline 

Adding a Configured Report to the View 

Some configured reports will not be automatically displayed when you open the Configured Reports view. 
These reports have been configured by your report designer in such a way that you must explicitly add 
them to the view. 

To add a configured report: 

1) In the Configured Reports view, click New > Add Report in the toolbar. 

2) The object selector opens. Enter search criteria in the Search Pattern field, as needed. You can 
search via Caption, Name, or Type. Click Search.  

 
Access permissions to reports are configured by your user administrator. For example, 
configured reports may be available or unavailable for specific users, user groups, or us-
ers logged in with a specific user profile. Therefore, you may not necessarily have the 
access permissions required to add a configured report that is displayed in the selector. 
If you try to add a configure report for that you do not have access permissions for, the 
report will not be added to the view and a message will be displayed. 

3) Select the report(s) you want to add to your list of reports and click OK to save your changes. 

 You can remove a configured report from the view by clicking the Delete  button. The report 
will be removed from the table, but will remain in the Alfabet database can typically be added to 
the view at a later time. 
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Opening a Configured Report 

The content of a configured report will vary greatly depending on the configuration. Some reports are con-
figured to show results whereas others have been configured to show results only the filter(s) have been 
defined. For an overview of how to work with the different kinds of visualizations available in configured 
reports, see the section Analyzing Your Data in Page Views and Reports in the reference manual Getting 
Started with Alfabet. 

1) In the Configured Reports view, click the report that you want to open. 

2) In the toolbar, click the Open Report  button. 

3) Depending on the type of configured report you are working with, carry out one of the following 
steps to view the report:  

• Define the filters displayed and click the button to display the results in the table.  

 
Some reports might be configured to be executed offline. For reports executed 
online, you will not see the results immediately in the view but a window will open 
that allows you to define a name for the report result. The report result will be gen-
erated in the background and you will be informed as soon as the report results are 
available. For detailed information about the handling of reports executed executed, 
see Opening a Configured Report Executed Offline below. 

• Select an object in the table and click the Navigate  button to open the object profile of 
the object that is the base object of the configured report. 

• If the Chart Views  button is available, you may be able to select any of the standard 
formats to display data:  

• Lifecycle Chart 

• Portfolio Chart 

• Business Support Map Report 

• Information Flow Diagram 

• Project Tracking Overview (for reports with the base class Project) 

• If the configured report is of the report type Extern, you can directly view the specified URL in 
a web browser. Additional actions may have been configured in the external application in 
order to see the report results. If hyperlinks to Alfabet objects are displayed in the report, you 
can access the Alfabet view by clicking the hyperlink. However, your solution configuration 
may require that you access the Alfabet view using a different user profile than the one you 
are currently logged in with. 

Opening a Configured Report Executed Offline  

If execution of a configured tabular report with filters takes a long time, the report designer can configure 
the report to be executed offline. Instead of waiting for the report to load, you can then work on other views 
in the Alfabet user interface while the configured report is being executed in the background. 
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Offline executed reports consider the language setting of the user interface. The data is generated in the 
language of the Alfabet user interface at the time the user executes the report. If the report is configured 
to show translated data, the translation to the current rendering language will be stored in the result da-
taset. If the user switches to another language for the Alfabet user interface prior to opening the report re-
sults, the results will be displayed in the language they are created for and the user will be informed that 
the language of the report results differ from the current language of the user interface. Date, time, and 
number formats will be displayed in the format of the user interface language at the time the report results 
are displayed. 

After the report that has been executed offline has been opened: 

1) Set the filters of the configured report and click the button to execute the filter. 

2) In the pop-up window that opens, define a name for the report result with the current filter 
settings:  

  

3) Click OK to execute the report. You can now change to other views. Please note that the Event 
Feedback window informing about the availability of report results will only be displayed when the 
view is changed or re-loaded. 

4) After successful execution of the configured report, you will see an Event Feedback window 

displaying a text provided by the report designer for the report with a link  symbol.  

  

Move the cursor over the link  symbol to show a tooltip displaying the name you defined for 

the execution of the report. Click the link  symbol to open the report results in a new browser 
tab. Filters are displayed ReadOnly in the report results. 

 
If you have set a size restriction for text in table cells with the Max. Dataset Cell Text 
Length attribute in the User Settings editor, the text in the event feedback window 
may be truncated. To view the full text in a tooltip window, move the cursor over the 
text. 
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The Event Feedback window will open for a few seconds and then drop into the slide-in toolbar where it 
will be available as long as you are working with the same view. To open the report results after changing to 
another view: 

• Click the My Last Event Feedback notch in the slide-in toolbar to view a list of all event feedback 
available in the last 24 hours including your current report results. Open the configured report via 

the link  symbol. 

• Open the configured report and click the button (if available) to update the report results without 
changing the filter settings. A window will open that provides information about the availability of 
report results. Click Yes to open a link list of available report results. Click an execution result name 
in the link list to open the execution result in a new browser tab. 

Printing a View in Alfabet 

You can print most views in Alfabet including tables, diagrams, matrices, and business graphics. Object 
profiles and object cockpits can be printed, but they must first be published as a DOC or PDF file. A printing 
capability is not available for non-analytical views such as the bookmark desktop, world map, explorers, and 
selectors. The printing capability leverages the printing function of the standard browser installed on the 
user machine. 

The following information is available: 

• Printing Data in a Table 

• Printing a Business Graphic, Diagram, or Matrix 

• Printing an Object Profile/Object Cockpit via the Publish Capability 

Printing Data in a Table 

You can print the data displayed in a table using the browser print functionality. 

1) Navigate to the view that you want to print. 

2) Click a row in the table display the floating toolbar in the bottom right corner and click the 

Print  button. 

3) Confirm the information message by clicking OK. A separate browser tab will open displaying the 
view to be printed. 

4) User your browser's printing capability to print the view. 

Printing a Business Graphic, Diagram, or Matrix 

To print a business graphic, diagram, or matrix, you first need to set up the page to be printed. You must 
define the paper format, page orientation, scaling factor, and the page margins. Based on these specifica-
tions, the data in the view may be sliced with invisible page breaks into individual pages. The layout of the 
data will be based on the formatting specifications and will be displayed in a new browser window. You can 
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then print the view using your browser's print functionality. The Print button will not be displayed for views 
with business graphics that are not printable such branching diagram reports, circular roadmap reports 
map charts, and gauge reports. 

1) Click the Print  button in the floating toolbar to open the Prepare Print Page dialog. Define 
the page setup in order to provide specifications about the layout. If the view is large, the data will 
be distributed across pages. Page breaks will be created based on the page setup values. Define 
the following settings, as needed.  

• Print Format: Select the paper size that you will be printing to. You should select a print 
format to match the paper size you are printing to, otherwise the view may be sliced with page 
breaks. 

• Orientation: Select the orientation of the data on the page. 

• Scaling (%): Define the print scaling in percentage in order to resize the diagram. 

• Resolution (DPI): Define the resolution in dots per inch. 

• Left Margin (mm): Define the left margin in millimeter.  

 
The unit of measurement will depend on the cultures implemented in your Alfabet 
solution. For more information about the configuration of cultures, see the section 
Specifying the Cultures Relevant to Your Enterprise in the chapter Localization and 
Multi-Language Support for the Alfabet Interface in the reference manual Configur-
ing Alfabet with Alfabet Expand. 

• Right Margin (mm): Define the right margin in millimeter. 

• Bottom Margin (mm): Define the bottom margin in millimeter. 

• Top Margin (mm): Define the top margin in millimeter. 

• Add Filter Summary: Select the checkbox if the filter settings defined for the view should be 
included in the printout. 

2) Click OK to apply the page setup options. A separate browser tab will open displaying the view to 
be printed. 

3) Preview the layout of the data in the browser’s print functionality. If the layout of the view is not 
satisfactory, close the browser tab and re-adjust the page setup in Prepare Print Page editor in 
Alfabet. If part of the visualization is cut off, for example, you might change the orientation or 
scaling in the Prepare Print Page editor. Repeat this procedure until you are satisfied with the 
layout of the view. 

4) Print the view in the browser and close the browser tab by clicking X. 

Printing an Object Profile/Object Cockpit via the Publish Capability 

 
The browser print functionality does not recognize multiple scroll bars in a view. Therefore, only 
one page will be printed if you use the browser print functionality to print an object cockpit. 
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Object profiles and object cockpits must first be published as a DOC or PDF file via the Publish capability 
and then printed using the browser print functionality. Please note the following regarding the publication 
of object cockpits: 

• In the Object Document editor, you can select which group boxes and page views to include in the 
DOC or PDF file as well as the orientation of the each group box and view. During the publication 
process, group boxes are converted to tables, thus providing a structured visualization of the data 
in the DOC and PDF file. 

• You can specify whether large blocks of data such as diagrams and matrices should be published 
on a separate page in the DOC or PDF file. 

• The sequence of the object cockpit's content displayed in the DOC or PDF file is configured in the 
configuration tool Alfabet Expand. 

For more information about using the Publish capability, see the section Publishing an Object Profile/Ob-
ject Cockpit as a DOC or PDF File. For more information about the configuration of an object cockpit, see 
the section Configuring Object Cockpits for a Custom Object View in the reference manual Configuring 
Alfabet with Alfabet Expand. 

Exporting Data  

A number of standard mechanisms are available in Alfabet in order to export data from the Alfabet data-
base. Once a file has been exported, you may download it to your local network environment via the right-
click interactions available in Microsoft Internet Explorer. Please note that the file name is automatically 
generated but can be changed as needed. 

 
The third-party component Essential Objects® can be used to enhance the image quality for im-
ages exported to Microsoft Word®, Microsoft PowerPoint® or PDF files as well as the export of 
business charts such as line, area, or pie charts. Please note that the component is not automati-
cally used for image export and requires your system administrator to activate the web.config 
file of the Alfabet Web Application. For more information, see the section Setting Up the Alfabet 
Web Application in the reference manual System Administration. 

The following standard capabilities exist in order to export and publish Alfabet data: 

• Publishing an Object Profile/Object Cockpit as a DOC or PDF File 

• Exporting and Saving Data in a Table as XLS or XLSX 

• Exporting an Object Cockpit or Page View as a DOC or PDF File 

• Exporting and Saving Data as HTML 

• Exporting Views with Graphics as HTML+ PNG, EMF, JPEG, or BMP, or as SVG 

• Exporting Datasets, Diagrams, Matrix Reports, and Gantt Charts as PPT 
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Publishing an Object Profile/Object Cockpit as a DOC or PDF File  

You can publish data displayed in an object profile or object cockpit to either a DOC or PDF file. In the case 
of an object profile, you can specify the attribute information as well as which page views should be in-
cluded in the publication. In this way, you can choose to publish all of the data or only a specified set of the 
data displayed in the object profile or object cockpit. For object cockpits, all data displayed in the cockpit 
will be published. The content of the view will be automatically adjusted to the page width. In most cases, 
the content of the view is squeezed to fit the view, but in some exceptional cases, the content may be 
stretched to fit the view. Please note that the order of the content of the object cockpit is determined by 
the configuration of the object cockpit. 

If you are publishing an object profile, a legend available for a page view will be included in the publication. 
This is not the case for object cockpits. If you publish an object cockpit, legends will not be included. If the 
legend is required, you should export the page view separately. 

Please note that you can specify the layout of the information in the DOC or PDF file. Once the object pro-
file or object cockpit has been exported, you can further process the DOC or PDF file, as needed. You must 
have Adobe Reader®/ Adobe Acrobat® or Microsoft Word installed on your client machine in order to view 
and process the respective PDF or DOC file. You can print the file using your browser's print capability. 

 
To export an object cockpit as a single PDF page, select the Export > Adobe PDF option. For 
more information, see the section Exporting an Object Cockpit or Page View as a DOC or PDF File. 

This functionality is available to all users with Read permissions for an object profile if the Publish button is 
displayed. Whether the Publish button is displayed in an object profile or object cockpit will depend on the 
configuration of the user profile in your Alfabet solution. Object profiles and object cockpits must first be 
published as a DOC or PDF file via the Publish capability and then printed using the browser print function-
ality. 

 
Please note the following regarding the publication capability: 

• Exported Alfabet data that is processed in a DOC file cannot be reimported to Alfabet ! 

• Asian characters cannot be published to a PDF or DOC file via the Publish button. 

• Please note that configured gauge reports and geo-map reports that are embedded in 
an object cockpit cannot be exported to the DOC or PDF file. 

 

 
Please note that the configured row span and column span is ignored for a page view displaying a 
diagram when the object cockpit is published to a DOC or PDF file. In this case, the size of the di-
agram will be decreased in the publication. 

 

 
To enhance image quality of business graphics included in the publication, the embedded third-
party component Essential Objects® can be activated. For more information, see Prerequisites 
for Using Essential Objects® in the reference manual Technical Requirements. 

To publish object profile or object cockpit data to a DOC or PDF file: 

1) In the toolbar of the object profile or object cockpit, click the Publish button. The Object 
Document editor opens. 

2) Define the following information, as needed:  
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The settings that you define in the Object Document editor will be persistent for the 
object class that you are publishing. If you log in with a different user profile or publish 
the object profile/object cockpit for a different object class, you will need to redefine the 
settings. 

Data tab: In the Show in Document column, select all attributes, group boxes and page views that 
you want published in the report. In the View Orientation cell, define the orientation of the infor-
mation displayed in the Attributes section. Please note the following: 

• The sequence of the object cockpit's content displayed in the DOC or PDF file is configured in 
the configuration tool Alfabet Expand. 

• During the publication process, group boxes will be converted to tables, thus providing a 
structured visualization of the data in the DOC and PDF file. Scroll down to define the 
orientation of the page views displayed in the object profile/object cockpit. 

• Please note that you can improve the readability of large blocks of data such as diagrams and 
matrices by setting the View Orientation cell to Landscape, or by specifying that the view be 
published on a separate page in the DOC or PDF file (Portrait Separate Page or Landscape 
Separate Page). 

• Use the Select All and Clear All buttons to set or clear the checkmark for all attributes and 
page views, if needed. 

Layout tab: 

• Document Title: Enter a title for the document. The title appears on the first page of the 
document. 

• Document Type: Select DOC or PDF to define the publication format. 

• Default Page Orientation: Select the page orientation for the publication. All publication 
pages will be accordingly formatted except for those differently defined in the View 
Orientation column in the Data tab. 

• Page Size: Select the page size for the publication.  

Standard Text section: These settings determine the text for the data in the published page 
views. 

• Font Type: Select the font type for the text for the data in the selected views. 

• Font Size: Select the font size for the text for the data in the selected views. 

• Paragraph Spacing (px): Define the spacing in pixel between the end of the page view 
and the title of the following page view. 

Page View Names section: These settings determine the text representing the title of the 
document and page views. 

• Font Type: Select the font type for the text representing the title of the document and 
page views. 

• Font Size: Select the font size for the text representing the title of the document and 
page views. 
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Page View Descriptions section: These settings determine the text representing the page 
view descriptions displayed in the Alfabet interface that briefly explain the content of the page 
view. 

• Font Type: Select the font type for the text representing the page view descriptions. 

• Font Size: Select the font size for the text representing the page view descriptions. 

• Include Descriptions: Select the checkbox if the page view descriptions explaining the 
content of the page views should be included in the report. The page view descriptions 
will be displayed in the publication below the name of the page view. 

Page Footer Information section: These settings determine the information that is displayed 
in the footer of the exported document. 

• Font Type: Select the font type for the text in the document footer. 

• Font Size: Select the font size for the text in the document footer. 

• Include Attribute Captions: Select the checkbox if the captions for the footer attributes 
should be included in the document footer. Do not select the checkbox if only the values 
for the footer attributes should be included in the document footer. 

• Include Timestamp: Select the checkbox if the date and time that the publication was 
generated should be included in the document footer. 

• Include Object Image Property: Select the checkbox to display the configured image 
properties of the object for which the publication is created in the document footer. The 
image properties are typically configured to display the ID, name, and version of the 
object. 

• Include Alias Name: Select the checkbox if the name of the server alias used to connect 
to Alfabet should be included in the document footer. 

• Include User Name: Select the checkbox if the name of the user creating the publication 
should be included in the document footer. 

3) Click OK to save your changes and initiate the publication of the selected data. A standard Save As 
dialog box opens 

4) Enter a name and location for the file and click OK. You can open the DOC file with Microsoft Word 
or the PDF file with Adobe Reader® or Adobe Acrobat®. 

Exporting and Saving Data in a Table as XLS or XLSX  

You can export and save data displayed in a table in a view to an XLS or XLSX file. A flat list of data as well 
as data in expandable tables can be exported. The Name and ID of the object view and caption of the page 
view will also be exported to the XLS file. When exporting a dataset to an XLS or XLSX file, the filters in the 
view will be exported and displayed as filters in the column headers in the exported file. A flat list of data as 
well as data in expandable tables can be exported. 

When exporting to Microsoft Excel, the user can select the file extension XLSX and thus export a dataset 
with a size of up to 1M. If the user selects the default file extension XLS, a limit of 64k records will apply. 
You must have Microsoft Excel 2000 or later installed on your machine in order to view and process the XLS 
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file. You must have Microsoft Excel 2007 or later installed on your machine in order to view and process the 
XLSX file. 

 
• Exported Alfabet data that is processed in an XLS or XLSX file cannot be reimported to 

Alfabet ! 

• The final output that is exported will closely correspond to what you see on the screen. 
Therefore, if an object is selected in the table upon export, for example, the row will be 
highlighted grey in the exported file. 

• Boolean values exported to the report will be represented by an X for True and an empty 
cell for False. This is consistent with the display of True/False values in Alfabet. 

• If the content of a cell in the dataset begins with a protocol specification starting with 
http, https, ftp, etc., the syntax of the link will be validated during the export. If the 
syntax of the link is valid, it will be displayed as a link in the XLS file. If the syntax is not 
valid, the string will be published as text. Please note that a colon (for example:ABS:Test 
1" is valid URL syntax and would thus be displayed as a link. 

To export a Alfabet view to an XLS or XLSX file that you can process, as needed. 

1) Click Export > Include Filter Summary if filter settings are defined and you want to include a 
summary of the filter settings in the export file. A checkmark will be displayed if the option is 
selected. The legend will be exported to a separate tab labeled Filter Summary. Clear the 
checkbox if you do not want the filter summary included in the export.  

 
Please note the following: 

• If no Include Filter Summary option is available for the view, filter settings will 
not be included in the export. 

• The option Include Filter Summary may be available in the Export menu in 
views and configured reports even if filter settings are not available in the view. 

• The default setting for the Include Filter Summary option is defined in the 
User Settings editor. For more information about defining your default user 
settings, see the section Defining Your User Settings in Alfabet. 

2) In the Export menu, select Excel File to export the page view to an XLS file. 

3) A standard Save As dialog box opens. 

4) Enter a name and location for the file, select the file extension, and click OK. You can open the file 
with Microsoft Excel. 

Exporting an Object Cockpit or Page View as a DOC or PDF File  

Export to DOC or PDF is supported for datasets as well as views with images including, for example, dia-
grams, Gantt charts, portfolios, matrices, circular roadmaps, branching diagrams, and gallery diagrams, The 
visualizations will be exported in their actual size. If a graph is bigger than a single page, the graph will be 
automatically split across multiple pages upon export. Headers will be repeated when splitting if applicable. 
You must have a relevant program installed on your computer/device to open the DOC or PDF file. The 
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caption and description of an exported page view or configured report will be included in the PDF file that 
the data is exported to. 

If you export an object cockpit, console report, or dashboard, it will be exported to a single PDF page. Con-
figured reports published to a PDF file will scaled to the paper size selected by the user, thus overriding the 
size configured for the report. 

To export the view to a PDF file that you can share with others: 

1) If exporting a tabular dataset, ensure that all sections of the page view are expanded that you 
want to have visible in the PDF file. 

2) Click Export > Include Filter Summary if filter settings are defined and you want to include a 
summary of the filter settings in the export file. A checkmark will be displayed if the option is 
selected. Clear the checkbox if you do not want the filter summary included in the export.  

 
Please note the following: 

• If no Include Filter Summary option is available for the view, filter settings will 
not be included in the export. 

• The option Include Filter Summary may be available in the Export menu in 
views and configured reports even if filter settings are not available in the view. 

• The default setting for the Include Filter Summary option is defined in the 
User Settings editor. For more information about defining your default user 
settings, see the section Defining Your User Settings in Alfabet. 

3) In the toolbar of the view, click Export > Adobe PDF or Export > Microsoft Word. The Export 
Page Setup editor opens. Your most recents settings will be displayed. Define the following as 
needed:  

• Page Setup tab:  

• Page Size: Select the page size for the export.  

 
The options in the Page Size field are configured by your solution designer in 
the XML object ExportDocumentPageSizeManager. For more information, see 
the section Specifying the Page Sizes Available to Export DOC and PDF Files in 
the reference manual Configuring Alfabet with Alfabet Expand. 

• Page Orientation: Select the page orientation for the export. 

• Measurement Units: Select which type of measurement unit will be applied to the margin 
definitions. 

• Top Margin: Specify the distance of the top margin. 

• Bottom Margin: Specify the distance of the bottom margin. 

• Right Margin: Specify the distance of the right margin. 

• Left Margin: Specify the distance of the left margin. 

• Header/Footer Settings tab: Specify the information to display in the header and footer of 
the exported file. You can display the caption of the currently selected object and view, 
timestamp of the export, the user name of the person exporting the data, and the name of the 
server alias that Alfabet is running on in either the header or footer.  
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• Header Text: Select one or more pieces of information listed below that shall be included 
in the header of the DOC or PDF file. 

• Footer Text: Select one or more pieces of information listed below that shall be included 
in the footer of the DOC or PDF file. 

• Font Color: Specify the font color of the header and footer texts. The default font color is 
the color specified in the GUI scheme settings specified for your user profile. 

• Font Size: Specify the font size of the header and footer texts. The default size is 10. 

4) Click OK to save the page setup. 

5) In the dialog that opens, click the Download button and save the file. You can open the DOC or 
PDF file with a relevant program installed on your computer/device. 

Exporting and Saving Data as HTML  

You can export and save data in a table in a view to an HTML file. Configured reports created by your enter-
prise cannot be exported to HTML. 

 

Please note if images or icons are displayed, they must be exported to a ZIP file. For more infor-
mation, see the section Exporting Views with Graphics as HTML+ PNG, EMF, JPEG, or BMP, or as 
SVG. 

To export as view to an HTML file that you can share with others: 

1) If exporting a tabular dataset, ensure that all sections of the page view are expanded that you 
want to have visible in the HTML file. 

2) In the toolbar of the view, click Export > HTML File. A standard Save As dialog box opens. 

3) Enter a name and location for the file and click OK. You can open the HTML file in a standard 
browser. 

Exporting Views with Graphics as HTML+ PNG, EMF, JPEG, or BMP, or as SVG  

In the case of business graphics, the business graphic can be saved as either a PNG, EMF, JPEG, or BMP 
file. The diagram will be exported as a graphic in the selected format together with an HTML file. The HTML 
file displays a headline giving the name of the exported diagram and the diagram image. The graphic and 
the HTML file will be saved to a ZIP file. To open the ZIP file, you will need an extracting tool like WinZip® on 
your client machine. The HTML file requires the graphic file to be located in the same directory. 

 
Please note the following: 

• Some business graphics - in particular diagrams - may be exported to an SVG file. The 
option ZIP (HTML + SVG) will be displayed in the Export menu if it is possible to export 
the business graphic to an SVG file. Please note however that bitmap elements in 
diagrams cannot be exported to an SVG file. Furthermore, the export of a diagram to an 
SVG file may display content outside of the diagram item if it was removed in the 
originally displayed diagram. To address this, please ensure that the diagram item size 
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selected sufficiently displays the entire content. This is especially important if diagram 
views are displayed in the diagram. 

• The size of the objects in business graphics differ in the user interface and in an export. 
This is due to the fact that two different libraries are currently required to render and to 
print/publish business graphics. 

• The style sheet for export is configured in the configuration tool Alfabet Expand. For 
more information, see the sections Configuring the Style Sheet for the Export to HTML 
and Configuring Header and Footer Text for Exported HTML Files in the reference 
manual Configuring Alfabet with Alfabet Expand. 

 

 
Depending on the specifications of the server hardware and operating system that Alfabet runs 
on, the size of business support maps may be limited. This is due to a limitation on bit maps that 
can be rendered on the server. In this case, large datasets may not export correctly. 

Once a file has been exported, you may download it to your local network environment via the right-click 
interactions available in Microsoft Internet Explorer. If you are working with an Alfabet Web Client, the file 
available for downloading will be available for at least 10 minutes. If another export is executed, the file will 
be deleted after the 10 minute period. If no other export is initiated, the file will be deleted when your cur-
rent Alfabet session ends. 

To export a Alfabet view to an HTML file that you can share with others: 

1) Click Export > Include Filter Summary if filter settings are defined and you want to include a 
summary of the filter settings in the export file. A checkmark will be displayed if the option is 
selected. The legend will be exported to a separate HTML file with the suffix _Summary.html 
contained in the ZIP file. Clear the checkbox if you do not want the filter summary included in the 
export.  

 
Please note the following: 

• If no Include Filter Summary option is available for the view, filter settings will 
not be included in the export. 

• The option Include Filter Summary may be available in the Export menu in 
views and configured reports even if filter settings are not available in the view. 

• The default setting for the Include Filter Summary option is defined in the 
User Settings editor. For more information about defining your default user 
settings, see the section Defining Your User Settings in Alfabet. 

2) Click Export > ZIP (HTML + <Graphic Format >) to select the appropriate format to save your file. 
Please note that business graphics exported to the EMF format can only be displayed in Microsoft 
Internet Explorer.The EMF format is not standard and the display of colors may differ from other 
export formats. 

3) A standard Save As dialog box opens. Enter a name and location for the file and click OK. You can 
open the ZIP file by means of an extracting tool.s 
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Exporting Datasets, Diagrams, Matrix Reports, and Gantt Charts as PPT  

You can export datasets, diagrams, matrix reports, and Gantt charts directly to a Microsoft® PowerPoint® 
format. This functionality is supported for visualizations such as diagrams, business support maps, tree 
maps, cluster maps, grid reports, node arc reports, branch reports and lane reports. This allows you to eas-
ily integrate the data in presentations for your enterprise. You must have Microsoft PowerPoint installed on 
your machine in order to view and process the PPT file. 

The PPT file will include the caption of the view in a title placeholder as well as the description in a sub-title 
placeholder. Please note that space for descriptions of views or configured reports in the sub-title place-
holder is limited to one line. If the descriptions are longer, the entire text may not be visible. You can include 
a summary of the filter settings in the export, which will be exported to a separate slide. The legend will also 
be exported to a separate slide in the PPT file. 

The export of data to Microsoft® PowerPoint® ensures that visualizations are exported in their actual size 
by scaling on the natural definition of a report. If a graph is bigger than a single slide, the graph will be auto-
matically split across multiple slides upon export. Arrows will be added to the margins of the slides to pro-
vide help with understanding the layout of the slide content as well as during presentation navigation. 

For an excessively large view such as a matrix or diagram, the view will first be split horizontally across 
multiple pages and then vertically. The default slicing between pages will attempt to avoid cutting through 
objects in the visualization. Arrows will be added to the margins of the page to indicate that a page contin-
ues either vertically or horizontally and to directly link to the subsequent page in either horizontal or verti-
cal direction. Please note that the export of data in a dataset or matrix to a PPT file is limited to 1000 cells in 
order to prevent performance issues from occurring when an excessively large amount of data is exported. 

Export of views with header information such as datasets, Gantt charts, and matrix map reports will repeat 
the header on each slide. In order to improve readability of exported business graphics 

 

Users should specify their preferences for exporting Alfabet views to Microsoft® PowerPoint® 
in the MS PowerPoint Export Format field in the User Settings editor. The options Wide-
screen x 4, Widescreen 16:9 and Standard 4:3 are available. The selected option corresponds 
to the slide size in the generated PowerPoint. For more information, see the section Defining 
Your User Settings in Alfabet. 

 

 

A Page Split Settings option has been added to the Other Actions menu in the Alfabet Dia-
gram Designer and allows the expected page format for printing or for exporting to PPTX export 
to be specified. The lines where the diagram is split can be added to the output via the View 
Page Split attribute in order to make excessively large diagrams easier to understand in their 
printed/exported format. For more information, see the section Specifying Settings to Export or 
Print the Diagram to PPT Format in the Designing IT Landscape Diagrams in Alfabet. 

 

 
To enhance image quality in the export and enable export for configured reports such as branch-
ing diagram reports or gallery reports, the embedded third-party component Essential Objects® 
can be activated. For more information, see Prerequisites for Using Essential Objects® in the ref-
erence manual Technical Requirements. 

 

 
Depending on the specifications of the server hardware and operating system that Alfabet runs 
on, the size of business support maps may be limited. This is due to a limitation on bit maps that 
can be rendered on the server. In this case, large datasets may not export correctly. 

1) Click Export > Include Filter Summary if filter settings are defined and you want to include a 
summary of the filter settings in the export file. A checkmark will be displayed if the option is 
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selected. The legend will be exported to a separate HTML file with the suffix _Summary.html 
contained in the ZIP file. Clear the checkbox if you do not want the filter summary included in the 
export.  

 
Please note the following: 

• If no Include Filter Summary option is available for the view, filter settings will 
not be included in the export. 

• The option Include Filter Summary may be available in the Export menu in 
views and configured reports even if filter settings are not available in the view. 

• The default setting for the Include Filter Summary option is defined in the 
User Settings editor. For more information about defining your default user 
settings, see the section Defining Your User Settings in Alfabet. 

2) Click Export > MS PowerPoint file (*.ppt) as picture to export the graphic to a PPT file. The 
diagram will be exported to a Microsoft PowerPoint file. The graphic will be included as an imported 
picture. 

3) A standard Save As dialog box opens. Enter a name and location for the file and click OK. 

Using the Clipboard Capability  

The clipboard capability is a convenient means to copy multiple objects and save them to the clipboard in 
order to easily define them as reference objects later in the user session. The objects will be saved to the 
Clipboard section of the dataset displayed in the My Objects tab in the relevant class selector. Data can be 
saved to the clipboard even if the user has read-only access to a standard page view or configured report. 
The class selector can be opened in another view and the clipboard objects can then be selected in the My 
Objects tab and added as references to another object. The clipboard objects will remain in the My Objects 
tab of the class selector for the current user session. 

 

For more information about the configuration of custom selectors, see Configuring a Custom 
Selector for Search Functionalities 

The Add to Clipboard button is available in the following: 

• Standard selectors and relevant custom selectors 

• Standard views and relevant configured reports where the data is displayed in a tabular dataset. 

• The toolbar of the following object profiles (unless the Add to Clipboard button has been explicitly 
hidden by your solution designer: Application, Component, Demand, Device, ICT Object, 
Peripheral, Project, Organization, Standard Platform, Service Product, Technology, Vendor, 
and Vendor Product. 

• A standard page view or configured report that is embedded in an object cockpit. In this case, the 
clipboard functionality can be used in the context of the object cockpit without explicitly opening 
the embedded view/report. 

To use the clipboard functionality: 
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1) Select the object(s) in the selector or dataset that you want to save to the clipboard. You can 
select several objects at once by holding down the CTRL key while selecting the objects 

2) In the toolbar, click the Add to Clipboard button. If you are saving the objects in a selector, they 
will be immediately displayed in the My Objects tab. 

3) Go to the relevant view where the objects shall be added and invoke the relevant functionality to 
open the selector to add the objects. Go to the My Objects tab in the selector, click the object(s) to 
add and click OK. The selected objects will remain in the clipboard for the current user session and 
can be added to other views where the selector for the relevant object class is invoked.Using the 
Clipboard Capability in the reference manual Getting Started with Alfabet.  

 

 

 

 
Please note the following about the clipboard functionality: 

• Data added to the clipboard will remain in the clipboard during the running sub-
session. If the user opens another browser tab to open Alfabet or if the user logs 
out, the data will be removed from the clipboard. Changing the user profile will 
not empty the clipboard. 

• Each time a user adds objects to the clipboard within a running session, the 
data will be added to the existing data in the clipboard. 

• The My Objects tab will only display the sub-set of objects in the clipboard that 
may be selected via the selector. For example, if components and applications 
have been added to the clipboard, only applications will be displayed in an 
application selector, only components will be displayed in a components 
selector, and none of the objects will be displayed in a device selector. 

Marking the Object as Reviewed  

Some objects are associated with an inactivity monitor that monitors whether the object’s data has been 
reviewed and is thus up-to-date. 

An inactivity monitor is a type of monitor that alerts subscribed users about the absence of activity occur-
ring to objects in a specified object class. The monitor owner must specify a set of objects that are to be 
monitored and a set of users that are defined as listeners to be alerted if the monitor is triggered. The moni-
tor owner is typically the user responsible for the objects defined for the monitor. The monitor owner as 
well as the listeners will be informed via email notification if a specified object has not been edited or re-
viewed within a specified period of time. If the monitored object does not need to be changed, the monitor 
owner can mark the object as reviewed. 

If changes are required for the object, an assignment can be defined and assigned to the relevant user. If 
no changes are required, the monitor owner or an authorized user can click the Mark as Re-

viewed  button to indicate that no explicit changes need to be made to the object but the object has 
been reviewed and is up-to-date. The monitor owner and listeners will then be informed that the selected 
object has been reviewed. The monitor owner and all monitor listeners will see that the object has been re-
viewed and the review date will be displayed in the Reviewed column in the Objects page view of the inac-
tivity monitor in the Monitors functionality. 
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Please note the following about access permissions: 

• If the user has ReadWrite permissions to the object and uses the Mark as Reviewed  button, 
then the object is specified as reviewed for all inactivity monitors associated with the object, 
regardless of who owns the inactivity monitor. 

• If a user has ReadOnly access permission to the object and uses the Mark as Reviewed  
button, the object will be specified as reviewed only for the inactivity monitor that the user owns. 

• If the user has ReadOnly access permissions to the object and uses the Mark as Reviewed  
button and no inactivity monitor has been defined for the object, a warning message will be 
displayed stating that the object is not monitored by an inactivity monitor. 

 
For general information about monitors, see the section Keeping Track of Objects via Monitors. 

Sending an Assignment About an Object to the Authorized User  

If you notice that information is incomplete or inaccurate, you can create an assignment for the authorized 

user of the object via the Notify Authorized User  button displayed in the object profile. When you 

click the Notify Authorized User  button, the Notification Assignment editor opens in which you can 
create the assignment and specify a target date and provide a description about the issue at hand. You can 
define whether the assignment is optional or whether it is mandatory. The assignment will be generated 
and displayed in the authorized user’s My Assignments functionality. 

Depending on the configuration of your Alfabet solution, an email notification may be sent to the author-
ized user of the object targeted by the assignment informing them that an assignment has been generated 
for the selected object. In this case, the name of the assignee will be displayed in the To: field of the email 
and the creator of the assignment will be displayed in the From: field of the email. If deputies are defined 
responsibility for the selected object in the Authorized Deputies Page View, they will also receive email no-
tifications when an assignment is created. In this case, the names of the deputies will be displayed in the 
CC: field. Information about the configuration required to send emails for assignments is explained in Con-
figuring Email Notifications in the Context of Assignments in the reference manual Configuring Alfabet 
with Alfabet Expand. 

 The Notify Authorized User  button is visible only if the selected object has an authorized 

user defined. Depending on your solution configuration, the Notify Authorized User  capa-
bility may be unavailable for the object class you are working with. In this case, the button will 
not be displayed in the toolbar of the object profile. For more information about the configuration 

of the assignment capability as well as the display of the Notify Authorized User  button, 
see the section Configuring the Assignment Capability in the reference manual Configuring 
Alfabet with Alfabet Expand. For an overview about how to use the assignment capability, see 
the section Sending and Receiving Assignments for Alfabet Objects. 

To notify the authorized user about the selected object: 

1) Navigate to the object profile of the relevant object. 
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2) In the toolbar, click the Notify Authorized User  button. You will see the Notification 
Assignment editor. 

3) Enter a title and target date for the assignment and, if necessary, provide a description or remarks 
about the issue at hand and attach any relevant documents or links. You can define whether this 
assignment is optional or whether it is mandatory that the authorized user acts on the assignment. 

4) Click OK to send the assignment to the authorized user, or Cancel to exit without sending the 
assignment. 

Viewing the Change History of an Object 

Alfabet provides an auditing functionality that documents the changes made to an object. You can view 
the audit trail only for objects that belong to an object class for which your solution designer has config-
ured the auditing functionality. You must have ReadOnly and ReadWrite access permissions to the object to 
view the report. 

The audit trail displays the changes made to an object’s standard and custom attributes as well as its refer-
ences to other objects. The audit trail includes the type of change made to the object, the user making the 
change, the time of the change, and the attribute or reference that has been changed. The auditing func-
tionality is implemented on a class-by-class basis. The audit trail data can be exported to a Microsoft® Ex-
cel® file or HTML file. 

 
Please note that the LAST_UPDATE_USER and LASTUPDATE properties are only updated in the 
Alfabet database when changes are made via the object's editor or editor embedded in a wizard. 
Changes made in page views are NOT updated in the LAST_UPDATE_USER and LASTUPDATE 
properties. 

 

 
The auditing functionality is solely for the purposes of tracking the change history of objects in 
the Alfabet solution. A deleted object cannot be restored via the auditing functionality. If an ob-
ject has been erroneously deleted, the object must be recreated and redefined in the Alfabet so-
lution. For information about how to configure the auditing functionality, see the section Speci-
fying History Tracking for an Object Class in the reference manual Configuring Alfabet with 
Alfabet Expand. 

1) In the toolbar of the object profile, click the Audit Trail  button. You will see the Object Audit 
page view. 

2) All changes made to the objects standard and custom attributes are documented and highlighted 
yellow. Changes to the object’s references are also shown. The following columns are displayed.  

• AUDIT EVENT: Displays the action that has occurred to the object. Possible values include:  

• Create Object 

• Change Object (changed property is highlighted) 

• Create Relation 

• Delete Relation 
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For the entries Create Relation or Change Relation, you can navigate to the 
referenced object if it still exists in the database. To do so, select the audit event 

and click the Shows Referenced Objects  button. The relevant object profile 
opens. Depending on your access permissions to the object, you may be able to edit 
it. 

• AUDIT TIME: Displays the timestamp of the action. 

• AUDIT USER: Displays the name of the person that triggered the action. 

• REL FROM: Displays a unique internal ID of the source object of the relation. 

• RELATION: Displays the object class that is targeted by the relation change. 

• REL TO: Displays a unique internal ID of the target object of the relation. 

• < ObjectClassAttributes >: Each column displays the value of a standard or custom attribute 
that has been changed for the object. The changed value will be highlighted. 

3) To close the view, click the Back button. 

Accessing Existing Publications About Objects 

The Report Publications functionality allows authorized users to download APF (Alfabet Publication 
Framework) publications. APF publications are configured Microsoft® Word documents containing infor-
mation about objects in the Alfabet database. The view lists all publications created within the last month. 
The publications will expire one month after their creation and can no longer be downloaded. 

 
The publication definitions and the interfaces to trigger the publications are configured by your 
solution designer in the configuration tool Alfabet Expand. Contact your solution designer re-
garding the execution of Alfabet publications. For more information about the configuration of 
Alfabet Publication Framework publications, see the chapter Publishing Data in Microsoft Word or 
PowerPoint Format in the reference manual Configuring Alfabet with Alfabet Expand. 

Publications are configured to expire one month after creation. Expired publications will no longer be dis-
played in the list of publications in the table. Nevertheless they will still be available in the Internal Docu-
ment Selector unless they are deleted by the system administrator via the batch utility AlfaBatchExecu-
tor.exe. For information about the batch deletion of expired publications, see Batch Processing for Monitors 
and Change Management with AlfaBatchExecutor.exe in the reference manual System Administration. 

To download a publication: 

1) Click the Refresh button to update the table. You will see all available publications in the table. 

2) Click the publication in the table and click the Download Document button. 

3) Select the location where you want to save the document to and click OK. The downloaded 
document is a ZIP file containing the Microsoft® Word output file(s). 

 To delete a publication, select the publication and click the Delete  button in the toolbar. The 
publication is deleted from the view as well as irrevocably deleted from the Internal Document 
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Selector. After a publication is deleted, it will no longer be available for download to Alfabet us-
ers. 
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Chapter 5:  Searching for Your Objects  

There are a number of means available in Alfabet to find an object that you want to work with. The easiest 
way is to use the standard search functionalities described below. In addition, you can also access objects 
that are relevant to you in the following views and functionalities: 

• If the AlfaBot is implemented to ease navigation to objects, you can enter a request in the AlfaBot 
to directly open a view or an editor for an object. For more information, see the section Using the 
AlfaBot User Assistance. 

• If the AlfaBot is implemented to analyze configured report content via a faceted search, you can 
enter a question in the AlfaBot requesting information about objects matching defined conditions, 
like for example objects of a specific class for which a specific indicator is set to a specific value. A 
faceted search view will then open listing all configured reports that provide the requested 
information. In addition, the search functionality will provide tabular datasets with relevant 
information if the data from the request provides a set of information which allows to create these 
datasets. The faceted search view might also be available via a menu option. The question can be 
entered directly in the view instead of the AlfaBot window. For more information, see the section 
Using the AlfaBot User Assistance. 

• To find any object that you are an authorized user of, go to the Authorized User Objects page 
view in the Personal Info functionality. For more information, see the section Managing Your 
Objects and Object Responsibilities. 

• To find an object that you are responsible for via an assignment, go to the My Assignments 
functionality. For more information, see the section Sending and Receiving Assignments for 
Alfabet Objects. 

• To find an object that you must process in the context of a workflow step, go to the My Workflow 
Activities functionality. For more information, see the section Executing Workflows and 
Participating in Workflow Steps. 

• To find a bookmarked view for an object, go to the Bookmark Desktop functionality. For more 
information, see the section Creating, Managing, and Accessing Your Bookmarks. 

• To work with your configured reports, see the section Executing Your Configured Reports in the 
chapter Analyzing Your Data in Page Views and Reports. 

• To work with your publications, see the section Accessing Existing Publications About Objects. 

The following information describes the basic search options available for Alfabet: 

• Finding Objects via the Global Search Field 

• Searching for Objects via the Simple Search 

• Conducting a Browse Search 

• Conducting a Full-Text Search 

• Full-Text Search Options and Operators 

• Searching an Enterprise Glossary via the Full-Text Search Capability 

• Defining Glossary Items for the Glossary 

• Organizing the Glossary Items in Glossary Folders 
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Finding Objects via the Global Search Field  

If a global search field has been configured for the start page, it will be available on the right side of the 
standard Alfabet toolbar during the entire user session. The global search field allows you to search for ob-
jects in the Alfabet database. You can enter the name or partial name or ID of an object in the global search 
field. Once the first three letters of a search string have been entered in the global search field, the auto-
complete function will invoke a search and start displaying a list of the first thirteen objects found by the 
query. The list of matching objects will be updated with each additional letter typed in to the search field. 

You can select an object displayed via the auto-complete function or click the Search icon. A configured 
report displaying the results of the search will be displayed in the current browser tab. For more infor-
mation about configuring a global search field, see the section Configuring a Global Search Field for a Guide 
View or Guide Page in the reference manual Designing Guide Pages for Alfabet. 

Searching for Objects via the Simple Search 

The Simple Search functionality allows you to quickly and easily find an object for all object classes that 
have been configured as searchable for your user profile. Your enterprise may have configured search se-
lectors for some of the classes available in the Search For field or for all of the available classes. Typically, 
a search selector will be customized for each object class and may consist of one or many tabs that allow 
you to define search criteria. It is highly recommended that you read the following information about the 
standard search functionalities in order to understand the basic operation of your customized search capa-
bility. If questions or errors should arise in your use of a custom search capability, please contact your en-
terprise’s solution designer. 

The Simple Search functionality contains a Simple tab that allows you to enter search criteria that returns 
a set of found objects.In addition to the Simple tab, a Browse tab lets you search for an object in an ex-
plorer structure and a Full-Text tab allows you to enter search terms for a preconfigured search group. 

The Simple tab allows you to conduct a search based on criteria that you enter. For example, you can enter 
the first few letters of the object's name and select other standard object class properties and/or custom 
properties to include in the search criteria. 

The search criteria you define is stored per object class or per object class stereotype. This means that the 
search string history relevant for the auto-complete capability will be different for the class Domain vs. the 
domain stereotype Business Capability. The search terms are persistent for later user sessions or if you 
change to a different user profile. 

An Add to Clipboard functionality is also available for standard selectors and relevant custom selectors 
and provides a convenient means to copy multiple objects and save them to the clipboard in order to easily 
define them as reference objects later in the user session. For more information about using the clipboard 
functionality, see the section Using the Clipboard Capability. 

 
For performance reasons, the return set for any search is limited to 300 objects. If more than 300 
objects are found, the search criteria should be refined. Otherwise, the object(s) you are looking 
for may not be included in the return set. 

 

 
You can add additional columns to the table in order to display more standard or custom proper-

ties via the Configure  button available in toolbar. By clicking the arrows available at the top 
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of the columns, you can sort the data displayed in the columns. The Configure function is availa-
ble to both ReadOnly and ReadWrite user profiles. 

To conduct a simple search based on your specified search criteria: 

1) Select the object class that you want to search for in the Search For field and click the Simple tab. 
If only one object class can be selected, the class will already be displayed in the Search For field 
and the filter cannot be defined. If object class stereotypes have been configured for your 
enterprise, the stereotypes will be displayed in the Search For field. However, if you select an 
object class stereotype for which no object has been defined on the root level of the object class 
stereotype hierarchy, then no results will be displayed in the Browse tab. For example, the object 
class Domain has the object class stereotypes 1) Area, 2) Sub-Area, and 3) Domain. If you select 
Sub-Area in the Search For field and no objects for the stereotype Area have been defined, a 
browse hierarchy cannot be displayed and thus no results will be displayed. 

2) Click the Simple tab. 

3) The search capability searches all searchable properties listed in the Search Properties filter by 
default. However, you can narrow the search criteria by specifying one or more standard object 
class properties and/or custom properties. For example, you could select Name in the drop-down 
list to base a search on a name or part of a name defined for your objects. Click the arrow symbol 
to open the drop-down list. Set a checkmark next to one or more attributes or click the Select 

All  button to select all attributes. You can remove a checkmark by clicking the Clear 

All  button to remove the checkmark from all attributes. Click the Accept Selection button 

 to confirm your selection or click the Revert Selection  button to close without making 
the selection. 

4) In the Search Pattern field, enter additional search criteria to be searched in the properties 
selected in the Search Properties field. Please note the following guidelines:  

• If you enter the full name of an object, it must be spelled correctly 

• If you do not know the full name of an object, you may use the * symbol as a wildcard 
character. For example, to find all applications beginning with the letters ABC, enter ABC*, 
enter *ABC to find applications ending with ABC, or A*BC to find applications containing the 
letters ABC.  

 
Depending on the configuration of the standard search functionalities, the wildcard 
* symbol my be automatically implemented. In this case, you do not need to enter 
the wildcard in the Search Pattern field. A message will be displayed in the header 
panel of the Simple tab if the wildcard is automatically implemented and thus not 
required. The configuration of the automatic implementation of the wildcard is con-
figured in the configuration tool Alfabet Expand. For more information, see the sec-
tion Configuring the Wildcard for Standard and Custom Search Functionalities in the 
reference manual Configuring Alfabet with Alfabet Expand. 

• Use the operator AND to search for an object containing both of two terms. For example, 
entering ABC AND OptiRetail returns all objects with both terms ABC and OptiRetail. 

• Use the operator BETWEEN <date> <date> or BETWEEN <number> <number> to search for 
custom attributes with values in a specific range. Be sure to use the date conventions for the 
culture implemented for your solution.  
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You can only search for dates, integers, and real numbers that have been defined 
for custom attributes. It is not possible to search the standard attributes Start Date 
and End Date. 

• Use the operators <, <=, >, >=, = to specify values for integers and real numbers for custom 
attributes.  

 
The format for search criteria using operators is: 

"<operator>_<value>" 

where _ is a whitespace. The whitespace is mandatory. 

• The characters % and _ should be escaped because some databases regard these characters 
as wildcards. The % and _ can be escaped by used square brackets [ ]. 

• A validation of the search pattern you specify will be performed. The search pattern will not be 
applied to any of the selected search attributes if the search pattern does not match the type 
of the search attribute. (For example, if you select a custom property for which an integer 
must be entered as a value but you enter text in the Search Pattern field, the custom 
property will automatically be dropped from the list of search attributes). 

5) Click the Search button to execute the search based on your settings. Please keep the following in 
mind:  

• Click and hold on any object in the results list to open a preview about the object. Click 
anywhere outside of the preview window to close it. 

• The number of results found by the search will be displayed in the header of the results table. 
Up to 300 objects may be found in the search. Each page in the results will display 100 results. 

• To navigate forward to the next page of results, click the Next Page  button. 

• To navigate forward to the last page of results, click the Last Page  button. 

• To navigate back to the previous page of results, click the Previous Page  button. 

• To navigate open to the first page of results, click the First Page  button. 

• Depending on the context in which you have opened the object selector, it may be possible to 
select multiple objects in the object selector. If this is the case, use CTRL + click to 
simultaneously select multiple objects in a page. Multiple objects can only be selected on one 

page at a time in the object selector. If you click the Next Page , Last Page , etc. 
buttons, your selection will be lost. 

6) Select the object you want to add and click the OK button. 

Conducting a Browse Search 

The Browse functionality allows you to browse through an object hierarchy to find the object you are look-
ing for. For example, you could search for a specific domain by searching through the hierarchical structure 
of domains defined for your enterprise. Not all object classes listed in the Search For field can be meaning-
fully searched in the Browse functionality. The browse functionality requires that you search for an object 
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by means of an explorer structure. Therefore, the object must be structured in an object hierarchy in order 
to be found via the browse. All available hierarchies will be displayed in the explorer. 

1) Select the object class that you want to search for in the Search For field and click the Browse 
tab. If only one object class can be selected, the class will already be displayed in the Search For 
field and the filter cannot be defined. If object class stereotypes have been configured for your 
enterprise, the stereotypes will be displayed in the Search For field. However, if you select an 
object class stereotype for which no object has been defined on the root level of the object class 
stereotype hierarchy, then no results will be displayed in the Browse tab. For example, the object 
class Domain has the object class stereotypes 1) Area, 2) Sub-Area, and 3) Domain. If you select 
Sub-Area in the Search For field and no objects for the stereotype Area have been defined, a 
browse hierarchy cannot be displayed and thus no results will be displayed. 

2) Browse through the hierarchy to locate the object you want. Click  to expand the explorer and 

click  to collapse it. 

3) Click and hold on any object in the explorer to open a preview about the object. Click anywhere 
outside of the preview window to close it. 

4) Select an object and click the OK button. 

Conducting a Full-Text Search 

The Full-Text Search functionality allows you to execute a full-text search for specific terms for a search 
group configured by your solution designer. 

Search groups provide full-text search for the following scopes: 

• Globally-defined search groups provide a full-text search capability for a set of objects of defined 
object classes, such as applications and ICT objects or business processes and organizations. The 
Full-Text Search functionality available via the menu or a guide page or guide view provides 
search capabilities on basis of globally-defined search groups. 

• Object-centric search groups provide a full-text search capability for a set of objects that are 
related to the object you are currently working with. The Full-Text Search page view in the object 
profile of an object provides search capabilities on basis of object-centric search groups. The 
search for glossary terms in the Glossary functionality and in domain glossaries is also provided via 
an object-centric search group that finds glossary items from the selected glossary only. 

 

Search groups and the Alfabet queries that are executed for the search are configured by your 
solution designer in the configuration tool Alfabet Expand. For more information, see the section 
Configuring the Full-Text Search Capability in the reference manual Configuring Alfabet with 
Alfabet Expand. 

In order to execute a search based on a search group, a search index must first be created. Once the search 
index has been created, the index should be updated regularly to reflect changes made to the inventory. 
The search index must then be updated in regular intervals. For globally-defined search groups, this is done 
centrally by an administrator. If the message in the header for Group Info indicates that an index has not 
yet been created for the selected search group, please contact your user administrator. 
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For more information about the methods available for creation and update of the search index 
for globally-defined search groups, see the section Creating an Index for the Full-Text Search in 
the reference manual User and Solution Administration. 

For object-centric search, you can create and update the index directly on the Full-Text Search page 
view. The full-text search can be conducted in the primary language as well as in all secondary languages 
for which a culture has been configured by your the enterprise. If you create a search index for an object-
centric search index, an index file is created for the combination of the selected search group, the object 
you are currently working with and the current language setting for the Alfabet user interface. If you 
change to another object, another search group for the same object or another interface language setting, 
a new search index file is required for the search. After having selected a search group, you are informed 
via a text in the filter field whether a search index exists and when the last update was performed. It is rec-
ommended to update the search index for object-centric full-text search prior to searching for an object 
via a search string. 

Please note the following about the full-text search: 

• For performance reasons, the return set for any search is limited to 300 objects. If more than 300 
objects are found, the search criteria should be refined. Otherwise, the object(s) you are looking for 
may not be included in the return set. 

• You can use a number of operators to focus your search. For more information, see Full-Text 
Search Options and Operators below. 

• If you are searching for data in a secondary language, only values available in the current language 
are included into the search. For example if the search group provides a search in the name and 
description of objects of an object class and the object class is configured to provide no translation 
capability for the name of the objects, you cannot find objects by name in the full-text search of 
any secondary language. You will only find results in the translation if a translation into the 
language you are conducting the search for is currently provided for the description. If you are for 
example searching for a string in the name and description of an object, and the name of the 
objects is not translatable for the object class, the search will only find results in the descriptions 
for that a translation is provided. Nevertheless you will see the name of the object in the primary 
language in the search results if it is defined in the search group to be used as informational text to 
identify the object.  

 

For example if the name of applications is not translatable, but displayed in the search 
results of the full-text search, and an application is named TradingApp, you will not 
find the application if you are searching for the string "Trading". You may find the appli-
cation via a search string included into any searchable and translated property, like the 
description. It is then listed in the search results as TradingApp. 

To execute a full-text search: 

1) Define your search criteria at the top of the screen. You can narrow your search by using a 
combination of filters. The filters are described below:  

• Search Group: This field allows you to select a preconfigured search group.  

 
If you are executing a full-text search in a glossary in the Search module, the pre-
configured search group Glossary will be automatically displayed. 

• Group Info: Displays the date of the last update to the selected search group’s index. If you 
see a message stating that an index does not exist, then an index must first be created to 
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perform the search. If the last update has been performed a long time ago, the index shall be 
updated. Click the button Create Index to create or update the search group's index. If the 
button is not available, the search group is a globally-defined search group and the search 
index must be created or updated by an administrator. 

• Search for: Enter the search term for the search group. A wildcard may only be appended to 
the end of the search term. For more information about search options and operators, see the 
section Full-Text Search Options and Operators. 

• Fuzziness: Define the level of tolerance regarding the search pattern. A number between 0-10 
can be selected in the field to specify how many characters are allowed to potentially not 
match the search pattern. The higher the value, the more differences are tolerated. 

• Show As Data Set: Select if you want to see a table showing all results from the search. You 
can click a result in the table and hold to see a preview of the object. If you do not select the 
checkbox, you will see one result at a time in the page view area. You can then use the 
Previous and Next buttons to navigate forward or back to the relevant search result. 

2) After you have defined your search criteria, click Search. You will see the search results in page 
view area:  

• If you have not selected the Show as Data Set checkbox, you will see the first result found by 
the search. Each occurrence of the defined search criteria is highlighted. Click the 

Previous  and Next  buttons to navigate forward or back through the search results. 

• If you have enabled the Show as Data Set checkbox, you will see all search results in a table. 
Click a result in the table and hold to see a preview of the object. The text matching the search 
criteria is highlighted. 

• The results will be sorted according to the number of matches with the search criteria. 

 
If an index has not been created for the search group, a message will be displayed below 
the toolbar. 

3) To navigate to the object profile of an object found by the search: and :  

• If you have not selected the Show as Data Set checkbox, click the Previous  and 

Next  buttons to find to the object that you want to navigate to. When the object is 

displayed, click the Navigate  button in the toolbar. 

• If you have enabled the Show as Data Set checkbox, select an object in the table and click the 

Navigate  button in the toolbar.  

 If multiple objects are selected, the Navigate  button will be disabled. 
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Full-Text Search Options and Operators  

After an index has been created, you can use a number of operators to focus your search. Please take the 
following into consideration when defining a search term: 

• Use a backslash \: to escape special characters: + - && || ! () { } [ ] ^ " ~ * ? For example, to find the 
application named !TradeNet, you would enter \!TradeNet. 

• The full-text search is not case-sensitive. Capitalization will not influence your results. 

 
A search term must begin with an alphabetic character. A wildcard at the beginning of a search 
term is not valid (for example, *ptiRetail). 

The following search options are available for a full-text search: 

Search Option Op-
era-
tor 

Example Result 

single term  OptiRetail Returns all objects with OptiRetail in the queried search crite-
ria. 

phrase " " "OptiRetail 
Marketing" 

Indicates a phrase. Returns all objects with OptiRetail Market-
ing in the queried search criteria. 

multiple char-
acter wildcard 
search 

* OptiRetail* Returns all objects that begin with OptiRetail. For example, re-
sults could include OptiRetail and OptiRetailing.  

 A wildcard may only be appended in the middle or the 
end of the search term. Wildcards positioned at the beginning 
of the search term are not valid for the full-text search. 

positive terms + +TradeNet 
+OptiRetail 

Indicates words that must be contained in the search results. 

All search results must contain OptiRetail and TradeNet. 

negative terms - -TradeNet 
OptiRetail 

Indicates words that may not be contained in the search re-
sults. 

All search results may contain OptiRetail and must not contain 
TradeNet. 
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Searching an Enterprise Glossary via the Full-Text Search Capabil-
ity 

The Glossary functionality allows you to create and structure a glossary for the enterprise and define glos-
sary items for it. Each glossary item has a name and glossary definition. Users can then execute a full-text 
search for terms in a glossary. 

 

In order to implement the Glossary functionality, the following is required: 

• A search group must be configured in the configuration tool Alfabet Expand. For more 
information about the configuration required, see the section Configuring the Full-Text 
Search Capability in the reference manual Configuring Alfabet with Alfabet Expand. 

• An index must first be created by a solution administrator in the Full-Text Search 
functionality accessible via the Admin user profile. Once an index is created, the index 
should be updated regularly to reflect changes made to the inventory. For more 
information, see Creating an Index for the Full-Text Search in the reference manual 
User and Solution Administration. 

• Once the glossary has been defined and the index has been created by an administrator 
in your enterprise, the glossary can searched in the Full-Text Search capability. For 
more information, see the section Conducting a Full-Text Search in the reference 
manual Getting Started with Alfabet. 

 

 
The Domain Glossary Page View provides another glossary functionality in the context of Domain 
Management. A domain glossary allows users to define domain-specific terminology for objects 
assigned to a selected domain. The domain glossary can be created and searched ONLY in the 
Domain Glossary Page View in the Domain object profile. 

The Glossary Manager explorer displays the object class Glossary . This explorer allows you to create 
and structure a glossary and define glossary items for it. You can create an unlimited number of glossaries 
and then structure them and fill them with glossary items. To create a glossary: 

1) Click the Glossary Manager icon at the top of the explorer. 

2) In the toolbar, click New > Create New Glossary. The Glossary editor opens. 

3) Enter a name and, if necessary, brief description of the glossary and click OK to save the glossary 
or Cancel to exit without saving. 

The following information is available: 

• Defining Glossary Items for the Glossary 

• Organizing the Glossary Items in Glossary Folders 

Defining Glossary Items for the Glossary 

A glossary item allows you to define a glossary entry. Each glossary item has a name and definition that can 
later be searched by means of a full-text search. You can define an unlimited number of glossary items for 
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the glossary. Glossary items can be assigned directly to a selected glossary or to a glossary folder defined 
for a glossary. A glossary item may only be assigned to one glossary. 

To define a glossary item for a glossary or glossary folder: 

1) In the Glossary Manager explorer, click the glossary or folder that you want to assign the glossary 
item to. 

2) In the glossary’s or glossary folder’s object profile, go to the Structure workspace and click 
Glossary Items. 

3) In the toolbar, click New > Create New Item. The Glossary Item editor opens with the following 
fields:  

• Name: Enter a unique name for the glossary entry. 

• Description: Enter text defining or explaining the meaning or purpose of the glossary item. 
Users will be able to search the name and text entered in the description field by means of a 
full-text search. 

4) Click OK to save the glossary item. 

Organizing the Glossary Items in Glossary Folders 

In the Glossary Folders page view, you can create and edit glossary folders for a glossary or for a glossary 
folder of a glossary. You can create an unlimited number of folders and sub-folders to structure glossary 
items assigned to a glossary. 

To create a glossary folder: 

1) In the Glossary Manager explorer, click the glossary or glossary folder that you want to define a 
folder or sub-folder for. 

2) In the glossary’s or glossary folder’s object profile, go to the Structure workspace and click 
Glossary Folders. 

3) In the toolbar, click New > Create New Sub-Folder. The Glossary Folder dialog box opens with 
the following fields:  

• Name: Enter a unique name for the glossary folder. 

• Description: Enter text defining or explaining the meaning or purpose of the glossary folder. 

4) Click OK to save the glossary folder. 

 

To move a glossary folder assigned to the selected folder or glossary, click the folder in the table 
and select New < Move Existing Folder Here. 
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Chapter 6:  Managing Your Objects and Object Responsibilities 

In Alfabet, most objects are assigned to an authorized user, user group, or organization that is held ac-
countable for the object or specific aspects of the object. 

 
The Personal Info functionality will be disabled in the Alfabet user interface for users logged in 
as anonymous users. 

The Personal Info functionality provides you with an overview of the following: 

• the objects that you are the authorized user of 

• the objects that you have been assigned a deputy responsibility for 

• the objects for which you have a role assigned 

• the workflow steps that you are responsible for 

• a schedule of your availability and planned absences in the enterprise 

• the users who should act as a proxy in your absence and who will be responsible for your objects, 
assignments, and workflows when you are unavailable. 

 
A detailed description of access permissions in Alfabet is described in the section Understanding 
Access Permissions in Alfabet. 

The following information is available about managing your objects and object responsibilities: 

• Viewing and Editing the User and Deputy Information for Your Objects 

• Viewing and Reassigning Your Role Objects 

• Viewing and Reassigning a Your Workflow Steps 

• Defining Your Availability and Planned Absences 

• Defining Proxies for Your Assignments and Workflow Steps 

• Defining a General Proxy to Manage All Workflow Steps and Assignments 

• Defining a Proxy to Manage Your Assignments 

• Defining a Proxy to Manage Your Workflow Steps 

Viewing and Editing the User and Deputy Information for Your Ob-
jects 

In Alfabet, most objects are assigned to a user, user group, or organization that is held accountable for an 
object or specific aspects of an object. In the Authorized User Objects page view you can view all objects 
that you are the authorized user for and thus have the primary responsibility for. Additionally, you can de-
fine one or more deputies to act on your behalf for any objects displayed in the table. 
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Please note that the LAST_UPDATE_USER and LASTUPDATE properties are only updated in the 
Alfabet database when changes are made via the User editor. Changes made in the Authorized 
User Objects page view are NOT updated in the LAST_UPDATE_USER and LASTUPDATE proper-
ties. For more information about the history tracking capability, see the section Viewing the 
Change History of an Object. 

1) In the Personal Info functionality, Click Authorized User Objects.. 

2) You can assign a new authorized user, authorized user group, or deputy to an individual object that 
you select in the table. In the Select Class field, select the object class whose objects you want to 
define and click Update.  

• To add a deputy to an object, select the object in the table and click Edit > Set Deputy for 
Selected Object(s). Although multiple deputies can be assigned to an object, you can only 
define one deputy at a time. 

• To change the deputy for an object, select the object in the table and click Edit > Substitute 
Deputy for Selected Object(s). 

• To remove all deputies from an object, select the object in the table and click Edit > Remove 
Deputies for Selected Object(s). 

• To assign a new authorized user to an object, select the object in the table and click Edit > 
Substitute Authorized Access for Selected Object(s). 

• To change the authorized user or authorized user group for an object, select the object in the 
table and click Edit > Change Authorized Access for Selected Object. 

• To assign an authorized user group to an object, select the object in the table and click Edit > 
Add User Groups to Selected Object(s). 

• To make any of the changes above to all objects displayed in the view, select the respective 
option in the Edit menu targeting all objects. 

Viewing and Reassigning Your Role Objects 

A role defines the functional relationship or responsibility that a user or organization has to an object. A role 
is based upon a configured role type that is configured for an object class. Roles are defined for informa-
tional purposes only and provide detail about users or organizations that may have information about or a 
stake in the object. The definition of a role for an object does not impact access permissions. 

In the Role Objects page view, you can view all objects for which a selected user has a role assigned. Addi-
tionally, you can remove a role object from a selected user and reassign it to another user. A user can be 
assigned a functional role for an object in the Responsibilities Page View for the relevant object. 

1) Navigate to the Personal Info functionality and click Role Objects. 

2) In the Select Class field, select the class of objects in the drop-down list that you want to display 
in the table and click Update. 

3) The following options are available:  

• To change the role for an object, select the object in the table and click Edit > Substitute 
Responsibility for Selected Object(s). 
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• To remove all roles from an object, select the object in the table and click Edit > Remove 
Responsibility for Selected Object(s). 

• To make any of the changes above to all objects displayed in the view, select the respective 
option in the Edit menu targeting all objects. 

 
For more detailed information about access permissions in Alfabet, see the section Understand-
ing Access Permissions in Alfabet in the reference manual Getting Started with Alfabet. 

Viewing and Reassigning a Your Workflow Steps 

The User’s Workflow Activities page view displays all workflow steps that you are responsible for. You can 
reassign individual workflow steps to another user. The following columns are displayed in the view: 

• Workflow: Displays the name of the workflow that the workflow step belongs to. 

• Workflow ID: Displays the identification number of the workflow that is being processed. 

• Object Name: Displays the name of the object that is being processed in the workflow step. 

• Object ID: Displays the identification number of the object that is being processed in the current 
workflow step. 

• Active Step: Displays the name of the workflow step that is currently being performed in the 
workflow. 

• Step ID: Displays the identification number of the workflow step that is being processed. 

• Previous Step: Displays the name of the workflow step that was performed prior to the current 
workflow step. 

• Enter Date: Displays the timestamp showing when the workflow advanced to the current 
workflow step. 

• Remaining Days: If a deadline has been configured, displays the number of days left before the 
workflow step expires. 

• Ready: Displays a checkmark if the current workflow step has been performed and is ready to be 
confirmed and completed. 

• Locked By. Displays the name of the user who is currently working on the workflow step. 

• Current Step Comments: Displays a checkmark if a comment has been made for the current 

workflow step. To access the comment, select the workflow step, click the Navigate  button 
and click Active Step Activities to view the comments in the Message column. 

• Previous Step Comments: Displays a checkmark if a comment has been made for the previous 

workflow step. To access the comment, select the workflow step, click the Navigate  button 
and click Activities of Preceding Steps to view the comments in the Message column. 

1) In the Personal Info functionality, click User’s Workflow Activities. 

2) Select the workflow step that you want to delegate. 
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3) In the My Workflow Activities view, click the Delegate  button. 

4) In the person selector, select the person you want to reassign the responsibility of the workflow 
step to and click OK. The Delegate Workflow Step editor opens. 

5) Define the following fields, as needed:  

• Substitute All Current Workflow Step Owners: Select if all users currently responsible for 
the selected workflow step should be replaced by the user(s) that the workflow step is being 
delegated to. 

• Revoke Responsibility from Current User: Select this checkbox if you want to remove 
yourself as a user responsible for the workflow step that is being delegated. Clear this 
checkbox if you to include yourself as a user responsible for the workflow step that is being 
delegated. 

• Comment: Provide an explanation about why the workflow is being delegated to another user. 
The explanation will be displayed in the Message column of the Workflow Step Event Trace 
page view. 

• Delegates: Click the Add Person button to select one or more persons to delegate the 
workflow step to. 

6) Click OK to save your changes. The responsible user will find the workflow step in the Workflow 
Activities Explorer or My Workflow Activities view. 

Defining Your Availability and Planned Absences 

Many tasks in Alfabet must be completed by a specified deadline. Therefore, it is recommended that you 
document the times that you are available as well as the times that you plan to be absent in the User's 
Availability page view. 

The proxy user(s) that you define in the User’s Proxies Page View will be responsible for the assignments or 
workflow steps during your absences. The proxy can then access your assignments in his/her My Assign-
ments functionality and your workflow steps in his/her My Workflow Activities functionality. The User's 
Availability page view lists all periods of availability and absence that have already been defined for you. 
The following information is available: 

• Start Date: Displays the start date of the entry. 

• End Date: Displays the end date of the entry. 

• Absent: Displays a checkmark if you will be absent during this period. A checkmark is not displayed 
if you will be available during this period. 

• Description: Displays a comment about the entry. 

 

It is also possible for your user administrator to document your availability and planned ab-
sences as well a define proxies for your assignments or workflow steps. 

To define a period of availability or absence: 

1) Navigate to the Personal Info functionality and click User's Availability. 

2) In the toolbar, click New > New Availability Entry in the toolbar. 
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3) Enter information in the following fields, as needed.  

Basic Data tab: 

• Start Date: Enter a start date for the entry. 

• End Date: Enter an end date for the entry. 

• Availability Type: Select a type of availability/absence in the drop-down list.  

 

The values available for the Availability Type property are preconfigured in the 
configuration tool Alfabet Expand. For more information, see the section Overview 
of Protected Enumerations in the reference manual Configuring Alfabet with 
Alfabet Expand - Appendix. 

• Absent: Select the checkbox if the definition specifies a period of absence. Leave the 
checkbox blank if the definition specifies a period of availability. 

• Description: Enter a meaningful description that will clarify the entry. 

4) Click OK to close the editor and save your data. 

Defining Proxies for Your Assignments and Workflow Steps 

Many tasks in Alfabet must be completed by a specified deadline. Therefore, it is recommended that you 
specify alternate persons to take care of your responsibilities in case of a planned absence. You can define 
proxies to be responsible for assignments associated with objects of a specific object class as well as work-
flow steps generated in the context of a specific workflow template. Additionally, you can define a general 
proxy to be responsible for all of your workflow steps or assignments. 

During the times that you are absent as specified in the User’s Availability Page View, each proxy user you 
have defined will have the necessary access permissions to the assignments or workflow steps that he/she 
is responsible for via the proxy assignment. Your assignments will be accessible in the proxy’s My Assign-
ments view and your workflow steps will be accessible in the proxy’s My Workflow Activities view. 

 

Your planned absences and general availability must be documented in the User’s Availability 
Page View. 

 

 
Email notifications will continue to be sent to the original user if the email notification capability 
has been implemented for the relevant workflow templates. Please note that the proxy user will 
NOT receive email notifications. A notification monitor can be configured to notify the proxy 
about the workflow step. For more information, see the section Defining Notification Monitors in 
the reference manual User and Solution Administration. 

The User's Proxies page view lists all proxies that have been defined to cover your responsibilities during 
your planned absences. 

• Category: Displays Assignments if the proxy is responsible for assignments, Workflows if the 
proxy is responsible for workflow steps, or General if the proxy is responsible for all of 
assignments and workflow steps. 

• Sub-Category: This column may display either of the following:  
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• Displays the object classes for which the proxy has access permissions in the case of 
assignments. The proxy will only be responsible for assignments targeting objects in the 
specified object classes. 

• Displays the workflow template owning the workflow steps for which the proxy has access 
permissions. The proxy will only be responsible for workflow steps based on the selected 
workflow templates. 

• First Name: The proxy’s first name. 

• Name: The proxy’s family name. 

The following is possible in the User's Proxies page view: 

• Defining a General Proxy to Manage All Workflow Steps and Assignments 

• Defining a Proxy to Manage Your Assignments 

• Defining a Proxy to Manage Your Workflow Steps 

Defining a General Proxy to Manage All Workflow Steps and Assignments 

You can define a general proxy who will be responsible for all workflow steps and assignments that you are 
responsible for. You should only assign one user as a general proxy. 

To define a general proxy: 

1) Navigate to the Personal Info functionality and click User's Proxies. 

2) In the toolbar, click the Add General Proxy button in the toolbar. The Proxy Definition editor 
opens. 

3) In the editor that opens, select the user in the Proxy field. 

4) Click OK to close the editor and save your data. 

Defining a Proxy to Manage Your Assignments 

Because assignments must be completed by a specified deadline, it is recommended that you specify alter-
nate persons to take care of your assignments in case of a planned absence. You can define proxies to be 
responsible for assignments targeting objects for a specific object class. You should not assign more than 
one user per object class. 

During the times that you are absent as specified in the User’s Availability page view, each proxy user you 
have defined will have the necessary access permissions to the assignments that he/she is responsible for 
via the proxy definition. The assignments will be accessible in the proxy’s My Assignments view. 

 

Your planned absences and general availability must be documented in the User’s Availability 
Page View. 

 

 
Email notifications will continue to be sent to the original user. Please note that the proxy user 
will NOT receive email notifications. A notification monitor can be configured to notify the proxy 
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about the workflow step. For more information, see the section Defining Notification Monitors in 
the reference manual User and Solution Administration. 

To define a proxy for your assignments: 

1) Navigate to the Personal Info functionality and click User’s Proxies. 

2) In the toolbar, click the Add Assignments Proxy button. The Proxy Definition editor opens. 

3) In the editor that opens, select a user in the Proxy field. 

4) In the Sub-Categories field, select the object class that the assignments are based on that is 
relevant for the selected person. This person will only be authorized to view and access 
assignments that are created for objects in the selected object class(es). 

5) Click OK to close the editor and save your data. 

Defining a Proxy to Manage Your Workflow Steps 

Because workflow steps must be completed by a specified deadline, it is recommended that you specify 
alternate persons to take care of your responsibilities in case of a planned absence. The User’s Proxies 
page view allows you to define proxies to be responsible for workflow steps generated in the context of a 
specific workflow template. In this way, you can assign the appropriate person for each workflow context. 
You should not assign more than one user per workflow template. 

During the times that you are absent as specified in the User's Availability Page View, each proxy user you 
have defined will have the necessary access permissions to the workflow steps that he/she is responsible 
for via the proxy assignment. Your workflow steps will be accessible in the proxy’s My Workflow Activities 
views as well as the Associated Workflows page view for the relevant object. 

 
Email notifications will continue to be sent to the original user if the email notification capability 
has been implemented for the relevant workflow templates. Please note that the proxy user will 
NOT receive email notifications. A notification monitor can be configured to notify the proxy 
about the workflow step. For more information, see the section Defining Notification Monitors in 
the reference manual User and Solution Administration. 

To define a proxy for your workflow steps: 

1) Navigate to the Personal Info functionality and open the User’s Proxies page view. 

2) In the toolbar, click the Add Workflows Proxy  button. The Proxy Definition editor opens. 

3) In the editor that opens, you will see your user name in the Person field. In the Proxy field, select 
the user that you want to assign the responsibility to. 

4) You will see Workflows selected in the Category field. In the Sub-Categories field, select the 
workflow template that the workflows are based on that is relevant for the selected proxy. The 
proxy will only be authorized to view and access workflows steps that are generated in context of 
the selected workflow template(s). 

5) Click OK to close the editor and save your data. 
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Chapter 7:  Managing Your Calendar, Tasks, and Timesheets 

Alfabet allows you to create personal calendars with blockout days that represent weekends, holidays, etc. 
so that you can track the hours worked on tasks that have been defined to you via skill requests for objects 
such as projects, applications, operational business supports, tactical business supports, strategic business 
supports, components, standard platforms, devices, deployments, and service products. 

 

Enterprise calendars are configured in the Enterprise Calendars functionality. For more infor-
mation about configuring enterprise calendars for the user community, see the chapter Config-
uring Enterprise Calendars for the User Community in the reference manual Configuring Evalua-
tion and Reference Data in Alfabet. 

The following information is available: 

• Creating Your Personal Calendar 

• Managing Your Tasks and Tracking Time 

• Submitting Timesheets of Time Worked On Your Tasks 

• Approving the Timesheets That You Are Responsible For 

• Managing Your Submitted Timesheets 

Creating Your Personal Calendar 

The My Calendars functionality allows you to define one calendar per calendar year. You can base your 
calendar on an enterprise calendar that has been defined and made available by your enterprise. The enter-
prise calendar will typically include blockout days, which are the days that represent weekends and holi-
days relevant for your region. All blockout days defined for the enterprise calendar will be copied to your 
personal calendar. You can add additional blocked out days, as needed, or remove unnecessary ones. Re-
gardless of the definition of blockout days, you will be able to record hours for any calendar day in the My 
Tasks and Time Reporting functionality. 

To display your personal calendar created for a specific year, select the year in the Year field. To display all 
of your personal calendars regardless of the year that they were created for, select the empty row in the 
Year field. 

To create a personal calendar: 

1) In the toolbar, click New > Create New Calendar. The Create Personal Calendar editor opens. 

2) Define the following fields, as needed:  

• Select Year: Select the year that you want to create a personal calendar for. A year will not be 
displayed if a calendar has already been created for that year. 

• Select Enterprise Calendar: Select the enterprise calendar that you want to use as a 
template for your personal calendar. Only the enterprise calendars created for the year you are 
defining the calendar for will be displayed. All blockout days defined for the enterprise 
calendar will be copied to your personal calendar. Enterprise calendars are configured in the 
Enterprise Calendars functionality. For more information about configuring enterprise 
calendars for the user community, see the chapter Configuring Enterprise Calendars for the 
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User Community in the reference manual Configuring Evaluation and Reference Data in 
Alfabet. 

3) Click OK to save your changes. The new personal calendar is displayed in the table. 

4) You can now edit the blockout days, if necessary. To do so, select the calendar in the table and 
click Edit Blockout Days. The Calendar Content view opens displaying your personal calendar for 
the selected year. The days that are highlighted in the calendar represent days that have been 
blocked out. Select a day and click the Edit button to view more information about the blocked out 
day. 

5) You can define blockout days using any of the methods described below:  

• To define a specific day as a blockout day: Select a day in the calendar and click New > Create 
New Blockout Day. In the editor, revise the Start Date and End Date fields, if needed. Enter a 
name in the Name field and a description in the Description field and click OK. The blockout 
day is highlighted in the calendar. 

• To copy all blockout days defined from another existing enterprise calendar to the selected 
enterprise calendar: Click New > Copy Blockout Days from Another Calendar. The object 
selector displays all defined enterprise calendars for the same year that you are defining. 
Select the enterprise calendar that you want to copy to the selected calendar and click OK. 
Additional blockout days from the enterprise calendar will be copied to your personal calendar. 
The blockout days are highlighted in your personal calendar. 

• To blockout specific days of every week in your personal calendar: Click New > Block Out 
Specific Weekdays. In the editor, click each day that should be highlighted as a blockout day 
in your personal calendar. Define the Start Date and End Date fields and enter a name for the 
blocked out days in the Blockout Calendar Item Name field (for example: Weekend). The 
name you define will be displayed in a tooltip when the you point to the day in the calendar. 
Click OK to save your changes. 

• To edit the blockout day definition: Select the day in your personal calendar and click the 

Edit  button. You can edit the Start Date and End Date fields, change the name of the 
blockout calendar item in the Name field, or add comments about the blockout day in the 
Description field. Click OK to save your changes. 

• To remove the blockout day definition from a day in your personal calendar: Select the day in 

the calendar and click the Delete  button. Confirm the message by clicking Yes. The 
blockout day is no longer highlighted. 

• To remove all blockout day definitions from your personal calendar: Click New > Clear All 
Blockout Days. Confirm the message by clicking Yes. The blockout days are no longer 
highlighted. 

Managing Your Tasks and Tracking Time 

The My Tasks and Time Reporting functionality allows you to track the hours worked on tasks that have 
been defined to you via skill requests for objects such as projects, applications, operational business sup-
ports, tactical business supports, strategic business supports, components, standard platforms, devices, 
deployments, and service products. The hours are tracked in your personal calendar that you create in the 
My Calendars functionality. Regardless of the definition of blockout days in your calendar, you can record 
hours worked on your tasks for any calendar day. 
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The hours that you track for projects will be displayed in the Task Time Schedule page view 
that can be accessed via the Project Resource Planning Page View. The hours that you defined 
for tasks in this view can be submitted for approval in a timesheet in the My Time-Tracking En-
tries Functionality. 

Define the Start Date field and End Date field in order to display all tasks assigned to you beginning be-
tween the defined start and end date or ending before the defined start and end date will be displayed and 
click Update. The following columns are displayed: 

• Task. Displays the task defined for the skill request that needs to be worked on. 

• Start Date: Displays the start date of the task. 

• End Date: Displays the end date of the task. 

• Count: Displays the number of man days or persons requested for the task.  

 
Please note that if the Capacity Type = Head Count and the value in the Count column 
is greater than 1, you should contact the authorized user of the object in the Requested 
For column for clarification. 

• Capacity Type: Displays whether the value in the Count column refers to Head Count or Man 
Days. 

• Requested For: Displays the name of the project, application, operational business support, 
tactical business support, strategic business support, component, standard platform, device, 
deployment, or service product that is requiring the task. 

• Status: Displays the release status of the project or the object state of the architecture object 
displayed in the Requested For column. 

• Reported Hours: Displays the number of hours that you have worked on the task. 

You can document the hours that you have worked on a task displayed in the view. To define the hours 
worked on the tasks: 

1) Select the task for which you want to document the hours that you have worked on the task and 
click the Time Tracking button. 

2) In the Time Tracking editor, the following is possible to define the hours worked:  

• To define individual dates: Enter the individual hours worked in the respective field in the 
Hours column and define the Comments field, as needed. Do this for all dates that you want 
to document your hours for. 

• To define multiple dates simultaneously: Enter the number of hours that you want to assign to 
multiple dates in the Hours field in the header of the editor. You can also define a comment in 
the Comments field. Pressing the CTRL key, click the relevant dates in the Date field that you 
want to copy the hour value and comment value to and click the Copy to Selected Dates 
button.  

 
Regardless of the definition of blockout days in your calendar, you will be able to 
record hours for any calendar day. Please note however that you cannot modify a 
time-track entry that has been submitted in a timesheet and has the status Ap-
proved. These time-track entries will be displayed but cannot be edited. 
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3) Click the OK button to save the time tracking definition or click Cancel to exit without saving. 

Submitting Timesheets of Time Worked On Your Tasks 

The My Time-Tracking Entries functionality allows you to review and submit timesheets documenting the 
hours worked on tasks that have been defined to you via skill requests for objects such as projects, appli-
cations, operational business supports, tactical business supports, strategic business supports, compo-
nents, standard platforms, devices, deployments, and service products. In this view, you can modify the 
hours defined in the My Tasks and Time Reporting functionality as well as submit timesheets for approval. 
Each entry of hours for a task is considered a time-tracking entry. 

A time-tracking entry may only be submitted once for a given day/task. Multiple time-tracking entries may 
be bundled in a timesheet and submitted for approval. A timesheet may contain a one or more time-track-
ing entries. Please note the following: 

• Undefined time tracking entries may be defined at any time. An undefined time-tracking entry will 
have the status Entered. 

• Only time-tracking entries that are explicitly selected to be submitted will be included in a 
timesheet and sent for approval. A time-tracking entry that is submitted but not yet approved will 
have the status Submitted. 

• A time-tracking entry may be rejected by the responsible user. A rejected time-tracking entry will 
have the status Rejected. A rejected time-tracking entry may be redefined and resubmitted. 

• A time-track entry that has been submitted in a timesheet and has the status Approved cannot be 
modified. Time-track entries with the status Approved will be displayed in the Time Tracking 
editor but cannot be edited. 

• The timesheets will be available in the Timesheet Approval functionality of the person 
responsible to approve the hours worked for the object targeted by the task. 

• All timesheets that you have submitted will be displayed in the My Timesheets functionality. The 
view provides information about the status of each timesheet. 

 

The capability to process and approve timesheets can be adapted to the timesheet approval 
process required in your enterprise via additional solution configuration. To this end, custom 
properties and custom editors/wizards can be configured by your solution designer for the ob-
ject class Timesheet and workflows can be specified to ensure that your enterprise's regula-
tions are complied with and its processes for timesheet approval are correctly carried out. 

You can modify the hours worked and submit the time-track entries for the tasks displayed in the view. To 
specify which time-track entries are displayed in the view, define the following filter settings and click Up-
date: 

• Start Date: Select the start date of the period of time-track entries that you would like to display. 

• End Date: Select the end date of the period of time-track entries that you would like to display. 

• Statuses: Specify one or more statuses to display in the view. For example, to display all time-
track entries for the defined period that need to be processed, select the statuses Entered and 
Rejected. 

• Object. Select the object whose tasks you want to process. 
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The view displays all relevant tasks for which hours have been defined in the My Tasks and Time Report-
ing functionality. The following columns are displayed: 

• Task: Displays the name of the task associated with the object selected in the Object filter. 

• Object: Displays the name of the object and the object class in parenthesis () for which the task 
has been defined. 

• Date: Displays the date that the task was worked on. 

• Value: Displays the number of hours that the task was worked on for the corresponding date. 

• Status: Displays the status of the time-track entry. The status will only be set once the time-track 
entry has been bundled in a timesheet which has been submitted. 

• Submission Date. Displays the date that the time-track entry was submitted for approval via a 
timesheet. 

You can edit the hours for any non-approved time-tracking entry displayed in the view. To edit the hours 
worked on the tasks: 

1) Select the task for which you want to edit the hours that you have worked on the task and click the 
Time Tracking button 

2) In the Time Tracking editor, select the year that you want to define hours for in the Year field and 
select the month that you want to define hours for in the Month field. Only the months and years 
that fall within the task's start date and end date can be selected. Once you have defined the Year 
and Month fields, the Date column will be updated to include the specified time period.  

 
Regardless of the definition of blockout days in your calendar, you will be able to record 
hours for any calendar day. Please note however that you cannot modify a time-track 
entry that has been submitted in a timesheet and has the status Approved. These time-
track entries will be displayed but cannot be edited. 

3) You can now do one of the following to define the hours worked:  

• To define individual dates: Enter the individual hours worked in the respective field in the 
Hours column and define the Comments field, as needed. Do this for all dates that you want 
to document your hours for. 

• To define multiple dates simultaneously: Enter the number of hours that you want to assign to 
multiple dates in the Hours field in the header of the editor. You can also define a comment in 
the Comments field. Pressing the CTRL key, click the relevant dates in the Date field that you 
want to copy the hour value and comment value to and click the Copy to Selected Dates 
button. 

4) Click the OK button to save the time tracking definition or click Cancel to exit without saving. The 
Status column in the Time Tracking editor will display the value Entered once the time-track 
entry has been saved to the Alfabet database. 

You can submit a timesheet containing any of the time-track entries displayed in the view with the status 
Entered or Rejected. To submit the time-track entries for approval: 

1) Select one or more time-track entries with the status Entered or Rejected in the view and click 
New > Submit Selected, or click New and select one of the following:  

• Submit Current Week: Submit all days for which a time-track entry has been defined starting 
with the first day of the current week up to the current day. 
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• Submit Last Week: Submit all days for which a time-track entry has been defined starting 
with the first day of the last week up to the last day of the last week. 

• Submit Current Month: Submit all days for which a time-track entry has been defined 
starting with the first day of the current month up to the current day. 

• Submit Last Month: Submit all days for which a time-track entry has been defined starting 
with the first day of the last month up to the last day of the last month. 

2) The status Submitted will be displayed for all time-track entries that were submitted. The 
approval of the timesheet bundling the submitted time-track entries can be tracked in the My 
Timesheets functionality. 

Approving the Timesheets That You Are Responsible For 

The Timesheet Approval functionality allows you to approve or reject the timesheets that you are respon-
sible. 

 

The responsibility for timesheet approval will typically be configured by your enterprise. The ca-
pability to process and approve timesheets should be adapted to the timesheet approval pro-
cess required in your enterprise via additional solution configuration. To this end, custom prop-
erties, custom editors/wizards can be configured by your solution designer for the object class 
Timesheet and workflows should be specified to ensure that your enterprise's regulations are 
complied with and its processes for timesheet approval are correctly carried out. For more infor-
mation about the configuration of workflows, see the chapter in the reference manual Configur-
ing Alfabet with Alfabet Expand. 

To specify which timesheets are displayed in the view, define the following filter settings and click Update: 

• Start Date: Select the start date for the period of timesheets that you would like to display. 

• End Date: Select the end date for the period of timesheets that you would like to display. 

• Statuses: Specify one or more statuses to display in the view. For example, to display all 
timesheets for the defined period that may be approved/rejected, select the status Submitted. 

The dataset in the Timesheet Approval functionality is a grouped dataset with the timesheets displayed 
on the first level and their associated time-tracking entries displayed on the second level. The following in-
formation is displayed: 

• Name. Displays the name of the user who has submitted the task followed by the name of the 
object that the task is associated with. 

• Status: Displays the status of the timesheet. You can only approve or reject a timesheet that has 
the status Submitted. 

• Submission Date. Displays the date that the timesheet was submitted for approval. 

• Approval Date. Displays the date that the timesheet was approved. 

• Start Date: Displays the start date of the timesheet. This is equivalent to the start date of the first 
time-track entry bundled in the timesheet. 

• End Date: Displays the end date of the timesheet. This is equivalent to the end date of the last 
time-track entry bundled in the timesheet. 
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To approve a timesheet, select the timesheet in the view and click the Approve  button. To reject a 

timesheet, select the timesheet in the view and click the Reject  button. 

Managing Your Submitted Timesheets 

The My Timesheets functionality displays all timesheets that have been submitted by the user responsible 
for working on the tasks. This view provides information about the status of each timesheet and allows the 
user to keep track of the submitted and approved timesheets. To specify which timesheets are displayed in 
the view, define the following filter settings and click Update: 

• Start Date: Select the start date for the period of timesheets that you would like to display. 

• End Date: Select the end date for the period of timesheets that you would like to display. 

• Statuses: Specify one or more statuses to display in the view. For example, to display all 
timesheets for the defined period that have been rejected, select the status Rejected. 

The following information is displayed: 

• Status: Displays the status of the timesheet. 

• Submission Date. Displays the date that the timesheet was submitted for approval. 

• Approval Date. Displays the date that the timesheet was approved. 

• Start Date: Displays the start date of the timesheet. This is equivalent to the start date of the first 
time-track entry bundled in the timesheet. 

• End Date: Displays the end date of the timesheet. This is equivalent to the end date of the last 
time-track entry bundled in the timesheet. 
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Chapter 8:  Creating, Managing, and Accessing Your Bookmarks 

Alfabet provides a bookmark capability that allows you to save links that allow you to quickly navigate to 
the relevant object or view that you want to work with. The bookmark can point to a page view, object pro-
file (or object cockpit), report, or object selected in an explorer. 

 
Please keep the following in mind when defining and accessing bookmarks: 

• A bookmark created for an explorer is a reference to a position in an explorer. The 
explorer hierarchy is dynamically computed at runtime. If the structure of the explorer 
changes, the link may no longer be valid. For example, if new intermediary levels have 
been added to an explorer since the bookmark was created, the path saved for the 
bookmark will no longer be accurate and the bookmarked location may not be found. 

• Please note that some explorers and views cannot be bookmarked. For example, 
bookmarks cannot be created for functionalities used for administrative purposes that 
are available via an administrative user profile or configuration functionalities that are 
not associated with objects governed by access permissions. If the functionality or view 
may not be bookmarked, the Create Bookmark capability will be disabled. 

• The user profile that your are logged in with when you create the bookmark is the user 
profile used to initially open the bookmark. Thus, if a bookmark is shared with other users 
via a storyboard, for example, then those users accessing an Alfabet functionality via 
the dashboard will access the functionality with the user profile associated with the 
bookmark implemented in the storyboard. For more information about working with 
storyboards, see the chapter Working with Storyboards. 

• Creating a Bookmark 

• Accessing Your Bookmarks 

• Managing and Structuring Your Bookmarks in Bookmark Folders 

Creating a Bookmark  

You can create a bookmark for an object profile, object cockpit, page view, configured report, or an object 
selected in an explorer. Multiple bookmarks can be created for standard views, configured reports, object 
profiles, and object cockpits can be saved to bookmarks, thus allowing bookmarks to be created for stand-
ard views and configured reports with different filter settings. When a bookmark is created, a new menu 
item such as Bookmarks for Current Page View or Bookmarks for Current Report will be added to the 
Bookmark menu. All bookmarks created for the selected view will be added to the new menu item. 

Please note that some explorers and views cannot be bookmarked. For example, bookmarks cannot be cre-
ated for functionalities used for administrative purposes that are available via an administrative user profile 
or configuration functionalities that are not associated with objects governed by access permissions. If the 
functionality or view may not be bookmarked, the Create Bookmark capability will be disabled. 

 
Furthermore, you solution designer may configure that specific object profiles/object cockpits, 
page views, and configured reports may not be bookmarked. For more information, see the chap-
ter Configuring Object Views. 
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To create a bookmark and add it to your collection of bookmarks: 

1) Go to the location in Alfabet that you want to bookmark. 

2) In the toolbar in the upper-right corner of the user interface, click Bookmarks > Create 
Bookmark.  

 
If you are defining a bookmark to an explorer, you must first specify whether the book-
mark you are creating should point to the object selected in the explorer or the view that 
is currently open in the workspace area. Please keep the following in mind: 

• Select Create Bookmark to Target View to define a bookmark that links to the 
object profile (or object cockpit), page view, or configured report of the object 
currently selected in the explorer. When the user accesses the bookmark, the 
view will be displayed in the screen. Please note that if an object cockpit is 
defined, the bookmark link will open the object cockpit rather than the object 
profile. If no object cockpit is defined, the bookmark link will open the object 
profile. 

• Select Create Bookmark to Target Explorer to define a bookmark that links to 
the selected object in the explorer. When the user accesses the bookmark, the 
explorer will be expanded and the selected explorer node will be highlighted. 
The object profile for the object selected in the explorer will be displayed in the 
workspace area.  

 
A bookmark created for an explorer is a reference to a position in 
an explorer tree. The explorer is dynamically computed at 
runtime. If the structure of the tree changes, the link may no 
longer be valid. For example, if new intermediary levels have been 
added to an explorer since the bookmark was created, the path 
saved for the bookmark will no longer be accurate and the book-
marked location may not be found. 

 

3) Define the following fields, as needed:  

• Bookmark Name: Enter a unique name of the bookmark. If you are creating multiple 
bookmarks with different filter settings for a view, the bookmark name should help the user 
understand the data that is displayed in the view. 

• Bookmark Description: Enter a meaningful description that will clarify the purpose of the 
bookmark. The text you define in the description field will be displayed as a tooltip for the 
bookmark icon in the desktop. 

• Create in Bookmark Folder: Select the bookmark folder where you want to store the 
bookmark. The bookmark will be available in its bookmark folder in the Bookmark > 
Bookmarks menu as well as in the Bookmark Desktop functionality. If you do not select a 
folder, the bookmark will be available directly on the highest level of the bookmark folder 
hierarchy. The bookmark can be assigned to a bookmark folder at any time. Bookmark folders 
are create in the Bookmark Desktop functionality. To create a folder structure for your 
bookmarks, see the section Managing and Structuring Your Bookmarks in Bookmark Folders. 

4) Click OK to save the bookmark. The bookmark is saved to the Bookmark > Bookmarks menu as 
well as in the Bookmark Desktop functionality. 
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Accessing Your Bookmarks 

Your bookmarks may be available in the Bookmark > Bookmarks menu as well as the Bookmark Desktop 
functionality. The availability of the Bookmarks menu is specified by your solution designer. For more in-
formation, see the section Making the Bookmarks Menu Available to the User Community in the reference 
manual Configuring Alfabet with Alfabet Expand. 

To open access a bookmark and navigate to the targeted views: 

• In the main toolbar in the Alfabet user interface, click Bookmark > Bookmarks and click the 
bookmark that you want to open. Please consider the following:  

• An arrow may be displayed next to each bookmark folder containing subordinate bookmarks 
and folders. The bookmarks are listed in alphabetical order. 

• Multiple bookmarks may be created for an object in an explorer or a standard view, configured 
report, object profile, or object cockpit. This allows you to create bookmarks with different 
filter settings for standard views and configured reports. When a bookmark is created, a sub-
menu may display either Bookmarks for Current Object, Bookmarks for Current Page 
View, Bookmarks for Current Report, Bookmarks for Current Object Cockpit, or 
Bookmarks for Current Object Profile, depending on the view that is open in the user 
interface. All bookmarks available for the current object or view will be displayed in the sub-
menu. 

• The display of the bookmark folder hierarchy as well as the sub-menus such as Bookmarks 
for Current Object, etc. in the Bookmark menu is configured in the GUI scheme settings 
available for your user profile. For more information, see the section Configuring GUI Scheme 
Definitions for the Alfabet Interface in the reference manual Configuring Alfabet with Alfabet 
Expand. 

• In the main toolbar in the Alfabet user interface, click Bookmark > Show Bookmark Desktop. In 

the Bookmark Desktop functionality, click the bookmark and click the Navigate  button. 

Managing and Structuring Your Bookmarks in Bookmark Folders  

The Bookmark Desktop allows you to organize and structure your bookmarks so that you can easily and 
efficiently access the objects and views that you regularly work with. 

When you create the view, you can define a name and provide descriptive text that provides essential infor-
mation about the bookmark. The bookmark will be saved to the Bookmark Desktop. You will find all of your 
bookmarks in the Bookmark Desktop, where you can organize and structure your bookmarks in folders. 
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 FIGURE: Bookmark icons are displayed in the Bookmark Desktop functionality 

To open the Bookmark Desktop, click the  button and select Show Bookmarks 
in the Alfabet toolbar. The Bookmarks explorer displays the hierarchy of bookmark folders and sub-folders. 
Click the Bookmarks root node to display the bookmark folders at the top level of the hierarchy or click any 
folder in the explorer to display its contents. 

To switch between a desktop view with icons of the bookmarks and a table listing the bookmarks: 

• Select View > As Icons to display the bookmarks as icons on the desktop. Point the mouse to a 
bookmark to display its description in a tooltip. 

• Select View > As List to display the bookmarks in a table structure. The following columns will be 
displayed in the table:  

• Bookmark/Folder Name: Displays the name of the bookmark or bookmark folder. 

• Type: Displays the technical type of view that the bookmark points to. You may see any of the 
following:  

• GraphicView: This is a bookmark that references a standard page view. 

• Report: This is a bookmark that references a configured report. 

• ObjectView: This is a bookmark that references an object profile. 

• Explorer: This is a bookmark that references an object within an explorer. 

• Creation Date: Displays the date that the bookmark was created. 
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• Description: Displays the comment defined about the bookmark. 

 
You can define a default view for the Bookmark Desktop in your user settings. There you can 
specify whether the bookmarks and bookmark folders are displayed as icons or in a table. For 
more information, see the section Defining Your User Settings in Alfabet. 

You can create bookmark folders in which you can structure and organize your bookmarks in the Book-
mark Desktop. The bookmark folders will be added to the Bookmarks explorer. When you click a bookmark 
folder in the explorer, you will see the bookmarks listed in the table or displayed as icons on the desktop. A 
bookmark may only be assigned to one folder. 

• To create a bookmark folder, click New > Create New Bookmark Folder and enter a name and 
description for the bookmark The description will be displayed as a tooltip when you mouse-over 
the bookmark folder icon in the desktop. 

• To assign a bookmark to a bookmark folder, select the bookmark and click Restructure > Cut and 
click the folder in the explorer you want to add it to and click Restructure > Paste. A bookmark 
can only be assigned to one folder. 

• To open the view targeted by the bookmark, click the bookmark and click the 

Navigate  button. 

• To understand if a bookmark is implemented in a storyboard, select the bookmark and click Show 
Bookmark Usage. A message will be displayed listing the storyboards that the bookmark is 
assigned to. 

• To edit an existing bookmark folder, select the bookmark folder and click the Edit  button. You 
will see the editor in which you can edit the object. 

• To delete an existing bookmark folder, select the bookmark folder and click the Delete  button. 
The bookmark folder will be irrevocably deleted from the database. Any bookmarks assigned to the 
deleted bookmark folder will be returned to the top node of the Bookmarks explorer and can be 
reassigned to another bookmark folder, as needed. You can only delete one bookmark at a time. 
Multiple selection and deletion is not supported in the Bookmark Desktop. 

 
Please keep the following in mind when defining and accessing bookmarks: 

• A bookmark created for an explorer is a reference to a position in an explorer. The 
explorer hierarchy is dynamically computed at runtime. If the structure of the explorer 
changes, the link may no longer be valid. For example, if new intermediary levels have 
been added to an explorer since the bookmark was created, the path saved for the 
bookmark will no longer be accurate and the bookmarked location may not be found. 

• Please note that some explorers and views cannot be bookmarked. For example, 
bookmarks cannot be created for functionalities used for administrative purposes that 
are available via an administrative user profile or configuration functionalities that are 
not associated with objects governed by access permissions. If the functionality or view 
may not be bookmarked, the Create Bookmark capability will be disabled. 

• The user profile that your are logged in with when you create the bookmark is the user 
profile used to initially open the bookmark. Thus, if a bookmark is shared with other users 
via a storyboard, for example, then those users accessing an Alfabet functionality via 
the dashboard will access the functionality with the user profile associated with the 
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bookmark implemented in the storyboard. For more information about working with 
storyboards, see the chapter Working with Storyboards. 
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Chapter 9:  Communicating and Collaborating with Your Col-
leagues in Alfabet  

A variety of functionalities are available in Alfabet that allow you to communicate with your colleagues 
about the objects in your inventory. 

• Interoperability with Skype for Business Server® is available in order to support video calls and 
video chats between users in the Alfabet user community. If interoperability with Skype for 
Business Server® is configured for your enterprise and Skype is permissible for a user, a Skype 
icon will be displayed next to the user's name in the Attributes section of object profiles/object 
cockpits as well as previews, allowing the user to contact the authorized user of an object should 
questions arise. 

• An express view allows you to share the most up-to-date information about your enterprise 
architecture with colleagues who may or may not be part of the user community, thus supporting 
communication among those people in your enterprise for whom the Alfabet data is most relevant. 
An express view is a link to a specific Alfabet view or explorer displaying data that allows 
individuals inside or outside of the Alfabetuser community to view Alfabet information. When the 
express view is created, an email notification is automatically mailed to the specified recipient who 
receives a URL that allows him/her to access the current page view in Alfabet. 

• A collaboration capability is available that supports a free-form exchange of information and ideas 
about objects or views in Alfabet by members of the user community. The capability supports the 
exchange of user-generated content as is common in social media. A collaboration topic can be 
created for an object in an object profile/object cockpit or a specific page view and all invited users 
can add a post to the collaboration topic. 

• The collaboration capability can optionally be configured to integrate with Microsoft Teams. 
Depending on the configuration, an Alfabet user can open a predefined Microsoft Teams channel 
or create a new Microsoft Teams channel for an Alfabet object in the Collaboration Panel in the 
object profile of the relevant object and specify the initial set of users that may collaborate about 
the object. Additional users with a Microsoft Teams ID can be added to the discussion at any time 
with the Microsoft Teams client. Posts about the object that are made in Alfabet will be displayed 
in Microsoft Teams and likewise posts made in Microsoft Teams about the Alfabet object will be 
displayed in the Collaboration Panel in the object profile of the relevant object. In this way, users 
can reply to each other's posts from both Microsoft Teams and the Alfabet user interface.  

Furthermore, the online status of an Alfabet user with Microsoft Teams ID will be displayed next to 
the user's name in the Attributes section of previews, object profiles, and object cockpits. Users 
can click the online status icon and open the Microsoft Teams chat. Please note that it is not possi-
ble to configure both integration with Microsoft Teams and Skype in parallel. 

• A discussion functionality supports collaborative discussions about objects in the enterprise. A 
discussion can be initiated for a selected object by an authorized user who is responsible for the 
object. Any user that has been configured to be a participant in a discussion group may contribute 
to a discussion. All users with authorized access to the object as well as members of the managing 
discussion group and invited discussion groups may contribute to and track the ongoing 
discussion about the object. Discussion participants may add comments, define the status of the 
discussion, and trigger email notification for other discussion participants informing them about 
the contribution. 

The following information is available: 

• Skyping with Your Colleagues 
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• Sending and Receiving Express Views 

• Communicating with Your Colleagues via the Alfabet Internal Collaboration Functionality 

• Creating a Collaboration Topic 

• Accessing and Participating in the Collaboration Topics You Have Been Invited To 

• Posting a Message to a Collaboration Topic 

• Defining a Bookmark for a Collaboration Topic 

• Attaching a Document to a Collaboration Topic 

• Inviting Users to Participate in a Collaboration Topic 

• Exporting the Collaboration Topic as an HTML File 

• Communicating with Your Colleagues Using Integration with Microsoft Teams 

• Initiating Microsoft Teams Integration 

• Contacting a Single User via Microsoft Teams Chat 

• Discussing with Colleagues About an Object in Alfabet and Microsoft Teams 

• Accessing the Collaboration Panel in Alfabet 

• Starting a New Teams Channel for an Object in Alfabet 

• Contributing to an Existing Chat in Alfabet 

• Inviting Users to Participate in a Chat 

• Opening the Chat in Microsoft Teams from the Collaboration Panel 

• Viewing and Accessing All Microsoft Teams Chats You are Involved in 

• Adding a Link to a Document in Microsoft Teams to an Object 

• Ending a Chat 

• Managing and Scheduling Microsoft Teams Meetings in Alfabet 

• Scheduling a Microsoft Teams Meeting about an Object 

• Importing a Microsoft Teams Meeting 

• Initiating, Contributing to, and Managing a Discussion About Objects 

• Understanding the Discussion Process 

• Initiating a Discussion about an Object 

• Managing and Contributing to the Discussion 

• Inviting Other Discussion Groups to Join the Discussion 

• Contributing to the Discussion 

• Editing the Object Under Discussion 
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• Closing the Discussion for a Discussion Group 

Skyping with Your Colleagues 

Interoperability with Skype for Business Server® is available in order to support video calls and video chats 
between users in the Alfabet user community, thus allowing a user to contact the authorized user of an ob-
ject from within Alfabet should questions arise. 

If interoperability with Skype for Business Server® is configured for your enterprise and Skype is permissi-
ble for a user, a Skype status symbol will be displayed next to the user's name in the Attributes section of 
object profiles/object cockpits as well as previews indicating their current Skype status. The user can click 
the Skype status icon to open the Skype screen, allowing the user to contact the authorized user of an ob-
ject should questions arise. 

You may see any of the following symbols: 

 Available  Appear Offline 

 Busy  Idle Busy 

 Do Not Disturb  Idle Online 

 Be Right Back  No Skype Connection. Click to open Skype. 

 Appear Away  Skype Unknown 

The following is required in order to use the Skype capability in the context of the Alfabet user interface: 

• Integration with Microsoft Teams must not be configured for Alfabet. Integration with Microsoft 
Teams supersedes integration with Skype and your Skype integration configuration will be ignored 
if an active Microsoft Teams integration configuration is available. 

• Integration with Skype for Business Server must be configured for your enterprise. For more 
information, see the section Configuring Interoperability with Skype for Business Server® in the 
reference manual API Integration with Third-Party Components. 

• The Skype ID and Skype domain must be defined for the user. This can be defined via the Personal 
Info option in the < Alfabet User > menu or by a user administrator in the Users Administration 
functionality. For more information about specifying your user information via the Personal Info 
option, see the section Defining Your User Information. For more information, see the section 
Creating a User in the reference manual User and Solution Administration. 

• Please note that the contact status must be selected to be displayed for the user in the Contacts 
List section of the Skype for Business - Options editor in the Skype for Business application. If the 
contact status is not enabled in the Skype for Business application, the skype presence status will 
not be displayed for the user in Alfabet. 
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Sending and Receiving Express Views  

An express view allows you to share the most up-to-date information about your enterprise architecture 
with colleagues who may or may not be part of the user community, thus supporting communication 
among those people in your enterprise for whom the Alfabet data is most relevant. 

An express view is a link to a specific Alfabet view or explorer displaying data that allows individuals inside 
or outside of the Alfabet user community to view Alfabet information. When the express view is created, an 
email notification is automatically mailed to the specified recipient who receives a URL that allows him/her 
to access the current page view in Alfabet. 

When a user clicks the hyperlink to the targeted view in the email notification, the user profile used to ac-
cess Alfabet is by default the user profile that the sender of the express view was logged in with when 
he/she created the express view. However, your system administrator can configure the express view ca-
pability so that the recipient’s user profile is used to open the express view instead of the sender’s user 
profile. For more information about the configuration of express views, see the section Configuring the Ex-
press View (Email) Capability in the reference manual System Administration. 

 

If an express view is created for an object that is governed by a mandate and the express view is 
assigned to a user who is defined by your user administrator as an anonymous user, the user will 
not be able to access the view in Alfabet. Users defined as anonymous users may only access 
objects via express views that are not governed by a mandate. 

User profiles that are marked as administrative user profile will grant administrative access per-
missions even when opened via an express view. Mandate settings are not taken into account 
for views opening via an express view link with an administrative user profile. If the express view 
functionality is configured to use the sender's user profile to display the express view, you 
should avoid to send express views while working in an administrative user profile. 

Express views cannot be created for some explorers and views. For example, explorer root nodes 
as well as all functionalities used for administrative purposes that are available via an adminis-
trative user profile as well as the Configuration functionalities in the Alfabet user interface that 
are not associated with objects governed by access permissions do not allow express views to 
be created. In this case, the functionality to create an express view will be disabled. 

You can send an express view via your email client for any Alfabet view if the Mail Express View option is 
available in the Bookmark menu in the main toolbar. When the recipient of the email clicks the hyperlink in 
the email, Alfabet will open and the user will have ReadOnly access to the view. 

To email an express view to another person: 

1) Go to the view in Alfabet for which you want to create an express view. 

2) In the upper-left corner of the toolbar, click Bookmark > Mail Express View in the main toolbar. A 
dialog box opens. 

3) To send the express view, you can do either of the following:  

• Click the hyperlink available for the view or, if relevant, explorer in order to open your email 
program with the link automatically pasted in the email notification Additional text can be 
written in the email, as needed. 

• Copy the URL and paste it in your email program. 

4) Send the email from your email client. 

5) Click Close to close the dialog box in Alfabet. 
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Communicating with Your Colleagues via the Alfabet Internal Col-
laboration Functionality  

A collaboration capability is available that supports a free-form exchange of information and ideas about 
objects or views in Alfabet by members of the user community. The capability supports the exchange of 
user-generated content as is common in social media. A collaboration topic can be created for an object in 
an object profile/object cockpit or a specific page view and all invited users can add a post to the collabora-
tion topic. Any user with ReadOnly and ReadWrite access permissions to the object view or page view can 
start a collaboration topic. 

The collaboration topic will automatically be linked to the relevant object view or page view. The user initi-
ating the collaboration can invite other users to join the discussion, and these invited users can also invite 
other users to the collaboration topic. Bookmarks and attached documents can be associated with a collab-
oration topic and will be accessible to all users invited to the collaboration. Keyword tags can be defined for 
a collaboration topic in order to search for the collaboration. Users can access all collaboration topics that 
they have been invited to in the collaboration functionality. The collaboration topic including all posts by all 
users can be downloaded as an HTML file. 

 
If the object that the collaboration topic targets is deleted, the collaboration will not be deleted. 
The hyperlink to the original object view or page view will open but no data will be displayed. 

 

 
It is possible that the collaboration functionality is disabled in your Alfabet solution. In this case, 

the Show Collaboration Panel  button will not be displayed in the toolbar in object views and 
page views. You can enable the collaboration capability by selecting the checkbox for the Collab-
oration field in your user settings. For more information, see the section Defining Your User Set-
tings in Alfabet. Please note that the collaboration functionality may be disabled by your system 
administrator via the server alias setting for all users in the user community. For more infor-
mation, see the reference manual System Administration. 

If your company configured Alfabet to integrate with Microsoft Teams, the Microsoft Teams inte-
gration will substitute the internal collaboration capability. For information about working with 
the collaboration capability integrated with Microsoft Teams, see Communicating with Your Col-
leagues Using Integration with Microsoft Teams. 

The following information is available: 

• Creating a Collaboration Topic 

• Accessing and Participating in the Collaboration Topics You Have Been Invited To 

• Posting a Message to a Collaboration Topic 

• Defining a Bookmark for a Collaboration Topic 

• Attaching a Document to a Collaboration Topic 

• Inviting Users to Participate in a Collaboration Topic 

• Exporting the Collaboration Topic as an HTML File 
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Creating a Collaboration Topic  

A collaboration topic is created via the Show Collaboration Panel  button which is available in the 
toolbar in standard page views and objects views. The Collaboration Panel displays all collaboration topics 
for the view. If no collaboration topic exists, the panel will be empty. 

  

All existing posts will be displayed for the selected collaboration topic. 
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Any user with ReadOnly and ReadWrite access permissions to an object view or page view can start a col-
laboration topic. 

 
If a federated architecture is implemented in the enterprise, then mandate definitions for objects 
are also applied to the collaboration topics. If a user creating a new collaboration topic is cur-
rently logged in with a mandate, the collaboration topics will only be visible to users with the 
same mandate regardless of whether they have been invited to participate in the collaboration. 

To create a new collaboration topic, click the New Collaboration Topic button. In the Collaboration Topic 
editor, define the following fields, as needed: 
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• Title: Enter a new name for the collaboration topic, if necessary. The default name is based on the 
syntax: <ViewType>:<ObjectClass>:<ObjectName>. 

• Description: Enter a description of the collaboration topic. This will be the first post in the 
collaboration. 

• Tags: Enter keywords to search for the collaboration topic. If you want to add multiple tags, enter 
each tag on a separate line. When you close the editor, each tag will automatically be preceded by 
a hashmark (#). Tags can be used to search for collaboration topics via the Search by Tags filter in 
the Collaboration functionality. Users must enter the correct spelling as defined in the Tags 
attribute. 

• Invited Users: Click the Add Users button to invite one or more users to the collaboration topic. 

You can remove users by selecting the user in the pane and clicking the Remove  button. To 
export a list of all invited users including their defined email addresses and telephone numbers, 

click the Export  button. 

Click OK to save the new collaboration topic. When the editor is closed, you will see the new collaboration 
topic in the collaboration panel. Invited users can view the topic and post a message via the Collaboration 
functionality. For more information, see the section Posting a Message to a Collaboration Topic. 

Accessing and Participating in the Collaboration Topics You Have Been Invited To 

All collaboration topics that you have been invited to are displayed in the My Collaboration Topics func-
tionality. Here you can view the collaboration topics and see all posts that have been made for the topic. 
You can post a message for a collaboration topic, define bookmarks to other views and attach documents 
that are relevant to the collaboration topic, and invite other users to participate in the collaboration topic. 
The collaboration topic including all posts by all users can be downloaded as an HTML file. 

The Collaboration Topics Explorer displays all collaboration topics  that you have started and that 

you have been invited to. Click the Collaboration Topics Explorer node  and click Collaboration > 
New Collaboration Topic in the toolbar to create a new collaboration topic. For details about creating a 
new collaboration topic, see the section Creating a Collaboration Topic. 

To search existing collaboration topics based on keyword tags, click the Collaboration Topics Explorer 

node  and enter a keyword in the Search by Tag filter and click Search. You must spell the keyword 
correctly. All collaboration topics that match the search criteria are displayed in the table. 

To view all posts that have been made for a collaboration topic, click the collaboration topic  in the 
Collaboration Topics Explorer. The collaboration topic and all posts are displayed in the view on the right. 
If you are the topic owner of the collaboration topic, a Details button will be displayed in the topic entry. 
You can click the Details button to open the Collaboration editor and modify the name, description, and 
tags defined for the collaboration topic. The Details button will not be displayed if you are not the topic 
owner. 

Each collaboration post displays the user who has made the contribution to the collaboration topic, the 
message they have posted, the date and time of their post, and possible hyperlinks for bookmarks or docu-
ments. Blue fonts are hyperlinks that you can click to access relevant information. Tags are displayed in 
green font. In the bottom section of the view, you can post a new message, add a bookmark or document, 
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invite other users to the collaboration topic, and export the collaboration topic and all posts to an HTML 
page. 

  

The following information is available: 

• Posting a Message to a Collaboration Topic 

• Defining a Bookmark for a Collaboration Topic 

• Attaching a Document to a Collaboration Topic 

• Inviting Users to Participate in a Collaboration Topic 

• Exporting the Collaboration Topic as an HTML File 

Posting a Message to a Collaboration Topic  

Any user invited to a collaboration topic can post a message for the topic. To post a message, click the col-
laboration topic in the Collaboration Topics Explorer. Click in the pane at the bottom of the screen dis-
playing the text Post a message, enter your message, and click the Post button. The message is displayed 
as the most recent post to the collaboration topic. 

Defining a Bookmark for a Collaboration Topic  

In order to provide additional information relevant to the collaboration topic, you can add a bookmark point-
ing to another view. You can either add an existing bookmark or create a new bookmark for the collabora-
tion topic. If you need to create a new bookmark, you can open a different browser tab, create the book-
mark, and assign the bookmark to the collaboration topic in the original browser tab. The creation of book-
marks is described in detail in the section Creating, Managing, and Accessing Your Bookmarks. 

The bookmark will be displayed as a hyperlink in the post for the collaboration topic. Any user invited to the 
collaboration topic can click the hyperlink to access the bookmark. A bookmark will be displayed using the 
interface language that it was created with. Any user can change the language of the bookmarked view by 
means of the language button in the upper-right corner of the user interface. 

To add a bookmark to the collaboration topic: 
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1) In the Collaboration Topics Explorer, click the Add Reference  button in the toolbar of the 
pane at the bottom of the screen. 

2) In the object selector, select the bookmark in either the Simple tab or the Browse tab if the 
bookmark is structured in a bookmark group. Click OK. 

3) The bookmark is displayed to the right of the message box. You must enter text in the Post a 
message field and click the Post button to add the bookmark to the collaboration topic. Click the X 
next to the bookmark if you want to remove it from the collaboration topic. 

Attaching a Document to a Collaboration Topic  

You can attach a document stored in the Internal Document Selector to the collaboration topic in order to 
provide necessary content to the discussion. For more information about uploading a document to the doc-
ument, see the section Uploading Documents and Managing User Permissions to Document Folders in the 
Internal Document Selector in the reference manual User and Solution Administration. 

The document will be displayed as a hyperlink in the post for the collaboration topic. Any user invited to the 
collaboration topic can click the hyperlink to access the document. 

To attach a document to the collaboration topic: 

1) In the Collaboration Topics Explorer, click the Add Document  button in the toolbar of the 
pane at the bottom of the screen. 

2) In the internal document selector, select the document and click OK. 

3) The document is displayed to the right of the message box. You must enter text in the Post a 
message field and click the Post button to add the document to the collaboration topic. Click the 
X next to the document if you want to remove it from the collaboration topic. 

Inviting Users to Participate in a Collaboration Topic  

As a participant in a collaboration topic, you can invite one or more users to the collaboration topic. Invited 
users can view the topic and post a message via the Collaboration functionality. 

 
If a federated architecture is implemented in the enterprise, then mandate definitions for objects 
are also applied to the collaboration topics. If a user creating a new collaboration topic is cur-
rently logged in with a mandate, the collaboration topics will only be visible to users with the 
same mandate regardless of whether they have been invited to participate in the collaboration. 

1) In the Collaboration Topics Explorer, click the Add Users  button in the toolbar of the pane at 
the bottom of the screen. 

2) In the person selector, select the user(s) and click OK. 

3) The new users are displayed to the right of the message box. You must enter text in the Post a 
message field and click the Post button to add the users to the collaboration topic. Click the X 
next to the user if you want to remove him/her from the collaboration topic. 
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Exporting the Collaboration Topic as an HTML File  

The collaboration topic including all posts by all users can be downloaded as an HTML file. In the Collabora-

tion Topics Explorer, click the Download Collaboration Content  button in the toolbar of the pane at 
the bottom of the screen. In the dialog, click the Download button and save the HTML file to your com-
puter. The HTML file can be opened in your browser. 

Communicating with Your Colleagues Using Integration with Mi-
crosoft Teams 

This functionality is only available if your company has configured and activated integration with Microsoft 
Teams®. For information about the required configuration, see Configuring Interoperability with Microsoft 
Teams in the reference manual API Integration with Third-Party Components. 

Integration with Microsoft Teams provides the following functionality: 

• The status of the user in Microsoft Teams is visible in Alfabet behind the user name in the 
Attribute section in object profiles and object cockpits. Users can click the status icon to open 
Microsoft Teams and chat with the colleague who's status is displayed. 

• Conversations about Alfabet objects can be started via the Alfabet user interface. 

• A link to files attached to a team in Microsoft Teams about an Alfabet object can be attached to 
that object in the Attachments page view. 

• Microsoft Teams meetings with relevant Alfabet users can be scheduled via the Alfabet user 
interface. 

• Initiating Microsoft Teams Integration 

• Contacting a Single User via Microsoft Teams Chat 

• Discussing with Colleagues About an Object in Alfabet and Microsoft Teams 

• Accessing the Collaboration Panel in Alfabet 

• Starting a New Teams Channel for an Object in Alfabet 

• Contributing to an Existing Chat in Alfabet 

• Inviting Users to Participate in a Chat 

• Opening the Chat in Microsoft Teams from the Collaboration Panel 

• Viewing and Accessing All Microsoft Teams Chats You are Involved in 

• Adding a Link to a Document in Microsoft Teams to an Object 

• Ending a Chat 

• Managing and Scheduling Microsoft Teams Meetings in Alfabet 

• Scheduling a Microsoft Teams Meeting about an Object 

• Importing a Microsoft Teams Meeting 
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• Managing Your Scheduled Microsoft Teams Meetings 

Initiating Microsoft Teams Integration 

Microsoft Teams integration requires login of the user to Microsoft Teams in the background. The required 
user login name is usually added to the user configuration by a user or system administrator. You will then 
be logged in automatically to Microsoft Teams on login to Alfabet. If you are not automatically logged in, 
you may need to manually establish the connection. 

To manually establish the connection if you have never used Microsoft Teams integration before: 

1) Click the <Alfabet User Name> menu and select Personal Info. 

2) Make sure that you Microsoft Teams user name is specified in the field MS Teams User Name. 

3) Click OK to close the editor. 

4) Click the <Alfabet User Name> menu and select Request MS Teams Authorization Code. Log in 
to Microsoft Teams with your user name and password in the new browser tab that opens. 

If the connection to Microsoft Teams fails during your Alfabet session: 

1) Click the <Alfabet User Name> menu and select Request MS Teams Authorization Code. Log in 
to Microsoft Teams with your user name and password in the new browser tab that opens.  

 
An exclamation mark will be displayed in front of the Request MS Teams Authorization 
Code option if the authorization code is no longer valid. 

Contacting a Single User via Microsoft Teams Chat 

The status of a user in Microsoft Teams is displayed next to the user's name in the Attributes section of 
object profiles/object cockpits as well as previews. The symbol displaying the status in Alfabet is identical 
with the symbol displayed in Microsoft Teams. 

  

The status will be regularly updated as configured. Depending on the interval to update, changes in Mi-
crosoft Teams may be displayed with a delay in Alfabet. 

You can click the status icon behind a user name to open Microsoft Teams. Microsoft Teams will open with 
a chat window to chat with the selected user. 

Discussing with Colleagues About an Object in Alfabet and Microsoft Teams 

Users can start a conversation about an object in Alfabet that will then also be available in Microsoft Teams. 
The conversation will be synchronized between both applications: 
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• In Alfabet, a collaboration panel can be opened for objects of all object classes that are configured 
by your company to provide a collaboration capability. The collaboration panel is accessible via the 

Show Collaboration Panel menu option of the Microsoft Teams Interactions  button in the 
toolbar of the object profile and object cockpits of an object and in page views opened for a base 
object. If the button is opened from a page view, the collaboration channel will open for the 
conversation related to the base object. The structure of messages is similar to those in teams 
channels in Microsoft Teams so that both a new conversation or a reply to an existing conversation 
can be posted.  

  

• A conversation about an object started in Alfabet is synchronized with a defined channel in 
Microsoft Teams. The channel shows the same content as the collaboration panel in Alfabet.  



 
 Chapter 9: Communicating and Collaborating with Your Colleagues in Alfabet 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 225 

  

If the integration solution with Microsoft Teams is configured to provide a back link to the object in 
Alfabet, a tab with the name of the object will be available in the team channel. The user can open 
the tab to view current information about the object in an Alfabet view. 

  

Content added in Alfabet will be visible in Microsoft Teams and vice versa and options for opening Microsoft 
Teams directly from the Alfabet user interface and for opening the Alfabet user interface from Microsoft 
Teams are provided. 

A conversation about an object in Alfabet can only be synchronized with a single team channel in Microsoft 
Teams, while multiple chats about different Alfabet objects can be synchronized with the same team chan-
nel in Microsoft Teams. You can combine the chat about multiple objects in one team channel. The same 
conversation is then displayed in the collaboration panel of all of the objects assigned to the team channel 
in Microsoft Teams. 

The following information is available about having a conversation about an object both in Alfabet and Mi-
crosoft Teams: 

• Accessing the Collaboration Panel in Alfabet 

• Starting a New Teams Channel for an Object in Alfabet 

• Contributing to an Existing Chat in Alfabet 

• Inviting Users to Participate in a Chat 

• Opening the Chat in Microsoft Teams from the Collaboration Panel 

• Viewing and Accessing All Microsoft Teams Chats You are Involved in 

• Adding a Link to a Document in Microsoft Teams to an Object 

• Ending a Chat 
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Accessing the Collaboration Panel in Alfabet 

The ability to start a conversation about an object in Microsoft Teams is restricted to the subset of object 
classes that have been configured by your solution designer. The button for opening the collaboration 
panel will only be available if a conversation can be started. The button is visible in the object profile and 
object cockpits for the object as well as in all views that the object is the base object for. For example, in 
the Applications view of an application group the button will open the collaboration panel for the applica-
tion group you are currently working with. 

 

Prior to accessing the collaboration panel, make sure that you are currently logged in to Mi-
crosoft Teams. 

To open the collaboration panel: 

1) In the toolbar, select Microsoft Teams Interactions  > Show Collaboration Panel. 

2) The collaboration panel will open with one of the following options:  

•   

The object is not yet connected with a team channel in Microsoft Teams. In this case, you can 
connect the object to a teams channel to start a conversation. Follow the procedure described 
in the section Starting a New Teams Channel for an Object in Alfabet. 

•   

A conversation has already been started and the object is connected with a team channel in 
Microsoft Teams. You are a member of the team channel and can contribute to the discussion 
as described in the section Contributing to an Existing Chat in Alfabet. 

 If you do not see any conversations, click the Refresh  button to load the team 
channel content from Microsoft Teams. 
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•   

A conversation has already been started and the object is connected with a public team chan-
nel in a public team in Microsoft Teams. You are not a member of the team channel. Click the 

Join Team  button to join the team. You will be added as member to the team in Microsoft 
Teams and the conversation of the connected team channel will load into the collaboration 
panel. You can then contribute to the discussion as described in the section Contributing to an 
Existing Chat in Alfabet 

•   

A conversation has already been started and the object is connected with a private team 
channel or a private team in Microsoft Teams. You are not a member of the team channel. Ac-
cess can only be requested in Microsoft Teams. Click the link in the message text to access 
Microsoft Teams. 

Starting a New Teams Channel for an Object in Alfabet 

If another colleague has already started a conversation about an object, you will see the chat in the collab-
oration panel and can add to it as described below in the next section. If no chat has already been started, 
you can start a new one: 

1) Click Connect to MS Teams to create a Microsoft Teams channel for the object and start the 
conversation.  

  

2) In the editor, define the following fields:  

• MS Teams Connection Name: Define the standard name for the connection to Microsoft 
Teams for the object. This name will also be displayed in the collaboration panel in Alfabet as 
heading of the conversation. 
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• MS Team: Define which team in Microsoft Teams that the team channel for this object shall be 
created for. Your company can preconfigure the Microsoft Teams integration to either allow 
selection of an existing Microsoft Teams team from a drop-down list only or to allow creation 
of new teams as well. Creation of a new team in Microsoft Teams is listed as an option in the 
drop-down list. 

• MS Team Display Name: Enter the name that shall be used in Microsoft Teams for the team. If 
you have selected an existing team in the MS Team drop-down list, this field is view only. 

• MS Team Description: Enter a description for the team that will be visible in Microsoft Teams 
and will help users to find the team. If you have selected an existing team in the MS Team 
drop-down list, this field will be view only. 

• MS Channel: Select an existing team channel in the drop-down list or select the option to 
create a new team channel.  

 
A conversation about an object in Alfabet can only be synchronized with a single 
team channel in Microsoft Teams, while multiple chats about objects can be syn-
chronized with the same team channel in Microsoft Teams. You can combine the 
chat about multiple objects in one team channel. The same conversation is then dis-
played in the collaboration panel of all of the objects assigned to the team channel. 

• Private MS Channel: Select the checkbox if you want the team channel in Microsoft Teams to 
be private, which means that only people that you actively invited will have access to the team 
channel in Microsoft Teams. If the checkbox is not selected, all members of the team that the 
team channel belongs to will have access to the channel. If you have selected an existing team 
channel in the MS Channel drop-down list, this field is view only. 

• MS Channel Display Name: Define a name for the new team channel in Microsoft Teams. If 
you have selected an existing team channel in the MS Channel drop-down list, this field is 
view only. 

• MS Channel Description: Define a description for the new team channel in Microsoft Teams 
that will help users to find it in Microsoft Teams. If you have selected an existing team channel 
in the MS Channel drop-down list, this field will be view only. 

• Users: Click the Add Users button in the toolbar of the field and select the users that shall be 
explicitly invited to the conversation. Only users that have a Microsoft Teams user ID defined 
will be listed in the selector. The users will get a notification that they have been added to a 
team channel. If you have selected the Private MS Channel checkbox, access to the team 
channel in Microsoft Teams is limited to the selected users.  

 
In Microsoft Teams, only members of the team that a team channel belongs to can 
access the team channel. If you add a user that is not currently member of the team 
that the new team channel is created in, this user will automatically be added as 
member to the team in Microsoft Teams. 

3) Click OK to create the new team channel and open the conversation in the collaboration panel. You 
can now start posting comments in the collaboration channel window. 
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Contributing to an Existing Chat in Alfabet 

If another colleague already started a conversation about this object, you will see the conversation in the 
collaboration panel and can contribute to it. 

The conversation in the collaboration panel in Alfabet is structured identical to the conversation in the 
team channel in Microsoft Teams. You can start new conversations and reply to existing conversations. 

Replies to a conversation are hidden by default to enhance the visibility of conversations. The number of 
available replies is displayed at the bottom of each conversation as a link. Clicking the link will open the re-
plies for this conversation: 

  

The conversation ongoing in the team channel in Microsoft Teams and the collaboration panel on the 
Alfabet user interface will be synchronized as follows: 

• On opening the collaboration panel, the current conversation in the team channel in Microsoft 
Teams will be fetched and displayed in the collaboration panel.  

 
The complete conversation in the team channel in Microsoft Teams is displayed includ-
ing contributions made by Microsoft Teams users which are not Alfabet users. 

• Every contribution made in the collaboration panel will be pushed to Microsoft Teams and will be 
immediately visible to Microsoft Teams users in the respective team channel. 

• Contributions made in Microsoft Teams while the collaboration panel is still open in Alfabet are not 

automatically added to the collaboration panel. You must use the Refresh  button to update 
the collaboration panel. Please note that conversations and replies are refreshed separately. If you 

use the Refresh  button on the upper right of the collaboration panel, only conversations are 

updated. Click the Refresh  button button under a conversation to refresh the replies to the 
conversation. 

Replies to conversations are by default hidden in the collaboration panel. 

You can do any of the following to participate in the conversation in Alfabet: 

• To start a new conversation, enter the text into the field at the bottom of the collaboration panel 

and click the Send  button. 

• To start a new conversation including a snapshot of the current view, enter the text into the field 
at the bottom of the collaboration panel and click the Include Current View as 

Snapshot  button. The snapshot will be made available in Microsoft Teams with a link to open 
the view in Alfabet. 
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• To reply to a conversation, click the Reply  button under the conversation you would like to 

reply to. Enter a comment into the text field and click the Send  button. 

• To send a snapshot of the current view as reply to a conversation, click the Reply  button 
under the conversation you would like to reply to. Enter a comment into the text field and click the 

Include Current View as Snapshot  button. The snapshot will be made available in Microsoft 
Teams with a link to open the view in Alfabet. 

Inviting Users to Participate in a Chat 

Additional users can be invited to an ongoing conversation about an object. This is of special relevance for 
the following use cases: 

• In Microsoft Teams, only members of a team have access to the team channel. If you invite a user 
to a conversation in the collaboration panel in Alfabet and the user is not a member of the relevant 
Microsoft Team, the user will be automatically added as member to the team. 

• If the conversation is ongoing in a private team channel, only explicitly invited users can 
participate in the conversation. 

To add new users to an ongoing conversation in the collaboration panel: 

1) Click the Details  button in the header of the collaboration panel. 

2) In the editor, click the Add Users button in the Users field. 

3) Select the users to be invited and click OK. 

4) Click OK to close the editor. 

Opening the Chat in Microsoft Teams from the Collaboration Panel 

You can open the team channel you are currently contributing to in the collaboration channel in Microsoft 
Teams: 

1) Click the Open in MS Teams  button in the header of the collaboration panel. 

Viewing and Accessing All Microsoft Teams Chats You are Involved in 

The All MS Teams Collaboration Topics functionality lists all open Microsoft Teams chats you have either 
started for an object or are currently invited to or participating in. the views are sorted to show the chats 
with posts that you did not see yet on top of the dataset. 

You can select a post in the table and do one of the following: 



 
 Chapter 9: Communicating and Collaborating with Your Colleagues in Alfabet 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 231 

• Click the Navigate  button to navigate to the object view of the object the chat is about and 
open the collaboration panel. 

• Click the Open in MS Teams button to open the chat in Microsoft Teams. 

The view provides the following information: 

• ID: The ID of the object the chat is about. 

• Object: The name of the object the chat is about. this column shows the same information about 
the object also displayed in explorers. For example for applications, both name and version is 
displayed. 

• Object Class/Stereotype : The object class and object class stereotype of the object in the 
format ObjectClassName:StereotypeName. 

• Posts Available in Alfabet: the number of posts that are currently visible in the collaboration 
panel. Please note that this is not identical to the content of the team channel in Microsoft Teams. 
The number of posts displayed in Alfabet are limited. 

• Unread Alfabet Posts: The number of posts in the chat you have not seen yet. Please note that 
these are only posts added to the chat in Alfabet. If a contribution is made in Microsoft Teams, you 
must refresh the chat via the collaboration channel to see whether new posts are available in 
Microsoft Teams. 

• Last Post: the date and time the last post was made. 

• Last Post User: the user who wrote the last post. 

You can search for information about a chat started for a defined object using one of the following filters to 
search for the object: 

• Class/Stereotype Name: Select the object class and optionally object class stereotype for which 
you want to see current chats from the drop-down list. 

• Object Reference : Type part of or the complete REFSTR value for the object into the field. Please 
note that the object ID is based on the middle part of the number representing the REFSTR value. If 
you type the number which is part of the object ID into the field, you can find the object even if you 
do not know the REFSTR of the object. 

• Object: Select the object for which you want to see the chat information from the selector. Please 
note that the field is only active if an object class and optionally object class stereotype has been 
selected in the Class/Stereotype Name field. 

Adding a Link to a Document in Microsoft Teams to an Object 

If documents are available in the Files tab of the Microsoft Teams team channel connected the Alfabet ob-
ject you are currently working with, you can add a link to the document to the Attachments page view. All 
users with access to the object can then select the link in the Attachments page view and click the Open 

Document Using Default Program  button in the toolbar to open the document in Microsoft Teams. A 
log in to Microsoft Teams is required to access the document. 

To add a link to a Microsoft Teams document: 
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1) In the toolbar, click New > Add Web Link Based on MS Teams File Link. 

2) In the selector, select the file for which you would like to add a link. You can do the following to find 
a document in the selector:  

• To open a folder displayed in the selector, select the folder in the list and click the Load 
Selected Folder option in the menu bar of the list. 

• To go back to a superordinate folder after having opened a folder in the selector, click the 
Back to Folder '<Name>' button in the menu bar of the list to go back to the parent folder or 
click the Load Root Folder button to go back to the root folder. The Load Root Folder button 
is not available if the root folder is the parent folder of the current folder and accessible via the 
Back to Folder '<Name>' button. 

• To find a file or folder in the list, enter the start of the file or folder name into the field MS 
Teams Drive Item Name: Starts With field and click the Search button. 

3) In the editor that open, define the link details:  

• Title: Change the title of the document if necessary. The title will be displayed in the 
attachment list of the Attachments page view. 

• URL: This field must not be changed. 

• Category: Select one of the document category that your company defined to categorize 
documents. 

Ending a Chat 

You can detach the conservation in the collaboration channel from the team channel in Microsoft Teams. 
The conversation will be deleted from the Alfabet database and the connection to the team channel will be 
removed. The collaboration panel will be empty after a detach action. 

The team channel will still exist in Microsoft Teams. It can either be deleted from within Microsoft Teams or 
kept for further discussion outside of Alfabet. In addition, multiple objects in Alfabet can be connected with 
the same team channel in Microsoft Teams and the channel might still be used for discussion of the re-
maining connected objects. 

After having detached the existing connection, you can establish a connection with a new or existing team 
channel. 

To detach a conversation from the team channel in Microsoft Teams: 

1) Click the Detach  button in the header of the collaboration panel. 

Managing and Scheduling Microsoft Teams Meetings in Alfabet 

You can schedule new Microsoft Teams meetings about an object in Alfabet, import existing meetings from 
Microsoft Teams, and view, edit, accept and join meetings directly in the Alfabet user interface. 

The ability to schedule meetings is also available if the object you are currently working with is not con-
nected with a team channel in Microsoft Teams. 
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Microsoft Teams meetings that are scheduled in Alfabet are always referencing the object that they are 
scheduled for. If a Personal Info section is available in the object profile or object cockpit for the object, it 
will include the information about the number of Microsoft Teams meetings which are scheduled for the 
current object and the current date: 

  

You can schedule meetings in both Microsoft Teams and in Alfabet. Teams meetings created in Alfabet are 
automatically assigned to the object they are defined for. Teams meetings in Microsoft Teams can be im-
ported into Alfabet for a defined objects. Teams meetings can only be imported to a single object. Teams 
meetings that are not about any Alfabet object are not managed in Alfabet. The Microsoft Teams meeting 
functionalities in Alfabet are not a copy of the calendar function in Microsoft Teams. They shall only provide 
a means to view and edit meetings scheduled in the context of Alfabet. You can select participants from all 
Alfabet users or only from the users that are assigned a role for the current object in Alfabet. 

You can do any of the following to manage your Microsoft Teams meetings in Alfabet: 

• Scheduling a Microsoft Teams Meeting about an Object 

• Importing a Microsoft Teams Meeting 

• Managing Your Scheduled Microsoft Teams Meetings 

Scheduling a Microsoft Teams Meeting about an Object 

The button interaction to schedule Microsoft Teams meeting is available for a configurable subset of object 
classes only. It will be available in the object profile and object cockpits for the objects of the permissible 
object class as well as in all views the object is the base object for. 

To schedule a Microsoft Teams meeting to discuss the object you are currently working with: 

1) In the toolbar, select Microsoft Teams Interactions  > Schedule Meeting. The MS Teams 
Meeting view opens. It lists all Microsoft Teams meetings you have currently scheduled or are 
invited to for the current object. 

2) In the toolbar, click the New Meeting button. An editor opens. 

3) In the editor, define the meeting details:  

Basic Data tab: 

• Meeting Subject: Enter the title of the meeting that will be displayed in calendar items. 

• Sensitivity: This setting is currently not relevant. Although a sensitivity level is available in 
Microsoft Teams, it is currently not actively used in Microsoft Teams. This setting will therefore 
be ignored as long as no Microsoft Teams functionality will use it. 

• Details: Enter additional information about the meeting if necessary. 

• Add External Link to Object: Select the checkbox if you want a link to the current object and 
view you were working with when starting to schedule the meeting to be added to the meeting 
invitation. If a user clicks the link in MS Teams, the link in MS Teams opens. 

The picture can't be displayed.
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Attendees tab: In the toolbar, click one of the following to add participants to your new scheduled 
meeting: 

• Click Add > Add from Person to select participants from all Alfabet users. The selector 
informs about the availability of a Microsoft Teams User ID for the users. 

• Click Add > Add from Responsible Users to select participants from a list of users that are 
assigned a role for the current object. The selector provides information about about the role 
the user has for the object and the availability of a Microsoft Teams User ID for the users. 

Availability tab: You can do either of the following to schedule the meeting time: 

• Click the Suggested Meeting Slots button to view all time slots for which the participants will 
be available and select a time slot. The display of time slot suggestions can be fine-tuned with 
the following fields:  

• Is Organizer Optional: Select the checkbox if you are organizing a meeting that you 
might not attend yourself. Time slots will then be shown even if they are not free on your 
own calendar. 

• % Attendance: If there are no time slots that are free in the calendars of all participants in 
the acceptable time frame for the meeting, you can set the attendance level to the 
minimum percentage of invited attendees that should be available. The information 
displayed about the time slot will inform you about the percentage of attendees available 
and the attendees that will not be available at that time slot. 

• Max. Results: Enter the maximum number of time slots to be listed. 

• Calendar Type : If the users in the meeting have different Microsoft Teams calendars for 
work and private meetings, select the type of calendar that the meeting shall be 
scheduled for from the drop-down list. If you select unrestricted, free time slots are 
evaluated from all calendars. 

• Schedule a time via the following fields:  

• Start Date: Select the start date of the meeting from the calendar. 

• Start Time: Enter the start time of the meeting. 

• End Date: If you have selected the All Day checkbox, select the end date of the meeting. 

• End Time: If you have not selected the All Day checkbox, select the time the meeting will 
end. 

• All Day: Select the checkbox to reserve one or multiple complete days for the meeting. 

 

Once a meeting is created, you can edit, delete, and join the meeting. The functionalities for 
management of Microsoft Teams meetings are the same as the functionalities in the view My MS 
Teams Meetings. for more information, see Managing Your Scheduled Microsoft Teams Meet-
ings. 
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Importing a Microsoft Teams Meeting 

The button interaction to schedule and import Microsoft Teams meeting is available for a configurable sub-
set of object classes only. It will be available in the object profile and object cockpits for the objects of the 
permissible object class as well as in all views the object is the base object for. 

1) In the toolbar, select Microsoft Teams Interactions  > Schedule Meeting. The MS Teams 
Meeting view opens. It lists all Microsoft Teams meetings you have currently scheduled or are 
invited to for the current object. 

2) In the toolbar, click the Import Meeting button. An editor opens. 

3) Optionally define the following filters to find the correct meeting to import:  

• Meeting Subject: Enter a string to find a meeting with a meeting subject including or 
matching your string. 

• Start Date / End Date: define the time period the meeting should be in. Please note that you 
can only search for a time period smaller than or equal to one week. If you do not define the 
start and end date, all meetings in the next seven days will be displayed. 

• Show meetings referenced by other artifacts: Select the checkbox to also see meetings 
that are already imported to other objects in Alfabet. Please note that if you select a meeting 
that is already assigned to another Alfabet object, the meeting will be detached from the other 
object and moved to the current one. 

4) Click Search to see all meetings matching your search. 

5) Select one or multiple meetings in the list and click OK to import the meetings. 

 

Once a meeting is imported, you can edit, detach, delete, accept and join the meeting. The func-
tionalities for management of Microsoft Teams meetings are the same as the functionalities in 
the view My MS Teams Meetings. for more information, see Managing Your Scheduled Microsoft 
Teams Meetings. 

Managing Your Scheduled Microsoft Teams Meetings 

In the My MS Teams Meetings functionality, you can accept and decline Microsoft Teams meeting invita-
tions, cancel or edit meetings that you scheduled, and join meetings. The functionality will show all Mi-
crosoft Teams meetings that you have imported or scheduled or that were scheduled or imported by some-
one else to Alfabet and that you are invited to. 

You can access the functionality via a link in a menu or link in the guide views configured for your user pro-
file by your solution designer or, if implemented, via the link in a guide view that provides information about 
the number of Microsoft Teams meetings that are scheduled for today. the following functionalities are 
provided via the menu buttons for a Microsoft Teams meeting selected in the table: 

• Detach: Click to detach the meeting from the current Alfabet object. The meeting will still exist in 
Microsoft Teams and can then be imported to another Alfabet object, if applicable. 

• Cancel Meeting: Click to remove the meeting from the list and from all Microsoft Teams calendars 
of the participants. 



 
 Chapter 9: Communicating and Collaborating with Your Colleagues in Alfabet 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 236 

• Edit: Click to open an editor and edit the meeting details. The fields in the editor will only be 
editable if you have scheduled the selected Microsoft Teams meeting. 

• Accept Invitation: Click to accept the meeting. A new window opens. Optionally enter a comment 
for the organizer of the meeting and click OK. 

• Tentative Acceptance: Click to inform the organizer of the meeting that you might attend the 
meeting. A new window opens. Optionally enter a comment for the organizer of the meeting and 
click OK. 

• Decline Invitation: Click to inform the organizer of the meeting that you will not attend the 
meeting. A new window opens. Optionally enter a comment for the organizer of the meeting and 
click OK  

• Propose New Time: Click to propose a new time for the meeting. A new window opens. enter the 
new time for the meeting. Optionally enter a comment for the organizer of the meeting and click 
OK. The organizer of the meeting will receive an email with your proposal. 

• Open in Outlook: Click to open the Microsoft Outlook® calendar and see the meeting there. 

• Join Meeting: Click to join the meeting. The meeting will open in Microsoft Teams. 

the Response Status column in the table informs you whether you have already accepted, declined, or 
tentatively accepted the meeting, or whether you are the organizer of the meeting. 

Initiating, Contributing to, and Managing a Discussion About Ob-
jects  

Alfabet provides a discussion functionality that supports collaborative discussions about objects in the en-
terprise. Any user that has been configured to be a participant in a discussion group may contribute to a 
discussion. 

The following users can participate in a relevant discussion: 

• The authorized user, member of an authorized user group, or deputy of an object. These users can 
initiate a discussion for objects that they are responsible for. Authorized users can contribute to, 
track, and close a discussion. 

• The members of the discussion group that the discussion has been activated for. This discussion 
group is responsible for managing the discussion. The members of the managing discussion group 
can contribute to and track the discussion. Depending on the configuration of the discussion 
groups, members of the managing discussion group may have Read/Write access permissions to 
the object that is the focus of the discussion. The managing discussion group can invite other 
discussion groups to participate in the discussion and can close the discussion when it has been 
completed. 

• The members of a discussion group that has been invited to join in the discussion. The members of 
the invited discussion group can contribute to and track the discussion. Depending on the 
configuration of the discussion groups, members of the invited discussion groups may have 
Read/Write access permissions to the object that is the focus of the discussion. 
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Discussion groups are configured in the Discussion Groups functionality in the Solution Admin 
functionality. For more information about the configuration required for the discussion capabil-
ity, see the section Defining Discussion Groups for Collaborative Discussions in the reference 
manual User and Solution Administration. 

The following information is available: 

• Understanding the Discussion Process 

• Initiating a Discussion about an Object 

• Managing and Contributing to the Discussion 

• Inviting Other Discussion Groups to Join the Discussion 

• Contributing to the Discussion 

• Editing the Object Under Discussion 

• Closing the Discussion for a Discussion Group 

Understanding the Discussion Process 

 

A discussion in Alfabet will typically proceed as follows: 

• A discussion is initiated in the Discussion page view for a selected object by an 
authorized user, member of an authorized user group, or deputy who is responsible for 
the object. The Discussion page view is only available in the object profile for object 
classes for which the discussion capability has been configured. The configuration will 
specify the release status that an object must have in order for a discussion to be 
initiated for that object as well as which discussion groups may participate in the 
discussion. Typically, the user initiating the discussion will make the first contribution to 
the discussion explaining why discussion was initiated. When initiating the discussion, 
the user must select a discussion group to be the managing discussion group for the 
discussion. 

• Any member of the managing discussion group may choose to invite other discussion 
groups to participate in the discussion in the My Discussions functionality. The 
managing discussion group may only invite discussion groups that have been 
configured to be invited to the discussion. Any member of the managing discussion 
group can include or exclude an invited discussion group at any time. Depending on the 
configuration of the discussion capability, email notification may be sent to all members 
of the managing discussion group and invited discussion groups when a discussion is 
initiated about an object. 

• All users with authorized access to the object as well as members of the managing 
discussion group and invited discussion groups may contribute to and track the 
ongoing discussion about the object in the My Discussions functionality. Discussion 
participants may add comments, define the status of the discussion, and trigger email 
notification for other discussion participants information them about the contribution. 
Depending on the configuration, the members of a participating discussion group may 
or may not be able to edit the object targeted by the discussion. 
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• Once it has been determined that the discussion has been completed, an authorized 
user of the object or a member of the managing discussion group can deactivate and 
close the discussion. No further contributions can be made to an inactive discussion. 

Initiating a Discussion about an Object 

The Discussion page view is available in the object profiles of all object classes for which the discussion 
capability has been configured. The view allows you to initiate a discussion about a selected object that you 
have authorized access to as an authorized user, member of an authorized user group, or deputy. As the 
initiator of the discussion, you can also contribute to and track the discussion, and close the discussion 
when it has been completed. Members of the discussion group managing the discussion may also close the 
discussion. 

The Discussion page view displays all discussion groups that may participate in a discussion for the se-
lected object. Each column in the view is defined below: 

• Group Type / Name : The discussion group type is displayed in bold text. Click  to view the 
discussion groups that may participate in a discussion about the selected object. Any discussion 
groups that are greyed out cannot participate in a discussion about the object due to the object's 
release status. 

• Activity State: Displays the active or inactive state of a discussion. 

• Discussion Status: Displays the current stage of the discussion. 

• Change Date: Displays the date of the most recent contribution to the discussion. 

• Comments: Displays the contribution that has most recently been added to the discussion. 

To initiate a discussion for the selected object: 

1) In the Discussion page view, select the discussion group for which you want to initiate a 
discussion about the selected object. If the discussion group has an inactive status, you can view 
information about the discussion group in the preview section. 

2) In the toolbar, click the Manage Group Discussions  button. The Discussion Items editor 
opens. 

3) In the Activity State column, change the value in the Activity State column to Active. Once the 
Activity State has been defined as active, contributions can be made to the discussion and 
comments added.  

 

Activity states are configured in the Discussion Groups functionality available via an 
administrative user profile. For more information about the configuration required for 
the discussion capability, see the section Defining Discussion Groups for Collaborative 
Discussions in the reference manual User and Solution Administration. 

4) Click OK to close the editor. 

5) To make a contribution to the discussion, select the active discussion group and click the 

Edit  button. The Discussion Contribution editor opens. 
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6) In the Comments field, enter your contribution to the discussion and, if necessary, modify the 
status of the discussion in the Discussion Status field. The discussion status describes the 
current stage of the discussion. 

7) If you would like the members of the participating discussion group(s) to be informed via an email 
notification that a contribution has been made, select the Notify Discussion Group Members 
checkbox. 

8) Click OK to save your contribution to the discussion or click Cancel if the contribution should not 
be saved. The members of the participating discussion group(s) will see your comment in the My 
Discussions functionality.  

Once the discussion has been completed, either the authorized user or a member of the managing 
discussion group can make the discussion inactive for a participating discussion group. No further 
contributions can be made by an inactive discussion group. 

To remove a discussion group from the discussion, select the discussion group for which you want 

to close the discussion, click the Manage Group Discussions  button, and change the value in 
the Activity State column to Inactive. The discussion has been terminated for the discussion 
group and is no longer displayed in the My Discussions functionality. If you want to completely 
close the discussion for all discussion groups, you must set the activity state to Inactive for all 
discussion groups participating in the discussion. 

Managing and Contributing to the Discussion 

The members of discussion groups participating in the discussion can access, contribute to, and track the 
discussion in the My Discussions functionality. Additionally, the managing discussion group can invite 
other relevant discussion groups to participate in the discussion, manage the status of the discussion 
group, and close the discussion when it has been completed. 

Members of all participating discussion groups may add their contribution to the discussion in the My Dis-
cussions functionality. A Show Discussion History capability allows everyone to view and understand the 
development of the discussion. Depending on the configuration of the discussion groups, members of the 
participating discussion groups may have Read/Write access rights to the object that is the focus of the 
discussion. 

 
If the release status of the object changes during the discussion to a release status that is not 
allowed for discussion, then the discussion will be disabled for that object. Discussion groups are 
configured in the Discussion Groups functionality accessible via an administrative user profile. 
For more information about the configuration required for the discussion capability, see the sec-
tion Defining Discussion Groups for Collaborative Discussions in the reference manual User and 
Solution Administration. 

The following information is available: 

• Inviting Other Discussion Groups to Join the Discussion 

• Contributing to the Discussion 

• Editing the Object Under Discussion 

• Closing the Discussion for a Discussion Group 
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Inviting Other Discussion Groups to Join the Discussion 

Once the discussion is initiated, all discussion groups that may participate in the discussion are displayed in 
the Discussion page view in the relevant object profile and the My Discussions functionality. Any member 
of the managing discussion group may choose to invite other relevant discussion groups to participate in 
the discussion. Contributions can only be made by a discussion group for which the activity state has been 
set to Active. Depending on the configuration, an email notification might be sent to all members of the 
invited discussion group informing them that they are being asked to participate in the discussion. 

The members of the invited discussion group will also be able to access the discussion in the My Discus-
sions functionality. Likewise, depending on the configuration, the members of the invited discussion 
groups may have Read/Write permission to the objects targeted by the discussion. 

1) In the My Discussions functionality, select the managing discussion group for which the 
discussion has initially been activated. 

2) In the toolbar, click the Manage Group Discussions  button. The Discussion Items editor 
opens. 

3) To invite other discussion groups to participate in the discussion about a specific object, change 
the value in the Activity State column to Active. Once the Activity State has been defined as 
active, contributions can be made to the discussion and comments added. If you set the Activity 
State to Inactive for a discussion group, you will make the discussion inactive for the entire 
discussion group. 

4) Click OK to close the editor. 

Contributing to the Discussion 

The access permissions granted to members of the discussion group are independent of the accessibility 
granted via an authorized user, authorized user group, or deputy definition. However, access permissions 
specified via mandates are applied. If your enterprise implements a federated architecture, you may be pre-
vented from viewing an object that is the target of the discussion. In this case, you should contact your 
user administrator. 

1) In the My Discussions functionality, select your discussion group and click the Edit  button. 
The Discussion Contribution editor opens. 

2) In the Comments field, enter your contribution to the discussion and, if necessary, modify the 
status of the discussion in the Discussion Status field. The discussion status describes the 
current stage of the discussion. 

3) If you would like the members of the participating discussion group(s) to be informed via an email 
notification that a contribution has been made, select the Notify Discussion Group Members 
checkbox. 

4) Click OK to save your contribution to the discussion or click Cancel if the contribution should not 
be saved. The members of the participating discussion group(s) will see your comment in the My 
Discussions functionality. 
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Editing the Object Under Discussion 

If Read/Write access permission has been configured for the discussion group, members may edit the ob-
ject that is under discussion. To edit the object, select your discussion group in the My Discussions func-

tionality and click the Navigate  button. 

Closing the Discussion for a Discussion Group 

Once the discussion has been completed, either the authorized user or a member of the managing discus-
sion group can make the discussion inactive for a participating discussion group. No further contributions 
can be made by an inactive discussion group. 

To remove a discussion group from the discussion, select the discussion group for which you want to close 

the discussion, click the Manage Group Discussions  button, and change the value in the Activity 
State column to Inactive. The discussion has been terminated for the discussion group and is no longer 
displayed in the My Discussions functionality. If you want to completely close the discussion for all discus-
sion groups, you must set the activity state to Inactive for all discussion groups participating in the discus-
sion. 
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Chapter 10:  Sending and Receiving Assignments for Alfabet Ob-
jects 

Assignments allow users to collaborate with one another about objects in the enterprise architecture. 

An assignment is a task that is defined for a selected object and assigned to a specific user. The assignee is 
expected to provide the required input for the object by a specified due date. Assignments can be defined 
to be optional or mandatory. Email notifications may be configured to be sent in the context of the assign-
ment capability. 

 

For example, the authorized user of an ICT object might send an assignment to the authorized 
users of the applications owned by the ICT objects, requesting them to review specific applica-
tion data. The owner of the ICT object would then create an assignment for each relevant appli-
cation, assign it to the relevant user, specify a target date when the assignment should be com-
pleted, and determine whether the assignment is mandatory or optional. If necessary, additional 
comments can be written in the assignment and relevant documents or Web links can be at-
tached. Assignments that require input from multiple persons can further be broken into sub-
assignments. 

The application owners will then receive an email notification informing them that they have a 
new assignment. The assignment can be accessed by the assignee in the My Assignments 
functionality. The assignee can define a reminder period for the deadline so that impending as-
signments are highlighted and a reminder email is sent to his/her email program when the re-
minder period begins. Once an assignment has been completed, the assignee can set the as-
signment’s status to completed. 

The originator of the assignment can track the progress of the assignment in the Sent Assign-
ments functionality. Impending assignments can be highlighted and any assignment’s that are 
not completed by their deadline will be returned to the originator who created the assignment. 
Completed assignments can be closed and removed from the Sent Assignments view. 

There are three different contexts in Alfabet in which you may encounter assignments: 

• The Assignments page view: In this view, you can create new assignments for the selected 
object, spin-off sub-assignments, update or reassign existing assignments, and keep track of all 
assignments created for the selected object. The Assignments page view also features a notepad 
functionality that allows you to communicate about the assignment or the object targeted by the 
assignment. 

• The My Assignments functionality: All assignments that have been assigned to you are displayed 
in the My Assignments functionality. You can navigate to any object associated with an 
assignment and thus process each assignment based on current data. Furthermore, you can set a 
reminder for yourself regarding the upcoming deadline of an assignment. 

• The Sent Assignments functionality: Here you have an overview of all assignments that you are 
the originator of. You can navigate to the object associated with a particular assignment and track 
the progress of each assignment. Furthermore, you can set a reminder for yourself about the 
upcoming deadline of an assignment. 

 

For more information about the configurations necessary for the assignments capability, see the 
section Configuring the Assignment Capability in the reference manual Configuring Alfabet with 
Alfabet Expand. 

The following information is available about assignments: 
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• Creating and Managing Assignments for Objects 

• Creating a New Assignment for an Object 

• Communicating with Other Users About the Assignment 

• Reassigning an Assignment to a Different User 

• Changing the Status of an Assignment 

• Viewing the History of the Assignment's Status Changes 

• Creating a Sub-Assignment for an Existing Assignment 

• Defining a Proxy to Manage Your Assignments 

• Working With the Assignments Assigned to You 

• Defining a Reminder about the Assignment 

• Fulfilling the Task Required by the Assignment 

• Failing to Complete an Assignment on Time 

• Keeping Track of Assignments That You Have Created 

• Changing the Target Date of an Assignment That You Own and Defining a Reminder 

• Viewing Closed Assignments 

• Deleting an Assignment That You Own 

Creating and Managing Assignments for Objects 

When you create an assignment for a selected object, you indicate what issue is at stake concerning the 
selected object, assign the issue to a user in the user community who is responsible for the assignment, 
and define a target date to indicate when the issue should be resolved. 

 

• An assignment is always created for a specific object. You can create an assignment for 
an object in the Assignments page view in the object profile of the targeted object or 

by clicking the Notify Authorized User  button in the toolbar of the object profile of 
the targeted object. 

• The user that you assign the assignment to will see his/her assignments in the My 
Assignments functionality. For more information, see the section Working With the 
Assignments Assigned to You. 

• You can track and maintain the assignments that you are the originator of in the Sent 
Assignments functionality. For more information, see the section Keeping Track of 
Assignments That You Have Created. 

• For more information about the configuration necessary for the assignments capability, 
see the section Configuring the Assignment Capability in the reference manual 
Configuring Alfabet with Alfabet Expand. 
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Depending on the configuration of your Alfabet solution, an email notification may be sent to the author-
ized user of the object targeted by the assignment informing them that an assignment has been generated 
for the selected object. In this case, the name of the assignee will be displayed in the To: field of the email 
and the creator of the assignment will be displayed in the From: field of the email. If deputies are defined 
responsibility for the selected object in the Authorized Deputies Page View, they will also receive email no-
tifications when an assignment is created. In this case, the names of the deputies will be displayed in the 
CC: field. Information about the configuration required to send emails for assignments is explained in Con-
figuring Email Notifications in the Context of Assignments in the reference manual Configuring Alfabet 
with Alfabet Expand. 

The Assignments page view is available for most objects in Alfabet. To access the Assignments page 
view, navigate to the object profile of the object that you want to create the assignment for and click As-
signments to open the view. 

The view displays all assignments associated with the selected object including critical information such as 
the user responsible to complete the assignment, the target date when the task should be complete, and 
the current status of the assignment. To display closed assignments that are no longer visible in the As-
signments page view, select the Show Closed Assignments with Target Date After checkbox and spec-
ify a date in the Calendar field to display closed assignments that have a target date after the defined date. 

The columns in the table are described below: 

• ID: The identification number of the assignment. 

• Assignment Type: Displays whether the assignment is optional or mandatory. A mandatory 
assignment must be completed by the target date or it will be returned to the originator. An 
optional assignment will be automatically closed if not completed by the target date. Additionally, 
the uncompleted assignment will be automatically removed from the My Assignments view of the 
assignee and NOT returned to the originator. 

• Name: Displays the assignment’s title. 

• Target Date: Displays the target date or deadline for the assignment. 

• Status: Displays the current status of the active assignment. Closed assignments are 
automatically removed from the view. 

• Last Changed Date: Displays the date when the assignment’s status was last changed. 

• Assignee Name: Displays the family name of the user that the assignment is assigned to. 

• Assignee First Name: Displays the first name of the user that the assignment is assigned to. 

The following information is available: 

• Creating a New Assignment for an Object 

• Communicating with Other Users About the Assignment 

• Reassigning an Assignment to a Different User 

• Changing the Status of an Assignment 

• Viewing the History of the Assignment's Status Changes 

• Creating a Sub-Assignment for an Existing Assignment 

• Defining a Proxy to Manage Your Assignments 
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Creating a New Assignment for an Object  

There are several methods to create an assignment for an object in the Alfabet database: Once an assign-
ment has been created for a selected object, the assignment will be displayed in the assignee’s My Assign-
ments functionality as well as the Sent Assignments functionality of the person who created the assign-
ment. 

1) Use on of the following methods to create an assignment for an object:  

• Create an assignment in the Assignments page view in the object profile of the targeted 
object to assign the assignment to a user of your choice. You can also view all other 
assignments that have been created for the selected object and break down a assignment into 
smaller sub-assignments. Open the view and click New > Create New Assignment. 

• Create an assignment for an object via the Notify Authorized User  button in the toolbar 
of the object profile of the targeted object to assign the assignment to the object's authorized 

user. Whether the Notify Authorized User  button is available in an object profile will 
depend on the configuration of your Alfabet solution. Click the Notify Authorized 

User  button. In the editor that opens, the authorized user will automatically be entered in 
the Assigned To field. 

• Copy an existing assignment for an object in the Assignments page view and create a new 
assignment that you can assign to another person. To do so, click New > Reuse Assignment 
in the toolbar. The Title, Target Date, Type, Creator, and Object fields will be copied to the 
new assignment. Any documents that have been attached to the original assignment will be 
included in the new assignment but can be removed, as needed. Once the new assignment 

has been created, you can modify it by clicking the Edit  button. 

2) The Assignment editor opens. Enter data in the editor, as needed. Each field is defined below:  

• ID: Alfabet assigns a unique identification number to each object in the inventory. This number 
cannot be edited. 

• Title: Title that clarifies the purpose of this assignment. 

• Target Date: Enter the target date or deadline for the assignment in the format appropriate to 

your cultures or click the Calendar  icon to select a date. 

• Status: Define or update the completion status of the assignment.  

 

The set of release statuses available for the class Assignment are configured by 
your solution designer in the configuration tool Alfabet Expand. For more infor-
mation, see the section Defining the Statuses Used for the Assignment Capability 
in the reference manual Configuring Alfabet with Alfabet Expand. 

• Assigned To: Click the Search icon to select the user that this assignment is assigned to. 

• Type: Define whether completion of the assignment is Mandatory or Optional. Please note 
the following consequences if the assignee does not complete the assignment by the 
specified target date.  

• Mandatory assignments: If the assignee fails to complete a mandatory assignment by the 
target date, the status of the assignment will automatically change to a re-assigned 
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status when the target date is reached. Consequently, the assignment will be 
automatically returned to the originator of the assignment and will be removed from the 
assignee's My Assignments view. 

• Optional assignments: If the assignee fails fail to complete an optional assignment by the 
target date, the status of the assignment will automatically change to a closed status 
when the target date is reached. Consequently, the assignment will be automatically 
removed from the assignee's My Assignments view. Optional assignments will NOT be 
returned to the originator of the assignment. 

• Object: Displays the object that this assignment is about. 

• Description: Enter a meaningful description about the assignment. 

• Remarks: Enter any necessary remarks about the assignment. 

• Documents: Attach a document stored in the Internal Document Selector or define a URL 
that pertains to the assignment. For more information about attaching documents and 
defining URLs, see the Attachments Page View. 

3) Click OK to save your changes or click Cancel to exit without saving. The assignment will be 
displayed in the Assignments page view for the selected object. The assignment will also be 
displayed in the My Assignments view of the assignee and the Sent Assignments view of the 
user who originally created the assignment. 

Communicating with Other Users About the Assignment  

A Notepad capability is available to facilitate free-form communication about an assignment for a selected 
object. Users can access the Notepad capability in the Assignments page view and write text relevant to 
the assignment. All entries are saved with a timestamp and displayed in the Notes History pane in the As-
signment Notepad editor. Any user wishing to view the notepad entries can select the assignment in the 
Assignments page view and click Assignment > Notepad in the toolbar to open the Assignment Notepad 
editor. 

Depending on the configuration of your Alfabet solution, the user entering a notepad entry may send an 
email notification to the assignee and/or the person who created the assignment. Furthermore, you can 
export the notepad entries displayed in the Notes History pane to an HTML file. 

 
Please consider the following regarding the sending of email notifications in conjunction with the 
Notepad capability. 

• A user with ReadOnly permission to an object associated with an assignment may create 
and send notes via the Notepad capability. Please note that, in this case, if the server 
settings are configured to use the sender’s user profile to access Alfabet via hyperlinks 
in emails, the recipient of the email will also have ReadOnly permissions when he/she 
accesses the relevant views via the hyperlinks in the email notification. 

• If emails are to be sent in the context of the Notepad capability, the email capability for 
assignments must be activated. For more information about activating automatic email 
generation in the context of the assignment capability, see the section Configuring the 
Assignment Capability in the reference manual Configuring Alfabet with Alfabet Expand. 

• If email notifications about notepad entries are to be sent to the originator or the 
assignee of the assignment, the Notify Originator and/or Notify Assignee checkboxes 
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respectively must be selected in the Assignment Notepad editor. If neither the Notify 
Originator or Notify Assignee checkboxes are checked, no email notification will be 
sent. In this case, the notepad entries can only be viewed in the Notes History pane in 
the Assignment Notepad editor. 

To create a notepad entry: 

1) In the Assignments page view for a selected object, select the assignment that you want to 
create a note for. 

2) In the toolbar, click Assignment > Notepad. The Assignment Notepad editor opens. 

3) The following fields are displayed:  

• Notes History: Displays a history of the notepad entries defined for the assignment. The 
syntax contains Date, Timestamp, User Name (of the user writing the note), ID of the 
assignment, and the note text. 

• Note Info: Displays notepad information including the timestamp, name of the user who 
created the notes, and the ID of the assignment that the note is for. 

• Note Text: Enter text for the note you want to create for the assignment. 

• Notify Originator: Select this checkbox if you want an email sent to the originator of the 
assignment informing him/her that a notepad entry has been created. 

• Notify Assignee: Select this checkbox if you want an email sent to the assignee of the 
assignment informing him/her that a notepad entry has been created. 

4) Click OK to save the note or Cancel if you do not want to save it. 

Reassigning an Assignment to a Different User  

If necessary, you can reassign an assignment to another user. For example, you might want to reassign an 
assignment to a user who has the permission to edit an object associated with the object that the assign-
ment is about. The status of the assignment will be changed to Reassigned. 

 
Please note the following: 

• You should only reassign an assignment if it no longer concerns the current assignee in 
any way. Once an assignment has been reassigned, it will be removed from the original 
assignee’s My Assignments functionality. 

• If it is necessary to delegate a part of the task assigned to you, you may create a sub-
assignment based on the original assignment. For more information, see Creating a Sub-
Assignment for an Existing Assignment. 

When you reassign an assignment, the assignment will be displayed in the new assignee’s My Assign-
ments functionality as well as the Sent Assignments functionality of the person who originally created 
the assignment. Depending on the configuration of your Alfabet solution, an email notification may be sent 
to the new assignee informing them that they have been assigned a task for the selected object. 

To reassign an assignment to another user: 
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1) In the My Assignments functionality, Sent Assignments functionality, or the Assignments page 
view for a selected object, select the assignment that you want to reassign to another user. 

2) In the toolbar, click Edit  button. The Assignment editor opens. 

3) In the Assigned To field, click the Search icon to select the user that this assignment is assigned 
to. Once you change the Assigned To value and close the editor by clicking OK, the Status value 
will automatically be set to Re-Assigned. Any changes you make to the Status value before you 
close the editor will be ignored. 

4) If necessary, provide additional remarks about the assignment in the Remarks field or relevant 
documents in the Documents field. 

5) Click OK to save your changes or click Cancel to exit without saving. The assignment is displayed 
in the Assignments page view for the selected object. The assignment will also be displayed in the 
My Assignments view of the new assignee and the Sent Assignments view of the user who 
originally created the assignment. 

Changing the Status of an Assignment  

While the assignment is being processed, the assignment’s status may need to be changed in order to indi-
cate its degree of completion so that the user who created the assignment as well as other users interested 
in the object can track the progress of the assignment. 

You can change an assignment's status by clicking the Edit  button and changing the Status property 

in the Edit  button editor in any of the following views: 

• In the Assignments page view. 

• In the My Assignments functionality. 

• In the Sent Assignments functionality. 

• In the assignment’s object profile. 

When you change the status of an assignment, the new status will be displayed in the assignee’s My As-
signments functionality as well as the Sent Assignments functionality of the person who created the as-
signment. Depending on the configuration of your Alfabet solution, an email notification may be sent to the 
person who created the assignment informing them that the assignment’s status has been changed. 

After an assignment’s status is changed to a closed status, the assignment will be automatically removed 
from the views associated with the assignment capability. However, the originator of the assignment can 
explicitly choose to display any assignments that have been closed after a specific date in the Sent As-
signments view. For more information about how to access closed assignments, see the section Viewing 
Closed Assignments. 

To view the assignment’s previous statuses, select the assignment and click the Assignment > Audit Trail 
button. The Assignment Audit Trail view displays the statuses of the assignment prior to the current sta-
tus as well as information about the user who made the status change and the time of the change. 

 

The release statuses available will depend on the configuration of your Alfabet solution. The set 
of release statuses available for the class Assignment are configured by your solution designer 
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in the configuration tool Alfabet Expand. For more information, see the section Configuring the 
Assignment Capability in the reference manual Configuring Alfabet with Alfabet Expand. 

Viewing the History of the Assignment's Status Changes 

It may be that some assignments are complex and require a long period of time between status changes. 
Alfabet provides a history capability that allows you to view the status changes that have been made to a 
selected assignment prior to the assignment’s current status. 

The Assignment Audit Trail page view for an assignment can be accessed via the following views: 

• In the Assignments page view, select the assignment and click Assignments > Audit Trail. 

• In the My Assignments functionality, select the assignment and click the Audit Trail button. 

• In the Sent Assignments functionality, select the assignment and click the Audit Trail button. 

• In the assignment’s object profile, click the Assignment Audit Trail page view. 

The following information is displayed about the assignment’s history and progress: 

• Caption: The name of the assignment 

• Target Date: The targeted deadline of the assignment. 

• Status: The previous status of the assignment.  

 
The assignment’s current status is NOT displayed in the Assignment Audit Trail view. 
To view the assignment’s current status, click the browser's Back button to return to the 
My Assignments view. 

• Change Date: The date that the assignment was edited. 

• Change User: The user that edited the assignment. 

You can export an HTML or Microsoft® Excel® file of this report by clicking Export > HTML or Export > MS 
Excel File in the toolbar. For more information about export options in Alfabet, see the section Exporting 
Data. 

Creating a Sub-Assignment for an Existing Assignment 

In order to coordinate and manage more complicated data maintenance tasks, you can create sub-assign-
ments for an existing assignment. A sub-assignment is processed and tracked the same as a regular as-
signment. When you create a sub-assignment for a selected object, the sub-assignment will be displayed in 
the assignee’s My Assignments functionality as well as the Sent Assignments functionality of the person 
who created the assignment. 

1) In the Assignments page view for a selected object, select the assignment that you want to break 
down into sub-assignments. 

2) In the toolbar, click Assignments > Sub-Assignments. The Sub-Assignments page view opens. 

3) In the toolbar, click New > Create New Sub-Assignment. The Sub-Assignments editor opens. 
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4) Enter the data, as needed. Each field is defined below:  

• ID: Alfabet assigns a unique identification number to each object in the inventory. This number 
cannot be edited. 

• Title: Enter a meaningful title that clarifies the purpose of this assignment. 

• Target Date: Enter the target date or deadline for the assignment in the appropriate format or 
click the Calendar icon to select a date. 

• Status: Define the completion status of the assignment.  

 

The set of release statuses available for the class Assignment are configured by 
your solution designer in the configuration tool Alfabet Expand. For more infor-
mation, see the section Configuring Release Status Definitions for Object Classes in 
the reference manual Configuring Alfabet with Alfabet Expand. 

• Assigned To: Click the Search icon to select the user that this assignment is assigned to. 

• Parent Assignment: Displays the assignment that this assignment is subordinate to. 

• Type: Define whether completion of the assignment is Mandatory or Optional. Please note 
the following consequences if the assignee does not complete the assignment by the 
specified target date.  

• Mandatory assignments: If the assignee fails to complete a mandatory assignment by the 
target date, the status of the assignment will automatically change to a re-assigned 
status when the target date is reached. Consequently, the assignment will be 
automatically returned to the originator of the assignment and will be removed from the 
assignee's My Assignments view. 

• Optional assignments: If the assignee fails fail to complete an optional assignment by the 
target date, the status of the assignment will automatically change to a closed status 
when the target date is reached. Consequently, the assignment will be automatically 
removed from the assignee's My Assignments view. Optional assignments will NOT be 
returned to the originator of the assignment. 

• Object: Select the object that this assignment is about. 

• Description: Enter a meaningful description about the assignment. 

• Remarks: Enter any necessary remarks about the assignment such as an explanation about 
why the sub-assignment is necessary. 

• Documents: Attach a document stored in the Internal Document Selector or define a URL 
that pertains to the assignment. For more information about attaching documents and 
defining URLs, see the Attachments Page View. 

5) Click OK to save your changes or click Cancel to exit without saving. The sub-assignment is 
displayed in the Assignments page view for the selected object. The assignment will also be 
displayed in the My Assignments view of the assignee and the Sent Assignments view of the 
user who originally created the assignment. Depending on the configuration of your Alfabet 
solution, email notifications may be sent to the assignee informing him/her of the new assignment. 
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Defining a Proxy to Manage Your Assignments  

Because assignments must be completed by a specified deadline, it is recommended that you specify alter-
nate persons to take care of your assignments in case of a planned absence. You can define proxies to be 
responsible for assignments targeting objects for a specific object class. You should not assign more than 
one user per object class. 

During the times that you are absent as specified in the User’s Availability page view, each proxy user you 
have defined will have the necessary access permissions to the assignments that he/she is responsible for 
via the proxy definition. The assignments will be accessible in the proxy’s My Assignments view. 

 

Your planned absences and general availability must be documented in the User’s Availability 
Page View. 

 

 
Email notifications will continue to be sent to the original user. Please note that the proxy user 
will NOT receive email notifications. A notification monitor can be configured to notify the proxy 
about the workflow step. For more information, see the section Defining Notification Monitors in 
the reference manual User and Solution Administration. 

To define a proxy for your assignments: 

1) Navigate to the Personal Info functionality and click User’s Proxies. 

2) In the toolbar, click the Add Assignments Proxy button. The Proxy Definition editor opens. 

3) In the editor that opens, select a user in the Proxy field. 

4) In the Sub-Categories field, select the object class that the assignments are based on that is 
relevant for the selected person. This person will only be authorized to view and access 
assignments that are created for objects in the selected object class(es). 

5) Click OK to close the editor and save your data. 

Working With the Assignments Assigned to You 

The My Assignments functionality provides you with an overview of all active assignments that have been 
assigned to you and that you currently responsible for completing. After an assignment’s status is changed 
to a closed status, the assignment will automatically disappear from the My Assignments functionality. An 
optional assignment that is not completed by the target date will automatically be changed to a closed sta-
tus and will be removed from the My Assignments functionality. 

The columns in the table are described below: 

• ID: The identification number of the assignment. 

• Assignment Type: Displays whether the assignment is optional or mandatory. A mandatory 
assignment must be completed by the target date or it will be returned to the originator. An 
optional assignment will be automatically closed if not completed by the target date. Additionally, 
the uncompleted assignment will be automatically removed from the My Assignments view of the 
assignee and NOT returned to the originator. 

• Name: Displays the assignment’s title. 
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• Target Date: Displays the target date or deadline for the assignment. If you have defined a 
reminder for yourself about impending assignments, any assignments that have reached the 
defined reminder period will be highlighted. To define reminders about impending target dates, see 
the section Defining a Reminder about the Assignment. 

• Status: Displays the current status of the active assignment. Closed assignments are 
automatically removed from the view. 

• Last Changed Date: Displays the date when the assignment’s status was last changed. 

• Object ID: Displays the identification number of the object that the assignment has been created 
for. 

• Object Name: Displays the name of the object that the assignment has been created for. 

• Originator Name: Displays the family name of the user that has assigned this assignment to you. 

• Originator First Name: Displays the first name of the user that has assigned this assignment to 
you. 

 

Please keep the following in mind: 

• You cannot create new assignments here. An assignment is created for a specific 
object in the Assignments page view associated with that object. For more 
information, see the section Creating and Managing Assignments for Objects. 

• Assignments that you have created are listed in the Sent Assignments functionality. 
For more information, see the section Keeping Track of Assignments That You Have 
Created. 

• For an overview of the configuration required to work with the assignment capability, 
see the section Configuring the Assignment Capability in the reference manual 
Configuring Alfabet with Alfabet Expand. 

For more information about working with assignments that have been assigned to you, see the following 
topics 

• Defining a Reminder about the Assignment 

• Fulfilling the Task Required by the Assignment 

• Failing to Complete an Assignment on Time 

The following procedures are also often necessary when working with assignments. 

• Communicating with Other Users About the Assignment 

• Reassigning an Assignment to a Different User 

• Changing the Status of an Assignment 

• Creating a Sub-Assignment for an Existing Assignment 
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Defining a Reminder about the Assignment  

You can define a reminder for yourself that lets you know when the assignments that you are responsible 
for are about to reach their target dates. When you define the reminder period, assignments with a target 
date that fall within the defined period will be highlighted red in the My Assignments table. You can define 
a date before or after the assignments’ target date. 

To define a reminder for yourself about the assignment: 

1) In the My Assignments functionality, click the Configure Reminder Period button in the toolbar. 
In the window that opens, define the following settings, as needed:  

• Reminder Period (days): Enter the number of days before the target date when an 
assignment in the My Assignments table should be highlighted. If you want assignments 
highlighted after a target date, enter a negative number value (for example, "-5" indicates that 
the reminder should be triggered five days after a target date). 

• Send Reminder Notifications: Select this checkbox if you want an automatically-generated 
email notification sent to your email account when the reminder is triggered. Automatic email 
notification must be configured for the assignment capability in order for reminder 
notifications to be sent. For more information about configurability requirements, see the 
section Configuring the Assignment Capability in the reference manual Configuring Alfabet 
with Alfabet Expand. 

2) Click OK to save your changes, or click Cancel to exit without saving. The assignment will be 
highlighted red when it reaches the reminder period you have defined. 

 

To communicate with the assignee about an assignment that is due, see Communicating with 
Other Users About the Assignment. 

Fulfilling the Task Required by the Assignment  

To complete the task specified by the assignment, you will need to understand the task that is required of 
you as well as the view in which you can carry out the required task. Once the task has been completed, 
you must change the status of the assignment to indicate that it has been completed. 

 

In some cases, you may not be able to complete the assignment because you need additional 
feedback or other users to contribute to the assignment. In this case, functionalities available in 
the Assignments page view allow you to break down the assignment into sub-assignments or 
communicate with other users about the assignment. For more information, see the following: 

• Creating a Sub-Assignment for an Existing Assignment 

• Communicating with Other Users About the Assignment 

To carry out the task required by the assignment: 

1) Select the assignment in the My Assignments functionality. In the preview pane below, scroll the 
information in order to display the description of the assignment as well as any remarks that may 
be useful to completing the task. 
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2) To navigate to the object profile of the object that is targeted by the assignment, select the object 

in the table and click the Navigate  button and carry out the required task.  

 
For help finding the relevant page view, please refer to the context-sensitive Help avail-
able for the object profile you are currently working with. 

3) Once the task has been completed, return to the My Assignments functionality or the 
Assignments page view for the object and change the status of the assignment to indicate that it 
has been completed. To change the status of the assignment, see the section Changing the Status 
of an Assignment. 

Failing to Complete an Assignment on Time  

Completing an assignment entails carrying out the task that is required and changing the status of the as-
signment to a completed status. 

 
You must manually change the Status property of the assignment in order for it to be recognized 
as finished in the assignment capability. To change the status of the assignment, see the section 
Changing the Status of an Assignment. 

Please note the following consequences if you do not complete an assignment that you are responsible for: 

• Mandatory Assignments: If you fail to complete a mandatory assignment by the target date, the 
status of the assignment will automatically change to a re-assigned status when the target date is 
reached. Consequently, the assignment will be automatically returned to the originator of the 
assignment and will be removed from your My Assignments view. 

• Optional Assignments: If you fail to complete an optional assignment by the target date, the status 
of the assignment will automatically change to a closed status when the target date is reached. 
Consequently, the assignment will be automatically removed from your My Assignments view. 
Optional assignments will not be returned to the originator of the assignment. 

It is therefore highly recommended that you define a reminder period for your assignments so that they do 
not leave your My Assignments functionality before you have completed them. All assignments that fall 
within the reminder period you define will be highlighted red in the My Assignments table. Additionally, you 
can set the reminder capability to send email notifications to your email program letting you know that a 
target date is impending for an assignment that you are responsible for. 

For or more information about defining a reminder period, see the section Defining a Reminder about the 
Assignment. 

Keeping Track of Assignments That You Have Created 

The Sent Assignments functionality allows users who have created assignments to keep track of the pro-
gress of all assignments that they own. 

The Sent Assignments functionality displays all assignments that you have created that have not yet 
reached a completed status. Select any assignment in the table to display a preview showing the selected 
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assignment’s description and creation/update history. To display closed assignments that are no longer 
visible in the Sent Assignments functionality, select the Show Closed Assignments with Target Date 
After checkbox and a date in the Calendar field to display closed assignments that have a target date af-
ter the selected date. All assignments with a closed status that have a target date after the selected date 
will be included in the table. 

The columns in the table are described below: 

• ID:The identification number of the assignment. 

• Assignment Type: Displays whether the assignment is optional or mandatory. A mandatory 
assignment must be completed by the target date or it will be returned to the originator. An 
optional assignment will be automatically closed if not completed by the target date. Additionally, 
the uncompleted assignment will be automatically removed from the My Assignments view of the 
assignee and NOT returned to the originator. 

• Name: Displays the assignment’s title. 

• Target Date: Displays the target date or deadline for the assignment. If you have defined a 
reminder for yourself about impending assignments, any assignments that have reached the 
defined reminder period will be highlighted. 

• Status: Displays the current status of the active assignment. Closed assignments are 
automatically removed from the view. 

• Last Changed Date: Displays the date when the assignment’s status was last changed. 

• Object ID: Displays the identification number of the object that the assignment has been created 
for. 

• Object Names: Displays the name of the object that the assignment has been created for. 

• Assignee Name: Displays the family name of the user that the assignment is assigned to. 

• Assignee First Name: Displays the first name of the user that the assignment is assigned to. 

 

• New assignments cannot be created in the Sent Assignments functionality. An 
assignment can be created for a specific object in the Assignments page view 
associated with that object. For more information, see the section Creating a New 
Assignment for an Object. 

• Any assignments that have been assigned to you and that you are responsible for are 
listed in the My Assignments functionality. For more information, see Working With the 
Assignments Assigned to You. 

• For more information about the configurations necessary for the assignments 
capability, see the section Configuring the Assignment Capability in the reference 
manual Configuring Alfabet with Alfabet Expand. 

For more information about working with assignments that have created, see the following information: 

• Changing the Target Date of an Assignment That You Own and Defining a Reminder 

• Viewing Closed Assignments 

• Deleting an Assignment That You Own 
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The following procedures are also often necessary when working with assignments. 

• Communicating with Other Users About the Assignment 

• Reassigning an Assignment to a Different User 

• Changing the Status of an Assignment 

• Creating a Sub-Assignment for an Existing Assignment 

Changing the Target Date of an Assignment That You Own and Defining a Reminder  

In some cases, it may be necessary to change the assignment’s target date. Only the owner of the assign-
ment (the person who created the assignment) may change the target date. When you change the target 
date of an assignment, the new target date will be displayed in the assignee’s My Assignments functional-
ity. 

You can also define a reminder for yourself that lets you know when the assignments that you have cre-
ated are about to reach their target dates. When you define the reminder period, assignments with a target 
date that fall within the defined period will be highlighted red in the Sent Assignments table. You can de-
fine a date before or after the assignments’ target date. 

To change the status of an assignment: 

1) In the Sent Assignments functionality, select the assignment that you want to reassign to 
another user. 

2) In the toolbar, click Edit  button. The Assignment editor opens. 

3) In the Target Date field, enter the new target date. 

4) If necessary, provide additional remarks about the assignment in the Remarks field or relevant 
documents in the Documents field. 

5) Click OK to save your changes or click Cancel to exit without saving. The assignment target date 
will be updated in the Assignments page view for the selected object. The assignment target date 
will also be displayed in the My Assignments view of the assignee and the Sent Assignments 
view of the user who originally created the assignment. 

6) To view the assignment’s previous target date, select the assignment and click the Assignment > 
Audit Trail button. The Assignment Audit Trail view displays the target date of the assignment 
prior to the current change as well as information about the user and time of the change. 

To define a reminder about an assignment's target date. 

1) In the Sent Assignments functionality, click the Configure Reminder Period button in the 
toolbar. In the window that opens, define the following setting, as needed:  

• Highlight Assignments Due in (days): Enter the number of days prior to the target date 
when an assignment in your Sent Assignments table should be highlighted. If you want 
assignments highlighted after a target date, enter a negative value (for example, "-5" indicates 
that the reminder should be triggered five days after a target date). 

2) Click OK to save your changes, or click Cancel to exit without saving. The assignment will be 
highlighted red when it reaches the reminder period you have defined. 
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To communicate with the assignee about the assignment that is due, see Communicating with 
Other Users About the Assignment. 

Viewing Closed Assignments  

An assignment can be closed by either the assignee or originator once it has been completed. On optional 
assignment that is not completed by the target date will also be automatically closed. After an assign-
ment’s status is changed to a closed status, the assignment will be automatically removed from the views 
associated with the assignment capability. However, the originator of the assignment can explicitly choose 
to display any assignments that have been closed in the Sent Assignments view. 

1) In the Sent Assignments functionality, select the Show Closed Assignments with Target Date 
After checkbox. 

2) In the Calendar field, enter a date to show all closed assignments with a target date later than the 
date entered. 

3) Click the Update button. All closed assignments that meet the filter criteria will be displayed 

Deleting an Assignment That You Own  

The owner of the assignment (the person who created the assignment) or the authorized user of the object 
targeted by the assignment may delete the assignment. 

 
You can delete an assignment regardless of its status. If you delete an object in the object class 
Assignment, it will be irrevocably deleted from the Alfabet database. If any of the following de-
pendent objects or data is defined for the deleted object, these will also be deleted: Sub-Assign-
ment; Assignment Notepad. 

1) In the Sent Assignments functionality, select the assignment you want to delete. 

2) In the toolbar, click the Delete  button. 

3) Confirm the warning by clicking Yes, or click No to exit without deleting the selected object(s). 
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Chapter 11:  Executing Workflows and Participating in Workflow 
Steps 

A workflow is a collaborative process made up of workflow steps that are typically carried out by one or 
more users. A workflow is based on a configured workflow template that determines the sequence of work-
flow steps that are to be performed on a specific object and its references by specified user(s). Workflow 
steps may have specific pre- and post-conditions that determine different paths to take in the workflow 
depending on whether the conditions are or are not met. 

Typically, the workflow owner is the user who initiates and is responsible for maintaining the workflow. 
When a workflow is initiated by the workflow owner and when a workflow advances to the next workflow 
step, relevant users may be informed via automatically-generated emails of their impending responsibility 
for the workflow step. This functionality ensures that all relevant users are informed and reminded of their 
responsibilities in the collaborative workflow. The option to refuse, delegate, and pause workflow steps, re-
mind users of an impending target date for a workflow step as well as redirect a workflow that has encoun-
tered an error enables workflow owners and workflow administrators to keep track, coordinate, and manage 
the completion of each workflow step and the workflow as a whole. 

The workflow capability provided in Alfabet allows you to perform all tasks related to workflows: 

• Workflows can be started based on configured workflow templates. When a workflow template is 
triggered, a workflow is generated for each object found by the workflow template. Depending on 
the configuration of the workflow template, it is possible that only one workflow is generated or 
perhaps hundreds of workflows. The user who triggers the workflow template is considered the 
owner of the workflow(s). Workflows may be started in the following ways:  

• Via the My Workflows functionalities. For more information about starting workflows via the 
My Workflows functionality, see the section Starting and Maintaining Workflows in the My 
Workflows Functionality. 

• Via the Workflow  button in the toolbar of an object profile of an object class for which 

workflow templates have been configured. The Workflow  button in the object 
profile/object cockpit allows the user to start a workflow for the selected object. For more 
information about starting a workflow for a selected object via it's object profile/object 
cockpit, see the section Starting a Workflow for an Object via the Object Profile/Object Cockpit. 

• Via configured batch processes that are initiated by the system administrator. Some workflow 
templates may be configured to start automatically via a batch process. In this case, the user 
who initiates the batch process is the owner of the workflow and will be responsible for 
maintaining the workflows that he/she has initiated. The workflow administrator, however, 
can reassign such workflows to a different workflow owner in the Workflow Administration 
functionality. For more information about changing the workflow owner, see the section 
Changing the Owner of a Workflow Template or Workflow in the reference manual User and 
Solution Administration. 

• Workflows can be tracked and managed by the workflow owner. For more information, see the 
section Starting and Maintaining Workflows in the My Workflows Functionality. 

• Workflow steps can be viewed, performed, and managed by the users that are responsible for the 
workflow steps. The user(s) responsible for a workflow step may edit the object targeted by the 
workflow step even though they may not otherwise have access permissions to the object. 
However, access permissions will not be granted for the object outside of the context of the 
workflow step. Workflow steps are processed in either the My Workflow Activities functionalities 
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or, if configured by your solution designer in the Workflow Activities Explorer. For more 
information, see the section Performing the Workflow Steps That You Are Responsible For. 

 

A Workflow Administration functionality is available via an administrative user profile that al-
lows a workflow administrator to track the progress and resolve a conflict for any workflow. For 
example, if a workflow step’s target date has expired or if no responsible user is assigned to a 
workflow step or found via the query specified for the workflow template, the workflow step will 
escalate. These errors must be dealt with and resolved by either the workflow owner or the 
workflow administrator. The workflow administrator may also carry out other tasks such as 
rechanneling the workflow to another workflow step, changing the state of a workflow template 
or the owner of a workflow. For more information about the functionalities available to the work-
flow administrator, see the chapter Tracking and Managing Workflows in the reference manual 
User and Solution Administration. 

The following information is available for workflow owners and users responsible for workflow steps: 

• Starting a Workflow for an Object via the Object Profile/Object Cockpit 

• Starting and Maintaining Workflows in the My Workflows Functionality 

• Triggering a Workflow Template and Starting Workflows in the My Workflows Functionality 

• Accessing More Information About the Workflow 

• Understand the Course of the Workflow 

• Suspending, Resuming, or Withdrawing the Workflow 

• Understanding Event Values and Resolving Workflow Errors 

• Fixing a Workflow with an Error State 

• Redirecting a Workflow Step to Another Step 

• Adding Responsible Users to a Workflow Step 

• Delegating a Workflow Step to Another User 

• Deleting a Running Workflow 

• Performing the Workflow Steps That You Are Responsible For 

• Performing and Tracking Your Workflow Steps in the Workflow Activities Explorer Functionality 

• Performing and Tracking Your Workflow Steps in the My Workflow Activities Functionality 

• Accessing More Information About the Workflow Step 

• Performing and Completing a Workflow Step 

• Delegating a Workflow Step to Another Alfabet User 

• Refusing a Workflow Step 

• Releasing the Lock on a Workflow Step 

• Accessing Details about the Current Workflow Step 

• Accessing Details about the Preceding Workflow Step 
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• Performing and Tracking Your Workflow Steps for a Selected Object in the Associated 
Workflows Page View 

• Defining a Proxy to Manage Your Workflow Steps 

Starting a Workflow for an Object via the Object Profile/Object 
Cockpit  

If a workflow can be initiated for an existing object, a Workflow  button will be displayed in the toolbar 
of the object’s object profile/object cockpit. If more than one workflow template exists that you have ac-
cess permissions to for the object class, all relevant workflow templates will be displayed in the drop-down 

menu when the Workflow  button is clicked. 

You can initiate a workflow for the selected object for any workflow template displayed in the drop-down 
menu. Once you initiate and start a workflow, you are the workflow owner for the entire duration of the 
workflow unless the workflow administrator changes the workflow owner. As workflow owner, you are re-
sponsible for tracking the progress of the workflow from its start to completion as well as ensuring that the 
current workflow step is being performed in a timely manner. 

 

You can only start a workflow via the object profile if a workflow template has been configured 
that allows for workflows to start for existing objects in the relevant object class. For more infor-
mation about the configuration of the workflow functionality for an object profile, see the sec-
tion Configuring the Manual Start of Workflows in the chapter Configuring Workflows in the ref-
erence manual Configuring Alfabet with Alfabet Expand. 
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 FIGURE: Starting a workflow for a selected object in the object profile 

1) To initiate a workflow for the selected object, click the Workflow  button in the object 
profile/object cockpit toolbar and select the relevant workflow template that you want the 
workflow to be based on. Depending on the definition of the initial workflow step, you may see any 
of the following:  

• An editor in which you can create and define an object. Enter the relevant data and click OK to 
close editor. 

• A wizard that will guide you through the workflow step. Enter the relevant data for each view 
and click Next to advance to the next view in the wizard. Click Finish when all views are done. 
For general information about using a wizard, see Entering Data in Editors and Wizards in the 
reference manual Getting Started with Alfabet. If you do not complete the data input in the 
current session and you are working in a wizard, the following will apply:  

• If the workflow was started by creating a new object:  

• If the user has entered information in the first wizard step and clicked the Next 
button and then cancels the wizard, the first workflow step and the newly created 
object WILL be saved to the database. 

• If the user has entered information in the first wizard step, has NOT clicked the Next 
button and then cancels the wizard, the workflow step as well as the newly created 
object will NOT be saved to the database. 

• If the workflow was started with an existing object and the wizard was cancelled 
during the first wizard step, the workflow step will not be saved to the database. 
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• A report that should be reviewed. Typically this step requires no data entry. 

• A page view that may require data entry or may require a review. 

• An object profile that may require data entry or may require a review. 

• In some cases, the first workflow step may be a system-generated action that does not 
require user input or user action. Typically, an informational message will be configured by 
your workflow designer letting you know that the workflow has been started. 

2) Carry out the necessary data entry or data review required for the first workflow step. The data 
input that is required for the first workflow step may be none or minimal and you may be able to 
complete the first workflow step immediately. Or, the data input that is required may be more 
extensive and you may need to perform the first workflow step over multiple sessions. Please note 
the following:  

• If you complete the input of required data in the current session, the workflow will 
automatically begin once you close the relevant editor, wizard, page view, etc. The new 
workflow will be displayed in the Workflows section of the My Workflows functionality and, if 
the workflow step is complete, will show Running in the Workflow State column. You can 
track and maintain the workflow in the My Workflows functionality. For more information, see 
the section Starting and Maintaining Workflows in the My Workflows Functionality. 

• If you do not complete the data input required in the current session, any data you have 
entered in the relevant editor, page view, etc. will be saved. The new workflow will be displayed 
in the Workflows section of the My Workflows functionality and will show Pending in the 
Workflow State column. You can return to the first workflow step at any time in the My 
Workflows functionality. To view all workflows that are still in the state of initiation, select the 
value Pending in the Workflow State filter in the My Workflows functionality. To resume 
definition of the interrupted workflow step, select the workflow and click the 

Perform  button in the My Workflows functionality. The relevant view will open that 
allows you to continue the definition of the initial workflow step. For more information, see the 
section Starting and Maintaining Workflows in the My Workflows Functionality. 

• Once the workflow is running, the users responsible to perform the workflow step displayed in 
the Current Step column will be able to access and process the workflow step. For more 
information about processing a workflow step, see the section Performing the Workflow Steps 
That You Are Responsible For. 

Starting and Maintaining Workflows in the My Workflows Function-
ality 

Workflows in Alfabet are based on a workflow template that is configured in the configuration tool Alfabet 
Expand by your company's workflow designer. 

A workflow template is a customer-defined blueprint for one or more workflows. The template specifies 
what object class is the point-of-departure in the workflow, which user groups and/or user profiles may 
initiate and administrate the workflow, which workflow steps comprise the workflow as well as their se-
quence, any possible per- and post-conditions or update actions associated with a workflow step, and 
what kinds of workflow notifications should be sent to collaborating users in which contexts. The user who 
creates the workflow template is the workflow template owner. 
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A workflow template must have the attribute Workflow State attribute set to Plan to be configured and 
validated. Once the workflow template is completed and approved, the attribute Workflow State must be 
switched to Active in order to make it available to the user community. Once the workflow template is 
available in Alfabet, a permitted user may initiate a workflow based on the workflow template. Multiple 
workflows may be simultaneously initiated and running for a workflow template. 

The My Workflows functionalities displays all workflow templates that you have access permissions to. You 
can trigger workflows for any of these workflow templates. A workflow will be started for every object 
found by the query configured for the workflow template. 

Typically, the Alfabet user who triggers the workflow is the owner of the workflow. The workflow owner is 
responsible for maintaining the workflow and ensuring its progress towards completion. The option to re-
fuse, delegate, withdraw, and suspend workflow steps, remind users of an impending target date for a 
workflow step as well as redirect a workflow that has encountered an error enables workflow owners and 
workflow administrators to keep track, coordinate, and manage the completion of each workflow step and 
the workflow as a whole. 

When a workflow is initiated by the workflow owner, relevant Alfabet users are typically informed via auto-
matically generated emails of their impending responsibility in the workflow. Whether emails are automati-
cally sent when a workflow step is entered will depend on the configuration of the workflow. 

Before you start workflows, you should familiarize yourself with the information displayed in these func-
tionalities. The table is divided into two sections. The Workflows section displays all workflows that you are 
the workflow owner of. These are the workflows that you have initiated or been assigned ownership of by 

your workflow administrator. Click the  to expand a workflow in order to view it's currently active work-
flow step. The Start New Workflow section of the table displays all workflow templates that you have ac-
cess permissions to. You may trigger workflows for any of the workflow templates displayed. 

 

Please note that a maximum of 100 workflows and workflow templates will be displayed in the 
view. If the combination of workflows and workflow templates exceeds 100, navigate to the next 
page of results via the floating toolbar in the lower right corner of the view. 

It may be that you have access permissions to many workflow templates and an excessive amount of work-
flows. Filters allow you to limit the workflow templates and workflows displayed according to various crite-
ria. For example, to view all workflows that are currently in progress, you could select the value Running in 
the Workflow State filter. You can define one or more of the following filters as needed: 

• Workflow Templates: Click the arrow to select one or more active workflow templates. All 
workflows that have been initiated for the selected active workflow template(s) will be displayed in 
the table. Only active workflow templates that may be started manually will be displayed in the 
table. Workflow templates configured to start automatically will not be displayed. 

• Workflow: Click the arrow to select one or more workflows to display in the table. All instances of 
the selected workflow(s) will be displayed in the table, including any workflows based on retired or 
renamed workflow templates. 

• Workflow State: Click the arrow to select one or more workflow states. All workflows with the 
selected workflow state(s) will be displayed in the table. 

• Click the Update button to apply your filter settings to the information displayed. The view 
displays the following columns: Workflow: Displays the name of the workflow. The workflow’s 
name is automatically the same as the workflow template that the workflow is based on. 

• Workflow ID: Displays the identification number of the workflow. 
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• Current Workflow Step: Displays the name of the workflow step that is currently being performed 
in the workflow. You must expand the workflow to see the workflow step. 

• Workflow Step ID: Displays the identification number of the current workflow step. 

• Object ID: Displays the identification number of the object that is being processed in the current 
workflow step. 

• Object Name: Displays the name of the object that is being processed in the workflow step. 

• Start Date: Displays the timestamp showing when the workflow/workflow step was started. 

• End Date: Displays the timestamp showing when the workflow/workflow step was completed. 

• Workflow State: Displays the current state of the workflow/workflow step. For more information 
about the meaning of the various values and how to resolve errors, see the section Understanding 
Event Values and Resolving Workflow Errors. 

 

The following information is available regarding the initiation of workflows: 

• Triggering a Workflow Template and Starting Workflows in the My Workflows Functionality 

• Accessing More Information About the Workflow 

• Understand the Course of the Workflow 

• Suspending, Resuming, or Withdrawing the Workflow 

• Understanding Event Values and Resolving Workflow Errors 

• Fixing a Workflow with an Error State 

• Redirecting a Workflow Step to Another Step 

• Adding Responsible Users to a Workflow Step 

• Delegating a Workflow Step to Another User 

• Deleting a Running Workflow 

Triggering a Workflow Template and Starting Workflows in the My Workflows Func-
tionality  

All workflow templates that you have access permissions for will be displayed in the Start New Workflow 
section of the table in the My Workflows functionalities. You can start workflows for any workflow tem-
plate displayed in this section of the table. 

Once you start a workflow, you are the workflow owner for the entire duration of the workflow unless the 
workflow administrator changes the workflow owner. As workflow owner, you are responsible for tracking 
the progress of the workflow from its start to completion as well as ensuring that the current workflow step 
is being performed in a timely manner. 

1) In the Start New Workflow section of the table, click the workflow template that you want to 
initiate as a workflow. 
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2) In the toolbar, click the New Workflow  button. Depending on the definition of the initial 
workflow step, you may see any of the following:  

• An object selector in which you can select an object to define. Select the relevant object in the 
object selector and in the editor that opens, enter the relevant data and click OK to close 
editor. If the base class configured for the workflow template is an object class stereotype 
(<ObjectClass:ObjectClassStereotype>), then you must select an object of the correct 
stereotype in the object selector. 

• An editor in which you can create and define an object. Enter the relevant data and click OK to 
close editor. 

• A wizard that will guide you through the workflow step. Enter the relevant data for each view 
and click Next to advance to the next view in the wizard. Click Finish when all views are 
completed. For general information about using a wizard, see Entering Data in Editors and 
Wizards in the reference manual Getting Started with Alfabet. If you do not complete the data 
input in the current session and you are working in a wizard, the following will apply:  

• If the workflow was started by creating a new object:  

• If the user has entered information in the first wizard step and clicked the Next 
button and then cancels the wizard, the first workflow step and the newly created 
object WILL be saved to the database. 

• If the user has entered information in the first wizard step, has NOT clicked the Next 
button and then cancels the wizard, the workflow step as well as the newly created 
object will NOT be saved to the database. 

• If the workflow was started with an existing object and the wizard was cancelled 
during the first wizard step, the workflow step will not be saved to the database. 

• A report that should be reviewed. Typically this step requires no data entry. 

• A page view that may require data entry or may require a review. 

• An object profile that may require data entry or may require a review. 

• In some cases, the first workflow step may be a system-generated action that does not 
require user input or user action. Typically, an informational message will be configured by 
your workflow designer letting you know that the workflow has been started. 

3) Carry out the necessary data entry or data review required for the first workflow step. The data 
input that is required for the first workflow step may be none or minimal and you may be able to 
complete the first workflow step immediately. Or, the data input that is required may be more 
extensive and you may need to perform the first workflow step over multiple sessions. Please note 
the following:  

• If you complete the required data input in the current session, the workflow will automatically 
begin once you close the relevant editor, wizard, page view, etc. The new workflow will be 
displayed in the Workflows section of the table and, if the workflow step is complete, will 
display the value Running in the Workflow State column. You can click the Start Date 
caption at the top of the column in order to sort the workflows according to the start date and 
quickly find them in the table. Once the workflow is running, the users responsible to perform 
the workflow step displayed in the Current Workflow Step column will be able to access and 
process the workflow step. For more information about processing a workflow step, see the 
section Performing the Workflow Steps That You Are Responsible For. 
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• If you do not complete the required data input in the current session, any data you have 
entered in the relevant editor, page view, etc. will be saved. The new workflow will be displayed 
in the Workflows section of the table and will display the value Pending in the Workflow 
State column. You can return to the first workflow step at any time. To view all workflows that 
are still in the state of initiation, select the value Pending in the Workflow State filter. To 
resume definition of the interrupted workflow step, select the workflow in the table and click 

the Perform  button. The relevant view will open that allows you to continue the definition 
of the initial workflow step. 

4) Once you have created the workflow by performing the initial workflow step, click the  symbol 
next to Workflows to expand the table and display the workflow that you just created. Once all the 
data has been defined, the following will be possible depending on the configuration of the 
workflow step:  

• If you see the value Initiation in the Workflow State column, the initial workflow step has not 
been completed. To resume definition of the interrupted workflow step, select the workflow in 

the table and click the Perform  button. The relevant view will open that allows you to 
continue the definition of the initial workflow step. 

• If you see the value Running in the Workflow State column, the workflow has automatically 
started and you must take no further action. The workflow will advance to the next workflow 
step and the user(s) responsible to perform the workflow step will see the new step in the My 
Workflow Activities functionality. Once the workflow has advanced to the next workflow 
step, emails are typically generated and the user(s) who are responsible to carry out the 
subsequent workflow step will be notified. 

• If you see the value Suspended in the Workflow State column, the execution of the workflow 
has been paused. This can be done by either the workflow administrator or workflow owner. A 
paused workflow can be resumed in the Workflow Event Trace page view. For more 
information, see the section Understand the Course of the Workflow. 

• If you see the value Finished in the Workflow State column, the initial workflow step has 
been completed. If the workflow is made up of system-generated workflow steps, it is possible 
that the workflow is completed without any user needing to take action. 

• If you see the value Withdrawn in the Workflow State column, the workflow has been 
withdrawn by either the workflow administrator or workflow owner. 

• If you see the value Error in the Workflow State column, select the workflow and click the 

Navigate  button. Open the Workflow Event Trace page view to view an explanation of 
the error. For more information, see the section Understand the Course of the Workflow. 

 To withdraw the workflow, select the workflow and click the Withdraw  button in the toolbar. 
The workflow has been withdrawn from the user community and any current workflow steps will 
no longer be displayed in the My Workflow Activities view of the responsible users. 
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Accessing More Information About the Workflow 

There are a number of different means to access more information about the workflow in the My Work-
flows functionalities: 

• To display the workflow template's preview, click-and-hold the workflow. The following attributes 
are displayed:  

• Workflow Name: The technical name of the workflow template. 

• Workflow Caption: The caption of the workflow template. 

• Workflow Description: Information describing the purpose of the workflow template. 

• To open the object profile of the workflow template, select the workflow template and click the 

Navigate  button in the toolbar. The following information is displayed:  

• Caption: The caption of the workflow template. 

• Base Class: The base class of the workflow template. This is the object class that the 
workflow begins with when the initial workflow step is performed. 

• Workflow Template State: The state of the workflow template. 

• Owner: The name of the current workflow template owner. 

• Description: Information describing the purpose of the workflow template. 

• To display the workflow's preview, click-and-hold the workflow. The following attributes are 
displayed:  

• ID: The identification number of the workflow that is being processed. 

• Workflow Name: The technical name of the workflow. 

• Workflow Caption: The caption of the workflow. 

• Workflow Base Class: The base class of the workflow template. This is the object class that 
the workflow begins with when the initial workflow step is performed. 

• Workflow State: The state of the workflow. 

• Automatic Start: Displays True if the workflow was automatically started via a batch process. 
For more information about configuring and initiating a batch process for workflows, see the 
section Batch Processes for Workflows with AlfaWorkflowCommandPrompt.exe in the 
reference manual System Administration. 

• To open the object profile of the workflow, select the workflow and click the 

Navigate  button in the toolbar. The following information is displayed:  

• ID: The identification number of the workflow that is being processed. 

• Workflow Name: The technical name of the workflow. 

• Workflow Caption: The caption of the workflow. 
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• Workflow Base Object Class: The base class of the workflow template. This is the object class 
that the workflow begins with when the initial workflow step is performed. 

• Start Base Object: The name of the object that the workflow was initiated for. 

• Workflow State: The state of the workflow. 

• Owner: The name of the current workflow owner. 

• Initiator: The name of the user who initiated the workflow. 

• Locked By: The name of the user who is performing the current workflow step. 

• Start: The timestamp showing when the current workflow was started. 

• End: The timestamp showing when the current workflow was completed. 

• Current Step: The workflow step that is currently being processed. 

• Workflow Template: The name of the workflow template that the workflow is based on. 

• Comment: Information describing the purpose of the selected workflow. 

 

The following page views are also available in the workflow object profile: 

• For more information about the Workflow Event Trace page view, see the 
section Suspending, Resuming, or Withdrawing the Workflow. 

• For more information about the Workflow Diagram page view, see the section 
Understand the Course of the Workflow. 

• For more information about the Active Workflow Steps page view, see the 
section Fixing a Workflow with an Error State. 

• To view the workflow and all of its potential workflow steps, select the workflow and click the 

Show Workflow Diagram  button to open the Workflow Diagram page view. Alternatively, 
you can click-and-hold the workflow and click Details to navigate to the Workflow Diagram page 
view. For more information about how to read the diagram, see the section Understand the Course 
of the Workflow. 

• To open the workflow step's preview, click-and-hold the workflow. The following attributes are 
displayed:  

• ID: The identification number of the workflow that is being processed. 

• Workflow Step Name: The technical name of the workflow step. 

• Workflow Step Caption: The caption of the workflow step. 

• Workflow Step State: The state of the workflow step. 

• Is Confirmable : Displays True if the workflow step can be processed or False if the workflow 
step either needs to be performed, is paused, or is blocked by an error. 

• Workflow Step Base Object Class: The base class of the object that the workflow step 
targets. 
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• To open the object profile of the workflow step, select the workflow step and click the 

Navigate  button in the toolbar. The following information is displayed:  

• Workflow Step Description: Displays the description of the workflow step. 

• ID: Displays the identification number of the selected workflow step. 

• Name: Displays the technical name of the selected workflow step. 

• Caption: Displays the caption of the selected workflow step. 

• Workflow: Displays the name of the workflow that the workflow step belongs to. 

• Previous Step: Displays the name of the workflow step that was performed before the 
selected workflow step. 

• Base Object: Displays the name of the object that the workflow started with. 

• Workflow Step State: Displays the state of the workflow step. 

• Ready : Displays True if the workflow step can be processed. Displays False if the workflow 
step is being pause or is blocked by an error. 

• Locked By: Displays the name of the person currently performing the workflow step. 

• Automatic Closure : Displays True if the workflow step will be automatically closed and 
advance to the next workflow step via a batch process if all post-conditions have been 
satisfied. The user responsible for the workflow step does not need to manually confirm the 
workflow step in this case. Displays False if the workflow step must be manually confirmed 
by the responsible user. 

• Due Date: Displays the target date by which the workflow step should be completed. 

• Responsible Users: Displays the names of the users that are responsible for performing the 
workflow step. 

• Completed Users. Displays the names of the users that have performed the workflow step. 

 

The following page views are also available in the workflow object profile: 

• For more information about the Active Step Activities page view, see the 
section Accessing Details about the Current Workflow Step. 

• For more information about the Activities of Preceding Steps page view, see 
the section Accessing Details about the Preceding Workflow Step. 

Running workflows that may be running too long without being completed may be closed by the workflow 
administrator or workflow owner. To close one or more running workflows, select the running workflows in 
the Workflow section of the table and click Manage > Close Running Workflows. The workflow state will 
be changed to Withdrawn and the workflow will be removed from the dataset of running workflows. To 
view the closed workflow, select the option Withdrawn in the Workflow State filter and click the Update 
button. 
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Understand the Course of the Workflow 

The Workflow Diagram page view allows you to view graphic information about the selected workflow. The 
diagram displays all workflow steps defined for the workflow template and the possible paths the workflow 
may take depending on the fulfillment of configured pre-conditions or post-conditions. This view is for in-
formational purposes only and cannot be edited. 

 

If a workflow diagram has been configured for the associated workflow template in the configu-
ration tool Alfabet Expand, that diagram will be displayed in this page view. If no workflow dia-
gram has been designed, a default diagram will be automatically generated. The layout of the 
default diagram cannot be edited. For more information about designing workflow diagrams, see 
the section Configuring and Visualizing a Workflow in a DiagramConfiguring and Visualizing a 
Workflow in a Diagram in the reference manual Configuring Alfabet with Alfabet Expand. 

Navigate to the object profile of the relevant workflow and open the Workflow Diagram page view. Please 
keep the following in mind when viewing the workflow diagram: 

• A yellow rectangle is the active step that is currently pending. The step may be pending because it 
is being performed or because a sub-workflow was triggered during the workflow step. Once the 
sub-workflow is finished and the workflow step is completed, the rectangle will turn green. 

• A green rectangle is a completed step. 

• A grey rectangle is a step that has been refused or expired. 

• A red rectangle is a workflow where an error has occurred. 

• A white rectangle is a step that has not yet been performed or will not be performed (for example, 
for workflow steps on a path that the workflow does not take because a pre-condition has not 
been satisfied). 

• A blue arrow points to the next workflow step in the configured sequence of the workflow. 

• A red arrow points to the next workflow step specified in the configuration should a workflow step 
be refused. 

• A green arrow points to the next workflow step specified in the configuration should a workflow 
step expire. 

• Select a workflow step that has been entered (yellow, green, grey, or red rectangles), and click-
and-hold to open the preview window to view basic information about the workflow step. It is not 
possible to open the preview for a workflow step that has not been instantiated. 

• Select a workflow step that has been entered (yellow, green, grey, or red rectangles), and click the 

Navigate  button in the toolbar to open the object profile of the workflow step. 

Suspending, Resuming, or Withdrawing the Workflow 

The Workflow Event Trace page view allows workflow owners and workflow administrators to suspend, 
resume, or withdraw workflows from operation. Furthermore, it provides valuable information about the 
course of events that have occurred in a workflow. The view displays all events for the selected workflow. 
You can limit the content in the view by defining filters. In the Event Type field, select the type of events 
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that you want to display. In the Workflow Step field, select the workflow step(s) that you want to display. 
Click Update to apply the filter criteria to the view. The following information is displayed: 

• Event : Displays the actions that have occurred to the workflow. Any workflow that is in the state 
Error is in immediate need of attention and must be dealt with by either the workflow owner or 
workflow administrator. The workflow owner and workflow administrator will typically be informed 
of the escalated state of the workflow step via email. For detailed description of all potential values 
displayed in the Events column as well as their meaning, see Understanding Event Values and 
Resolving Workflow Errors. 

• Step: Displays the workflow step number and caption. 

• Step ID: Displays the identification number of the workflow step. 

• Initiator of Action: Displays the name of the user triggering the event. 

• Affected Users: Displays the users that are impacted by the event. 

• Confirmation Type: Displays who is responsible to confirm the relevant workflow step. The 
following values may be displayed:  

• AllUsers: Indicates that all responsible users must perform/confirm the workflow step in 
order to complete the workflow step. 

• SingleUser: Indicates that only one of the responsible users must perform/confirm the 
workflow step in order to complete the workflow step. 

• SingleUserOfEachUserGroup: Indicates that one responsible user from each responsible 
user group must perform/confirm the workflow step in order to complete the workflow step. 

• Message: Displays either system messages or messages entered by responsible users. If the 
workflow step is escalated because one or more pre-conditions for the successor step have not 
been met, you will see the message text configured for the pre-condition(s), which should indicate 
what is required to fulfill the pre-condition. 

• Time Stamp: Displays the timestamp indicating when the event occurred. 

To suspend and resume the workflow: 

• To suspend the workflow, select the current workflow event and click the Suspend  button in 
the toolbar. Depending on the configuration of the workflow step, email notifications may be sent 
to all users responsible for the selected workflow step informing them that the workflow has been 
paused. The current workflow step will no longer be displayed in the My Workflow Activities view 
of the responsible users. The workflow will have the state Suspended. To continue the workflow 

step, you must select the Resume  button. 

• To continue the workflow, select the current workflow event and click the Resume  button in 
the toolbar. Depending on the configuration of the workflow step, email notifications may be sent 
to all users responsible for the selected workflow step informing them that the workflow has been 
resumed. The current workflow step will be displayed in the My Workflow Activities view of the 
responsible users. The workflow step will have the state Running. 

• To withdraw the workflow, select the current workflow event and click the Withdraw  button 
in the toolbar. The workflow has been withdrawn from the user community and any current 
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workflow steps will no longer be displayed in the My Workflow Activities view of the responsible 
users. 

Understanding Event Values and Resolving Workflow Errors  

The following values may appear in the Event column: 

Event Column Value Meaning and Possible Resolution 

Error The workflow step has encountered an error during its execution. The value Er-
ror indicates that an error has occurred in the execution of the workflow. This 
could be caused by the following situations: 

• No responsible users have been found for the current workflow step. In 
this case, the workflow owner can add responsible users to the 
workflow step. This is carried out in the Active Step Activities page 
view. For more information, see the section Fixing a Workflow with an 
Error State. 

• A responsible user has refused a workflow step and no next step has 
been configured for this situation. This error must be corrected in the 
configuration of the workflow template. Please contact your workflow 
designer. 

• A workflow step has expired and no next step has been configured for 
this situation. This error must be corrected in the configuration of the 
workflow template. Please contact your workflow designer. 

• Multiple workflow steps qualify as a next step based on the pre-
conditions defined for the potential next steps. This error must be 
corrected in the configuration of the workflow template. Please contact 
your workflow designer. 

• A workflow step cannot be performed because a required wizard is 
absent or a required Alfabet query cannot be executed. This error must 
be corrected in the configuration of the workflow template. Please 
contact your workflow designer. 

NOTE: For more information, contact your workflow designer or see the chapter 
Configuring Workflows in the reference manual Configuring Alfabet with Alfabet 
Expand. 

Resolved_StepRe-
sponsiblesNot-
Found 

If the workflow step is in an Error state because no responsible users were 
found for the current workflow step and the workflow owner has added respon-
sible users to the workflow step via the Active Step Activities page view, this 
event type will be displayed displaying the user who resolved the error and the 
users assigned responsibility for the workflow step. 
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Event Column Value Meaning and Possible Resolution 

StepCancelled The workflow step has been cancelled. This could be the result of redirecting 

the workflow to another workflow step via the Go To  button. 

StepConfirmed The workflow step has been confirmed by all responsible users required to con-
firm the workflow step. 

StepDelegated The workflow step has been delegated by a responsible user to another respon-
sible user. Text in the Comments column provides an explanation about the 
delegation. 

StepEntered The workflow step has been started. 

StepExited The workflow step has been exited. All responsible users required to confirm 
have confirmed the workflow step. 

StepExpired The configured amount of time to complete the workflow step has been sur-
passed and the workflow step is now expired. Depending on the configuration, 
the workflow step may be automatically redirected to another workflow step. If 
this is not the case, the workflow owner can redirect the workflow to another 
workflow step. This is carried out in the Active Step Activities page view. For 
more information, see the section Fixing a Workflow with an Error State. 

NOTE: For more information about configuring the amount of time to complete 
a workflow step, see the section Defining a Deadline and Reminders for a Work-
flow Step in the reference manual Configuring Alfabet with Alfabet Expand. 

NOTE: Depending on the configuration of the workflow step, the step may auto-
matically advance to another workflow step if expired. For more information 
about configuring a workflow step to follow an expired workflow step, see the 
section Defining the Sequence of the Workflow Steps in the reference manual 
Configuring Alfabet with Alfabet Expand. 

StepPerformed The workflow step is being performed by a responsible user and is therefore 
locked and cannot be accessed. 

StepRefused The workflow step has been refused by a responsible user. All other responsible 
users are no longer required to confirm the workflow step. Depending on the 
configuration, the workflow step may be redirected to another workflow step. 

NOTE : Depending on the configuration of the workflow step, the step may au-
tomatically advance to another workflow step if refused. In this case, the Ste-
pEntered value will be displayed in the Event column and will indicate the 
workflow step that has been configured to follow in case of refusal. For more in-
formation about configuring the refusal of a workflow step, see the section 
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Event Column Value Meaning and Possible Resolution 

Defining the Sequence of the Workflow Steps in the reference manual Configur-
ing Alfabet with Alfabet Expand. 

WorkflowFinished The workflow has completed the last workflow step. There are no next workflow 
steps. 

WorkflowStarted The workflow has started and is in process. 

WorkflowSuspended The workflow administrator or workflow owner has paused the execution of the 
workflow. 

WorkflowResumed The workflow administrator or workflow owner has resumed the execution of 
the workflow. 

WorkflowTrigger One or more sub-workflows have been triggered by the current workflow step. 
The superordinate workflow can proceed to the next workflow step and will not 
wait for the completion of the sub-workflows. The sub-workflow(s) are trig-
gered and executed independent of the parent workflow triggering them. 

WorkflowTrig-
geredAndWait 

One or more sub-workflows have been triggered by the current workflow step. 
The superordinate workflow will resume activity as soon as the first of the sub-
workflows has finished. The completion of the first sub-workflow will be used to 
determine how to proceed in the superordinate workflow. 

WorkflowUpdated The workflow template has been updated in the context of a migration to a new 
workflow template. In the case of a running workflow, the current workflow step 
based on the old workflow template will be cancelled and automatically updated 
according to the new workflow template. The state defined for the workflow 
prior to the migration will be maintained. This is particularly relevant for work-
flows with the state WorkflowSuspended. 

NOTE: For more information about the configuration of a workflow template mi-
gration, see the section Creating a Migration Definition to Update Running 
Workflows in the reference manual Configuring Alfabet with Alfabet Expand. 

WorkflowWithdrawn The workflow step has been withdrawn and is no longer a current workflow 
step. Typically, the workflow will be configured so that the workflow will ad-
vance to another configured workflow step. 
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Fixing a Workflow with an Error State 

The Active Workflow Steps page view allows workflow owners and workflow administrators to delegate a 
workflow step to another user, add new responsible users to the workflow steps, or redirect the workflow to 
a different workflow step. 

Any workflow that is in the state Error is in immediate need of attention and must be dealt with by either 
the workflow owner or workflow administrator. The workflow owner and workflow administrator will typi-
cally be informed of the escalated state of the workflow step via email. In this case, the workflow owner or 
workflow administrator should first review the error displayed in the Event Type column in the Workflow 
Event Trace page view to understand the type of error that has occurred. 

The event type Error could be caused by a number of situations. Typically errors result due to problems in 
the configuration of the workflow template. For example, an error could occur because a responsible user 
has refused a workflow step and no next step has been configured for this situation, multiple workflow 
steps qualify as a next step based on the pre-conditions defined for the potential next steps, or a workflow 
step cannot be performed because a required wizard is absent or a required query cannot be executed. 
These are errors that typically must be resolved in the configuration of the workflow. In this case, you must 
contact your workflow designer so that the configuration of the workflow template is corrected. 

In some cases, the event type Error could be caused because no responsible users have been found for 
the current workflow step. The event type StepExpired indicates that the time configured to complete 
the workflow step has been surpassed. In this case, the workflow owner can redirect the workflow to an-
other workflow step. Both of these errors can be corrected as described below by the workflow owner or 
workflow administrator in the Active Step Activities page view. 

 

For more information about working with the Workflow Event Trace page view and under-
standing the event type values, see the sections Suspending, Resuming, or Withdrawing the 
Workflow and Understanding Event Values and Resolving Workflow Errors. 

The following information is available: 

• Redirecting a Workflow Step to Another Step 

• Adding Responsible Users to a Workflow Step 

• Delegating a Workflow Step to Another User 

Redirecting a Workflow Step to Another Step 

Any workflow that displays a state with the value Error is in immediate need of attention. This indicates 
that an error has occurred in the execution of the workflow and the workflow must either be rechanneled 
or, depending on the cause of the error, reconfigured. 

To rechannel the workflow to a different workflow step: 

1) Navigate to the object profile of the relevant workflow and open the Active Workflow Steps page 
view. 

2) Select the current workflow event and click the Go To  button in the toolbar. 
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3) An editor will open that requires you to select the new workflow step and provide an explanation 
about why you are redirecting the workflow step. In the Go to Another Workflow Step editor that 
opens, define the following:  

• Select the workflow step...: Select the workflow step that the workflow should be redirected 
to. 

• Execute the post-conditions...: Set a checkmark if post-conditions configured for the 
workflow step selected in the Active Workflow Steps page view should be checked before 
the new workflow step is triggered. 

• Execute the pre-conditions...: Set a checkmark if pre-conditions configured for the workflow 
step selected in the Select the workflow step... field should be checked. 

• Comment: Provide an explanation about why the workflow is being redirected to the selected 
workflow step. The explanation will be available to the user responsible for the subsequent 
step in the object profile of the workflow step. 

4) Click OK to save your changes. The responsible user(s) will typically be notified via email that the 
they are responsible for the new workflow step. 

Adding Responsible Users to a Workflow Step 

If the workflow is in a state of Error because no users have been identified as responsible for the workflow 
step, then you must manually assign responsible users to the workflow step in order to resolve the work-

flow error. The Add Responsible Users  button will be enabled if no responsible users have been found 
via the workflow step configuration. The new responsible user(s) will typically be notified via email that the 
workflow step has been delegated to him/her. 

To add responsible users to a workflow step: 

1) Navigate to the object profile of the relevant workflow and open the Active Workflow Steps page 
view. 

2) Select the current workflow event and click the Add Responsible Users  button in the toolbar. 

3) The person selector will open. Select the relevant users to add to the workflow step. 

4) Click OK to save the definition or click Cancel to exit the editor without saving your changes. The 
selected user(s) will typically be notified via email that they have been assigned a workflow step. 
The event type Resolved_StepResponsibilesNotFound will be displayed in the Event column 
in the Workflow Event Trace page view. 

Delegating a Workflow Step to Another User 

A workflow may need to be delegated to another responsible user. You can specify whether the responsi-
bility of the workflow will be removed from only the selected responsible user or all users responsible for 
the workflow step. The delegated user will typically be notified via email that the workflow step has been 
delegated to him/her. 

To delegate the workflow to another responsible user: 
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1) Navigate to the object profile of the relevant workflow and open the Active Workflow Steps page 
view. 

2) Select the current workflow event and click the Delegate  button in the toolbar. 

3) An editor will open that requires you to provide an explanation about why you are delegating the 
workflow step to the selected user. In the Delegate Workflow Step editor that opens, define the 
following:  

• Substitute All Current Workflow Step Owners: Select this checkbox if all users currently 
responsible for the selected workflow step should be replaced by the user(s) that the workflow 
step is being delegated to. 

• Revoke Responsibility from Current User: Select this checkbox if you want to remove 
yourself as a user responsible for the workflow step that is being delegated. Clear this 
checkbox if you want to include yourself as a user responsible for the workflow step that is 
being delegated. 

• Comment: Provide an explanation about why the workflow is being delegated to another user. 
The explanation will be displayed in the Message column of the Workflow Step Event Trace 
page view. 

• Delegates: Click the Add Person button to select one or more persons to delegate the 
workflow step to. 

4) Click OK to save the delegation definition or click Cancel to exit the editor without saving your 
changes. The selected user(s) will typically be notified via email that the workflow step has been 
delegated to him/her. 

Deleting a Running Workflow  

You can delete a workflow that has been initiated or started. The workflow and its workflow steps will be 
irrevocably deleted from the database. 

 
If you delete a running workflow, you also delete any workflow step that is currently being per-
formed by a responsible user. In this case, the workflow will be removed from the My Workflows 
functionality of the user owning the workflow. Any associated workflow steps will be automati-
cally deleted from the My Workflow Activities functionality of all users responsible for the work-
flow step. 

To delete a workflow: 

1) In the Workflows section of the table, click the workflow that you want to delete. 

2) In the toolbar, click the Delete  button. 

3) Confirm the warning by clicking Yes, or click No to exit without deleting the selected object(s). 

Performing the Workflow Steps That You Are Responsible For  

Depending on the configuration of the workflow capability by your solution designer, either a configured 
Workflow Activities Explorer or a My Workflow Activities functionality will be available for you to 
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perform and manage the workflow steps that you are responsible for. Although the methods to perform, 
refuse, or delegate a workflow step are generally similar in all of the functionalities, the interface in which 
you manage and process your workflow steps will be different. 

Typically you will be sent an email notification with a hyperlink to the workflow step that you must perform. 
Please note that once a workflow step has been confirmed and thus completed, the workflow step can no 
longer be opened via the link in the email notification. 

If the workflow step requires that you edit an object, you will be able to edit it in the context of the workflow 
step even though you may not otherwise have access permissions to the object. However, you will not have 
access permissions to the object outside of the context of the workflow step. 

The following information is available: 

• Performing and Tracking Your Workflow Steps in the Workflow Activities Explorer Functionality 

• Performing and Tracking Your Workflow Steps in the My Workflow Activities Functionality 

• Accessing More Information About the Workflow Step 

• Performing and Completing a Workflow Step 

• Delegating a Workflow Step to Another Alfabet User 

• Refusing a Workflow Step 

• Releasing the Lock on a Workflow Step 

• Accessing Details about the Current Workflow Step 

• Accessing Details about the Preceding Workflow Step 

• Performing and Tracking Your Workflow Steps for a Selected Object in the Associated Workflows 
Page View 

• Defining a Proxy to Manage Your Workflow Steps 

Performing and Tracking Your Workflow Steps in the Workflow Activities Explorer 
Functionality 

The Workflow Activities Explorer functionality supports users in processing workflow activities. The 
functionality features a user-friendly design and layout of data in Alfabet similar to established email man-
agement systems so that users can more easily and efficiently accomplish their workflow tasks. Because 
the view is highly configurable, users can be provided with precisely the data they need in order to process 
the task-at-hand with a minimum number of clicks and navigation to other views. 

 
Please note the following: 

• The number of days that finished, refused, and expired workflow activities will continue 
to be displayed in the Workflow Activities Explorer functionality is specified by your 
solution designer in the XML object SolutionOptions. For more information, see the 
section Configuring the Workflow Activities Explorer (WFS_Explorer) in the reference 
manual Configuring Alfabet with Alfabet Expand. 
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• The sort order of the workflow activities as well as the focus in the Workflow Activities 
Explorer can be defined in the Worklow Explorer Settings tab in the User Settings 
editor. For more information, see the section Defining Your User Settings in Alfabet. 

The Workflow Activities Explorer functionality typically includes the following elements: 

• The Start New Workflow node that allows you to open a view to trigger a new workflow. Click the 
node to display the My Workflows view to the right of the explorer. The view displays the table 
section Workflows which displays running workflows and Workflow Templates which displays 
workflow templates that you have access permissions to. For more information about how to 
create new workflows, see the section Starting and Maintaining Workflows in the My Workflows 
Functionality. 

• Depending on whether you have workflow activities (workflow steps) that are open, finished, or 
expired, the My Workflow Activities explorer will display the nodes Open Activities and Finished 
Activities. Symbols indicate the respective completion status of each workflow activity. 
Completed activities are displayed in the Finished Activities list for 30 days. Click the + symbol to 
expand a list and click the - symbol to collapse a list. The following symbols may be displayed:  

• Open Activities  (including pending workflow activities ) 

• Finished Activities  

• Cancelled Activities   

• Withdrawn Activities   

• Refused Activities  

• Expired Activities   

•  To sort the order of the workflow activities based on various criteria, click the My Workflow 
Activities root node. In the Workflow Activities Sort Order field, specify whether the workflow 
activities should be sorted based on the caption of either the workflow or workflow activity, the 
name of the object targeted by the workflow activity, or by the amount of time left to complete the 
workflow activity, whereby the most urgent workflow activities are at the top of the explorer. Click 
the Update button to apply the sort order to the My Workflow Activities explorer. 

• To display detailed information about the task in the reading pane, click a workflow activity in the 
left pane. The header of the reading pane displays the name of the workflow activity and targeted 
object as well as a brief task description. 

• Below the header is comprehensive data about the workflow activity and target object needed to 
support complete the workflow activity.  

• The data may contain hyperlinks that allow you to navigate to another object view, page view, 
or configured report. 

• The data may display a long list of responsible users. Due to size limitations, only a set of users 
will be displayed in the reading pane. A link... + <number> more... will be displayed that, when 
clicked, opens a window showing all users responsible for the workflow step. 

• The toolbar above the reading pane displays only the action buttons relevant for the selected 
workflow activity. Click a button in the toolbar to perform the relevant action. Please note that the 
captions and symbols on the buttons are configurable and thus may vary among workflow 
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activities. Once the workflow activity is completed, it will automatically be removed from the Open 
Activities section of the explorer and placed in the Finished Activities section. 

• The explorer search functionality supports the user in finding a specific workflow activity in the 
activities lists. For more information about using the explorer search functionality, see the section 
Working with Explorers in the chapter Navigating the Alfabet Interface in the reference manual 
reference manual Getting Started with Alfabet. 

• Workflow activities that are finished, expired, cancelled, etc. will remain visible in the Workflow 
Activities Explorer functionality for 30 days after they have been completed, etc. Thereafter, 
they will be automatically removed from the explorer. 

• In general, the operations available in the Workflow Activities Explorer functionality are 
described in the section Performing and Tracking Your Workflow Steps in the My Workflow 
Activities Functionality although the buttons available and the captions on those buttons will 
typically differ from standard view. 

 
For more information about the configuration of the Workflow Activities Explorer functionality, 
see the section Configuring and Visualizing a Workflow in a DiagramConfiguring and Visualizing a 
Workflow in a Diagram in the chapter Configuring Workflows in the reference manual Configuring 
Alfabet with Alfabet Expand. 

Performing and Tracking Your Workflow Steps in the My Workflow Activities Func-
tionality 

The My Workflow Activities functionality allows you to manage and perform all workflow steps that you 
are responsible for. To include the workflow steps that you are responsible for as a proxy, check the Show 
Proxy Steps checkbox and click the Update button. 

The view shows all workflow steps that you are responsible for. A row that is highlighted grey displays a 
workflow step that has been performed and is ready for completion/confirmation. For more information 
about how to process the workflow step, see the section Performing the Workflow Steps That You Are Re-
sponsible For. The My Workflow Activities view displays the following information: 

• Workflow: Displays the name of the workflow that the workflow step belongs to. 

• Workflow ID: Displays the identification number of the workflow that is being processed. 

• Object Name: Displays the name of the object that is being processed in the workflow step. 

• Object ID: Displays the identification number of the object that is being processed in the current 
workflow step. 

• Active Step: Displays the name of the workflow step that is currently being performed in the 
workflow. 

• Step ID: Displays the identification number of the workflow step that is being processed. 

• Previous Step: Displays the name of the workflow step that was performed prior to the current 
workflow step. 

• Enter Date: Displays the timestamp showing when the workflow advanced to the current 
workflow step. 
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• Remaining Days: If a deadline has been configured, displays the number of days left before the 
workflow step expires. 

• Ready: Displays a checkmark if the current workflow step has been performed and is ready to be 
confirmed and completed. 

• Locked By. Displays the name of the user who is currently working on the workflow step. 

• Current Step Comments: Displays a checkmark if a comment has been made for the current 

workflow step. To access the comment, select the workflow step, click the Navigate  button 
and click Active Step Activities to view the comments in the Message column. 

• Previous Step Comments: Displays a checkmark if a comment has been made for the previous 

workflow step. To access the comment, select the workflow step, click the Navigate  button 
and click Activities of Preceding Steps to view the comments in the Message column. 

 
If you are the workflow owner: To withdraw the workflow, select the workflow and click the With-

draw  button in the toolbar. The workflow has been withdrawn from the user community and 
any current workflow steps will no longer be displayed in the My Workflow Activities view of the 
responsible users. 

Workflow activities that are finished, expired, cancelled, etc. will remain visible in the My Workflow Activities 
views for 30 days after they have been completed, etc. Thereafter, they will be automatically removed from 
the view. 

The following information is available: 

• Accessing More Information About the Workflow Step 

• Performing and Completing a Workflow Step 

• Delegating a Workflow Step to Another Alfabet User 

• Refusing a Workflow Step 

• Releasing the Lock on a Workflow Step 

• Accessing Details about the Current Workflow Step 

• Accessing Details about the Preceding Workflow Step 

Accessing More Information About the Workflow Step 

There are a number of different means to access more information about the workflow in the My Workflow 
Activities functionalities: 

• To display the preview of the workflow step, click-and-hold the workflow step. The following 
attributes are displayed:  

• ID: The identification number of the workflow that is being processed. 

• Workflow Step Name: The technical name of the workflow step. 
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• Workflow Step Caption: The caption of the workflow step. 

• Workflow Step State: The state of the workflow step. 

• Is Confirmable : Displays True if the workflow step can be processed or False if the workflow 
step either needs to be performed, is paused, or is blocked by an error. 

• Workflow Step Base Object Class: The base class of the object that the workflow step 
targets. 

• To view the object profile of the workflow step, select the workflow step and click the 

Navigate  button and click Navigate to Activity. The following information is displayed:  

• Workflow Step Description: Displays the description of the workflow step. 

• ID: Displays the identification number of the selected workflow step. 

• Name: Displays the technical name of the selected workflow step. 

• Caption: Displays the caption of the selected workflow step. 

• Workflow: Displays the name of the workflow that the workflow step belongs to. 

• Previous Step: Displays the name of the workflow step that was performed before the 
selected workflow step. 

• Base Object: Displays the name of the object that the workflow started with. 

• Workflow Step State: Displays the state of the workflow step. 

• Ready : Displays True if the workflow step can be processed. Displays False if the workflow 
step is being pause or is blocked by an error. 

• Locked By: Displays the name of the person currently performing the workflow step. 

• Automatic Closure : Displays True if the workflow step will be automatically closed and 
advance to the next workflow step via a batch process if all post-conditions have been 
satisfied. The user responsible for the workflow step does not need to manually confirm the 
workflow step in this case. Displays False if the workflow step must be manually confirmed 
by the responsible user. 

• Due Date: Displays the target date by which the workflow step should be completed. 

• Responsible Users: Displays the names of the users that are responsible for performing the 
workflow step. 

• Completed Users. Displays the names of the users that have performed the workflow step. 

 

Please keep the following in mind when accessing this view: 

• If you have accessed an object profile of a completed workflow step, you will 
see a ReadOnly view. The attributes of the workflow step will be displayed but 
actions available via toolbar buttons will be disabled. 

• If you have accessed an object profile of a pending workflow step, you may 
process the workflow step from the object profile. Any actions that are enabled 
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for the selected workflow step can be executed via the toolbar buttons in the 
object profile. 

The following page views are also available in the workflow step object profile: 

• For more information about the Active Step Activities page view, see the 
section Accessing Details about the Current Workflow Step. 

• For more information about the Activities of Preceding Steps page view, see 
the section Accessing Details about the Preceding Workflow Step. 

• To open the object profile of the object targeted by the workflow step, select the workflow step 

and click the Navigate  button and click Navigate to Object. 

• To view the workflow step in the context of the workflow, select the workflow step and click the 

Show Workflow Diagram  button to open the Workflow Diagram page view. Alternatively, 
you can click-and-hold the workflow step and click Details to navigate to the Workflow Diagram 
page view. For more information about how to read the diagram, see the section Understand the 
Course of the Workflow. 

Performing and Completing a Workflow Step  

Workflow steps can be viewed, performed, and managed by the users that are responsible for the workflow 
steps. The user(s) responsible for a workflow step may edit the object targeted by the workflow step even 
though they may not otherwise have access permissions to the object. However, access permissions will 
not be granted for the object outside of the context of the workflow step. 

1) To perform a workflow step, select the workflow step in the view and click the 

Perform  button. Depending on the configuration of the workflow step, you may see any of the 
following:  

• An editor in which you can define an object. Enter the relevant data and click OK to close 
editor. 

• A wizard that will guide you through the workflow step. Enter the relevant data for each view 
and click Next to advance to the next view in the wizard. Click Finish when all views are 
completed. For general information about using a wizard, see Entering Data in Editors and 
Wizards in the reference manual Getting Started with Alfabet. If you do not complete the data 
input in the current session and you are working in a wizard, the following will apply:  

• If the user enters information in the wizard view, clicks the Next button and then cancels 
the wizard, the data defined in the previous wizard view(s) will be saved to the database. 

• If the user enters information in the first wizard view, does NOT click the Next button and 
then cancels the wizard, the data defined in the wizard view will NOT be saved to the 
database. 

• A report that should be reviewed. Typically this step requires no data entry. 

• A page view that may require data entry or may require a review. 

• An object profile that may require data entry or may require a review. 
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• In some cases, the a workflow step may be a system-generated action that does not require 
user input or user action. Typically, an informational message will be configured by your 
workflow designer letting the workflow owner or workflow administration know that the 
workflow step has been executed. 

2) Carry out the necessary data entry or data review required for the workflow step. The data input 
that is required for the workflow step may be none or minimal and you may be able to complete the 
workflow step immediately. Or, the data input that is required may be more extensive and you may 
need to perform the workflow step over multiple sessions. Please note the following:  

• If the workflow step is based on an editor or wizard, the workflow may automatically advance 
to the next workflow step once you close the relevant editor or wizard or you may have to 

complete the workflow step by clicking the Confirm  or Complete  button. The 

Ready column will have a checkmark if you must click the Confirm  or 

Complete  button to finish your workflow step. 

• If the workflow step is based on an object profile, page view, configured report, a 

Confirm  or Complete  button will be available. You must click the available button 
to finish your workflow step. 

• If you do not complete the data input required in the current session, any data you have 
entered in the relevant editor, page view, etc. will be saved. The workflow step will be 
displayed in the My Workflow Activities functionality and will display the value Pending in 
the Workflow State column. You can return to the workflow step at any time in the My 
Workflow Activities functionality. To resume definition of the interrupted workflow step, 

select the workflow step and click the Perform  button in the My Workflow functionality. 
The relevant view will open that allows you to continue the definition of the initial workflow 
step. 

• Once you have completed your workflow step, the workflow step will be removed from your 
My Workflow Activities functionality. Depending on the configuration of the workflow step, 
the workflow may advance to the next workflow step. However, the workflow may also be 
configured so that all responsible users assigned to the workflow step must complete the step 
in order for the workflow to advance to the next workflow step. 

Delegating a Workflow Step to Another Alfabet User  

If necessary, you can choose to delegate a workflow step to another Alfabet user. You will be required to 
provide an explanation about why you are delegating the workflow step to the selected user. The selected 
user will typically be notified via email that the workflow step has been delegated to him/her. 

To reassign a workflow step to another Alfabet user: 

1) Select the workflow step that you want to delegate. 

2) In the My Workflow Activities view, click the Delegate  button. 

3) In the person selector, select the person you want to reassign the responsibility of the workflow 
step to and click OK. The Delegate Workflow Step editor opens. 
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4) Define the following fields, as needed:  

• Substitute All Current Workflow Step Owners: Select if all users currently responsible for 
the selected workflow step should be replaced by the user(s) that the workflow step is being 
delegated to. 

• Revoke Responsibility from Current User: Select this checkbox if you want to remove 
yourself as a user responsible for the workflow step that is being delegated. Clear this 
checkbox if you to include yourself as a user responsible for the workflow step that is being 
delegated. 

• Comment: Provide an explanation about why the workflow is being delegated to another user. 
The explanation will be displayed in the Message column of the Workflow Step Event Trace 
page view. 

• Delegates: Click the Add Person button to select one or more persons to delegate the 
workflow step to. 

5) Click OK to save your changes. The responsible user will find the workflow step in the Workflow 
Activities Explorer or My Workflow Activities view. 

Refusing a Workflow Step  

Depending on the configuration of the workflow step, it may be possible to refuse to perform the workflow 

step. If it is possible to refuse the workflow step, a Refuse  button will be active in the My Workflow 
Activities view or a comparable button will be available in the Workflow Activities Explorer. You will be 
required to provide an explanation about why you are refusing the step. Depending on the configuration of 
the workflow step: 

• A workflow step that is refused may be automatically redirected to another workflow step. As a 
result, you or other Alfabet users may see a different workflow step in the Workflow Activities 
table that was triggered by the refusal. The relevant user(s) will be notified per email that they are 
responsible to carry out the workflow step that was triggered by the refusal. 

• If a workflow step is refused and no workflow step has been configured to follow the refusal of a 
workflow step, the state of the workflow will automatically change to Error. In this case, the 
workflow owner and workflow administrator will be notified and must manually redirect the 
workflow to another workflow step. 

 
Please note that the refusal of the workflow step is a means to not perform the workflow step. 
The refusal to perform a workflow step should not be confused with the rejection of or refusal to 
approve an object. The rejection of or refusal to approve an object (such as a demand or project) 
is managed through a release status definition via the Status property of the object. 

Typically, the configuration of the workflow specifies the subsequent workflow step that should 
follow if a selected workflow step is refused. If correctly configured, this potential path that the 
workflow would take will be displayed in the Workflow Diagram view. For more information about 
understanding the workflow diagram, see the section Viewing the Workflow in the Workflow Dia-
gram. 

To refuse a workflow step: 

1) Select the workflow step that you want to refuse. 
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2) In the Workflow Activities view, click the Refuse  button. If you are working in the Workflow 
Activities Explorer, click the relevant button configured by your workflow designer. You will see 
the Refuse Workflow Step editor. 

3) In the field, enter a comment explaining why you are refusing the workflow step as well as any 
other information that is important. 

4) Click OK. The workflow step is removed from the Workflow Activities Explorer or Workflow 
Activities view. 

Releasing the Lock on a Workflow Step  

In some cases, a workflow step may be locked by another user who, for example, is absent in the enterprise 
but has not defined a proxy. In this case, the lock on the workflow may be removed. Once the lock is re-
moved, the workflow step can be performed or delegated to another user. 

To release the lock on a workflow step, select the workflow step in the table and click the Release 

Lock  button in the toolbar. 

Accessing Details about the Current Workflow Step 

The Active Step Activities page view displays details about the currently selected workflow step. 

The following information is displayed: 

• Event: Displays the action occurring to the workflow step. For a detailed description of all potential 
values displayed in the Events column as well as their meaning, see the section Possible Values in 
the Events Column for Workflows. 

• Initiator of Action: Displays the name of the user initiating the event. 

• Affected Users: Displays the users that are affected by the event. 

• Comment: Displays either system messages or messages entered by responsible users. If the 
workflow step is escalated because one or more pre-conditions for the successor step have not 
been met, you will see the message text configured for the pre-condition. 

• Time Stamp: Displays the timestamp indicating when the event occurred. 

Accessing Details about the Preceding Workflow Step 

The Activities of Preceding Steps page view displays details about the workflow step performed prior to 
the currently selected workflow step. 

The following information is displayed: 

• Event: Displays the action occurring to the workflow step. For a detailed description of all potential 
values displayed in the Events column as well as their meaning, see the section Possible Values in 
the Events Column for Workflows. 
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• Initiator of Action: Displays the name of the user initiating the event. 

• Affected Users: Displays the users that are affected by the event. 

• Comment: Displays either system messages or messages entered by responsible users. If the 
workflow step is escalated because one or more pre-conditions for the successor step have not 
been met, you will see the message text configured for the pre-condition. 

• Time Stamp: Displays the timestamp indicating when the event occurred. 

Performing and Tracking Your Workflow Steps for a Selected Object in the Associ-
ated Workflows Page View 

The Associated Workflows page view displays all workflow steps that target the selected object. You can 
view the history of the workflow steps associated with the selected object. The report provides an overview 
of any completed workflow steps that may have impacted the selected object or are currently pending for 
the object as well as if you have been identified as a user who is responsible for performing the pending 
workflow step. 

Pending workflow steps may be processed in this view. A pending workflow step will be highlighted grey. 
The toolbar buttons will be disabled for all workflow steps except those that are pending. The following col-
umns are displayed: 

• Caption: The highest level of the table hierarchy displays the name of the workflow template that 
the workflow is based on, the second level of the table hierarchy displays the name of the 
workflow, and the third level of the table hierarchy displays the associated workflow steps. Any 
workflow steps that are highlighted grey are pending and need to be completed. 

• ID: Displays the identification number of the corresponding workflow or workflow step. 

• Start Date: Displays when the workflow step was entered. 

• End Date: Displays when the workflow step was exited. 

• Workflow State: Displays whether the state of the workflow step (for example, running, pending, 
confirmed, etc.) 

• My Pending Activity: Displays an X if you are the user responsible to complete the workflow step. 

• Current Step Comments: Displays an X if a comment has been made for the current workflow 
step. To access the comment, click the workflow step and select Navigate > Navigate to Activity. 
Open the Active Step Activities Page View to view the comments in the Message column. 

• Previous Step Comments: Displays an X if a comment has been made for the previous workflow 
step. To access the comment, click the workflow step and select Navigate > Navigate to Activity. 
Open the Activities of Preceding Steps Page View to view the comments in the Message column. 

• Locked By. Displays the name of the user who is currently working on the workflow step. 

You can navigate to the object profile of a completed or pending workflow step. If you navigate to the ob-
ject profile of a completed workflow step, the view will display the attributes of the workflow step. This view 

is ReadOnly. To do so, click the workflow step in the table and click the Navigate  button. 
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Defining a Proxy to Manage Your Workflow Steps 

Because workflow steps must be completed by a specified deadline, it is recommended that you specify 
alternate persons to take care of your responsibilities in case of a planned absence. The User’s Proxies 
page view allows you to define proxies to be responsible for workflow steps generated in the context of a 
specific workflow template. In this way, you can assign the appropriate person for each workflow context. 
You should not assign more than one user per workflow template. 

During the times that you are absent as specified in the User's Availability Page View, each proxy user you 
have defined will have the necessary access permissions to the workflow steps that he/she is responsible 
for via the proxy assignment. Your workflow steps will be accessible in the proxy’s My Workflow Activities 
views as well as the Associated Workflows page view for the relevant object. 

 
Email notifications will continue to be sent to the original user if the email notification capability 
has been implemented for the relevant workflow templates. Please note that the proxy user will 
NOT receive email notifications. A notification monitor can be configured to notify the proxy 
about the workflow step. For more information, see the section Defining Notification Monitors in 
the reference manual User and Solution Administration. 

To define a proxy for your workflow steps: 

1) Navigate to the Personal Info functionality and open the User’s Proxies page view. 

2) In the toolbar, click the Add Workflows Proxy  button. The Proxy Definition editor opens. 

3) In the editor that opens, you will see your user name in the Person field. In the Proxy field, select 
the user that you want to assign the responsibility to. 

4) You will see Workflows selected in the Category field. In the Sub-Categories field, select the 
workflow template that the workflows are based on that is relevant for the selected proxy. The 
proxy will only be authorized to view and access workflows steps that are generated in context of 
the selected workflow template(s). 

5) Click OK to close the editor and save your data. 
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Chapter 12:  Keeping Track of Objects via Monitors  

Alfabet provides a number of different monitors that help your enterprise maintain accurate and up-to-
date data. Monitoring allows you to keep track of specified objects for activity (the object has been edited), 
inactivity (the object has not been edited), or an approaching date (such as an end date). When a monitor is 
activated, all users defined as listeners to the monitor are automatically sent an email notification. The us-
ers defined will be able to access the object that the monitor is about via a hyperlink in the email notifica-
tion by means of a specified user profile. 

Alfabet provides a variety of monitors to alert Alfabet users about changes that have occurred to specific 
objects which may require further activity, reviews that did not occur as intended, or transactions that 
were expected to occur. The following monitor types are available in Alfabet. 

Monitor 
Type 

Purpose Example Details 

Activity 
Monitor 

An activity monitor alerts specified 
users about changes that have been 
made to specified objects in an ob-
ject class. The monitor owner must 
specify a set of attributes that are 
to be monitored and may specify a 
set of users that are to be alerted if 
the monitor is triggered. An email 
will be sent to the monitor owner 
and all defined users when the mon-
itor is triggered. 

The monitor owner and 
specified users should be 
alerted about changes made 
to the start and end dates of 
information flows defined 
for a specific set of applica-
tions. In this case, you 
would define an activity 
monitor of the type Appli-
cation with the monitored 
context Application - In-
formation Flows. You 
would then define the at-
tributes Start Date and End 
Date to track. 

Created in the Moni-
tors functionality. 

Inactiv-
ity Moni-
tor 

An inactivity monitor alerts the 
monitor owner and specified users 
about the absence of activity occur-
ring to specified objects in an object 
class. The monitor owner must 
specify a set of objects that are to 
be monitored and may specify a set 
of users that are to be alerted if the 
monitor is triggered. An email will be 
sent to the monitor owner and all 
defined users if a specified object is 
not changed or reviewed within a 
specified period of time. 

The monitor owner can specify the 
monitor object as reviewed via the 

Mark as Reviewed  button in 
the object profile of the targeted 
object. 

The monitor owner and 
specified users should be 
alerted if no changes are 
made to an application. 
Specified applications 
should be reviewed on a 
monthly basis. In this case, 
you would define an inactiv-
ity monitor of the type Ap-
plication with a monthly 
frequency. 

Created in the Moni-
tors functionality. 



 
 Chapter 12: Keeping Track of Objects via Monitors 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 290 

Monitor 
Type 

Purpose Example Details 

Date 
Monitor 

A date monitor allows you to keep 
track of the approach of a date 
(start date, end date, target date, 
etc.) for specified objects or the 
date of related objects. The monitor 
owner must specify a set of objects 
that are to be monitored and may 
specify a set of users that are to be 
alerted if the monitor is triggered. 
An email will be sent to the monitor 
owner and all defined users when 
the monitor is triggered. 

The monitor owner and 
specified users should be 
alerted about the approach-
ing end date of the business 
supports provided by spe-
cific applications. In this 
case, you would define a 
date monitor of the type 
Application with the moni-
tored context Application 
Business Support. You 
would then specify that the 
end date should be tracked. 

Created in the Moni-
tors functionality. 

System 
Date 
Monitor 

A system date monitor is a time-
triggered monitor for an object class 
on a system-wide basis. A system 
date monitor allows you to keep 
track of the approach of a date for 
all objects in a specified object class 
and their related objects (such as an 
object’s start date, end date, target 
date, etc.). 

When a specified date approaches 
for an object in the object class, an 
assignment will be generated for 
the object's authorized user. The 
authorized user will also receive an 
email information them of their new 
assignment. 

All users responsible for any 
application should be 
alerted about business sup-
ports that have an end date 
later than the applications 
providing the business sup-
port. 

Created in the System 
Date Monitors func-
tionality available via 
an administrative user 
profile. For more infor-
mation about defining 
system date monitors, 
see the section Defin-
ing System Date Moni-
tors in the reference 
manual User and Solu-
tion Administration. 

Con-
sistency 
Monitor 

A consistency monitor supports the 
system-wide maintenance of ob-
jects in the Alfabet database. The 
consistency monitor is specified to 
periodically search for inconsisten-
cies among objects. Each con-
sistency monitor is based on an 
alfabet query or native SQL query 
that defines the object classes tar-
geted by the query as well as the in-
consistent attributes to be de-
tected. 

If an inconsistency is found by the 
query, an assignment will be gener-
ated for the object's authorized 
user. The authorized user will also 
receive an email information them 
of their new assignment. The timely 
completion of the assignment 

Users responsible for an ap-
plications should be alerted 
if an application’s lifecycle is 
to change from the status 
Plan to the status Produc-
tion. Such a monitor would 
ensure that users across the 
enterprise assess the valid-
ity of the status change, 
thus allowing the enterprise 
to maintain consistency and 
accuracy regarding changes 
to application lifecycle defi-
nitions. 

Created in the Con-
sistency Monitors 
functionality available 
via an administrative 
user profile. For more 
information about de-
fining consistency 
monitors, see the sec-
tion Defining Con-
sistency Monitors in 
the reference manual 
User and Solution Ad-
ministration. 
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Monitor 
Type 

Purpose Example Details 

triggered by a consistency monitor 
can be tracked by the solution ad-
ministrator. 

Notifica-
tion 
Monitor 

A notification monitor allows email 
notifications to be automatically 
triggered based on configured 
Alfabet queries or native SQL que-
ries. The queries specify the objects 
and attributes that are targeted as 
well as the users who shall be noti-
fied about the objects found by the 
queries. 

Users who have a specified 
role for applications should 
be alerted about any new 
information flows that are 
created for the applications 
that they are associated 
with. 

Created in the Notifi-
cation Monitors 
functionality available 
via an administrative 
user profile. For more 
information about de-
fining notification 
monitors, see the sec-
tion Defining Notifica-
tion Monitors in the 
reference manual User 
and Solution Admin-
istration. 

Activity, inactivity, and date monitors are created in the Monitors functionality, which is described below. 
The configuration of system date monitors, consistency monitors, and notification monitors is a more in-
volved process that is carried about by a user with an administrative user profile. For more information 
about configuring system date monitors, consistency monitors, and notification monitors, refer to the ref-
erence manual User and Solution Administration. 

 

The following must be configured in order to work with monitors in Alfabet: 

• In order for any monitor to be executed and email notifications to be sent to relevant 
users, a batch process must be configured by your system administrator. For more 
information about setting up a batch process, see the section Batch Processing for 
Monitors and Change Management with AlfaBatchExecutor.exe in the reference 
manual System Administration. 

• All Alfabet functionalities for which the email capability is to be implemented require the 
setup of a connection to an SMTP server for outgoing email in the tool Alfabet 
Administrator. For more information, see the section Activating the Dispatch of Email 
Notifications in Alfabet in the reference manual System Administration. 

• Text templates for email notifications may be customized for all monitors in the 
configuration tool Alfabet Expand. For more information, see Configuring Monitors in 
the reference manual Configuring Alfabet with Alfabet Expand. 

• For each monitor created, the monitor owner must define the User Profile to Access 
Object in Notification field in the monitor's editor in the relevant monitor functionality 
in the Solution Admin tab that may be accessed via an administrative user profile. This 
is described for each monitor type in the chapter Configuring Monitors to Track Objects 
in Alfabet in the reference manual User and Solution Administration. 

• Access permissions must be available for the user profile so that relevant users 
receiving the email notification can access the relevant objects that are targeted by the 
hyperlink in the email notification. For more information about the configuration of 
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access permissions, see the section Configuring Access Permissions for Alfabet in the 
reference manual Configuring Alfabet with Alfabet Expand. 

• All object classes that are to be monitored via activity monitors and inactivity monitors 
have history tracking enabled in the configuration tool Alfabet Expand and therefore, 
the Audit attribute must be set to True for these object classes. Please note that this is 
not necessary for date, system date, consistency, and notification monitors. These 
monitors will be implemented even if the Audit attribute is set to False for the relevant 
object class. For more information, see the section Specifying History Tracking for an 
Object Class in the chapter Configuring the Class Model in the reference manual 
Configuring Alfabet with Alfabet Expand. 

The Monitors explorer displays the Activity Monitors  folder containing all existing activity monitors 

, the Inactivity Monitors  folder containing all existing inactivity monitors , and the Date Moni-

tors  folder containing all existing date monitors . You can do any of the following: 

  

• Click the  or  symbol next to the respective folder  to expand or collapse the folder and 
view the existing monitors. 

• Click a folder  to create a new monitor or view the existing monitors in the table to the right. 
The columns in the table are described below.  

• ID: The monitor’s identification number 

• Name: The monitor’s name 

• Start Date: The monitor’s start date 

• End Date: The monitor’s end date 

• Frequency: The frequency that the monitor is executed 

• Monitor Type: The object class whose objects should be monitored. The availability of classes 
depend on whether the monitor is an activity, inactivity, or date monitor. 
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• Next Execution Date: The next date that the monitor will be executed. If this monitor has not 
been executed at all it will be reset to the monitor's start date. 

• Is Active: An X indicates that the monitor is activated. If the cell is empty, the monitor is 
deactivated. 

For more information about working with monitors, see: 

• Defining Activity Monitors for Specific Objects 

• Creating an Activity Monitor 

• Activating and Deactivating the Activity Monitor 

• Defining the Objects to be Tracked by an Activity Monitor 

• Specifying the Users to Be Alerted About the Activity Monitor 

• Defining Inactivity Monitors for Specific Objects 

• Creating an Inactivity Monitor 

• Activating and Deactivating the Inactivity Monitor 

• Defining the Objects to be Tracked by an Inactivity Monitor 

• Specifying the Users to Be Alerted About the Inactivity Monitor 

• Defining a Date Monitor for Specific Objects 

• Creating a Date Monitor 

• Activating and Deactivating the Date Monitor 

• Defining the Objects to be Tracked by a Date Monitor 

• Specifying the Users to Be Alerted About the Date Monitor 

Defining Activity Monitors for Specific Objects  

An activity monitor is a type of monitor that alerts subscribed users about changes that have been made to 
objects in a specified object class. The monitor owner must specify a set of properties that are to be moni-
tored and a set of users that are to be alerted if the monitor is triggered. These users as well as the monitor 
owner will be informed via email notification if a specified attribute for any object in the class is changed. 
Monitoring is typically performed in regular intervals over a specific period of time. 

When you click an activity monitor  in the Activity Monitors  folder, you will see the object profile 
for the selected activity monitor. The section Attributes displays the basic information defined for the se-
lected activity monitor. You may see any of the following attributes for the selected activity monitor. 

• ID: The activity monitor's identification number 

• Name: The activity monitor's name 

• Start Date: The activity monitor's start date 
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• End Date: The activity monitor's end date 

• Frequency: The frequency that the activity monitor is executed 

• Monitor Type: The object class whose objects should be monitored. 

• Next Execution Date: The next date that the activity monitor will be executed. If this activity 
monitor has not been executed at all it will be reset to the monitor's start date. 

• Is Active: An X indicates that the activity monitor is activated. If the cell is empty, the activity 
monitor is deactivated. 

• Message Logging: An X indicates that emails sent in the context of the inactivity monitor will be 
logged in the Email Message Log functionality. If the cell is empty, the no emails will be logged for 
the inactivity monitor. 

 

In addition to the general requirements for monitors described in the section Keeping Track of 
Objects via Monitors, the following must be configured in order to work with activity monitors: 

• Activity monitors must be enabled in the configuration tool Alfabet Expand. To enable 
the activity monitor for an object class, the relevant object class must be enabled for 
auditing and the relevant monitor template must be enabled for monitoring. For more 
information, see Configuring Monitors in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• Activity monitors require the definition of monitored contexts, which allow 
modifications that may occur to different aspects or contexts of objects (such as 
lifecycles or information flows) to be monitored. The monitor contexts must be enabled 
for the relevant monitor template in the configuration tool Alfabet Expand. For more 
information, see Configuring Monitors in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• For more information about requirements to work with monitors in general, see the 
section Keeping Track of Objects via Monitors. 

To define an activity monitor, you must first create the activity monitor and specify which monitored con-
text and attributes are to be monitored, and then specify the objects that are to be tracked by the monitor 
and define the users that are to be alerted when the monitor is triggered for one of the specified objects. 

The following information is available: 

• Creating an Activity Monitor 

• Activating and Deactivating the Activity Monitor 

• Defining the Objects to be Tracked by an Activity Monitor 

• Specifying the Users to Be Alerted About the Activity Monitor 

Creating an Activity Monitor 

You can create an unlimited number of activity monitors. Multiple activity monitors may be defined for the 
same object class but may monitor different contexts and different objects. 
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1) In the Monitors explorer, click the Activity Monitors  folder. 

2) In the Activity Monitors view on the right, click New > Create New Monitor. The Activity Monitor 
editor opens. 

3) Enter information into each field, as required.  

General tab: 

• ID: Alfabet assigns a unique identification number to each object in the inventory. This number 
cannot be edited. 

• Name: Enter a unique name for the activity monitor. 

• Monitor Type: Select the object class whose objects should be monitored. 

• Monitor Frequency: Enter the frequency that the activity monitor should be executed. 
Choices include Daily, Weekly, and Monthly. Weekly monitors are executed on the same day of 
the week that the activity monitor is created.  

 

For example, a monitor created on Thursday, March 27 will be executed on Thurs-
day, April 3, Thursday, April 10, etc. 

• Start Date: Enter the activity monitor’s start date in the format appropriate to your cultures or 
select the start date in the calendar. The default date is today's date. 

• End Date: Enter the activity monitor’s end date in the appropriate format or select the end 
date in the calendar. The default date is one year after today's date. 

• User Profile to Access Object in Notification: Select the user profile that will be used by the 
defined listeners to access the monitored object in Alfabet via the hyperlink in the email.  

 
The user profiles displayed include all user profiles assigned to the current user as 
well as any user profiles defined for anonymous users. For more information about 
the definition of user profiles for anonymous users, see Defining a User Profile for 
Anonymous Users in the reference manual User and Solution Administration. 

 

Monitored Attributes tab: 

• Monitored Context: Alfabet allows you to monitor modifications that may occur to different 
aspects or contexts of objects in an object class. Select a context to be monitored. The 
availability of monitored contexts is configured by your solution designer. Depending on the 
object class you are monitoring, there may only be one context available. For more information 
about the meaning of the values listed in the field, see the section Overview of Monitored 
Contexts in the reference manual Configuring Alfabet with Alfabet Expand - Appendix. 

• [field listing attributes]: Check one or more standard or custom attributes that should be 
monitored for the objects targeted by the activity monitor. The list of attributes will depend on 
the monitored context you select. 

4) Click OK to save the monitor or Cancel if you do not want to save it 

 
If you delete an activity monitor, it will be irrevocably deleted from the Alfabet database. 
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Activating and Deactivating the Activity Monitor  

You must activate the activity monitor in order for it to be triggered when the batch process is initiated. To 
activate an activity monitor, select the relevant activity monitor in the table and click Monitors > Activate 
Monitors. You can simultaneously select multiple monitors by using the key combination CTRL + click to 
simultaneously select several objects in the table. A checkmark is displayed in the Is Active column for all 
currently active activity monitors. 

To deactivate an activity monitor so that it is not triggered when the batch process is initiated, select the 
relevant activity monitor in the table and click Monitors > Deactivate Monitors. The checkmark will be re-
moved from the Is Active column. 

Defining the Objects to be Tracked by an Activity Monitor 

The Objects page view allows you to define specific objects for an activity monitor. The objects that you 
associate with the activity monitor are the specific objects in Alfabet that are to be tracked by the activity 
monitor. When the criteria defined in the Activity Monitor editor is fulfilled, the activity monitor will be trig-
gered and email notifications will be sent to the users specified as listeners. 

To add specific objects to be targeted by the activity monitor: 

1) Navigate to the object profile of the selected activity monitor and open the Objects page view. 

2) In the toolbar, click New > Add New Monitor Object. The object selector opens. 

3) The object class relevant for the specified monitor type will be selected in the Search For field in 
the object selector. Enter search parameters, as needed. 

4) Select an object and click OK. The object is assigned to the selected monitor. 

Specifying the Users to Be Alerted About the Activity Monitor 

The Listeners page allows you to define the users that are to be informed via email whenever the selected 
monitor is triggered. As the creator of the monitor, you are automatically added to the list of listeners. A lis-
tener will only be able to edit the object associated with the monitor if he/she has the necessary access 
permissions to the object targeted by the monitor. 

To add the users to be alerted about the monitor: 

1) Navigate to the object profile of the selected monitor and open the Listeners page view. 

2) In the toolbar, click New > Add New Listeners. The object selector opens. 

3) Enter search parameters, as needed. 

4) Select one or more users to be alerted when the monitor is triggered and click OK. You will see the 
user's name and email address in the table. When the monitor is triggered, the users will be sent an 
email notification about the monitored object. 
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Defining Inactivity Monitors for Specific Objects  

An inactivity monitor is a type of monitor that alerts subscribed users about the absence of activity occur-
ring to objects in a specified object class. The monitor owner must specify a set of objects that are to be 
monitored and a set of users that are defined as listeners to be alerted if the monitor is triggered. The moni-
tor owner is typically the user responsible for the objects defined for the monitor. The monitor owner as 
well as the listeners will be informed via email notification if a specified object has not been edited or re-
viewed within a specified period of time. If the monitored object does not need to be changed, the monitor 
owner can mark the object as reviewed. 

If the monitored object does not need to be changed, the object can be specified as reviewed via the Mark 

as Reviewed  button that is available in the toolbar of most standard object profiles. If an inactivity 
monitor has been defined for an object, this button can be clicked to indicate that no explicit changes need 
to be made to the object and that the object has been reviewed. Please note the following about access 
permissions: 

• If the user has ReadWrite permissions to the object and uses the Mark as Reviewed  button, 
then the object is specified as reviewed for all inactivity monitors associated with the object, 
regardless of who owns the inactivity monitor. 

• If a user has ReadOnly access permission to the object and uses the Mark as Reviewed  
button, the object will be specified as reviewed only for the inactivity monitor that the user owns. 

• If the user has ReadOnly access permissions to the object and uses the Mark as Reviewed  
button and no inactivity monitor has been defined for the object, a warning message will be 
displayed stating that the object is not monitored by an inactivity monitor. 

 

For more information about reviewing an object, see the section Marking the Object as Reviewed. 

When you click an inactivity monitor  in the Inactivity Monitors  folder, you will see the object pro-
file for the selected inactivity monitor. The section Attributes displays the basic information defined for 
the selected inactivity monitor. You may see any of the following attributes for the selected inactivity mon-
itor. 

• ID: The inactivity monitor's identification number 

• Name: The inactivity monitor's name 

• Start Date: The inactivity monitor's start date 

• End Date: The inactivity monitor's end date 

• Frequency: The frequency that the inactivity monitor is executed 

• Monitor Type: The object class whose objects should be monitored. 

• Next Execution Date: The next date that the inactivity monitor will be executed. If this inactivity 
monitor has not been executed at all it will be reset to the monitor's start date. 

• Is Active: An X indicates that the inactivity monitor is activated. If the cell is empty, the inactivity 
monitor is deactivated. 



 
 Chapter 12: Keeping Track of Objects via Monitors 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 298 

• Message Logging: An X indicates that emails sent in the context of the inactivity monitor will be 
logged in the Email Message Log functionality. If the cell is empty, the no emails will be logged for 
the inactivity monitor. 

 

In addition to the general requirements for monitors described in the section Keeping Track of 
Objects via Monitors, the following must be configured in order to work with inactivity monitors: 

• Inactivity monitors must be enabled in the configuration tool Alfabet Expand. In the 
case of inactivity monitors, the relevant object class must be enabled for auditing as 
well as the relevant monitor template must be enabled for monitoring. For more 
information, see Configuring Monitors in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• For more information about requirements to work with monitors in general, see the 
section Keeping Track of Objects via Monitors. 

To define an inactivity monitor, you must first create the inactivity monitor and specify the number of days 
of inactivity that is allowed, and then specify the objects that are to be tracked by the monitor and define 
the users that are to be alerted when the monitor is triggered for one of the specified objects. 

The following information is available: 

• Creating an Inactivity Monitor 

• Activating and Deactivating the Inactivity Monitor 

• Defining the Objects to be Tracked by an Inactivity Monitor 

• Specifying the Users to Be Alerted About the Inactivity Monitor 

Creating an Inactivity Monitor 

You can create an unlimited number of inactivity monitors. Multiple inactivity monitors may be defined for 
the same object class but may monitor different contexts and different objects. 

1) In the Monitors explorer, click the Inactivity Monitors  folder. 

2) In the toolbar, click New > Create New Monitor. The Inactivity Monitor editor opens. 

3) Edit the fields as needed.  

• ID: Alfabet assigns a unique identification number to each object in the inventory. This number 
cannot be edited. 

• Name: Enter a unique name for the inactivity monitor. 

• Monitor Type: Select the object class whose objects should be monitored. 

• Monitor Frequency: Enter the frequency that the inactivity monitor should be executed. 
Choices include Daily, Weekly, and Monthly. Weekly monitors are executed on the same day of 
the week that the monitor is created.  

 

For example, a monitor created on Thursday, March 27 will be executed on Thurs-
day, April 3, Thursday, April 10, etc. 
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• Start Date: Enter the inactivity monitor’s start date in the format appropriate to your cultures 
or select the start date in the calendar. The default date is today's date. 

• End Date: Enter the inactivity monitor’s end date in the appropriate format or select the end 
date in the calendar. The default date is one year after today's date. 

• Critical Period of Inactivity: Enter the number of days that inactivity is allowed. An email 
notification will be generated when this number of days is exceeded. 

• User Profile to Access Object in Email Notification: Select the user profile that will be used 
by the defined listeners to access the monitored object in Alfabet via the hyperlink in the 
email.  

 
The user profiles displayed include all user profiles assigned to the current user as 
well as any user profiles defined for anonymous users. For more information about 
the definition of user profiles for anonymous users, see Defining a User Profile for 
Anonymous Users in the reference manual User and Solution Administration. 

 

4) Click OK to save the monitor or Cancel if you do not want to save it 

 
If you delete an inactivity monitor, it will be irrevocably deleted from the Alfabet database. 

Activating and Deactivating the Inactivity Monitor  

You must activate the inactivity monitor in order for it to be triggered when the batch process is initiated. 
To activate an inactivity monitor, select the relevant inactivity monitor in the table and click Monitors > Ac-
tivate Monitors. You can simultaneously select multiple monitors by using the key combination CTRL + 
click to simultaneously select several objects in the table. A checkmark is displayed in the Is Active column 
for all currently active inactivity monitors. 

To deactivate an inactivity monitor so that it is not triggered when the batch process is initiated, select the 
relevant inactivity monitor in the table and click Monitors > Deactivate Monitors. The checkmark will be 
removed from the Is Active column. 

Defining the Objects to be Tracked by an Inactivity Monitor 

The Objects page view allows you to define specific objects for an inactivity monitor. The objects that you 
associate with the inactivity monitor are the specific objects in Alfabet that are to be tracked by the moni-
tor. When the criteria defined in the Inactivity Monitor editor is fulfilled, the inactivity monitor will be trig-
gered and email notifications will be sent to the users specified as listeners. 

To add specific objects to be targeted by the inactivity monitor: 

1) Navigate to the object profile of the selected inactivity monitor and open the Objects page view. 

2) In the toolbar, click New > Add New Monitor Object. The object selector opens. 

3) The object class relevant for the specified monitor type will be selected in the Search For field in 
the object selector. Enter search parameters, as needed. 
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4) Select an object and click OK. The object is assigned to the selected monitor. 

Specifying the Users to Be Alerted About the Inactivity Monitor 

The Listeners page allows you to define the users that are to be informed via email whenever the selected 
inactivity monitor is triggered. As the creator of the inactivity monitor, you are automatically added to the 
list of listeners. A listener will only be able to edit the object associated with the inactivity monitor if he/she 
has the necessary access permissions to the object targeted by the monitor. 

To add the users to be alerted about the inactivity monitor: 

1) Navigate to the object profile of the selected inactivity monitor and open the Listeners page view. 

2) In the toolbar, click New > Add New Listeners. The object selector opens. 

3) Enter search parameters, as needed. 

4) Select one or more users to be alerted when the inactivity monitor is triggered and click OK. You 
will see the user's name and email address in the table. When the inactivity monitor is triggered, 
the users will be sent an email notification about the monitored object. 

Defining a Date Monitor for Specific Objects  

A date monitor is a type of monitor that alerts subscribed users about approaching dates that have been 
defined for objects in a specified object class (for example, the approach of an object's start or end date). 
Two kinds of date monitors are available in Alfabet: object-specific date monitors and system-wide date 
monitors that target all objects in a specified object class. 

Object-specific date monitors are defined by an individual user to keep track of the approach of a date for 
specified objects. The monitor owner must specify a set of properties that are to be monitored and a set of 
users that are to be alerted if the monitor is triggered. These users as well as the monitor owner are in-
formed when the target date approaches for the specified attribute and can then decide upon the appro-
priate action to take. Monitoring is performed in regular intervals over a specified period of time. 

In addition to the conventional Alfabet date monitors, system-wide defined date monitors can be config-
ured for an object class. When a specified date approaches, all authorized users responsible for objects in 
the relevant object class will be sent notifications per email asking them to review the objects that they are 
responsible for. 

When you click a date monitor  in the Date Monitors  folder, you will see the object profile for the 
selected date monitor. The section Attributes displays the basic information defined for the selected date 
monitor. You may see any of the following attributes for the selected date monitor. 

• ID: The date monitor's identification number 

• Name: The date monitor's name 

• Start Date: The date monitor's start date 

• End Date: The date monitor's end date 

• Frequency: The frequency that the date monitor is executed 
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• Monitor Type: The object class whose objects should be monitored. 

• Next Execution Date: The next date that the date monitor will be executed. If this date monitor 
has not been executed at all it will be reset to the monitor's start date. 

• Is Active: An X indicates that the date monitor is activated. If the cell is empty, the date monitor is 
deactivated. 

• Message Logging: An X indicates that emails sent in the context of the date monitor will be logged 
in the Email Message Log functionality. If the cell is empty, the no emails will be logged for the 
date monitor. 

 

In addition to the general requirements for monitors described in the section Keeping Track of 
Objects via Monitors, the following must be configured in order to work with date monitors: 

• Date monitors require the definition of monitored contexts, which allow modifications 
that may occur to different aspects or contexts of objects (such as lifecycles or 
information flows) to be monitored. The monitor contexts must be enabled for the 
relevant monitor template in the configuration tool Alfabet Expand. For more 
information, see Configuring Monitors in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• For more information about requirements to work with monitors in general, see the 
section Keeping Track of Objects via Monitors. 

• For more information about configuring system-wide date monitors, see the section 
Defining System Date Monitors in the reference manual User and Solution 
Administration. 

To define a date monitor, you must first create the date monitor and specify which monitored context and 
attributes are to be monitored, and then specify the objects that are to be tracked by the monitor and de-
fine the users that are to be alerted when the monitor is triggered for one of the specified objects. 

The following information is available: 

• Creating a Date Monitor 

• Activating and Deactivating the Date Monitor 

• Defining the Objects to be Tracked by a Date Monitor 

• Specifying the Users to Be Alerted About the Date Monitor 

Creating a Date Monitor 

You can create multiple date monitors. 

1) In the Monitors explorer, click the Date Monitors  folder. 

2) In the toolbar, click New > Create New Monitor. The Date Monitor editor opens. 

3) Enter information into each field, as required.  

General tab: 
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• ID: Alfabet assigns a unique identification number to each object in the inventory. This number 
cannot be edited. 

• Name: Enter a unique name for the date monitor. 

• Monitor Type: Select the object class whose objects should be monitored. 

• Monitor Frequency: Enter the frequency that the date monitor should be executed. Choices 
include Daily, Weekly, and Monthly. Weekly monitors are executed on the same day of the week 
that the monitor is created.  

 

For example, a monitor created on Thursday, March 27 will be executed on Thurs-
day, April 3, Thursday, April 10, etc. 

• Start Date: Enter the date monitor’s start date in the format appropriate to your cultures or 
select the start date in the calendar. The current date is the default. 

• End Date: Enter the date monitor’s end date in the appropriate format or select the end date 
in the calendar. One year after the current date is the default. 

• Alert Period: Enter the number of days before (positive value) or after (negative value) the 
defined date attribute that an email notification should be generated. 

• User Profile to Access Object in Notification: Select the user profile that will be used by 
listeners to access the object in Alfabet via the hyperlink in the monitor's notification email.  

 
The user profiles displayed include all user profiles assigned to the current user as 
well as any user profiles defined for anonymous users. For more information about 
the definition of user profiles for anonymous users, see Defining a User Profile for 
Anonymous Users in the reference manual User and Solution Administration. 

 

Monitored Attributes tab: 

• Monitored Context: Alfabet allows you to monitor modifications that may occur to different 
aspects or contexts of objects in an object class. Select a context to be monitored. The 
availability of monitored contexts is configured by your solution designer. Depending on the 
object class you are monitoring, there may only be one context available. For more information 
about the meaning of the values listed in the field, see the section Overview of Monitored 
Contexts in the reference manual Configuring Alfabet with Alfabet Expand - Appendix. 

• [field listing attributes]: Check one or more standard or custom attributes that should be 
monitored for the objects targeted by the date monitor. The list of attributes will depend on 
the monitored context you select. 

4) Click OK to save the monitor or Cancel if you do not want to save it 

 
If you delete a date monitor, it will be irrevocably deleted from the Alfabet database. 
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Activating and Deactivating the Date Monitor  

You must activate the date monitor in order for it to be triggered when the batch process is initiated. To 
activate a date monitor, select the relevant date monitor in the table and click Monitors > Activate Moni-
tors. You can simultaneously select multiple monitors by using the key combination CTRL + click to simul-
taneously select several objects in the table. A checkmark is displayed in the Is Active column for all cur-
rently active date monitors. 

To deactivate a date monitor so that it is not triggered when the batch process is initiated, select the rele-
vant date monitor in the table and click Monitors > Deactivate Monitors. The checkmark will be removed 
from the Is Active column. 

Defining the Objects to be Tracked by a Date Monitor 

The Objects page view allows you to define specific objects for a date monitor. The objects that you asso-
ciate with the date monitor are the specific objects in Alfabet that are to be tracked by the monitor. When 
the criteria defined in the Date Monitor editor is fulfilled, the date monitor will be triggered and email noti-
fications will be sent to the users specified as listeners. 

To add specific objects to be targeted by the date monitor: 

1) Navigate to the object profile of the selected date monitor and open the Objects page view. 

2) In the toolbar, click New > Add New Monitor Object. The object selector opens. 

3) The object class relevant for the specified monitor type will be selected in the Search For field in 
the object selector. Enter search parameters, as needed. 

4) Select an object and click OK. The object is assigned to the selected monitor. 

Specifying the Users to Be Alerted About the Date Monitor 

The Listeners page allows you to define the users that are to be informed via email whenever the selected 
date monitor is triggered. As the creator of the date monitor, you are automatically added to the list of lis-
teners. A listener will only be able to edit the object associated with the date monitor if he/she has the nec-
essary access permissions to the object targeted by the monitor. 

To add the users to be alerted about the date monitor: 

1) Navigate to the object profile of the selected date monitor and open the Listeners page view. 

2) In the toolbar, click New > Add New Listeners. The object selector opens. 

3) Enter search parameters, as needed. 

4) Select one or more users to be alerted when the date monitor is triggered and click OK. You will see 
the user's name and email address in the table. When the date monitor is triggered, the users will 
be sent an email notification about the monitored object. 
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Chapter 13:  Creating a Splash Screen As Your Start Page  

A splash screen capability is available that allows with read-only and read-write access permission to cre-
ate a personal start page that consists of the views that you work with most often. This could include, for 
example, standard page views, configured reports, and analytic dashboards. An object profile or object 
cockpit cannot be added to the splash screen. The splash screen you create can be displayed instead of the 
start page configured by your enterprise upon login to Alfabet. If your enterprise has configured a guide 

page, a drop-down menu will be added to the Start Page  button in the main toolbar that allows you 
to select either the splash screen or the guide view. 

  

 FIGURE: Example of a splash screen 

A splash screen may contain multiple tabs, each containing one or more views in a table layout structure. 
You can specify the size and placement of the views in a tab by defining a table layout to determine how 
the views are placed in the layout. In this way, you can determine that some views take up more space ver-
tically and horizontally than others. Each tab may have a different table layout. 
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 FIGURE: Table layout in the Splash Screen editor 

For example, in table layout with 2 columns and 4 rows, the column span of one view might be 2 and the 
row span 2, and two other views may be positioned below the rows with the first view and have a column 
span of 1 and a row span of 2. 

Furthermore, you can specify the captions to display for the tabs and views. 

 

 

The following must be completed in order to view the splash screen in the Alfabet user interface: 

• The Enable Splash Screen option in the User Settings editor must be enabled in order to display 
the Edit Splash Screen option in the Bookmark menu. A splash screen cannot be created if this 
option is not enabled. 

• The Active attribute available in the Splash Screen editor must be set to True. 
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To specify a splash screen as your personal start page 

1) Navigate to a view that you want to add to your splash screen and in the Bookmark menu in the 
main toolbar, click Edit Splash Screen.  

 
The splash screen capability is only available for views that may be bookmarked. For ex-
ample, bookmarks cannot be created for specific administrative functionalities as well as 
custom object views, page views, and configured reports for which the solution designer 
has set the Can Create Bookmark attribute to False. If a view may not be bookmarked, 
the Create Bookmark option in the Bookmark menu in the main toolbar will be disabled. 

2) The Splash Screen Editor opens. The entire splash screen is in focus, evident by the outermost 
blue border, and displays a default table. First, define the following general attributes for the 
splash screen:  

• Caption: Define a caption for the splash screen. The caption will be displayed as the title of 
the splash screen in the Alfabet user interface. 

• Active: Select the checkbox to activate the splash screen and make it visible in the Alfabet 
user interface. You should activate the splash screen immediately so that you can test the 
display as you are defining it. Once activated, the splash screen will be displayed as your start 
page and will override any other configured start page defined by your enterprise. 

• Ignore Common Container Skin: Per default, this attribute is set to False (no checkmark is 
set) and the skin styles such as margins, borders padding, and box shadowing specified via the 
Common Container Skin attributes in the GUI scheme are applied. Select the the skin styles 
such as margins, borders padding, and box shadowing are specified via the Common 
Container Skin attribute in the GUI scheme. Check the Ignore Common Container Skin 
checkbox if no skin styles configured for the user profile should be used to display the 
content. In this case, the content is displayed in a simple grid layout. For more information 
about configuring GUI schemes, see the section Configuring GUI Scheme Definitions for the 
Alfabet Interface in the reference manual Configuring Alfabet with Alfabet Expand. 

3) Next, you must create tabbed pages in order to add views to the splash screen. Click the Create 
Tab Page button. Two tabs will be automatically displayed. Please note that if you don't require 
two tabbed pages, you can delete one by clicking the outer border of the tabbed page to place the 
focus on it and clicking the Delete button. 

4) Select the tab you want to specify in the Pages drop-down men and define the following:  

• Caption: Enter a caption if for the tabbed page. This is necessary if you plan to specify 
multiple tabbed pages.. 

• Table Layout: The default table layout is set to 6x8 (rows x columns). Enter the number of 
rows and the number of columns for the layout of the tabbed page. When you add views to the 
table layout, you will be able to specify that a view stretches horizontally across more than one 
row and vertically across more than one column. In other words, if views of different sizes shall 
be displayed in the splash screen, then you should consider the amount of space in the table 
that the individual views require in relation to each other. In the images above, the Table 
Layout is specified with the value 4x2. The splash screen contains three views with one view 
filling 2 rows and 2 columns, and 2 other views, each filling 2 rows and 1 column. 

5) To add the current view to the splash screen, click the Add Current View button. The view will be 
added to the first tabbed page. You can further refine the size and position of the view in the table 
layout specified. You can drag-and-drop the view and move it to another cell in the table.  

• Caption: Enter a caption for the tab, if necessary. 
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• Column Span: Specify the number of columns in the table layout that the view should span. 

• Row Span: Specify the number of rows in the table layout that the view should span. 

• Left: Specify the column cell in the table grid where you want to place the view. The first 
column = 0, the next column = 1, etc. 

• Top: Specify the row cell in the table grid where you want to place the view. The first row = 0, 
the next row = 1, etc. 

6) Click OK to save the view definition in the tabbed page of the splash screen. The Splash Screen 
Editor will close. You can check the layout of the splash screen by clicking the Start 

Page  button. 

7) To add another view to the tabbed page, navigate to the view in the Alfabet user interface and 
click Bookmark > Edit Splash Screen.In the Splash Screen editor, click the Add Current View 
button and report the procedure described above. Repeat until all views have been added to the 
tabbed page. 

8) To add another tabbed page to the splash screen, click Bookmark > Edit Splash Screen. In the 
Splash Screen editor, click the Create Tab Page button. Specify the Caption and Table Layout 
attributes as explained above and add views as needed. You can create multiple tabbed pages as 
needed. 

9) Please note the following:  

• To delete a tabbed page, click the outer border of the tabbed page to place the focus on it and 
click the Delete button. 

• To delete a view in a tabbed page, click the view to place the focus on it and click the Delete 
button. 

• To completely remove the splash screen, click outside of the outer border of the tabbed page 
to place the focus on the splash screen and clear the Active checkbox. 
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Chapter 14:  Designing, Sharing, and Viewing Analytics Dash-
boards  

Alfabet provides analytics dashboards that are designed based on the embedded third-party tool DevEx-
press® Dashboard. Analytics dashboards support end users to create ad-hoc information-rich data visuali-
zations. Users can use the full-range of visualization possibilities available in the DevExpress Dashboard 
Designer. One or more dashboard items such as charts, scatter charts, grids, cards, gauges, pivots, range 
maps, treemaps, etc. can be added to the analytics dashboard and filtering options such as combo-boxes, 
list boxes, and tree views can be leveraged. 

 

For example, an analytics dashboard has been designed application analysis in the enterprise. 
The analytics dashboard displays a list of application groups and applications to filter the data, 
pie charts visualizing the count of applications per release status and object state, and a portfo-
lio chart show the applications based on their business value and adaptability. 

Analytics dashboards can be shared with other users and the designer of an analytics dashboard may 
specify which users have authorization to edit the analytics dashboard and which users may only view it. 
Authorized users as well as users in authorized user groups will jointly manage and edit an analytics dash-
board. Access to the analytics dashboard may also be granted to specified users, users in specified user 
groups, and users with a specified user profile. These users will only be able to view the analytics dash-
board. 

Navigation to objects displayed in the analytics dashboard is supported. To navigate to an object displayed 
in an analytics dashboard, click and hold the pointer on an object in the analytics dashboard to open the 
preview and click the Show Details button to open the object profile or object cockpit of the object. The 
analytics dashboard can also be exported to a PDF file, shared as an express view, and embedded in a guide 
view or splash screen. 

 

To create an analytics dashboard, the following steps are required: 

• An analytics dashboard must be created in the Analytics Dashboards explorer. An 
analytics dashboard data provider configured by your enterprise must be assigned to 
the analytics dashboard in order to fetch the data to be displayed.  

 

Analytics dashboard data providers must first be configured in the Analytics 
Dashboard Data Provider view in the Integration Solutions Configuration 
functionality in order to fetch the data from the Alfabet database that will be 
displayed in the analytics dashboard. For more information, see the section 
Specifying Analytics Dashboard Data Providers in the reference manual 
Configuring Evaluation and Reference Data in Alfabet. 

• The analytics dashboard must be designed via the Dashboard Designer provided by the 
third-party tool DevExpress® Dashboard.  

 

The following link provides samples of DevExpress dashboards: https://de-
mos.devexpress.com/Dashboard/. Please note that this documentation ad-
dresses only the use of Alfabet -specific functionalities. For more infor-
mation about how to design the analytics dashboard in the context of the 
Dashboard Designer, see the following documentation available for DevEx-
press® Dashboard: https://devexpress.github.io/dotnet-eud/dashboard-
for-web/articles/web-dashboard-designer-mode.html 

https://demos.devexpress.com/Dashboard/
https://demos.devexpress.com/Dashboard/
https://devexpress.github.io/dotnet-eud/dashboard-for-web/articles/web-dashboard-designer-mode.html
https://devexpress.github.io/dotnet-eud/dashboard-for-web/articles/web-dashboard-designer-mode.html
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• The analytics dashboard may be shared with other users who may view the analytics 
dashboard but may not edit. User access can be explicitly defined for specified users or 
define via a user group or user profile affiliation.  

 
Analytics dashboards that are jointly managed may be edited by the author-
ized user as well as members of authorized user groups that have been de-
fined for the diagram. 

 

The following information is available: 

• Creating an Analytics Dashboard 

• Designing the Analytics Dashboard 

• Assigning Other Users Read-Only Access to the Analytics Dashboard 

• Assigning User Profiles Read-Only Access to the Analytics Dashboard 

• Assigning User Groups Read-Only Access to the Analytics Dashboard 

Creating an Analytics Dashboard 

The Analytics Dashboards functionality allows you to create new dashboards as well as navigate to the 
views in which access permissions can be defined for other users, user groups, and user profiles. The Ana-
lytics Dashboards explorer contains the following nodes: 

• My Analytics Dashboards: This node contains all analytics dashboards that you are the 
authorized user of.  

• Expand this node to display all analytics dashboards that you have created. 

• Click this node to open the view that allows you to create new analytics dashboards and edit 
the analytics dashboards that you are the authorized user of. 

• Click an analytics dashboard to open the Dashboard Designer in order to design the 
visualization of the data in the analytics dashboard. 

• Jointly Managed Analytics Dashboards: This node contains all analytics dashboards that you 
may edit based on your membership in an authorized user group that has been defined as 
responsible for the analytics dashboard.  

• Expand this node to display all analytics dashboards that you may edit as a member of an 
authorized user group. 

• Click this node to open the view that allows you to edit the analytics dashboards that you 
jointly manage. 

• Click an analytics dashboard to open the Dashboard Designer in order to design the 
visualization of the data in the analytics dashboard that you jointly manage. 

• Shared Analytics Dashboards: This node contains all analytics dashboards that you have read-
only access permissions to because the owner(s) of the analytics dashboards have explicitly 
provided permissions to you as a user, a member of a user group, or a user assigned a specified 
user profile.  
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• Analytics Dashboards Shared with Me: Expand this node to view all analytics dashboards 
that have been shared with you. 

• Analytics Dashboards Shared with My User Groups: Expand this node to view all analytics 
dashboards that have been shared with one or more users groups that you are a member of. 

• Analytics Dashboards Shared with My User Profile: Expand this node to view all analytics 
dashboards that have been shared with your user profile. 

To create an analytics dashboard: 

1) In the Analytics Dashboards explorer, click the My Analytics Dashboards node. 

2) In the view on the right, click New > Create an Analytics Dashboard. 

3) In the Analytics Dashboard editor, define the following:  

Basic Data tab: 

• ID: Displays the automatically-generated unique identification number for the analytics 
dashboard. 

• Name: Enter a name for the analytics dashboard. 

• Release Status: Select the analytics dashboard's current release status.  

 

The set of release statuses available for an object class are configured by your so-
lution designer in the configuration tool Alfabet Expand. For more information, see 
the section Configuring Release Status Definitions for Object Classes in the refer-
ence manual Configuring Alfabet with Alfabet Expand. For general information 
about release statuses, see the section Understanding Release Statuses in the ref-
erence manual Getting Started with Alfabet. 

• Description: Project a meaningful explanation about the purpose of the analytics dashboard. 

• Analytics Dashboard Data Provider: Select the analytics dashboard data provider that will 
find the data to display in the analytics dashboard.  

 

The analytics dashboard data provider is configured in order to fetch the data from 
the Alfabet database that will be displayed. This is carried out in the Analytics 
Dashboard Data Provider view in the Integration Solutions Configuration func-
tionality. For more information, see the section Specifying Analytics Dashboard 
Data Providers in the reference manual Configuring Evaluation and Reference Data 
in Alfabet. 

• Analytics Dashboard Data Provider Description: Displays the description provided for the 
analytics dashboard data provider. 

Authorized Access tab: 

 
The visibility of an analytics dashboard in the Analytics Dashboards explorer mainly 
depends on the specification of the authorized user and authorized user groups in the 
editor of the analytics dashboard. A check for authorization data will be executed to en-
sure that an analytics dashboard will not be hidden from the explorer after creation be-
cause no authorized user or authorized user group has been defined in the editor or wiz-
ard. If an authorized user is not defined, you will not be able to close the editor and a 
message about the missing settings will be displayed. 
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• Authorized User: Click the Search icon to assign an authorized user to the selected analytics 
dashboard. The authorized user will have Read/Write access permissions for the analytics 
dashboard and is responsible for the maintenance of the analytics dashboard. The authorized 
user can access the analytics dashboard in the My Analytics Dashboards node in the 
Analytics Dashboards explorer. 

• Authorized User Groups: Select one or more checkboxes to assign Read/Write access 
permissions to all users in the selected user group(s). All users in the selected user groups can 
access the analytics dashboard in the Jointly Managed Analytics Dashboards node in the 
Analytics Dashboards explorer. 

4) Click OK to save your changes or click Cancel to exit without saving. 

Designing the Analytics Dashboard 

Analytics dashboards can be designed to provide ad-hoc information-rich data visualizations. The analytics 
dashboard object must be created in Alfabet as described in the section Creating an Analytics Dashboard 
and the Alfabet data to display in the analytics dashboard is fetched via the analytics dashboard data pro-
vider specified for the analytics dashboard. 

The visualization of the data in the analytics dashboard is then designed in the DevExpress Dashboard De-
signer available via the embedded third-party tool DevExpress® Dashboard. You may design the visualiza-
tion of the analytics dashboards that you have created as well as the analytics dashboards that you may 
edit, which are stored below the Jointly Managed Analytics Dashboards node. You can use the full-range 
of visualization possibilities available in the DevExpress Dashboard Designer. One or more dashboard items 
such as charts, scatter charts, grids, cards, gauges, pivots, range maps, treemaps, etc. can be added to the 
analytics dashboard and filtering options such as combo-boxes, list boxes, and tree views can be lever-
aged. 

 
Please note that this documentation addresses only the use of Alfabet-specific functionalities. 
For more information about how to design the analytics dashboard in the context of the Dash-
board Designer, see the following documentation available for DevExpress® Dashboard: 
https://devexpress.github.io/dotnet-eud/dashboard-for-web/articles/web-dashboard-de-
signer-mode.html The following link provides samples of DevExpress dashboards: https://devex-
press.github.io/dotnet-eud/dashboard-for-web/articles/web-dashboard-design 

To design the analytics dashboard: 

1) In the Analytics Dashboards explorer, expand either the My Analytics Dashboards node or the 
Jointly Managed Analytics Dashboards node. 

2) In the Analytics Dashboards explorer, click the analytics dashboard that you want to design. The 
analytics dashboard is displayed on the right in view mode.  

 
Please note the following: 

• Point to a dashboard item and click the Inspect Data  button to show 
aggregated and raw data in detail.. 

https://devexpress.github.io/dotnet-eud/dashboard-for-web/articles/web-dashboard-designer-mode.html
https://devexpress.github.io/dotnet-eud/dashboard-for-web/articles/web-dashboard-designer-mode.html
https://demos.devexpress.com/Dashboard/
https://demos.devexpress.com/Dashboard/
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• Point to a dashboard item and click the Maximize  button to maximize the 
dashboard item to fill the screen 

• To edit the analytics dashboard object, click the Edit  button. For more 
information about editing the analytics dashboard, see the section Creating an 
Analytics Dashboard 

3) Click the Configure Mode  button in the toolbar to open the Analytics Dashboard 
Designer. For each analytics dashboard, you can:  

• Use the dashboard menu to define a name for the dashboard, view the data sources, specify 
the currency, etc. Please note that the currency definition is independent of the currency 
configured in the Alfabet data. 

• Use the toolbox items pane to add dashboard items such as charts, scatter charts, grids, 
cards, gauges, pivots, range maps, treemap. 

• Bind the data fetched by the analytics dashboard data provider to the dashboard items. 

• Specify filters for the data displayed in the analytics dashboard. 

4) Click the Save Configuration  button to save the visualization of the analytics dashboard. 

5) Click the View Mode  button to view the visualization of the analytics dashboard. 

Assigning Other Users Read-Only Access to the Analytics Dash-
board 

If a user is assigned permissions to an analytics dashboard, the analytics dashboard will be available in the 
Analytics Dashboards Shared with Me node in the Analytics Dashboards explorer for the specified us-
ers. These users will be able to view but not edit the analytics dashboard. 

To assign users read-only access permissions to the analytics dashboard: 

1) In the Analytics Dashboards explorer, click either the My Analytics Dashboards node or the 
Jointly Managed Analytics Dashboards node to view the analytics dashboards that you are an 
authorized user of. 

2) In the table, select the analytics dashboard that you want to provide one or more user(s) access to 

and click the Navigate  button. 

3) Click User Access to Analytics Dashboard to open the view. 

4) Click the Add Users button to open the person selector. 

5) Select one or more users that you want to provide read-only access to and click OK. 
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Assigning User Profiles Read-Only Access to the Analytics Dash-
board 

The User Profile Access to Analytics Dashboard page view allows users with edit permissions to an ana-
lytics dashboard to change the access permissions of the analytics dashboard. If a user profile is assigned 
permissions to an analytics dashboard, the analytics dashboard will be available in the Analytics Dash-
boards Shared with My User Profiles node in the Analytics Dashboards explorer for all users logged in 
with the user profile. Users with the user profile assigned will be able to view but not edit the analytics 
dashboard. 

The table displays all user profiles that have read-only access to the selected analytics dashboard. The fol-
lowing columns are displayed: 

• User Profile: Displays the name of the user profile. 

• Administrative: Indicates whether the user profile is an administrative user profile and has access 
to standard administrative views in Alfabet as well as all configured reports specified as 
administrative. 

• Has Access: Indicates whether the user profile has read-only access to the analytics dashboard. 

To assign one or more user profiles read-only access permissions to the analytics dashboard: 

1) In the Analytics Dashboards explorer, click either the My Analytics Dashboards node or the 
Jointly Managed Analytics Dashboards node to view the analytics dashboards that you are an 
authorized user of. 

2) In the table, select the analytics dashboard that you want to provide one or more user(s) access to 

and click the Navigate  button. 

3) Click User Profile Access to Analytics Dashboard to open the view. 

4) To provide a user profile with access to the analytics dashboard, select the relevant user profile in 
the dataset and click the Grant Access button. A checkmark will be displayed in the Has Access 
column for each user profile that has been granted access to the analytics dashboard. 

5) To remove access from a user profile to the analytics dashboard, select the relevant user profile in 
the dataset and click the Revoke Access button. The checkmark will be removed from the Has 
Access column for the user profile. 

Assigning User Groups Read-Only Access to the Analytics Dash-
board 

The User Group Access to Analytics Dashboard page view allows users with edit permissions to an ana-
lytics dashboard to change the access permissions of the analytics dashboard. If a user group is assigned 
permissions to an analytics dashboard, the analytics dashboard will be available in the Analytics Dash-
boards Shared with My User Groups node in the Analytics Dashboards explorer for all users that are 
members of the user group. Users belonging to the user group will be able to view but not edit the analytics 
dashboard. 
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User groups defined as authorized user groups in the Authorized Access tab in the Analytics 
Dashboard editor will have edit access permissions to the analytics dashboard. In this case, the 
analytics dashboard will be available in the Jointly Managed Analytics Dashboards node in the 
Analytics Dashboards explorer. 

The table displays all user groups that have read-only access to the selected analytics dashboard. The fol-
lowing columns are displayed: 

• User Group: Displays the name of the user group. 

• Has Access: Indicates whether the user group has read-only access to the analytics dashboard. 

To assign one or more user groups read-only access permissions to the analytics dashboard: 

1) In the Analytics Dashboards explorer, click either the My Analytics Dashboards node or the 
Jointly Managed Analytics Dashboards node to view the analytics dashboards that you are an 
authorized user of. 

2) In the table, select the analytics dashboard that you want to provide one or more user groups 

access to and click the Navigate  button. 

3) Click User Group Access to Analytics Dashboard to open the view. 

4) To provide a user group with access to the analytics dashboard, select the relevant user group in 
the dataset and click the Grant Access button. A checkmark will be displayed in the Has Access 
column for each user group that has been granted access to the analytics dashboard. 

5) To remove access from a user group to the analytics dashboard, select the relevant user group in 
the dataset and click the Revoke Access button. The checkmark will be removed from the Has 
Access column for the user group. 
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Chapter 15:  Defining and Navigating with Your Corporate Frame-
works 

A framework is a means to define a semantic structure for objects managed in Alfabet, regardless of the 
object class that an object belongs to. In Alfabet, a framework is a hierarchically structured collection of 
framework groups in which a user can navigate through the levels of the framework structure. 

Alfabet provides the Corporate Framework Designer functionality that allows you to create and design 
framework diagrams and reference models. Users can navigate the diagrams and access data within the 
context of the framework or reference model. For example, you could configure a standard framework like 
Zachman or TOGAF® or a reference model that is domain specific, such as a business architecture with its 
business data and usage or a warehouse management system and its technical components. 

A framework in this context is a placeholder to model and present your objects in a specific structure that 
may be different from the structure of you inventory objects in Alfabet. The framework is merely used as 
for purposes of visualization and presentation. 

The framework diagrams can be viewed by users in the Corporate Frameworks functionality. They are 
typically viewed by a large number of users that may have no direct access to the inventory of objects in 
Alfabet. 

The following information is available: 

• Designing Framework Diagrams and Reference Models 

• Creating a Framework Group 

• Assigning Objects to the Framework Group 

• Defining Subordinate Framework Groups 

• Adding an Existing Sub-Group 

• Removing a Sub-Group 

• Deleting a Sub-Group 

• Designing the Navigation Diagram for a Framework Group 

• Working with Corporate Frameworks in Alfabet 

Designing Framework Diagrams and Reference Models 

The Corporate Framework Designer allows you to create and design framework diagrams and reference 
models. Users can navigate the diagrams and access data within the context of the framework or reference 
model. For example, you could configure a standard framework like Zachman or TOGAF® or a reference 
model that is domain specific, such as a business architecture with its business data and usage or a ware-
house management system and its technical components. 

A framework in this context is a placeholder to model and present your objects in a specific structure that 
may be different from the structure of you inventory objects in Alfabet. The framework is merely used as 
for purposes of visualization and presentation. The framework diagrams created by a framework designer 
are typically viewed by a large number of users that may have no direct access to the inventory of objects 
in Alfabet. 
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A framework group is a container to structure objects from different object classes in order to view, ana-
lyze, and communicate the company's enterprise architecture. 

The Corporate Framework Designer functionality allows you to: 

• Define framework groups at the top-level of the explorer. You can create an unlimited number of 
subordinate framework groups for each root-level framework group. 

• Assign an unlimited number of sub-groups and objects to framework groups. You may view the 
details of all objects that you assign to the framework diagram. However, framework objects 
cannot be edited in the context of the Corporate Framework Designer functionality. 

• Define the visualization of the framework diagram. You can test the framework diagram that you 
create here in the Corporate Frameworks functionality. For more information, see Working with 
Corporate Frameworks in Alfabet. 

Users can view the framework groups in the Corporate Frameworks functionality. 

The following information is available. 

• Creating a Framework Group 

• Assigning Objects to the Framework Group 

• Defining Subordinate Framework Groups 

• Adding an Existing Sub-Group 

• Removing a Sub-Group 

• Deleting a Sub-Group 

• Designing the Navigation Diagram for a Framework Group 

Creating a Framework Group  

To create a new framework group at the top-level of the explorer structure: 

1) In the Corporate Framework Designer functionality, click the Corporate Framework Designer 

icon  at the top of the explorer. 

2) In the toolbar, click New > Create New Framework Group. The Framework Group editor opens. 

3) Enter information into each field, as required.  

Basic Data tab: 

• ID: Alfabet assigns a unique identification number to each object in the inventory. This number 
cannot be edited. 

• Name: Enter a unique name for the framework group. 

• Description: Enter a meaningful description that will clarify the purpose of the framework 
group. 

• Show Text: Enter the text to be visualized on the diagram item in the framework diagram. 
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Authorized Access tab: 

• Authorized User: Click the Search icon to assign an authorized user to the selected object. 
The authorized user will have Read/Write access permissions to the object and is authorized to 
maintain the object in Alfabet. 

• Authorized User Groups: Select the checkbox to assign Read/Write access permissions to all 
users in the selected user group. For more detailed information about the concept of access 
permissions, see the section Understanding Access Permissions in Alfabet in the reference 
manual Getting Started with Alfabet. 

4) Click OK to save the framework group or Cancel if you do not want to save it. 

 
If you delete an object in the object class Framework Group, it will be irrevocably deleted from the 
Alfabet database. If any of the following dependent objects or data is defined for the deleted ob-
ject, these will also be deleted: Assignment, Attachment, Deputy, Evaluation, Role. 

Assigning Objects to the Framework Group 

A framework group groups object classes that share a specific context. The Objects page view allows you 
to assign an unlimited number of objects to a framework group. You can also group objects from different 
classes together. 

The Objects page view displays all objects that have been assigned to the framework group. The objects 
are organized according to object class. You cannot edit the details of an object in the Objects page view. 
Each column in the table is defined below: 

• Name: Displays the object’s name. 

• State: Displays the object’s state 

To add existing objects to a framework group: 

1) Go to the selected framework group's profile and click Objects. 

2) In the toolbar, click New > Add Existing Objects. 

3) The object selector opens. Enter search criteria, as needed, and click Search. 

4) Click the object and click OK. The object appears in the table. 

Defining Subordinate Framework Groups 

The Subordinate Framework Groups page view allows you to create sub-groups for a selected framework 
group. A framework group can have an unlimited number of sub-groups as well as an unlimited number of 
levels in the tree structure. 

The Subordinate Framework Groups page view displays the subordinate groups that have been defined 
for the framework group selected in the Corporate Frameworks explorer. Each column in the table is de-
fined below: 

• ID: Displays the identification number of the sub-group 
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• Short Name: Displays the sub-group’s short name 

To create a subordinate framework group: 

1) Go to the selected framework group's profile and click Subordinate Framework Groups. 

2) In the toolbar, click New > Create New Framework Group. The Framework Group dialog box 
opens. 

3) Enter the information into each field, as required.  

Basic Data tab: 

• ID: Alfabet assigns a unique identification number to each object in the inventory. This number 
cannot be edited. 

• Name: Enter a unique name for the framework group. 

• Description: Enter a meaningful description that will clarify the purpose of the framework 
group. 

• Show Text: Enter the text to be visualized on the diagram item in the framework diagram. 

Authorized Access tab: 

• Authorized User: Click the Search icon to assign an authorized user to the selected object. 
The authorized user will have Read/Write access permissions to the object and is authorized to 
maintain the object in Alfabet. 

• Authorized User Groups: Select the checkbox to assign Read/Write access permissions to all 
users in the selected user group. For more detailed information about the concept of access 
permissions, see the section Understanding Access Permissions in Alfabet in the reference 
manual Getting Started with Alfabet. 

4) Click OK to save the framework group or Cancel if you do not want to save it. 

Adding an Existing Sub-Group 

To add an existing framework group as a sub-group: 

1) In the toolbar, click New > Add Existing Framework Group. 

2) The object selector opens. Enter search criteria, as needed, and click Search. 

3) Click a sub-group and click OK. The sub-group appears in the table. 

Removing a Sub-Group 

If you remove any framework group, its sub-groups will also be removed. To remove a sub-group: 

1) In the table, click the sub-group that you want to remove. 

2) In the toolbar, click the Detach  button. 

3) Confirm the warning by clicking Yes, or click No to exit without saving your changes. 
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Deleting a Sub-Group 

If you delete any framework group, it’s sub-groups will move to the top level of the explorer hierarchy. To 
delete a sub-group: 

1) In the table, click the sub-group that you want to delete. 

2) In the toolbar, click the Delete  button. 

3) Confirm the warning by clicking Yes, or click No to exit without deleting the selected object(s). 

Designing the Navigation Diagram for a Framework Group 

The Navigation Diagram page view allows you to view and design a framework group. Before you do this, 
you should create all necessary sub-groups and objects that are relevant to the selected framework group. 
Once these objects are created, you can define the visualization of all objects in the framework group in the 
Navigation Diagram page view. 

 
To design a diagram, you must have access to the tool Alfabet Diagram Designer. You can access 
the Alfabet Diagram Designer by clicking the Open Diagram button. If the button is not visible in 
the view you are working with, you do not have the relevant access permissions to design dia-
grams in the Alfabet Diagram Designer. 

 

 
For general information about designing, interpreting, and navigating diagrams in Alfabet, see 
the section Working with Diagrams in the reference manual Getting Started with Alfabet. For de-
tailed information about how to design a diagram in the Alfabet Diagram Designer, see the refer-
ence manual Designing IT Landscape Diagrams in Alfabet. 

When you open a diagram, you will see the diagram with the default settings. To change the dis-
play, set the following filters and click Update. To save the diagram layout for the selected pro-
ject, click Save Layout. 

• Object State: Define the application’s object state that you want to view in the diagram. 
All applications with the defined object state will be displayed in the diagram. The default 
displays all object states. 

• Information Flow Attribute: Select one or more information flow attributes that you 
want to display on the information flows. The attributes available in the Information 
Flow Attribute field are configured by your solution designer in the XML object 
DiagramInformationFlowDef in the configuration tool Alfabet Expand. For more 
information, see the section Configuring the Visualization of Connection Items and 
Subordinate Object in Diagrams in the reference manual Configuring Alfabet with 
Alfabet Expand. 

• Object Filter : Select one or more standard or custom attributes in order to specify 
which applications and local components to display. The checked attributes are 
combined with an OR property so that an application or local component will be 
displayed if it satisfies at least one of the checked attributes. The filter displays standard 
and custom attributes that have an enumeration defined or are of the type Boolean 
(True/False). The attribute is written using the following convention: 
ClassName.PropertyName. 
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• Layout : If necessary, define the layout you want to display. The default layout type is 
Condensed whereby all information flows for the same nodes are stacked on top of each 
other. The number of stacked information flows is displayed on the information flow 
node. Other layout choices include Mixed Model, Spring, and Sugiyama. 

 
Please keep the following in mind: 

• A page size selected in the Format field is only applied to the 
diagram if Mixed Model, Spring, and Sugiyama are selected in 
the Layout field. If Condensed is selected in the Layout field, the 
page size definition will have no impact. 

• If Spring has been selected in the Layout field, click the Update 
button to improve the layout. Whenever the Update button is 
clicked, the algorithm will attempt to improve the node 
placement. 

• Diagram Item Size: Select the size of the diagram items displayed in th the diagram. 
Depending on the configuration, some sizes may be configured to hide the name, icon, 
and attributes. In this case, point to the diagram item to display a tooltip with the 
object's name or click-and-hold to open the preview of the object. The values available 
in the Diagram Item Size field are configured by your solution designer in the XML 
object DiagramInformationFlowDef in the configuration tool Alfabet Expand. For more 
information, see the section Configuring the Sizes of Diagram Items in Automatically 
Generated Diagrams in the reference manual Configuring Alfabet with Alfabet Expand. 

• Format: Define the page format to use to display the diagram. 

• Active Date: Define a date to display all applications for which the selected date is 
within the application's active period (as defined by its start and end date). 

• Landscape: Set a checkmark to display the diagram in landscape orientation. Clear the 
checkmark to display the diagram in portrait orientation. 

• Hide Mismatches: Set a checkmark to remove (hide) the greyed out objects from the 
diagram that do not meet the selector or filter settings. 

To open the Navigation Diagram page view: 

1) Go to the selected framework group's profile and click Navigation Diagram. 

2) If a diagram already exists, you will see it in the page view area. If no diagram yet exists for the 
framework group, you will see the default view.  

 
If the page view is empty, you must first define sub-groups and objects for the selected 
framework group. 

3) To access the Alfabet Diagram Designer, click the Open Diagram button in the header of the 
Navigation Diagram page view you are currently working in. The Alfabet Diagram Designer opens. 
You can design your framework diagram in the Alfabet Diagram Designer. Please refer to the 
chapter Designing Framework Group Diagrams in the reference manual Designing IT Landscape 
Diagrams in Alfabet. 
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4) After you have designed a framework group and closed the Alfabet Diagram Designer, click 
Update in order to view the most recent changes to the diagram. The filter settings you define in 
the header page view will be applied to your new diagram. 

Working with Corporate Frameworks in Alfabet 

The Corporate Frameworks functionality allows you to view a framework diagram and navigate to infor-
mation about objects in Alfabet. A framework diagram models and presents objects in a specific structure 
that may be different from the structure of the inventory objects. The diagram is used solely for the pur-
poses of visualization, presentation, and navigation. 

Open the Corporate Frameworks functionality explorer, select the relevant framework group  and 
click Navigation Diagram. You will see the framework diagram for the selected framework group. The first 
time the framework group is selected, you will see the diagram with the default settings. To change the dis-
play, select a diagram view in the Diagram View filter and click Update. A diagram view allows users to su-
perimpose qualitative information - such as indicators - on the objects in the diagram. 

 

Frameworks are designed in the Corporate Framework Designer. For more information, see 
the section Designing Framework Diagrams and Reference Models. Diagram views must be con-
figured in order to select and display them in this view. For more information about the configu-
ration of diagram views, see the section Configuring Diagram Views for Diagrams in the refer-
ence manual Configuring Evaluation and Reference Data in Alfabet. 



 
 Chapter 16: Working with Storyboards 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 322 

Chapter 16:  Working with Storyboards  

Storyboards provide a portal-like environment that allows users to easily access data and relevant infor-
mation for their tasks. For example, storyboards may be defined for various stakeholders in the enterprise 
such as CIOs and business managers as well as users who have concrete aspects of the IT inventory that 
they are responsible for. The Storyboards explorer allows you to access all storyboards that you are the 
authorized user of or that you have been defined access permissions for as a specified user, member of a 
user group, or user assigned a permissible user profile. 

In the Storyboards explorer, click a storyboard  to display it in the workspace to the right. You will see 
the selected storyboard on the right. Each graphic element in the diagram will typically have a bookmark 
defined behind it that targets a view in Alfabet. However, there may also be links to other storyboards, ARIS 
diagrams, websites and documents. You can click a link (or a part of the graphic image representing the 
link) and the link target will open. 

  

 FIGURE: Storyboard diagram with 5 bookmarks 

Storyboards are created in the Storyboard Management capability and designed in the Alfabet Diagram 
Designer. 

The following information is available: 

• Creating and Managing Storyboards 

• Creating Bookmarks for the Storyboard 

• Creating ARIS Diagram Links for the Storyboard 

• Creating a Diagram for the Storyboard 



 
 Chapter 16: Working with Storyboards 

Alfabet 10.15 ©2023 Software AG. All rights reserved. Reference Manual 323 

• Designing a Diagram for the Storyboard 

• Defining User Access to a Storyboard 

• Defining User Group Access to a Storyboard 

• Defining User Profile Access to a Storyboard 

• Defining the Storyboard as the Start Page for Users 

Creating and Managing Storyboards 

The Storyboard Management functionality allows you to create and design storyboards for various kinds 
of users from CIOs to business managers to those responsible for the IT. The storyboard is a diagram made 
up of a set of visual links that allow users to navigate directly to the information they need. The dashboard 
typically consists of bookmarks that target objects in explorers, object profiles (or object cockpits), page 
views, or configured reports. A dashboard may also have links to other storyboards, ARIS diagrams, web-
sites or documents. 

Users defined as viewers of the storyboard will be able to access it in the Storyboards functionality. If a 
storyboard has been defined for a user, the bookmark can be accessed via Bookmarks > Show Start Sto-
ryboard. If no dashboard is available for the user, the option will not be displayed in the Bookmarks drop-
down menu. You can also make a storyboard available to specific users as the start page that they first see 
after they log in to Alfabet. 

The following steps that are required in order to create a storyboard: 

• Create all bookmarks, ARIS diagram links, and other storyboards that are to be available in the 
storyboard. A standard default setting should be defined for any existing filters in views targeted 
by a bookmark. 

• Create a storyboard diagram containing bookmarks and other links that should be accessed by a 
specific set of users via the storyboard. The diagram is created in the Alfabet Diagram Designer 
which can be accessed via the Storyboard Diagram page view. 

• Assign the users who may access the storyboard in the Viewers page view. These users will see 
the storyboard when they open the Storyboards functionality. 

• Assign the user groups who may access the storyboard in the Attached User Groups page view. 
Users in these user groups will see the storyboard when they open the Storyboards functionality. 

• Assign the user profiles who may access the storyboard in the Attached User Profiles page view. 
Users with these user profiles will see the storyboard when they open the Storyboards 
functionality. 

• Assign the users who shall view the storyboard as their start page in the Use for Start Page page 
view. 

The following information is available: 

• Creating Bookmarks for the Storyboard 

• Creating ARIS Diagram Links for the Storyboard 

• Creating a Diagram for the Storyboard 
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• Designing a Diagram for the Storyboard 

Creating Bookmarks for the Storyboard 

Before you can configure the storyboard, you must create all bookmarks that are to be available in the sto-
ryboard. A standard default setting should be defined for any existing filter settings in the view when the 
bookmark is defined. You can open a separate browser window to create the bookmarks and assign them 
directly to the dashboard diagram in the Alfabet Diagram Designer. 

For information about how to create bookmarks, see the chapter Creating, Managing, and Accessing Your 
Bookmarks. 

 
Please keep the following in mind when defining and accessing bookmarks: 

• A bookmark created for an explorer is a reference to a position in an explorer. The 
explorer hierarchy is dynamically computed at runtime. If the structure of the explorer 
changes, the link may no longer be valid. For example, if new intermediary levels have 
been added to an explorer since the bookmark was created, the path saved for the 
bookmark will no longer be accurate and the bookmarked location may not be found. 

• Please note that some explorers and views cannot be bookmarked. For example, 
bookmarks cannot be created for functionalities used for administrative purposes that 
are available via an administrative user profile or configuration functionalities that are 
not associated with objects governed by access permissions. If the functionality or view 
may not be bookmarked, the Create Bookmark capability will be disabled. 

• The user profile that your are logged in with when you create the bookmark is the user 
profile used to initially open the bookmark. Thus, if a bookmark is shared with other users 
via a storyboard, for example, then those users accessing an Alfabet functionality via 
the dashboard will access the functionality with the user profile associated with the 
bookmark implemented in the storyboard. For more information about working with 
storyboards, see the chapter Working with Storyboards. 

Creating ARIS Diagram Links for the Storyboard 

Before you can configure the storyboard, you must create all ARIS diagram links that are to be available in 
the storyboard. In the object selector that opens when users select the ARIS diagram link to assign to the 
dashboard, users can search via the Simple tab for any ARIS diagram link defined for any object in Alfabet, 
or search the business process hierarchy for ARIS diagram links defined for the relevant business pro-
cesses via the Browse tab. Please note that other browse hierarchies may be configured in Alfabet Expand 
and displayed in the object selector. Links to ARIS diagrams must first be created in the ARIS Diagrams 
Page View. 

Creating a Diagram for the Storyboard  

You can create multiple storyboard diagrams. The storyboard diagrams that you create can be accessed by 
users in the Storyboards functionality or as their start page, if so defined. Once you have created the 
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diagram, you can add bookmarks to it and design the layout of the diagram in the Alfabet Diagram Designer. 
To create a dashboard diagram, open the Storyboard Management functionality and click New > Create 
Storyboard Diagram in the toolbar. In the window that opens, enter a name and, if necessary, a descrip-
tion and click OK. The new diagram name appears in the table. You can now design the diagram. 

 

Alternatively, you can click New > Copy Selected Diagram in the toolbar in order to create a dia-
gram based on an existing diagram. 

Designing a Diagram for the Storyboard 

Storyboard diagrams are designed in the Alfabet Diagram Designer, which can be opened via the Open Dia-
gram button in the Storyboard Diagram page view. The diagram designer can add links to other story-
boards as well as bookmarks, Web links, and ARIS diagram links. Any links to storyboards, bookmarks, and 
ARIS diagrams must first be created before they can be added to the storyboard diagram. 

The links can be visually designed using any of the visual design elements available in Alfabet Diagram De-
signer. For example, the link could be placed behind an image so that when the user clicks the image, the 
link will open in the Storyboards functionality. 

 
To design a diagram, you must have access to the tool Alfabet Diagram Designer. You can access 
the Alfabet Diagram Designer by clicking the Open Diagram button. If the button is not visible in 
the view you are working with, you do not have the relevant access permissions to design dia-
grams in the Alfabet Diagram Designer. 

The following description is a brief explanation of how to create a storyboard diagram. Detailed information 
is available in the chapter Designing Storyboard Diagrams in the reference manual Designing IT Landscape 
Diagrams in Alfabet. 

To access the Alfabet Diagram Designer in order to design a storyboard diagram: 

1) Click a storyboard in the Storyboards Management view, navigate to the storyboard object 
profile and click Storyboard Diagram. 

2) In the view that opens, click the Open Diagram button. The Alfabet Diagram Designer opens in a 
new browser tab. 

3) You can add existing bookmarks, links to ARIS diagrams or other storyboards as well as Web links 
and documents:  

• To add a link that navigates to another storyboard diagram, click the Storyboard icon  in 
the Toolbox Items pane and click a blank space in the diagram. The object selector opens. 
Define search parameters, as needed, and select the storyboard diagram(s) you want to add to 
the diagram. After you click OK in the object selector, a yellow rectangle is placed in the 
diagram. 

• To add a Web link that opens a website or an externally-stored document, click the Web 

Link  icon in the Toolbox Items pane and click a blank space in the diagram. The URL 
editor opens. Define the following fields and click OK:  

• Title: Enter the text that should be displayed for the Web link. The text should help users 
understand why the URL is available. Please note that the text will be displayed in the 
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language in which it was captured and will not be translated if the user interface is 
rendered in a secondary language. 

• URL: Enter the complete URL starting with http://, or click the Browse button to navigate 
to a directory where a document is located that you want to link to. The URL link may 
contain up to 511 characters. 

• Category: Optionally select the document category that the URL should be assigned to. 

• To add a link that opens a bookmarked object profile/object cockpit, explorer, or view, click the 

Bookmark icon  in the Toolbox Items pane and click a blank space in the diagram. In the 
object selector, define search parameters, as needed, and select the bookmark(s) you want to 
add to the diagram. After you click OK in the object selector, a white rectangle is placed in the 
diagram. 

• To add a link to ARIS diagrams in ARIS, click the ARIS Diagram Link icon  in the Toolbox 
Items pane and click a blank space in the diagram. In the object selector, define search 
parameters, as needed, and select the ARIS diagram link(s) you want to add to the diagram. 
After you click OK in the object selector, a white rectangle is placed in the diagram. 

4) Repeat the previous steps, as needed, in order to add the relevant links to the storyboard diagram. 

5) Design the visualizations of the links with text, color, images, etc., as needed. For more 
information, see the section Tips for Designing the Layout of the Diagram. 

6) Click the Save button to save your changes. 

7) Return to the browser tab displaying the Storyboard Diagram page view and click the Update 
button to view the design. Please note that you cannot navigate via the links in this view. To 
navigate to the views targeted by the links, go to the Storyboards functionality and select the 

relevant storyboard  in the explorer. 

Defining User Access to a Storyboard  

In the Viewers page view in the Storyboard Management functionality, you can define the users that may 
access a storyboard diagram. Only those users defined as viewers will be able to view and access the story-
board in the Storyboards functionality. 

To define the users that may access a storyboard diagram: 

1) Click a storyboard in the Storyboards Management view, navigate to the storyboard object 
profile and click Viewers. 

2) In the toolbar, click New > Add New Viewers. 

3) The person selector opens. Enter search criteria to find the relevant users and click Search. 

4) In the selector, select the user(s) who should have access to the storyboard and click OK. The user 
is added to the list of viewers and his/her name and email address is displayed in the table. 
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Defining User Group Access to a Storyboard  

In the Attached User Groups page view in the Storyboard Management functionality, you can define the 
user groups that may access a storyboard diagram. Only users in the assigned user groups will be able to 
view and access the storyboard in the Storyboards functionality. 

To define the user groups that may access a storyboard diagram: 

1) Click a storyboard in the Storyboards Management view, navigate to the storyboard object 
profile and click Attached User Groups. 

2) In the toolbar, click New > Assign User Groups. 

3) The user group selector opens. Enter search criteria to find the relevant user groups and click 
Search. 

4) In the selector, select the user group(s) who should have access to the storyboard and click OK. 

Defining User Profile Access to a Storyboard  

In the Attached User Profiles page view in the Storyboard Management functionality, you can define 
the user profiles that may access a storyboard diagram. Only users in the assigned user profiles will be able 
to view and access the storyboard in the Storyboards functionality. 

To define the user profiles that may access a storyboard diagram: 

1) Click a storyboard in the Storyboards Management view, navigate to the storyboard object 
profile and click Attached User Profiles. 

2) In the toolbar, click New > Assign User Profiles. 

3) The user profile selector opens. Enter search criteria to find the relevant user profiles and click 
Search. 

4) In the selector, select the user profile(s) who should have access to the storyboard and click OK. 

Defining the Storyboard as the Start Page for Users  

In the Use for Start Page page view in the Storyboard Management, you can define the users that may 
access the storyboard diagram as their start page. All users defined in this view will see the storyboard dia-
gram as their start page. If multiple storyboards are defined as the start page for a user, a view with a link to 
all storyboards defined as start pages for that user will be displayed after the user logs in to Alfabet and the 
user can click the link to the relevant dashboard. 

 
If a storyboard has been configured as the start page for a user, the storyboard will have prece-
dence over the guide page configuration and the user will not have access to the guide pages 
defined for his/her user profile. 

To define the users that may access a storyboard diagram: 

1) Click a storyboard in the Storyboards Management view, navigate to the storyboard object 
profile and click Use for Start Page. 
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2) In the toolbar, click New > Add New Persons. 

3) The person selector opens. Enter search criteria to find the relevant users and click Search. 

4) Select the user(s) who should have see the storyboard as their start page and click OK. The user is 
added to the list of users and his/her name and email address is displayed in the table. 
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Appendix 1:   Configuration Tools and Functionalities for 
Alfabet  

Software AG provides a number of tools to simplify the tasks of configuration. If a specific tool is not de-
scribed in this documentation, the respective manual describing the tool will be referenced. 

The following Alfabet tools and functionalities are described below: 

Use the 
Configura-
tion Tool... 

In Order To... 

 Alfabet Ad-
ministrator  

Configure the Alfabet components and manage the Alfabet database. Configure access 
rights to Alfabet and track Alfabet usage and audit history.  

The Alfabet Administrator is described in the reference manual System Administration. 

 Alfabet Ex-
pand  

Configure the Alfabet solution. Many Alfabet functionalities as well as administrative 
tasks are based on a specific solution configuration defined in Alfabet Expand. For infor-
mation about the configuration tool Alfabet Expand, see the reference manual Configur-
ing Alfabet with Alfabet Expand. This is available as a PDF document on your installation 
CD.  

Alfabet Expand is currently available as either Alfabet Expand Windows or as Alfabet Ex-
pand Web. Alfabet Expand Web is available for the Alfabet Cloud Enterprise and is a web-
based tool that supports most core configuration tasks. Alfabet Expand Windows is re-
quired for more complex configuration tasks including workflow configuration, ADIF, and 
APF. 

 Guide 
Pages De-
signer  

Create customized as start pages for the user profiles in your user community. The Guide 
Pages Designer is available as a web-based tool. For information about the Guide Pages 
Designer, see the reference manual Designing Guide Pages for Alfabet. This is available 
as a PDF document on your installation CD. 

 

Use the Func-
tionality in 
Alfabet... 

In Order To... 

 Administration 
application 

The Administration application is accessible via the Alfabet interface by using the 
Admin user profile. For more information, see the reference manual User and Solu-
tion Administration. 

The Administration application contains the following modules and functionalities: 

• User Administration  

• User Profiles Administration 



 
 Appendix 1:  Configuration Tools and Functionalities for Alfabet 

Alfabet 10.15  ©2023 Software AG. All rights reserved. Reference Manual 330 

Use the Func-
tionality in 
Alfabet... 

In Order To... 

• Users Administration 

• User Groups Administration 

• Reports Administration 

• Solution Administration  

• Monitors 

• Date Monitors 

• Consistency Monitors 

• Notification Monitors 

• Monitor Management 

• Workflow Administration 

• Internal Documents 

• Archive Manager 

• Broadcast Messages 

• Discussion Groups 

• Risk Management Templates 

• Technical Environments 

• Time Series Manager 

• Publications Manager 

• Risk Mitigation Templates by Risk Mitigation Category 

• ADIF Jobs Administration 

• Email Messages logging 

• Automated Data Translations 

• Event Administration 

• Questionnaire Indicators 

• Configuration  

• Reference Data 

• Evaluations and Portfolios 

• Class Configuration 
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Use the Func-
tionality in 
Alfabet... 

In Order To... 

• Diagram Views 

• Costs Centers 

• Manage Business Documents 

• Color Rules Manager 

• Enterprise Calendars 

• Integration Solutions Configuration 

• Search  

• Simple Search 

• Browse 

• Full-Text Search 

• Glossary 

• Reports 

• Publication 

• Admin Desktops  

• Organization Admin 

• Application Group Admin 

• Component Group Admin 

• Domain Admin 

• ICT Object Category Admin 

• Data  

• Capture Data 

• ADIF Jobs Administration 

 Configuration 
module 

The Configuration module is accessible via the Alfabet interface. For more infor-
mation, see the reference manual Configuring Evaluation and Reference Data in 
Alfabet. 

The Configuration module contains the following functionalities: 

• Reference Data 

• Evaluations and Portfolios 
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Use the Func-
tionality in 
Alfabet... 

In Order To... 

• Class Configuration 

• Diagram Views 

• Costs Centers 

• Manage Business Documents 

• Color Rules Manager 

• Enterprise Calendars 

• Integration Solutions Configuration 

The configuration tools Alfabet Expand and the Guide Pages Designer are optional components. Their avail-
ability is regulated by your enterprise's licensing agreement with Software AG. In addition to the configura-
tion tools, a number of small executables for batch job processing are available. Their functionality is de-
scribed in the reference manual System Administration in conjunction with the relevant tasks to be per-
formed. 
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Index 

access permission see  permission 

accessibility 30 

accessing publications 176 

active period 87 

activity monitor 283 

activate 285 

deactivate 285 

target object 286, 289 

Add Missing Object button 95 

Add to Clipboard button 172 

Admin user profile 318 

Administration module 318 

affinity matrix 150 

Alfabet Administrator 318 

Alfabet Diagram Designer 

accessing 131 

Alfabet Expand 318 

Alfabet interface see  interface 

AlfaBot 

accessing 56 

analytics dashboards 298 

application version 

lifecycle report 139 

ARIS diagram link 

adding to storyboard 315 

assigment 

mandatory 237 

assignment 
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closed 249 

completing 246 

creating 237 

deadline 245, 248 

deleting 249 

my assignments 244 

optional 237 

overdue 246 

permission 29 

proxy 191, 243 

reassigning 240 

reminder 245, 248 

status change 241 

sub-assignment 242 

target date 248 

writing notes 239 

asynchronous execution 

configured report 160 

attachment 

collaboration topic 215 

attribute 83 

editing in object profile 117 

mandatory 89 

audit history 

viewing 175 

Audit Trail button 175 

authorized deputy 

permission 28 

authorized user 

notify 174 

permission 27 

reassigning 187 

authorized user group 

permission 28 

propagation/inheritance 28 

automated help assistant 

accessing 61 

automated translation 106 

availability of user 190 

Back button 

wizard 104 

bar chart 152 

barrier free 30 

BMP file 
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exporting 169 

bookmark 

adding to storyboard 315 

collaboration topic 214 

creating 201 

default view 19 

organizing 203 

printing 162 

showcase database 50 

bookmark desktop 201 

bookmark folder 

organizing bookmarks 203 

broadcast message 44 

browse search 180 

browser 11 

business graphic 

printing 162 

business support map 162 

configured 141 

business support matrix 

configured 141 

Calculate Indicators 

diagram 131 

calendar 100, 124 

change password 18 

Change User Mandate 16 

Change User Profile 15 

chat bot see  AlfaBot 

check box 99 

check entry 19 

CheckBox 124 

class see  object class 

Class Configuration 320 

clipboard 172 

cluster map 149 

cockpit see  object cockpit 

collaboration 210 

personal setting 19 

collaboration topic 



 
 Index 

Alfabet 10.15  ©2023 Software AG. All rights reserved. Reference Manual 336 

accessing 213 

adding bookmark 214 

attaching document 215 

creating 211 

exporting 215 

inviting users 215 

posting message 214 

searching 213 

tagging 211 

collapse 

dataset 126 

color rule 

diagram 131 

column 

visibility in table 126 

configuration 

Alfabet 13 

editor 13 

configuration module 320 

Configure button 126 

Configure Reminder Period 245 

configured report see  report 

affinity matrix 150 

bar chart 152 

business support matrix 141 

cluster map 149 

diagram matrix 150 

executing 157 

layered diagram 145 

offline execution 160 

pie chart 152 

radar 152 

tree 147 

treemap 156 

console report 

PDF file 168 

content voting 65 

context-sensitive help see  online help 

corporate framework 310 

Costs Centers 320 

culture setting 

default 17, 19 

custom selector 178 

custom wizard 102 
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customer feedback see  Feedback Bot 

customized editor 89 

dashboard see  storyboard, see  analytics dashboard 

PDF file 168 

dashboards 

ad-hoc 298 

analytics 298 

DevExpress 298 

data see  object 

translate 106 

data capture 

secondary language 112 

statutory language 114 

data translation 89 

database 

showcase 50 

dataset 

exporting to XSL 167 

date format 100, 124 

editor 89 

date monitor 289 

activate 292 

deactivate 292 

target object 292 

deadline 

my assignment 245 

myassignment 248 

Default Language 17 

Default User Profile 19 

Delete button 119 

deleting an object 119 

deputy 

permission 28 

Detach button 119 

detaching an object 119 

DevExpress dashboards 298 

diagram 
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color rule 131 

creating for storyboard 314 

designing 131 

Diagram View 131 

filter 131 

fit to windo 131 

framework 309 

indicator 131 

legend 131 

print 131 

printing 162 

size 131 

zoom 131 

Diagram Designer see  Alfabet Diagram Designer 

keyboard shortcut 30 

diagram matrix 150 

diagram view 

diagram 131 

Diagram Views 320 

disable automated translation 106 

discussion 

closing 232 

contributing to 232 

inviting user 232 

starting 231 

discussion group 

permission 29 

DOC file 

exporting 168 

document 

adding to storyboard 315 

collaboration topic 215 

downloading publications 176 

Draft status 

deleting object 119 

Drill Down to Object Diagram 129 

drop-down list 99, 124 

editor 

customized 13 

dates 89 

language 89 

mandatory field 89 

online help 89 

translating data 106 

email 
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monitor 279 

email address 19 

EMF file 

exporting 169 

Empower eService 49 

Enable Feedback Bot 19 

Enable Splash Screen 294 

Enable User Interface to Poll Web Server 19 

error reporting 49 

Error state in workflow 262 

Evaluations and Portfolios 320 

event 262 

Event Feedback 

configured report 160 

Execute Object Validation 19 

executing offline 

configured report 160 

eXpand 

dataset 126 

explorer 63 

printing 162 

export 

BMP file 169 

collaboration topic 215 

data 164 

dataset to XSL 167 

EMF file 169 

HTML file 169 

including filter setting 19 

JPEG file 169 

object cockpit 168 

object profile 164 

PDF file 168 

PNG file 169 

SVG file 169 

XLS file 167 

XLSX file 167 

Export button 164 

export user for an object 65 

express view 209 

favorites see  bookmark 

federated architecture 16 
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permission 25 

feedback bot 

accessing 60 

filter 

defining 122 

diagram 131 

Help 122 

filter setting 

including in export 19 

framework 

adding objects 307 

configuring 305 

modeling diagram 309 

framework diagram 309 

framework group 

adding objects 307 

creating 306 

defining sub-group 307 

full text search 181 

full-text search 

operators 183 

Gantt chart 

standard report 139 

global search 178, 181 

glossary 

creating 184 

searching 184 

glossary item 185 

Go To Step field 104 

graphic 

portfolio 136 

Guide Pages Designer 318 

help see  online help 

defining editor 89 

defining filter 122 

Help on Filter Fields 122 

Hide Filter Panel 122 

HTML 

collaboration topic 215 

HTML file 

exporting 169 

hyperlink 
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sending to user 209 

inactivity 

marking as reviewed 173 

inactivity monitor 286 

activate 289 

deactivate 289 

incidence reporting 49 

Include Filter Summary 19 

indicator 

diagram 131 

inheritance 

permission 28 

inline editing 117 

instance data 

translate 106 

instance translation 89 

interface 52 

explorer 63 

object cockpit 65 

object view 65 

page view 71 

start page 53 

toolbar 77 

interface configuration 13 

interface language 17 

invited user 

collaboration topic 215 

issue reporting 49 

JavaScript 

online help 45 

key sequence 30 

keyboard shortcut 30 
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bookmark desktop 43 

diagram designer 30 

editor 39 

explorer 34 

filters 39 

focus color 30 

menu bar 33, 34 

object cockpit 30 

object profile 35 

page view 36 

search functionality 44 

selector 43 

wizard 39 

workflow explorer 30 

keyword 

collaboration topic 211 

language 17 

editor 89 

layered diagram 145 

legend 

diagram 131 

lifecycle 87 

lifecycle report 139 

liking an object 65 

line chart 152 

configured report 152 

link 

sending user 209 

localization 106 

log in 

default user profile 19 

mandate 16 

user 13 

user profile 15 

Log Out 

user 13 

mandate 16 

express view 209 

permission 25 
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